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BOOK OVERVIEW AND
ADDITIONAL RESOURCES

Thank you for using MicroStrategy—Platform for Mobile Intelligence.

The MicroStrategy Basic Reporting Guide describes the steps for a business
analyst to execute and analyze a business report in MicroStrategy
Developer and MicroStrategy Web. It also provides the information
necessary for report designers to design, create, and modify simple
business reports and reporting objects using the MicroStrategy platform.

Specifically, this guide provides the following information:

• Chapter 1, Getting Started with MicroStrategy Reporting, shows you how
to log in and get started with MicroStrategy Developer and MicroStrategy
Web.

• Chapter 2, Formatting a Report, explains how to format a report.

• Chapter 3, Analyzing Data, describes common methods you can use to
better understand and present the data that appears in a report.

• Chapter 4, Answering Questions about Data, explains how to expose
additional data related to your original report.

• Chapter 5, Answering Prompts and Refreshing Data, shows you how to
refresh your report data and how to answer report prompts.

• Chapter 6, Building a Quick Query for Analysis, is for report analysts. It
shows you how to create a simple report using MicroStrategy's Report
Builder tool.

• Chapter 7, Building Query Objects and Queries, for Designers, is for
report designers. It describes MicroStrategy objects and how to use them
in creating new reports.
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• Appendix A, Reporting Interfaces in MicroStrategy , helps you to become
familiar with the MicroStrategy Web and Developer interface.

Technical terms that need more clarification are defined in the glossary
section of this guide.

The Advanced Reporting Help presents more advanced product functionality
and is a logical "next step" when you have mastered the information in this
manual. Other MicroStrategy manuals cover installation, system
administration, and other topics. Most MicroStrategy manuals assume you
have read and mastered all topics covered in this guide.

Detailed steps for all functionality in the MicroStrategy system are available
in the Online Help.

Basic Repor t ing Guide
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GETTING STARTED WITH
M ICROSTRATEGY
REPORTING
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This chapter shows you how to log in and get started using MicroStrategy
Web and MicroStrategy Developer. It also provides many examples using
the sample Tutorial project that comes with MicroStrategy. It gives you an
opportunity to familiarize yourself with the Web interface and learn some
basic functionality.

MicroStrategy Web is a user-friendly environment for interactive analysis. A
full set of data browsing, dril l ing, and reporting development capabilit ies
enable stream-of-consciousness navigation. Boardroom-quality reports can
be generated using a wide range of charting and formatting options.

MicroStrategy Developer is a business intelligence environment designed to
meet today's sophisticated business intelligence requirements. It brings
integrated query and reporting, powerful collaborative analytics, and
investigative workflow to every desktop.

This guide provides steps primarily for MicroStrategy Web.

Starting MicroStrategy

Use the appropriate procedure below, depending on whether you are
starting MicroStrategy Web or MicroStrategy Developer.

Starting MicroStrategy Web
You can access MicroStrategy Web from any computer that can run a
browser.

To start MicroStrategy Web

1. In a browser, enter the URL of your company's MicroStrategy Web site.
MicroStrategy Web opens, displaying the MicroStrategy Tutorial project
as well as any other projects you have permissions to access.

Basic Repor t ing Guide
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2. Click the project to log in to. (To follow the examples in this guide, click
MicroStrategy Tutorial.) The Login screen appears.

3. Type your User name and Password. Depending on how your
administrator set up your user account, this may be the same login and
password you use to access your computer, or it may be a
MicroStrategy-specific login and password.

4. Click Login.

The Home page opens, displaying icons to view, work with, and create
reports and dashboards. The icons also provide direct access to the
most commonly used areas of the project, such as folders containing
existing reports and dashboards.

5. Click Shared Reports.

To explore the sample project data in MicroStrategy Tutorial, open any
of the folders and click on any report name to run the report or
dashboard and see the sample data results.

Starting MicroStrategy Developer
You can access MicroStrategy Developer from any computer on which
Developer has been installed.

To start MicroStrategy Developer

1. From your computer's Start menu, go to Programs (or All Programs) >
MicroStrategy Products > Developer.

2. In the User Login window, type your Login ID and Password.
Depending on how your administrator set up your user account, this
may be the same login and password you use to access your computer,
or it may be a MicroStrategy-specific login and password.

3. Click OK.
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MicroStrategy Developer opens, displaying the Folder List on the left,
where the MicroStrategy Analytics Module project source appears, as
well as any project sources that your organization may have created.
The MicroStrategy Analytics Module project source includes the
MicroStrategy Tutorial project.

4. To explore this sample project data, in the Folder List expand
MicroStrategy Tutorial, then expand Public Objects, then expand
Reports. Explore the folders and double-click any report or dashboard
to run it and see the sample data results.

Security privileges
The data you can view and work with may be controlled by privileges that an
administrator has assigned to you. Security settings can limit your data
access to specific projects, certain reports within a project, the ability to use
specific objects on reports, and even how you can explore some data.

If you have any questions about any data you expect to be able to access
but cannot, see your MicroStrategy administrator about having your security
role or privileges adjusted.

About sample data and the MicroStrategy Tutorial project
MicroStrategy comes with a sample project called MicroStrategy Tutorial.
The theme of the MicroStrategy Tutorial project is activity in a retail store
over a three-year time period. The retail store sells electronics, books,
movies, and music.

The Tutorial project includes sample data, such as actual customer names
and items purchased. It also includes predesigned sample reports. The
reporting areas are grouped logically so you can see reports based on
business roles, MicroStrategy platform capabilit ies, or various subject areas
such as customer analysis, inventory and supply chain analysis, sales and
profitability analysis, and so on. Reports that are useful in more than one
area are duplicated in all applicable folders.
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The Tutorial project lets you familiarize yourself with MicroStrategy because
you can run the sample reports in the Tutorial project and experience
various ways to analyze data.

Most of the reports discussed in this chapter exist in the MicroStrategy
Tutorial project. These sample reports show you how you can build and
generate reports.

To access the Tutorial project, follow the steps in the section above to log in
to MicroStrategy Web or MicroStrategy Developer. Once you have logged in,
you can access the reports in the Tutorial project.

Warehouse data in the sample MicroStrategy projects is updated regularly,
and these changes are reflected in the documentation whenever possible.
However, the sample reports, documents, objects, and images in this guide
may display warehouse data that no longer appears in the software.

Sample analysis areas

The MicroStrategy Tutorial project comes with the following groups of
reports:

l Business Roles: This folder contains reports for different types of
business intelligence users, such as bill ing managers, brand managers,
company executives, sales managers, and operations managers. For
example, brand managers can see a report for Brand Performance by
Region. A bill ing manager can see data in a report called Invoice
Statements by Selected Customers, as well as a customer-level
transaction detail report.

l Dashboards and Scorecards: This folder contains several examples of
dashboards. Dashboards provide a distil led view of the business,
organized in logical sections, often containing interactive visualizations
and other adaptive features.

l Enterprise Reporting Documents: This folder contains examples of
different types of enterprise reporting documents, such as scorecards and
dashboards, managed metrics reports, production and operational reports,
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invoices and statements, and business reports. The documents and
dashboards in this folder are a sample of the types of documents that can
be built using MicroStrategy Report Services.

l MicroStrategy Platform Capabilities: This folder contains examples of
the sophisticated capabilit ies within the MicroStrategy platform. Use the
reports and dashboards to get a better feel for platform functionality. For
example, the Graph Styles folder contains examples of most of the graph
types that can be created in MicroStrategy. The Ad Hoc Reporting folder
shows examples of commonly used features like sorting and thresholds.

l Subject Areas: This folder contains reports that cover various topics such
as customer analysis, enterprise performance management, human
resources analysis, inventory and supply chain analysis, sales and
profitability analysis, and supplier analysis.

Opening a report

Reports that display your business data are the focus and goal of business
intelligence. Reports allow you to gather business insight through data
analysis. The results displayed in any MicroStrategy report are often a
starting point for further investigation.

Use the steps below to open a sample report in the Tutorial project, to
become familiar with a standard grid report in MicroStrategy.

To open a report

1. Log into MicroStrategy Web. Follow the steps above to log in (Starting
MicroStrategy Web, page 2).

2. In the Tutorial project, click Shared Reports.

3. Expand Subject Areas, expand Sales and Profitability Analysis, and
then click Category Sales Report to run the report and see the sample
data results. This is a MicroStrategy grid report.
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Use the rest of this chapter to help you understand how to read a grid report.
The information you learn will help you throughout the rest of this guide.

Components of a report

The image below shows a standard grid report in MicroStrategy.

Rows and columns
On a typical report, each row represents a business concept, such as
products, employees, customers, stores, and so on. MicroStrategy calls
these business concepts "attributes," because they represent the many
important attributes of a business.
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Attribute: A business concept that provides context in which data is relevant.
In the example of a report that shows sales in the Southeast, Southeast is
the attribute. An attribute on a report serves as a label for a group of
metrics.

While the rows represent business concepts, the columns of a typical report
represent financial calculations that are important to the business, such as
inventory, sales, costs, profits, salaries, and so on. MicroStrategy calls
these calculations "metrics".

Metric: A calculation that shows the numbers you want to see. In the
example of a report that shows sales in the Southeast, sales is the metric.
Metric calculations can show information at simple levels as well as at
complex levels, such as displaying sales trends, growth patterns, percent-
to-total contributions, and profit analysis. A metric on a report shows a list of
values used for analytical calculations.

Cells
Each individual cell on a report contains a single value which is produced by
calculating data gathered from somewhere in your organization's data
source. That data is the focus of business analysis in a reporting
environment.

In the report shown above, for example, the revenue forecast for the first
quarter of the year (Q1) for your Art & Architecture books (in the first row) is
much lower than the revenue forecast for the same books in Q2. This
difference may represent a general slump in sales after the US holiday
period, or some other customer behavior specific to the retail industry. The
analysis of this data might lead to a decision to prepare a sale or other
special promotion on Art & Architecture books for Q1, to attempt to
counteract the forecasted revenue reduction.

Basic Repor t ing Guide
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Report types

You can view a MicroStrategy report from different perspectives, depending
on the type of work that you want to perform.

Grids
A grid report is the most commonly used type of report. Grid view displays
grid reports using a formatted, cross-tabular display of the report data. Most
business intelligence analysis is performed using this view. The following
figure displays the Grid view of a report.

To see a report in Grid view in MicroStrategy Web, from the toolbar click the
Grid icon .
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Graphs
A graph report is a representation of data in a visual format that can help
you see overall trends easily, identify medians and exceptions, and so on.
You display report data as a graph using Graph view. There are many
different graph styles you can choose from to display your report data most
effectively. The following figure displays the Graph view of a report in the
bar graph style.

The graph report above and the grid report on the previous page are the
same report, seen in two different views. Comparing these two views of the
same data helps you see how a graph report can be more useful than a grid
report for identifying trends, in this case, trends across certain products.
The grid report is generally more useful than a graph report for identifying
specific numbers you may need for financial reports and so on.

To see a report in Graph view in MicroStrategy Web, from the toolbar click
the Graph icon .
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Grids and graphs combined
Grid and Graph view is a combination display of the Grid view and the Graph
view of a report, side by side. The following figure displays the Grid and
Graph view of a report.

To see a report in Grid and Graph view in MicroStrategy Web, from the
toolbar click the Grid and Graph icon .

SQL view
You can see the SQL used to generate the report. Viewing the SQL provides
a good way to troubleshoot and fine-tune the selection of data that is
retrieved from your data source and displayed in reports. SQL view also
includes various execution statistics for a report, such as the number of
rows, number of columns, the time it took to execute, and so on. The
following figure displays the SQL view of a report in Developer.
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To see the SQL for a report in MicroStrategy Web, from the Tools menu
select Report Details Page. The SQL is displayed in the SQL Statement
area. Click Show Advanced Details below the SQL Statement area to see
execution statistics for the report.

Displaying multiple reports in a single presentation

Reports are a common way to analyze your business data in MicroStrategy.
This guide generally uses reports as examples.

MicroStrategy also offers other ways to display data. While working in
MicroStrategy Web or Developer you might see boardroom-quality business
presentations, invoices that go out to customers, all kinds of management
reports and dashboards, and so on. These alternatives are described below.

Visual Insight dashboards
Visual Insight allows you to quickly create a customized, interactive
dashboard that can be used to explore business data. You can create a
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Visual Insight dashboard using data in your organization's data warehouse
storage, or by quickly importing data from an Excel or other file. You can
perform manipulations on the data to customize the information that is
included in the dashboard, and add visual representations of the data (called
visualizations) to the dashboard to make the data easier to interpret. Visual
Insight dashboards can be viewed in MicroStrategy Web or on an iPad with
MicroStrategy Mobile. You can share a dashboard through email, by linking
to the dashboard, or by embedding the dashboard in a web page.

Visual Insight allows you to streamline the tasks required to create a
polished dashboard. For example, you can:

l Add, rearrange, or remove report objects quickly from a visualization in a
dashboard.

l Create additional visualizations to display the data in multiple ways, then
easily modify, rearrange, or resize visualizations in a dashboard.

l Add filtering based on report objects to a dashboard, to allow users to only
display the information they are interested in.
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l Add thresholds to a dashboard, to change the display of data based on the
value of a metric.

Report Services dashboards and documents
MicroStrategy Report Services dashboards and documents are available
with MicroStrategy Report Services. Dashboards are a display of data from
multiple reports with special formatting added, with interactive components,
and so on.

An example of a Report Services dashboard is shown below:

The example above shows the California Population Analysis dashboard, a
sample dashboard in the MicroStrategy Tutorial project.

An example of a simple Report Services document is shown below:
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The image above shows the Balanced Scorecard Strategy Map document, a
sample document in the MicroStrategy Tutorial project.

A document or dashboard can contain data from one or more MicroStrategy
reports. Documents and dashboards can appear in almost as many ways as
you can imagine and are generally formatted to suit your business needs, in
a single display of presentation quality. Documents and dashboards allow
you to display your business data in a user-friendly way that is suitable for
presentation to management for boardroom-quality material.

To see sample dashboards in MicroStrategy Web

1. Log in to the MicroStrategy Tutorial sample project. For steps, see
Starting MicroStrategy Web, page 2.

2. Click Shared Reports.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 16

3. Click the Enterprise Reporting Documents folder.

4. Click any of the documents listed on the right side of MicroStrategy
Web, to execute it and see the results.

To see sample dashboards in Developer

1. Log in to the MicroStrategy Tutorial sample project. For steps, see
Starting MicroStrategy Developer, page 3.

2. Expand the Public Objects folder, then expand the Reports folder.

3. Click the Enterprise Reporting Documents folder.

4. Double-click any of the documents listed on the right side of Developer,
to execute it and see the results.

OLAP Services

MicroStrategy OLAP Services lets MicroStrategy Developer, Web, and
Office users make use of features that slice and dice data in reports without
re-executing SQL against your data source. This improves performance by
resulting in quicker data display within a report as users analyze and
manipulate the data. Information on OLAP Services is provided in the In-
memory Analytics Help.

Determining whether you have OLAP Services

In MicroStrategy Web, open a report, then click the Tools menu to expand
it. If Report Objects appears as an option, you have access to OLAP
Services.

In Developer, open a report, then click the View menu. If Report Objects
appears as an option, you have access to OLAP Services.

Basic Repor t ing Guide
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View filters
A view filter is different from a report fi lter, which restricts how much data is
retrieved from the data warehouse. A view filter dynamically restricts the
data being displayed on the report without re-executing the report against
the warehouse. This capability provides improved response time and
decreased database load.

You can use a report fi lter and view filter on the same report. The report
fi lter returns a set of data for the report, which the view filter then further
restricts. Therefore, you should avoid defining contradictory filtering criteria
in both. Otherwise, you many encounter situations where no data is
displayed.

For details on creating view filters and using them to analyze data, see the
In-memory Analytics Help.

Derived metrics
Derived metrics perform calculations on-the-fly with the data available in a
report. They are an easy way to present data already available on the report
in different ways, providing further analysis of data. You can use derived
metrics to quickly perform on-the-fly analyses such as margins,
contributions, and differences between metrics included on the report.

These metrics are created based on existing metrics in the report. Since
derived metrics are evaluated in memory, their computation does not require
any SQL execution in the database.

Since derived metrics are created within a report, they can only be used for
the report in which they are created. Derived metrics cannot be saved as
individual objects in the project, and therefore cannot be applied to other
reports in the project.

For details on creating derived metrics and using them to analyze data, see
the In-memory Analytics Help.
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Derived elements
An attribute is a business concept that reflects your stored data, such as
Year or City. The elements of a business attribute are the unique values for
that attribute. For example, 2006 and 2007 are elements of the Year
attribute, while New York and London are elements of the City attribute. On
a report, attributes are chosen to build the report, but once the report is
executed, the attribute's elements are displayed in the rows or columns.

A derived element is a grouping of attribute elements on a report. These
groups provide a new view of report data for analysis and formatting
purposes. For example, you can group data for the months of December,
January, and February into a single element that combines and displays the
data for the entire winter season.

Rather than having to define consolidations or custom groups, you can use
derived elements to create these groups on-the-fly while viewing a report.
Derived elements are evaluated in the report without regenerating or re-
executing SQL.

Derived elements are defined by using a list, fi lter, or calculation to combine
attribute element data.

For details on creating derived elements and using them to analyze data,
see the In-memory Analytics Help.

Dynamic aggregation
Dynamic aggregation allows you to change the level of report aggregation
on-the-fly, while you are reviewing the report results. This feature allows
metric values to be aggregated at different levels depending on the
attributes included on the report without having to re-execute the report
against the data warehouse. Dynamic aggregation occurs when the
attributes included on the report layout change. The attributes included on
the report layout change when you move an attribute or attribute form off of
the report layout to the Report Objects pane, or when you move an attribute
or attribute form from the Report Objects pane back onto the report layout.

Basic Repor t ing Guide
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As objects included on the report layout change, metric values are
dynamically aggregated to the new level of the report.

For details on using dynamic aggregation to analyze data, see the In-
memory Analytics Help.

Printing a report

To print a report

1. In MicroStrategy Web, click any report to execute it.

2. From the Home menu, select the view you want to print: Grid, Graph,
or Grid and Graph view.

3. From the Home menu, select Print.

Exporting data

You can export reports in a variety of formats, such as HTML, Microsoft
Excel, and plain text. A report's designer determines which export formats
are available for a report, based on what makes sense for that report. Each
format is described in detail below, to help you decide what format suits your
purposes:

l PDF: You can export the report to an Adobe PDF viewer, in .pdf format.
After the report is exported, the report content is displayed in an Adobe
PDF file.

l Excel with plain text: You can export the report to Microsoft Excel, in .xls
format. After the report is exported, the content of the report is displayed
using the default settings in Microsoft Excel. The structure and format of
the report as it is displayed in MicroStrategy Web is not retained. For large
report results, this export option is recommended over Excel with
formatting.
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l CSV file format: You can export the report to a comma-separated values
file (CSV). After the report is exported, the report content is displayed in a
CSV file as plain text. This format is suitable for Microsoft Access and
Lotus 1-2-3. The structure and format of the report as it is displayed in
MicroStrategy Web is not retained.

l Excel with formatting: You can export the report to Microsoft Excel, in
.xls format. After the report is exported, the report displays with the same
formatting, color, and structure that appears in MicroStrategy Web.

l Microsoft Excel does not support all colors that browsers do, so some
colors may differ after export.

l If the report is large, it is recommended that you use the Excel with
plain text export option.

l HTML: You can export the report to an HTML editor or browser, in .html
format. After the report is exported, the report is displayed in an HTML
page. The structure and format of the report as it appears in MicroStrategy
Web is retained.

l Plain text: You can export the report to a text editor, in .txt format. After
the report is exported, the content of the report displays in a plain text
page. The structure and format of the report as it appears in MicroStrategy
Web is not retained. You can choose a comma, tab, semicolon, or space to
separate the fields of text.

Before you export, you can adjust several export options that allow you to
specify which report details are exported, whether the data should be
exported to PDF or another application, and more.

To export a grid report that contains characters in a double-byte language,
such as Simplified Chinese or Japanese, to a PDF, your computer should be
using that double-byte language (for example, Japanese Windows). If you
are using an English environment, to export double-byte characters, a
report designer must change the font of the attribute and metric names to

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 21

the font type that the locale supports. For steps, see Formatting for easier
data analysis, page 379 or the MicroStrategy Help.

To configure export sett ings in MicroStrategy Web

1. Open a report.

2. From the Home menu, select Export, and then select the required
output format.

l You can modify project-wide graph settings in the User Preferences
page. For more information, click Help in MicroStrategy Web.

l You can modify export options in the User Preferences page. For
more information, click Help in MicroStrategy Web.

3. Make any necessary changes to the export options.

To export data in MicroStrategy Web

1. From the Home menu, select Export, and then select the required
output format.

2. Make any necessary changes to the export settings and click Export.

Emailing a report

You can send a report to any email address.

Prerequisites

l You must have the Use Send Now privilege.

l You must have the Web Subscribe to History List privilege to send a report
or document to the History List.

l You must have the Use Link to History List in Email privilege to send a link
to the location of a report or document in the History List via email.
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To email a report

1. In MicroStrategy Web, click the name of a report to execute it.

2. From the Home menu, select Send Now.

3. Click To to locate the email address of the recipient.

4. Choose an address from the Available l ist. If you do not see the correct
email address to use, type the Address name and Physical address in
the respective fields and click Add to Recipients to add a new
address.

5. Click OK.

6. From the Send drop-down list, specify where the report is delivered by
choosing one of the following options. The options vary depending on
the privileges you are assigned, as described in Prerequisites above.

l Data in email: The report or document is displayed in the email.

l Data in email and to History List: The report or document is
displayed in the email and is also delivered to the History List.

l Data and link to History List in email: The report or document is
displayed in the email, along with a link to the History List location of
the report or document.

l Link to History List in email: A link to the History List location of
the report or document is provided in the email.

7. From the Delivery Format drop-down list, select the format in which to
send the report. The options are HTML, Excel, and PDF. When Excel or
PDF is chosen, the report is included as an attachment in the email; you
can reduce the size of the attachment by selecting the Compress
contents check box.
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8. If the delivery option is Plain Text, you can specify the delimiter
character to use to separate values in a report, such as a comma or tab.
From the Delimiter drop-down list, select one of the following:

l To choose a delimiter from the list, select the delimiter you want to
use, such as Comma or Space.

l To specify your own delimiter, select Other, then type the character
you want to use as the delimiter in the field.

9. Select the Expand page-by fields check box to print all objects in the
Page-by drop-down list when the report or document is emailed.

10. In the Subject l ine, type a description for the emailed report.

11. If you want a message to be displayed in the body of the email, type the
text in the Message f ield.

12. To include the report or document in a zip file:

a. Expand Advanced Options by clicking the plus sign.

b. Select the Password Protect Zip File check box if you want to
protect the zip file by providing a password. Type a password for
the zip file.

c. Type the name for the zip file in the Zip File Name f ield.

13. If you have selected a contact group as the recipient of the report or
document, by default MicroStrategy uses the security filter of the
contact group as a whole when delivering the report or document. To
use the separate security filters for each member of the subscribed
contact group instead, select the Use contact security for each
group member check box.

14. Click OK.
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FORM ATTING A REPORT
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Formatting a report involves highlighting certain data to enhance analysis,
as well as changing the overall display or look and feel of a report. You can:

l Highlight important numbers

l Put the focus on specific sets of data

l Rename an object on the report, such as a business attribute or a metric
calculation

l Apply your corporate look to a report for a business presentation

Using the banding option, you can group rows or columns of report data
using colors to enhance readability and make it easier to identify business
concepts on which you would like to focus.

MicroStrategy's autostyles are collections of formatting choices that can all
be applied at the same time with a single click. This chapter tells you how to
use autostyles and how to create and save your own.

Report formatting can be performed in Grid view, or it can be performed in
Design view (for report designers). Grid view shows you the results of your
changes immediately as you format the report. (For an introduction to
different views and how to access them, see Report types, page 9.)

Ideas for formatting

Formatting can be as fine-grained as you choose and as your needs require.
Steps for all of the ideas below are in this chapter.

l Individual cells in grid reports: Format individual cells of data in a grid
report when a single data value is important to call attention to or you want
it to be easy and quick to locate in a large report. Use thresholds to have
values formatted automatically. You can also determine a value to display,
such as the word EMPTY, when a cell would otherwise appear empty.

l Rows and columns in grid reports: You can hide a metric column on a
report so that it does not display when the report is executed again. You
can also apply bands of color to groups of report rows or columns, to make
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large quantities of data easier to analyze. You can rename row and column
headers so the object names are more meaningful to yourself or other
analysts. You can also manually make columns narrower or wider, or
adjust row height, to fine-tune your report display.

l Graph reports: You can select an appropriate style for your graph (pie,
bar, line, 3D Surface, Gantt, and so on) and format the colors of series (for
example, the colors of pie slices in a pie graph). You can also reposition
and resize elements such as the graph legend, tit les, and axis labels.

l Autostyles: MicroStrategy comes with several presentation styles for
displaying reports, called autostyles. Each autostyle automatically applies
a set of formatting that includes color scheme, font style, and font type to
a report. Autostyles let you standardize formatting across many reports.

Formatting a grid report

This section provides information on the following formatting tasks:

Formatting conditional values on a grid: Thresholds
Individual cell data can be automatically formatted differently than the data
in the rest of the report. Data that is formatted differently calls attention to
itself, and makes that data easier to locate for analysis.

In a simple example, for the report shown below, you want to highlight the
subcategories for which the revenue is greater than $1,000,000.
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You can achieve this by applying a threshold to the Revenue metric. The
threshold is defined to automatically apply a gray background and bold font
whenever values meet the threshold's condition. The resulting report is
shown below. Notice that revenue greater than $1,000,000 is highlighted.
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A threshold's condition can be as simple or as complex as you want.

Compare the example above to the example below. The image below shows
the Tutorial report named Product Sales Results By Region. Thresholds are
displayed for the % Change in Revenue metric, and for the Revenue metric.
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When data is set up to automatically appear with special formatting
depending on certain conditions, such as sales over $1 million or inventory
below 50, this is called conditional formatting. It is special formatting that is
applied to values when certain conditions are met. The data that meets the
condition is considered to be data that has passed the threshold of the
condition; once data passes the threshold, the formatting is applied. So
thresholds are cells of data that are formatted differently from the rest of the
data on a report; the formatting is applied dynamically, whenever the report
is re-executed.

An administrator can create an alert-based subscription to ensure that end
users are automatically notified by email when a metric on a report meets
specific threshold conditions. This allows email recipients to be alerted to
data that is likely to be important for making business decisions. An
administrator can also have formatting applied to metric values in the
report, to draw immediate attention to the data that meets the alert
conditions. See the System Administration Help for details on alerts.

Thresholds highlight particular data in a report by displaying special cell
formats, symbols, images, or replacement text. In the image above, the gray
diamond-shaped symbol replaces (and represents) all values that represent
a small increase in revenue from the previous year. "Small increase" is
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defined as revenue changes between 0 and 5 percent. The yellow diamond-
shaped symbol represents a medium decrease in revenue from the previous
year, with "medium decrease" defined as between -10 and 0. Values that
show a medium decrease for the Revenue metric are displayed in red. Each
of these thresholds makes analyzing large amounts of data easier because
symbols are easy to locate, and different colors are quickly identified.

To see threshold images you have added to a report, view the report in
MicroStrategy Web. Threshold images are also visible if the report is placed
in a Report Services document in Developer or Web, or a Visual Insight
dashboard in MicroStrategy Web.

You can use certain types of threshold formatting on a graph report. For
details to apply a threshold to a graph, see Formatting conditional data on a
graph: Thresholds, page 61.

Steps are below to create thresholds in MicroStrategy Web.

Prerequisites

l DHTML must be enabled. See the MicroStrategy Web Help for steps.

l Decide what condition the metric values must meet to have the threshold
formatting applied. Common examples of a threshold's condition include
sales that exceed a certain amount, revenue that falls below a certain
percentage, or employee resource numbers that drop below a particular
number.

You can use attributes or other metrics on the report to define a
threshold's condition. For example, in the following report, the Trend
Lead Conversion column includes a green + (plus) or red - (minus)
threshold to highlight when the month-to-month trend is positive or
negative. The month-to-month trend is determined by comparing the
first and second columns. This means the condition causing the
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threshold to appear in the last column is based on whatever values
appear in the first and second columns, as shown below:

l Decide what you want to be displayed on your report when the condition is
met. Common examples include displaying important numbers in red, or in
white font with a red background, or displaying a red stop sign or a green
traffic light in place of certain data.

Formatting null values and blank cells
An empty cell of data on a grid report represents a null value. A null value is
an unknown value, because it can be the result of an empty area of your
data source, or the result of the calculations and cross-tabbing that are
sometimes performed on a grid report.

For example, a null value in your data source can occur if a customer omits
his birth date or another piece of personal information. If your data source
does not contain data in a particular field and you pivot the rows and
columns on the resulting report, the resultant cross-tabbing may produce a
null value. In the image below, the Internet Revenue column does not have
data for display and returns empty cells when the report is run.
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You can replace null values with a specific value, such as a zero or the word
NULL or NO VALUE as shown in the image below, so that cells do not
appear as empty on a report. The replacement can be for the final report
display only, or for the calculation of the report data. Replacements do not
change any values in your data source.

Null value replacements are specified in MicroStrategy Developer.
MicroStrategy Web displays null values in the format designated for the
report in Developer.
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To replace a null value with a specific value

1. In Developer, open a grid report.

2. From the Data menu, select Report Data Options.

3. Expand the Display category and select the Null Values subcategory.

4. To replace a null value for the final report display only, enter the
replacement value (such as a zero) in the Null Display Settings area
for any of the scenarios listed:

l An empty value is retrieved from your data source.

l An empty value is calculated in the cross-tabulation process.

l An empty value appears when the report is sorted.

5. To replace a null value during the calculation of report data, enter the
replacement value in the Aggregation Null Values box.

6. Click OK.

Renaming row and column headers
You can give a report's row and column headers meaningful names by
renaming them. By creating an alias for an object on a report, the object can
be displayed on that report with a different name, without changing its name
in the MicroStrategy project.

For example, in the image of the report below, one metric is named Web
Sales and another metric is named Non-Web Sales.
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You might rename the first metric as Internet Revenue, and the second
metric as Main Street Revenue as shown in the image below, so that your
business audience can more easily understand what the values mean.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 35

You can rename any business attribute (usually a row header) or metric
calculation (usually a column header) on the report grid. This feature, called
aliasing, lets you name an object on a report something that makes sense to
you, within the context of a given report.

This alias feature is for report display purposes only. Creating aliases with
this feature does not change object names as they appear in the project, as
they are stored in the MicroStrategy object repository (metadata), or as they
are stored in your data source.

The alias feature also allows you to display descriptive information about an
object on a report and edit the description that exists. You can use this to
make object descriptions more meaningful for other users who will view this
report.

The following is a list of the objects you can rename on a report:
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l Attribute: A business concept, such as Product, Employee, Month, Region,
and so on. The individual characteristics of an attribute are attribute
elements. For example, 2006 and 2007 are elements of the Year attribute,
while New York and London are elements of the City attribute. On a report,
attributes are chosen to build the report, but once the report is executed,
the attribute's elements are displayed in the rows or columns.

l Metric: A business calculation, such as Revenue, Profit, Employee
Headcount, or Probability of Purchase. Some metrics are key performance
indicators (KPIs) because they present crucial progress information at a
glance. Metrics commonly appear in the columns of a grid report.

l Consolidation: A selected group of attribute elements used just like an
attribute on a report. For example, suppose you want to see each season
of the year as a separate row on a report, but Season does not exist as an
attribute in your project. A consolidation allows you to group together the
elements of the Month of Year attribute into various seasons and place
them on the report. In this example, the consolidation will contain four
consolidation elements, one for each season. Consolidations are covered
in the Advanced Reporting Help.

l Custom group: A special fi lter for report data. Custom groups are covered
in more detail in the Advanced Reporting Help.

Creating an alias

You can create an alias by renaming a row or column header.

To alias an object name

1. In MicroStrategy Web, open a grid report.

2. From the Data menu, choose Rename/Edit Objects. The Rename/Edit
Objects dialog box (DHTML) or panel (HTML) is displayed.

3. Select the object to rename from the Object drop-down list.
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Derived metric: If you have MicroStrategy OLAP Services (see OLAP
Services, page 16), you may have a derived metric on the report. If you
click on a data cell of a derived metric, you can change the syntax of
the derived metric formula in the formula box.

4. Type the Name for the object and click OK.

Determining whether aliases are used on a report

You can review any report to determine whether a column or row header is
an alias or shows the original column or row name that comes from your
MicroStrategy project.

To determine whether an alias is used on a report

1. In MicroStrategy Web, open a grid report.

2. From the Data menu, select Rename/Edit Objects.

3. From the Object drop-down list, select the object for which you want to
determine whether an alias is used. In the example image below, the
object Store shows that it is an alias for the Call Center object listed in
the Definition area.
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Changing from aliases to original names

You can change all row and column names from their alias to their original
name.

To quickly reset all names

1. In MicroStrategy Web, open a grid report.

2. From the Data menu, select Reset Data.

Hiding and re-displaying a metric column
You can hide a metric object (usually a column) on a grid report, yet that
metric's data will sti l l be included in any subtotals and grand totals you might
have displayed. You can also display any previously hidden metric column
so that the metric's data now shows in your report.

Depending on whether you have MicroStrategy OLAP Services, the
procedure is different to hide a metric column. To determine whether you
have OLAP Services, see OLAP Services, page 16. Use the appropriate
procedure below to hide or re-display a metric column.

With OLAP Services

Hiding a metr ic column

If you have MicroStrategy OLAP Services, you can hide any metric column
by simply dragging it off the grid report into the Report Objects pane to the
left of your report. (If you do not see the Report Objects pane and you have
OLAP Services, from the View menu select Report Objects.)

Displaying a previously hidden metr ic column

You can show any hidden metric column by right-clicking the metric in the
Report Objects pane and selecting Add to Grid.
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Without OLAP Services

Hiding a metr ic column

To hide a metric column on a report

1. Open a grid report.

The example image below shows a report with two metric columns,
Revenue and Percent Growth.

2. From the Format menu, select Resize Columns and Rows. The
Resize Columns and Rows dialog box is displayed.

3. Under Columns, choose the Fixed option. In the drop-down list
underneath, select the metric you wish to hide.

4. Enter 0 in the Width f ield.

5. Click OK.

The report automatically updates with the metric column you selected now
hidden. In the example image below, the metric Revenue has been hidden,
although the Percent Growth remains the same.
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Displaying a previously hidden metr ic column

Follow the procedure above for hiding a metric column. Instead of choosing
the Fixed option, select Auto Fit to Contents and click OK. The report
automatically updates with the column now showing.

Resizing a column or row: Column handles and Fixed Column
Width mode
Most reports are designed to have column widths and row heights sized
automatically by the system. However, you can redesign the report to size
columns and rows manually. This lets you drag a column edge left or right,
or a row edge up or down, to resize the space. This gives you fine control
over the look of your report.

Use the appropriate procedure below, depending on the degree of control
you want when resizing rows and columns:

l Use the column handles procedure if you want to simply drag column
handles around to resize a column.

l Use the pixel height and width procedure to enter a specific number of
pixels for column width, to assign a different width to specific columns,
and to enter a specific number of pixels to adjust row heights.

Steps are below to resize columns and rows in both MicroStrategy
Developer and MicroStrategy Web.
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To display column handles in Developer

The procedure below is slightly different depending on whether your report
was designed to use Fixed Column Width mode or Auto Column Width mode.
The differences are described below.

1. Run a grid report.

2. On the Grid menu, select View Column Handles.

The following message may appear: "Column width changes in
Automatic Column Width mode will not be saved. Do you want to switch
to Fixed Column Width mode?"

This message indicates that the report you executed is in Automatic
Column Width mode. This means the system automatically sizes the
columns for you. If you click No, the report stays in Automatic mode and
any column sizing you do will not be saved. If you click Yes, the report's
column width mode is changed to Fixed, and any column sizing you do
will be saved when you save the report.

3. Column handles appear along the top of the columns of the report. In
the following image, the report on the top has no column handles
displayed. The report on the bottom shows column handles displayed.
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4. Hover your cursor over a column handle until the cursor changes to a
double arrow, as shown below:

5. Drag the handle left or right to make the column narrower or wider.

To determine pixel height of rows and width of columns in Developer

1. Open a grid report.

2. From the Grid menu, select Options.

3. On the Columns and Rows tab, select Fixed.
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4. From the drop-down list, select the report features you want to specify
width for:

l All Columns: Determines the width of all the columns on the report.

l All Row Axis: Determines the width for the column on the row axis
(usually the attributes). Use this setting if there are no metrics
(columns) on the report.

l All Grid: Determines the width of the data columns.

l Attribute form name: Determines the width for the specified attribute
form. Each attribute form in the report is listed.

l Metrics: Determines the width of the column named "Metrics", which
holds the column headers.

l Metric name: Determines the width for the specified metric. Each
metric in the report is listed. All instances of this metric use this
width, including those that are in page-by fields. (For details on page-
by fields, see Grouping data by page, page 84.)

5. Enter the column width in Pixels.

6. Select one of the following row height settings:

l Auto Row Height: Allows row heights to be determined automatically
by the system.

l Fixed Row Height: Allows you to specify the height of the rows.
Enter the number of Pixels for the row height.

Column widths must be fixed for row heights to be fixed. Column
widths are applied first and then row heights.

7. Click OK.
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To resize the columns and rows on a report in MicroStrategy Web

1. Open a report.

2. Do one of the following:

l Click and drag a column header's vertical lines to adjust the size of a
column. The size of the column is adjusted accordingly.

l From the Format menu, select Resize Columns and Rows. The
Resize Columns and Rows dialog box is displayed.

l If DHTML is disabled, click Go. The Resize Columns and Rows
panel is displayed.

3. Resize the columns and rows using the following options:

l To automatically set the size of the columns and rows:

l Auto Fit to Window: The grid report's columns stretch to fit the
size of the browser window.

l Auto Fit to Contents: The width of the report's columns or rows is
determined by the data in the column or row. All extra space in the
grid is removed.

l To manually size the height of the rows or width of the columns,
select Fixed in the Columns area or Fixed Height in the Rows area.
Type a size for the columns or rows. The grid report is adjusted to the
column width and row height you specify.

Changing the height of the rows manually does not affect the header
rows at the top of the report.

4. Click OK.

Formatting groups of report rows or columns: Banding
You can color groups of report rows or columns so that they form bands of
data that are easy to locate and analyze. Banding can also make it easier to
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make sense of a very large report, because the large amounts of data are
broken up into visual groups. If you need to keep track of values that mean
different things in different columns (for example, dollars in one column and
inventory quantities in another column), banding can help an analyst avoid
making the mistake of reading the wrong number.

Banding is a method of organizing or grouping data values in a grid report
according to certain criteria. You can band rows or columns in several ways.
You can band based on the number of rows or columns (for example,
alternating color every 5 rows). You can also band based on the row and
column headers (for example, sorting the Units Sold column in order, then
applying alternating colors to sets of values). As shown in the image below,
banding based on column headers helps keep financial numbers from
getting confused with unit counts.

For example, for the report shown below, you want to band the columns
according to Revenue and Units Sold, such that all Revenue columns appear
with one color and all Units Sold columns appear with another color.
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To do this, you choose to band by columns, and you select the banding
colors. After applying the banding, the report appears as shown below.

The autostyle of a report provides the report's default banding options, but
you can define custom banding or even turn off banding for a report,
regardless of its autostyle. (For information on autostyles, see Preset
formatting: Autostyles, page 68.)

You can perform more complex banding of report data, based on custom
grouping of attribute elements (for example, Northeast, Mid-Atlantic, and
Southeast on the report above) and other banding conditions. For details,
see the chapters on Custom Groups and Consolidations as well as Reports
in the Advanced Reporting Help.

You cannot create banding formatting in MicroStrategy Web. However, you
can enable or disable the display of banding on a report in Web. The
procedure is below.
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To create custom banding in Developer

1. Open a grid report.

2. From the Grid menu, select Options.

3. On the General tab, select Custom banding.

4. Click Settings.

5. Set the banding options as desired. For details on each option in the
dialog box, click Help. In the example above, to band by columns, you
select the banding criteria By column header and select the banding
color.

6. Click OK.

To turn off banding in Developer

1. Open the banded report.

2. From the Grid menu, select Options.

3. Select No Banding and click OK.

To enable or disable banding in MicroStrategy Web

1. Open a grid report.

2. From the Tools menu, select Report Options.

3. On the General tab, select or clear the Show Banding check box.

Keeping row and column names visible: Locking headers
You can scroll side to side or up and down in a large report without losing
sight of the row or column names, by following one or both of the following
procedures.
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To lock row or column headers

1. In a report, from the Tools menu, select Report Options.

2. On the General tab, select the Lock check box for Rows or Columns.

3. Click OK.

Formatting report borders
You can apply special formatting to the outside borders of a grid report, if
you wish. The custom formatting you apply is visible when the report is
printed. You can apply dotted or dashed lines, heavier or lighter line
weights, and even apply colors to report borders. You can also make report
borders disappear.

For example, if you have a report that presents a lot of data along with
several subtotals and totals, the report may appear looking almost like a
spreadsheet. It may be more aesthetically pleasing to see the data printed
with the outside lines of the report gone, to create a more "open" feel and
make the data look less overwhelming. By removing the outside border of a
report, you can also make important, bolded, or totaled data stand out more
clearly.

The following image shows the Regional Sales Management report in the
Tutorial project with its default report borders, which are pale gray, the same
color as the cell borders:
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The next image shows the same report with the report's borders removed.
The data looks less crowded, and the important data at the bottom of the
report is emphasized:
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To format report borders in Developer

1. Open a grid report.

2. In the top left-hand corner of the grid report, right-click in the empty
area and select Formatting, then select Grid Borders.

3. Select one of the Preset icons. The None icon on the left removes all
borders from the report. The Outline icon on the right automatically
adds a border around the outside of the report.

4. If you chose to add a border, select the type of line Style you want,
such as solid or dashed, and then select a Color.
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5. Click on a line in the Border area and you can see your selections
appear on the sample page in the Border area.

The Hair line style cannot be displayed in reports viewed in
MicroStrategy Web. It is replaced with the Thin line style. If you want
appearance to be consistent between Developer and Web report
display, consider a line style other than Hair.

6. Click OK.

7. Some border effects can be seen well in Developer, while others are
more clearly seen in Print Preview mode. To view your border settings,
from the report's File menu select Print Preview.

Formatting a combined grid and graph report

Grid Graph view displays a report as both a cross-tabbed grid report and a
graph report in the same screen. You can determine the size and position of
the grid (and, in consequence, the size and position of the graph) in Grid
Graph view.

This formatting option is not available in MicroStrategy Web.

To view a report in Grid Graph view, see Grids and graphs combined, page
11.

To format Grid Graph view

1. Open a report.

2. From the View menu, select Grid Graph View.

3. From the Data menu, select Report Data Options.

4. Expand the Display category and select the Grid Graph Mode
subcategory.
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5. Adjust any of the following settings for the grid report:

• Grid Position determines where the grid is placed in relation to
the graph. For example, if you set the position to Top, the grid is
displayed on top of the graph. If you set the position to Left, the
grid displays to the left of the graph, as shown in the image
below.
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• Grid Percentage specifies how much space the grid occupies in
the display area. For example, if this option is set to 75, the grid
occupies 75% of the report display area while the graph is
resized to fit in the remaining 25%, as shown below.

If Grid Position is set to Top or Bottom, Grid Percentage
represents the height percentage. If Grid Position is set to Left or
Right, Grid Percentage is the width percentage.

• Minimum Grid Percentage is the minimum space that the grid
can occupy.

Grid Percentage and Minimum Grid Percentage interact to determine
the size of the grid. For example, if Grid Percentage is set to 25, you
cannot set the Minimum Grid Percentage higher than 25.

6. Click OK.

Formatting a graph report

You can format a graph report in many ways, including the following:
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l The style of the graph (for example, a pie graph, a bar graph, or a scatter
graph)

l The size and location of the graph, graph legend, tit les, and axis labels

l The color of different sections of the graph (for example, the color of the
pie slices on a pie graph)

l Whether a threshold (conditional formatting) appears on the graph

The following sections provide information and examples of different ways
you can format your graph report.

For a discussion of the graph styles available in MicroStrategy and when to
use each style, see the Graphing chapter in the Advanced Reporting Help.

For steps to apply specific graphing options, click Help.

Viewing a graph report
To view a graph report, you can open any report that was saved as a graph
report. You can also convert almost any grid report to a graph report, using
the procedure below.

To view a graph report in MicroStrategy Developer or MicroStrategy

Web

1. Open a grid report.

2. From the View menu, select Graph View (in Developer) or from the
Home menu, select Graph (in MicroStrategy Web).

3. If this is the first time you are viewing this report in Graph view, you are
prompted to select a graph style. Select a bar graph style, since it suits
most sets of data. For information on selecting other graph styles, see
Choosing a graph style, page 55.

You can also select Grid Graph view to see both the report grid and its
corresponding graph side-by-side.
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Reports saved in Graph view automatically appear in Graph view when
executed.

Understanding a graph report
A graph report represents a grid report's numerical data values with the
graphical elements within the graph (for example, points, bubbles, lines,
bars, or circles). The non-numerical data within a grid report, such as
attribute names and metric names (the row and column headers), are
represented as the axes on the graph. The axes on a graph are used as
reference for the report data (the points, bubbles, lines, bars, and so on).
When a grid report is converted to graph format, you can think of the values
within the grid cells as giving shape to the graph, while the column and row
headings become the graph's axes.

By seeing where a graph element, such as a bar or bubble, appears in
relation to the axes on the graph report, you can determine values for that
graph element. Additionally, by viewing all the graph elements together, you
can often more easily see overall trends in your data than is otherwise
possible in a grid report.

Choosing a graph style
You can display your report graph in a variety of graph styles. The style you
choose must be compatible with the data you want to display. For example,
consider the data requirements for the following graph styles:

l An area graph or a bar graph require only a minimum of one metric and
one attribute to be included in the report, to display data properly within
that style.

l A scatter graph requires at least 2 metrics in the report to display the
graph style properly.

l A bubble graph requires at least 3 metrics to be a useful graph style to
choose.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 56

For complete details on the requirements and recommendations for each
graph style available in MicroStrategy, see the Graphing chapter in the
Advanced Reporting Help.

Graph style examples

You may want to display your grid report data in a pie graph format, as
shown in the image below.

You might then want to see the same data in a Polar graph style, as shown
below.
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When selecting a graph style to view your data, you must consider two
important issues:

l The structure and amount of data on your report affect your decision
because some graph styles cannot be displayed unless a certain number
of attributes or metrics appear on the report grid. These requirements are
listed in the Graphing chapter of the Advanced Reporting Help.

l The position of report objects on your report grid also determines whether
a graph can be generated in a certain graph style. For example, to display
slices in a pie chart, you can change the placement of report objects by
pivoting data; for details, see Pivoting data, page 90. For general
information about how the placement of report objects determines which
graph styles you can use, see the Graphing chapter of the Advanced
Reporting Help.

Changing a graph's style

Perform the following steps to modify the graph style. Use the appropriate
procedure below, depending on whether you are working in MicroStrategy
Developer or Web.
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To change a graph style in Developer

1. Open a report in either Graph or Grid Graph view.

2. From the Gallery menu, select a graph style to use with the graph.

If a graph style is grayed out and unavailable, there is insufficient data on
your proposed graph to generate the graph in that style. Choose another
graph style for the graph. For information about the minimum requirements
for each graph style, see the Graphing chapter of the Advanced Reporting
Help.

To change a graph style in MicroStrategy Web

1. Open a report in either Graph or Grid and Graph view.

2. From the Graph toolbar, select a new graph style to use.

If an error message is displayed that notifies you that there is insufficient
data on your proposed graph to generate the graph in the selected style,
click Cancel. Choose another graph style for the graph. For information
about the minimum requirements for each graph style, see the Graphing
chapter of the Advanced Reporting Help.

Changing the color scheme of a graph
You can modify the colors of certain elements on your graph, for example,
the pie pieces on your pie graph or the individual bars in your bar graph.

In graphing terms, the pieces of a graph element (for example, the pie slices
of a pie graph or the individual bars in a bar graph) are referred to as the
graph's series. The series are described in a graph report's legend. The
groups of data along the X-axis are called categories. In general:
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l Categories:

l Are groups of data usually found on the X-axis of a graph report

l Usually correspond to the rows of a grid report

l Usually represent attributes

l Series:

l Are groups of data usually found on the Y-axis of a graph report

l Usually correspond to the columns of a grid report

l Are explained in the legend of a graph report

l Usually represent metrics

You can change the colors of the series in a graph by selecting a color
scheme from the Color Palette in the Graph toolbar, as described in the
following procedure.

By default, the graph color of a metric overrides the color scheme. For steps
to define the graph color, see Defining a graph color for metrics, page 60.
For steps to allow the color scheme to override the graph color, see
Defining a graph color for metrics, page 60.

To modify the colors of series on your graph in Developer

1. Open a report in either Graph or Grid Graph view.

2. Ensure that the Graph toolbar is enabled by selecting Toolbar from the
View menu, and then selecting Graph.

3. Select a color scheme from the color palette by clicking arrow on the
Color Palette icon on the Graph toolbar.

To format the series colors of a graph in MicroStrategy Web, you must be
granted the necessary Web Professional privilege. For more information,
contact your administrator.
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Defining a graph color for metrics
You can define the color used for a metric when it is displayed as a series in
a graph. By default, the graph color that you define for a metric overrides
any color schemes for the graph report. You can instead allow the graph
color scheme to override the metric's graph color, as described in To disable
metric-specific graph colors in a graph report, page 61.

You can define a default graph color for a particular metric, and this color is
used in all graph reports. You must have the necessary Developer
privileges to define this; see the Graphs chapter in the Advanced Reporting
Help for details.

To define the graph color for a metr ic in a graph report

1. In MicroStrategy Web, log in to a project and navigate to a graph report.
Click the report to run it.

2. Locate the metric whose color you want to change in the graph. Right-
click the metric and point to Fill.

3. Select your desired color in one of the following ways:

l Select one of the default colors in the color palette.

l To define a new color outside of the color palette, select More Colors.
The More Colors dialog box will now be displayed. You can select a new
color from the slider on the right or create one based on its Hex, RGB, and
HSV values. Click Apply to see the changes made to your graph or click
OK.

l To apply a gradient to the metric on the graph, select Gradient. A gradient
displays a blend of two colors in a gradual color change for the metric
when the metric is displayed as a series in a graph report. You can select
the two colors for the gradient from the Color 1 and Color 2 drop-down
lists, and then click one of the squares to set the direction of the shading
between the two colors. The colors can blend left to right, right to left, top
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to bottom, bottom to top, horizontally centered, or vertically centered.
Click OK.

You can repeat these steps for any metrics on the report that require a
specific graph color. Each metric should use a color that can be easily
distinguished from the colors used for other metrics. This ensures that graph
report results are easy to decipher based on color.

To disable metr ic-specific graph colors in a graph report

Inheriting metric graph color is enabled by default. The steps below show
you how to disable this formatting, to allow the graph color scheme to apply
to all the series in a graph.

1. In MicroStrategy Developer, log in to a project and navigate to a graph
report.

2. Right-click the graph report and select Run.

3. From the Graph menu, select Preferences.

4. In the Other area, clear the Apply metric formatting when available
check box.

5. Click OK.

Formatting conditional data on a graph: Thresholds
Individual cell data can be automatically formatted differently than the data
in the rest of the report. Data that is formatted differently calls attention to
itself, and makes that data easier to locate for analysis. This conditional
formatting is called a threshold, because when a given value in your data
reaches a certain point, or threshold, the conditional formatting is applied.

Thresholds are described in detail in Formatting conditional values on a
grid: Thresholds, page 26.

Because of how graph types display report data, a threshold on a graph
report displays background formatting only. This includes a solid color, a
gradient color, a pattern, and any other available background effects. Other
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threshold formatting, such as symbols and text formatting, are not applied
to the graph report, but are stil l displayed on the grid report.

Not all graph types can display thresholds. For example, Area graphs
combine all data into a single area object. Since the data is all visually
connected into the same area object, thresholds cannot be displayed for
specific data points. However, many graph types display a separate series
or data marker for each data point, and thus can display thresholds.

The following graph types can display thresholds directly on the series of the
graph:

l Bar

l Boxplot

l Bubble chart

l Funnel

l Histogram

l Pareto chart

l Pie chart

l Stock

For example, the Bar graph report shown below uses thresholds on the
series to highlight when employee satisfaction is above seven or below three
for a given survey field.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 63

The following graph types can display thresholds on the data markers that
highlight specific data points on the series of the graph:

l Gauge

l Line

l Polar chart

l Radar line chart

l Scatter plot and three-dimensional scatter plot

For example, the graph report shown below is the same report used in the
previous example. However, the report shown below uses a Line graph style,
and the threshold is applied to the data markers.
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To create and apply a threshold to a graph report

1. In Developer, open a graph report.

2. From the Data menu, select Thresholds.

3. Click on New Threshold, and name your new threshold.

Any thresholds that are already defined for this metric are displayed
below the toolbar. If you want, you can select any existing threshold to
modify, and then skip defining the condition, as described in the next
step. An existing threshold must include some type of background
formatting such as a solid color, a gradient, or a pattern. The
background formatting is the only conditional formatting that is
displayed on a graph report.

4. Define the condition that the value must meet to have the threshold
formatting applied. Click the text Click here to start a new
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qualification. The parts of the condition appear, each of which must be
defined:

a. Click Field f irst, to select the business attribute or metric
calculation that is part of your condition.

b. Click Operator to select an operator, such as In List, Not in List, or
Where.

c. Click Value to specify the elements from the available list.

If you selected an existing threshold in the step above, you do not have
to redefine the condition.

5. Next you define the formatting that you want displayed for values that
meet the condition you have defined above.

a. Click the Edit the threshold formatting icon.

b. Click the Background tab.

c. Select a Background Style from the drop-down list, and then
choose the colors to use.

To apply a background to a graph report, you must select a
Background Style other than Default.

d. Click OK.

6. Select the threshold that you formatted, and click the Enable threshold
on Graph icon on the toolbar. This applies the background color to

the graph when the threshold condition is satisfied.

This icon is available only when you have formatted the background of
the selected threshold.

7. Click OK to save your new threshold definition and close the
Thresholds dialog box. Your new threshold is automatically applied.
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8. Review the graph report. The thresholds should be displayed for
applicable data on the graph report. If you are using one of the graph
types that support thresholds, and you do not see thresholds on the
graph report, use the steps provided below to display the thresholds:

a. From the Graph menu, select Preferences.

b. In the Other area, clear the Apply rounded effects to all series
check box. This removes the automatic beveling effects used for
the series and data markers of the graph report, but it also allows
the display of thresholds for certain graph types. You can stil l
apply and create your own custom bevel effects for the graph
report, as described in the Graphing chapter of the Advanced
Reporting Help.

c. Click OK.

Undoing and redoing graph formatting
Creating an attractive and easily understandable graph usually means you
have to try different combinations of fonts, colors, gradients, and other
options.

For example, you format the series colors (pie pieces) of your pie graph by
selecting the Apex color style from the Color Palette in the Graph toolbar.
(To change the colors of series in a graph, see Changing the color scheme
of a graph, page 58.) Taking another look at your graph, you decide you do
not like the change and want to revert to the pie graph's original colors. The
Undo icon on the report's Edit menu allows you to easily reverse formatting
choices such as these.

If you decide later that you did not want to undo an action (for example, you
want to change back to the Apex color style), you can use the Redo icon on
the report's Edit menu to quickly reapply that formatting choice.

The Undo and Redo icons work similarly to the corresponding commands in
Windows.
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Moving and resizing graph objects
In MicroStrategy Developer, you can manually resize or reposition graph
elements, including the graph legend, tit le, subtitles, and the graph itself.

l Resizing: When you select any of the objects described above, handles
are displayed around the object. You can use these handles to manually
resize the object.

l Moving: You can relocate the selected object by clicking in the middle of it
and dragging it to another location on the graph.

For examples of how to manually resize and reposition objects on a graph,
refer to the Graphing chapter of the Advanced Reporting Help.

For steps to manually resize objects in your graph, see the Developer online
help (formerly the Desktop Help). (See the "Resizing a graph report" topic.)

You cannot manually resize or reposition a graph from MicroStrategy Web.

Formatting numeric data in a report

Metrics on a report can have formatting applied to the metric values
independently of any overall report formatting. The metric data displayed on
a report is shown with the formatting from the actual metric that is placed on
the report when the report is designed. Metric data formatting also depends
on several other factors.

To see the possible scenarios for metric formatting with grid and graph
image examples, see the Graphing chapter of the Advanced Reporting Help.
You can also see the online help (the "Formatting metrics on a report" topic)
for complete details on other factors that can affect number formatting in a
report.
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Preset formatting: Autostyles

MicroStrategy comes with several presentation styles for displaying reports.
These are called autostyles. Each autostyle automatically applies a set of
formatting that includes color scheme, font style, and font type to a report.

For example, in MicroStrategy Developer and Web, the default autostyle
used for all reports is called Corporate, which includes a gray background
and dark blue font color, as shown in the image below:

Autostyles let you standardize formatting across many reports.

Explore the available autostyles by opening a grid report in the Tutorial
project and selecting any of the available autostyles. For information to
locate reports in the Tutorial project, see About sample data and the
MicroStrategy Tutorial project, page 4.

Applying an autostyle

To apply an autostyle in MicroStrategy Web

1. In MicroStrategy Web, click to open a grid report.

2. Click the Grid menu. If DHTML is disabled, click Go.

3. Select an Autostyle from the drop-down list. If DHTML is disabled,
click Apply Style.
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Creating a new autostyle
You can save your favorite formatting settings as an autostyle, so you can
easily repeat your favorite styles on later reports.

Although you cannot create new autostyles in MicroStrategy Web,
autostyles created in Developer are available to be applied to reports in
Web.

To create and save an Autostyle in Developer

1. In Developer, double-click to open a grid report.

2. Format the report as desired, using any of the procedures in this
chapter or the online help. For example, apply a banding color scheme
to the columns or rows of the report, and change the report's borders.

3. From the report's Grid menu, select Save Autostyle As.

4. Specify a name for the new autostyle in the Save Autostyle As dialog
box. The name should be descriptive so you or other users can be
aware of what formatting changes it will make when applied to a report.

5. You can save objects in MicroStrategy so that only you can see and use
them, or so that all other users can see and use them. This is
determined by the location where you save the object:

l To save an autostyle so that other users can also use the autostyle to
apply formatting to their reports, save the autostyle in the Public

Objects\Autostyles folder.

l To save an autostyle so that only you can use it, save the autostyle in
the My Personal Objects\My Objects folder. If you save an
autostyle in this folder, it appears only in your autostyle drop-down
list and is not available to other users.

The next time you open a report, you can view the autostyle you created in
the list of available autostyles.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 70

For information on creating autostyles for a broad number of reports,
changing properties in the default autostyles, and so on, see the Advanced
Reporting Help.
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ANALYZING DATA
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When reports return large amounts of data, it can be difficult to easily
understand what the data is telling you. Several MicroStrategy tools can
help you analyze large amounts of data more quickly.

The following analysis tools are available in MicroStrategy Developer and
MicroStrategy Web:

l Sorting: See Sorting data, page 72.

l Finding values in a report: See Finding values, page 76.

l Outline mode: See Summary/detail of data, page 78.

l Page-by: See Grouping data by page, page 84.

l Pivoting: See Pivoting data, page 90.

l Report limits: See Specifying maximum and minimum values: Report
limits, page 93.

l Metric join type: See Determining how metric data is combined: Metric join
types, page 98.

l Evaluation order: See Evaluation order of calculations, page 105.

l Subtotals: See Subtotals, page 106.

Each analysis tool is discussed in detail in this chapter.

Sorting data

You can reorganize how data is displayed on your report by sorting the data.
Sorting lets you move data so you can analyze that data more effectively.
Consider the following sorting techniques:

l Move the most important data up to the top of the report where you can
see it easily.

l Group particular chunks of data together so you can more easily compare
the data.

For example, you are looking at a report that shows income ranges for your
customers. The report lists all income brackets for customers in every region
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in the United States. The image below shows just the top half of this lengthy
report. (The rest of the report that is not included here shows the rest of the
regions in the United States.)

This image shows the default sort order for this report. The default sort order
focuses on geographical regions, as shown in the far left column in the
report.
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But you want to analyze only the income bracket revenue over $80,000, and
with the report as it appears now, you must scroll up and down the data to
gather the numbers you need, risking missing a number or accidentally
looking at the wrong number.

If you sort the Income Bracket column in descending order, you can instantly
see the higher income brackets you are interested in, grouped together for
clarity and easier comparison, as shown in the image below. With the new
sort order, the focus of the report is now on income bracket rather than
geographical region.

You sort data based on a row header or column header. Row headers are
typically business attributes; for example, in the report above, Region and
Income Bracket are attributes and are in the rows of the report. Column
headers are typically business calculations called metrics; for example, in
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the report above, Revenue is a metric that is in the columns of the report.
Attributes and metrics are the most common objects on a report.

You can sort on any column or row that is on a grid report. When you sort,
you determine the sorting order, either ascending or descending:

l Ascending sort order arranges the data alphabetically, from A to Z, or
lowest to highest, such as from 1 to 10.

l Descending sort order arranges the data in reverse alphabetic order, from
Z to A, or highest to lowest, such as from 10 to 1.

Sorting is processed by the MicroStrategy Analytical Engine, which means
you can sort and organize the data on a report without taking up the time and
resources to re-execute the report against your data source.

This guide discusses only quick sorting. For information on more complex,
layered sorting patterns, see Advanced Sorting in the Advanced Reporting
Help. For information on sorting custom groups, see the Custom Groups and
Consolidations chapter in the Advanced Reporting Help.

Quick sort
You can quickly sort the data in a column or row, in either ascending or
descending order. A quick sort allows you to experiment with different sort
orders for your data, so you can determine which sort order displays the
data in the most useful way.

There are various ways to trigger a quick sort, including using the right-click
menu or using the sort icons:

l MicroStrategy Developer: You can right-click on the column or row, or
use the sort icons on the Data toolbar. (To see the sort icons, from the
View menu, select Toolbar, then select Data.)

l MicroStrategy Web: You can right-click on the column or row, or use the
sort icon in each row and column header. (To see the sort icons, from the
Tools menu, select Sort Buttons.)

The procedure below describes the right-click sort method.
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To perform a quick sort

1. Open a grid report.

2. Right-click in the heading of the column or row to be sorted.

In Developer, make sure you right-click directly on the column name,
not in the blank area of the column header.

3. Point to Sort, and select either Ascending or Descending.

Finding values

Whenever you want to quickly locate a specific data value in a grid report, or
you want to jump to a section of a large report, use the Find feature. You can
also use the Find feature to locate a string in the SQL syntax, when viewing
a report in SQL View. (For steps to look at a report in Grid View or SQL
View, see Report types, page 9.)

You can also narrow your searches if you need to, by defining specific
requirements for your search.

In MicroStrategy Web, use the browser's Find feature to locate values or
other data in a report. For example, in Internet Explorer, from the Edit
menu, select Find on this page.

To find a value in a report in Developer

1. Open a grid report.

2. From the View menu, display the report in the appropriate view,
depending on what you want to find:

l Grid View or Grid Graph View, to find a value in the report

l SQL View to find a string in the SQL syntax
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The Find feature is not available in Graph view.

3. From the Edit menu, select Find.

4. Enter the value to search for and click Find Next. The first instance of
the value is highlighted if the value is found.

5. Click Find Next again to search for additional instances of the value in
the report.

Each cell in a grid report is treated as a string value. This means that, for
example, if a grid report contains data that includes the numbers 50 and
500, both cells are found when you search for 50. To change this behavior,
see Narrowing a search for report data, page 77.

Narrowing a search for report data
When searching for data in a report in Grid view, use any of the following
options to narrow the results you get from a search using the Find feature.
These options work similarly to Find options in Microsoft Excel.

Searching by row or column

Search By Rows or By Columns allows you to set the direction of the
search so that the data you are looking for may be located more quickly.

Making a search case-sensitive

Match case f inds only text that has the same pattern of upper and lower
case as the text you specify in the Find what text box. Use this option to
make the search case-sensitive.

Finding an entire cell

Find entire cell f inds only cells that match all of the text you enter in the
Find what text box. For example, if you enter "3470", a cell containing
"3,470" will not be found. If you enter "50", a cell containing "500" will not be
found.
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Narrowing a search for SQL syntax
You can use SQL view to search for specific syntax in the SQL for a report.
Use any of the following options to narrow the results you get from a search
using the Find feature. These options work similarly to Find options in
Microsoft Notepad.

To view a report in SQL view, open a report and select SQL View from the
View menu.

Matching the whole word

Match whole word only f inds only strings that match all of the text you
enter in the Find what text box. For example, if you enter "temporary", a
string containing "temp" will not be found.

Making a search case-sensitive

Match case f inds only text that has the same pattern of upper and lower
case as the text you specify in the Find what text box. Use this option to
make the search case-sensitive.

Summary/detail of data

When you have a large set of data on a report, it is generally easier to
analyze and understand the data if you can look at only certain sets of the
data at one time. Use one of the following tools to organize large sets of
data so it is easier to handle:

l Outline mode: This tool lets you expand and collapse sets of data. See
Outlining data, page 79.

l Page-by: This tool lets you view one "page" of data at a time. See
Grouping data by page, page 84.
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Outlining data
You can create an indented grouping of related data on a grid report by
organizing the data into a standard outline style. Using an outline style, you
can collapse and expand sections of related data, as shown in the images
below.

The image below shows just a small portion of an outlined report expanded
completely. The outline style is controlled with the numbered buttons that
appear in the top left corner of the report. For this image, button 3 was
clicked, which expands the outline down to its third level. In this case, the
third level is Supplier. Note that most of the report data cannot be viewed
without scrolling, but each item of data and its related metric numbers can
be seen clearly:
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The next image shows the same report as in the image above, but with the
lowest level of data collapsed and only the higher levels of data expanded
(button 2 in the top left corner was clicked). Note that you can almost see
the entire report in a single screen. The detailed data is hidden, but higher
level numbers can be analyzed and compared more easily. It is also easier
to compare totals and averages for each category.
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The next image shows the same report as in the images above, but with all
data levels collapsed fully (button 1 in the top left corner was clicked). Note
that this outline level provides the highest summary of data:

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 82

Outlining is particularly useful when information displayed would otherwise
involve repetitive entries. For example, you want to display sales for three
years, 2004, 2005, and 2006. You also want data listed by month within each
of the years. Rather than having all data visible for every month of every
year, you can use an outline to expand and view just that data you want to
see immediately, and keep other data collapsed, to be expanded later for
quick comparisons.

Multiple-page reports work in the same way. For example, if you are on page
4 of a multiple-page report and you want to collapse the data to the second
level, then you will only be collapsing data that is displayed on the fourth
page of the report.

Enabling an outline

Use the appropriate procedure below, depending on whether you are
working in MicroStrategy Developer or MicroStrategy Web.

Outline mode is only available when the report has more than one object in
the rows. For example, if your grid report has business attributes on the
rows of the report, there must be more than one attribute if you want to use
outline mode.
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To enable an outline in Developer

1. Open a grid report.

2. From the Grid menu, select Display Outline Results. You can expand
and collapse the outline levels by clicking the numbered buttons at the
top of the report. There is one button for each outline level in the report.

Each outline level usually represents a business attribute on the report. For
a detailed explanation of rows and columns and what business data they
represent, see Rows and columns.

To enable an outline in MicroStrategy Web

1. Open a grid report.

2. From the Tools menu, select Report Options.

3. Select the Outline check box, and click OK.

4. You can expand and collapse individual levels by clicking the + or - box
within each row on the report. Click the numbers above the report to
expand or collapse everything to a certain outline level.

Each outline level usually represents a business attribute on the report. For
a detailed explanation of rows and columns and what business data they
represent, see Rows and columns.

Initial display of an outline

Depending on whether you are using MicroStrategy Developer or
MicroStrategy Web, you may be able to change how outlined reports appear
when they are opened.

l MicroStrategy Web: By default, reports with an outline applied are
displayed with all outline levels collapsed. This default cannot be
changed.
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l MicroStrategy Developer: By default, reports with an outline applied are
initially displayed with all levels expanded. However, you can specify how
you want the report to display when it is opened. You can have an outlined
report open with a specific level already expanded, or with all outline
levels collapsed.

To determine how an outline displays init ially

1. In Developer, open a grid report.

2. If the report does not already have Outline mode enabled, from the Grid
menu choose Display Outline Results. The report is displayed in
Outline mode.

3. From the Grid menu, select Options.

4. Click the General tab, and select one of the following:

l Open with all outline levels expanded: The report will open with all
outline levels expanded. This is the default setting.

l Open with all outline levels collapsed: The report will open with all
outline levels collapsed.

l Open outline expanded up to this level: The report will open
expanded up to the level you select from the drop-down list. The list
becomes available once you choose this option.

5. Click OK.

6. Click Save.

Grouping data by page
When you have a very large set of data on a report, it can be easier to
handle that data by grouping the report data into logical subsets, and
viewing only one of the subsets at a time. To group data into subsets, you
can use the page-by feature.

The subsets you separate your business data into are called pages, and you
then page your way through the report, viewing one data subset at a time.
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Page-by makes viewing a report easier than scrolling through long lists of
data.

For example, if a report showing your profit data is organized by Year,
Quarter, and Region, you can create a page-by for Year, so that the report
shows only one year's data at a time. The following image shows such a
report with Year in the page-by pane of the report (the top of the report).

You simply click the page-by field to select a different subset of data to
display. The page-by feature lets you decide what subsets of your business
data you want to display as separate pages of your report.

In MicroStrategy Web, the page-by feature appears as shown in the image
below. The specific subset of data from the report that is being displayed is
the data related to electronics, as shown in the page-by panel at the top of
the report:
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In the next image, the report is paged by books instead of by electronics,
resulting in data showing cost, price, and profits related to book sales:

Attributes and metrics are the most common objects available in the page-by
pane of a report, although you can enable page-by for most objects that
appear on a report.

You can page-by any of the following objects:

l Attributes

l Metrics

l Hierarchies

l Consolidations and custom groups. (Consolidations and custom groups
are described in the Advanced Reporting Help.)

l Most object prompts. (Specifically, object prompts that are made up of
attributes, hierarchies, consolidations, and custom groups. Object prompts
containing metrics can be placed in the page-by pane as long as the
report's rows or columns do not contain a metric. Prompts are discussed in
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detail in Asking for user input: Prompts, page 280 in Chapter 7, Building
Query Objects and Queries, for Designers.)

Page-by capabilit ies can be enabled or disabled for your project by your
company's project designer. (A project designer is someone who sets up
objects within MicroStrategy to reflect your organization's data.) If you
encounter a problem moving a certain type of object into the page-by pane
above a report, your project designer may have disabled the page-by
functionality for that type of object.

To move an object to the page-by pane in Developer

You can place more than one object in the page-by pane. If you decide to
place multiple related attributes in the page-by pane, be aware that order
matters. Whatever you page-by first (furthest to the left) affects the
elements displayed in the other page-by fields. Place multiple objects into
the page-by pane in logical order, from left to right.

1. Open a grid report.

2. From the View menu, select Page by. The Drop Page Fields Here pane
opens above the report.

3. On the report, right-click the object you want to move to the page-by
pane, point to Move, and select To Page-by. The object is moved to
the page-by pane above the report. In the example below, the Year
attribute is moved to the page-by pane.
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To move metrics in columns to the page-by pane, right-click the word
Metrics on the report and select Page-by. All metrics must be moved
together. You cannot have one metric in the page-by pane and others
on the report grid.

4. The report is automatically re-displayed to show only the subset of data
shown in the current page-by field. Click the page-by field and select an
option from the drop-down list to change the subset of data displayed.
In the example below, you can select Year 2009 instead of 2008 to see
the Revenue and Percent Growth for each customer region for that
year.
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To remove an object from the page-by pane

1. In the page-by pane at the top of the report, right-click the page-by field
you want to remove.

2. Point to Move, and select either To Rows or To Columns. The object
is moved out of the page-by pane and onto the report.

To further arrange objects on the report, you can click the row or column
headers of objects on the report, and drag and drop them into place.

Retaining page-by display when saving a report

When you save a report that contains the page-by feature, you can choose
to either retain the currently displayed page-by selection with the saved
report, or to revert to the original page-by display. If you save the current
display of a page-by report, the next time you run the report it automatically
displays the last page-by choice you made before you saved the report. This
feature allows you to choose different criteria to view a report by whenever it
is executed.

In instances where you want to view a specific page first, using this setting
allows you to decide the initial page to display.
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The default page-by saving method reflects the page-by setting designated
for the entire project. This is usually set by your company's project designer.
(A project designer is someone who sets up objects within MicroStrategy to
reflect your organization's data.)

To retain page-by display

1. Open a report that contains a paged-by object.

2. Click the page-by field at the top of the report, and, from the page-by
drop-down list, select the page you want to be displayed the next time
you execute the report. The report refreshes, displaying the page of
data you selected.

3. From the Data menu, select Report Data Options.

4. Expand the General category, and select Advanced.

5. From the drop-down list called Retain page-by selections when you
save this report, select Yes.

6. Click OK.

7. Save the report and then reopen it. The page-by field you last selected
is now the first page displayed.

Pivoting data

Data pivoting enables you to rearrange the columns and rows in a report so
you can view data from different perspectives.

For example, in the image below, the Inventory Received from Suppliers by
Quarter report shows a set of data spread across the screen in a large grid
display. (The image below shows only a small section of the full report.) It is
not always easy to compare numbers in reports of this size.
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If you pivot the objects on the report, so that the objects that were in the
columns are now in the rows, and the objects that were in the rows are now
in the columns, much of the data is easier to read and compare, as shown in
the image below.

For example, in this pivoted report it is simpler to analyze total units
received each quarter within a subcategory of books, because the totals are
listed in a single column, making them easy to compare. Any anomalies in
the numbers quickly become apparent. To perform the same comparison
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analysis with the first report above, you must visually skip over groups of
data and try to focus only on totals.

With data pivoting, you can do the following:

l Move an object (a business attribute or a metric calculation) and its
related data from a row to a column.

l Move an object (a business attribute or a metric calculation) and its
related data from a column to a row.

l Change the order of objects in the rows.

l Change the order of objects in the columns.

All metrics are kept together on a report, so they must be moved as a group
when pivoting data. For example, on a grid report you cannot move one
metric to a row and another to a column. For graph reports, metrics must all
be together on only one axis. To pivot metric data, select the word "Metric"
in the header to move all metrics together.

Methods for pivoting data
You can pivot data in a grid report using any of the following methods:

l From the Move menu (in MicroStrategy Developer) or the Data menu (in
MicroStrategy Web), select Swap Rows and Columns.

l Drag and drop objects on the report to move them around. (In
MicroStrategy Web, you must have the DHTML user preference enabled to
move data this way.)

l In MicroStrategy Developer, click an object on the report to select it, and
choose a data pivoting option from the Move menu.

l Right-click an object on the report, select Move, and choose a data
pivoting option. (In MicroStrategy Web, you must have the DHTML user
preference enabled to move data this way.)

l Select an object on the report and use one of the data pivoting buttons on
the toolbar (in MicroStrategy Developer) or in the column header (in
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MicroStrategy Web). To enable pivoting buttons in MicroStrategy Web,
from the Tools menu, select Pivot Buttons.

Specifying maximum and minimum values: Report
limits

After a report's results are displayed, you may need to further restrict the
data displayed without changing how the calculations were performed. You
can limit the data displayed in a report by specifying maximum and minimum
values for a given metric. These maximums and minimums determine which
rows of a result set are displayed in the report, and are called report limits.

For example, the image below shows you a report that ranks all employee
sales.
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You want to see only the results of the top ten employees. If you apply a
report limit to restrict the data displayed to the top ten employees, the data
used to calculate the sales rank is not affected. Only the employees
displayed changes, as shown in the image below.

A report limit is assigned to metrics that appear on the report. Report limits
are defined using operators such as Between and Less Than. By default,
report limits are joined by the AND operator. To change the operator,
double-click the operator and select a new operator.

For more information on additional options and settings within the Report
Limit Editor, click Help.

For more information on advanced operators to apply to a report limit, see
Appendix B: Logical and Mathematical Operators for Filtering in the
Advanced Reporting Help.

If you have MicroStrategy OLAP Services, you can apply report limits to any
data on a report, not just metrics. For information on OLAP Services, see
OLAP Services, page 16.
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To limit the data on a report using maximums and minimums

1. Open a grid report.

In the example below, the report shows revenue earned by each
employee. You want to add a report limit to restrict data to show
employees who earned revenue greater than 1,000,000.

2. From the Data menu, select Report Data Options. Under the
Calculations category, the Report Limit subcategory displays any report
limits that may already be applied to the report.

3. To apply new limits to the report data, click Modify.

4. Double-click in the Limit Definition area.

5. Click Browse and navigate to the metric you want to apply the limit to.
Then click OK.
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Derived metrics cannot be used in a report limit. A report limit is a SQL
engine function and therefore can only use a metric that exists in the
project. A derived metric, which is created within the report, exists only
in the report. To use the derived metric, re-create it as a regular
metric, using the Metric Editor. For background information on derived
metrics, see Derived metrics, page 17. For steps to create a metric,
see Calculating data on a report: Metrics, page 197.

6. From the Operator drop-down list, select the operator you want.
Examples include Between, Greater than, Less than, Exactly, and so
on.

7. Enter the Value that you want the operator to apply to. In the example
below, the Operator is set to Greater than, and Value is set to
1,000,000 to see only data over 1 mill ion.

8. Click OK. Then click Save and Close to save the report limit.
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9. Click OK to return to the report. In the image of the report below, you
can see that only those employee names that earned revenue greater
than 1,000,000 are displayed.

Report limits and filters: If the report has a filter, the filter is applied to the
report data first, then the report limit is applied to further restrict the data
returned in the report.

Calculating data

Your organization's data source contains data related to all of your
organization's operations. The goal of reporting is to access the latest data
related to your analysis needs, and then calculate that data to display the
numbers you need to see.

Within a single set of data that is gathered from your data source in
response to a report's query, the results of calculations on that data can
change drastically depending on a number of considerations, such as:

l Metric join types: These determine how tables of metric data (usually
numerical data, such as sales, costs, or profits) are joined to each other.
The effect of joining your data in different ways on calculations of
numerical data is described below in Determining how metric data is
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combined: Metric join types, page 98.

l Attribute join types: These determine how tables of attribute data
(business concepts, such as year, store, or item) are joined together. See
the Advanced Reporting Help for details and business examples of
attribute joins in a report.

l Evaluation order: This determines in what order the various objects on a
report are calculated. Objects that can affect the calculation of data to be
displayed on a report include such things as metrics, report limits, and
subtotals. Which object is calculated first, next, and so on can completely
change the report's results. A description of the default evaluation order
and examples for different evaluation orders are provided below in
Evaluation order of calculations, page 105.

l Subtotals: These allow you to total metric data using a selected
mathematical function. You can subtotal data in different ways for other
business users who will be viewing or analyzing the data. See Subtotals,
page 106.

As an introduction to understanding joins, be sure you understand the basic
report components of a metric, an attribute, and an attribute element. For
descriptions and examples, see MicroStrategy objects, page 189.

Determining how metric data is combined: Metric join types
When you execute a report, data is often retrieved that has come from more
than one table in your data source. The final results on any report are
greatly dependent on the organization and structure of your data source
tables and how data is stored within them.

When data is pulled from two or more tables of metric data in your data
source, a metric join determines the way that data is combined into a single
set of data. The order in which the data is joined from the different tables
can affect the outcome of the data calculation, just as the order of
operations in any arithmetic expression can affect the result.

Knowing how data is calculated for metrics on a given report is an important
part of the data analysis process. Several decisions go into determining
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rules for how data is calculated when that data is pulled from different tables
in your data source. Calculation rules for metrics are defined at several
organizational levels:

1. How data is calculated by default is usually decided first by your
company's project designer, who implements several settings on a
project-wide basis that affect how SQL handles your organization's
data during calculation. These decisions are often driven by the type of
database your organization owns; most databases process SQL
differently. These settings are generally made within the VLDB
properties for your project's database instance within MicroStrategy.
For details on metric-specific VLDB properties, see the Advanced
Metrics chapter in the Advanced Reporting Help.

2. Next, the person in your company who designs a metric can override
the project-level default settings described above when she creates the
metric. When a metric designer applies settings to a specific metric,
these settings are effective for that metric no matter which reports the
metric is used in. For details on metric calculation settings at the metric
level, as well as joins for a compound metric (a metric that is made up
of other metrics), see the Advanced Metrics chapter of the Advanced
Reporting Help.

3. Finally, report analysts can change how a metric is calculated for a
single report with which the analyst is concerned. You can view the
existing settings for a metric, as well as change various settings, within
the Report Data Options dialog box. (For steps to do this, see Viewing
and changing metric join types, page 103.) Any changes made to metric
joins in the report will override any join settings that were made by your
company's metric designer or by your company's project designer,
described above. However, changes made to the join type using the
Report Data Options dialog box affect this metric on this report only.
When the metric is used on another report, it uses its default metric join
type. These report-level metric join options are discussed in detail
below.
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Metric joins

An understanding of your organization's data source storage structure is
helpful to understand the details of metric joins.

A metric is often calculated based on data that comes from more than one
table in your data source. Data coming from multiple tables must be joined
together in some way during data calculation.

A metric join setting determines how data is combined by applying a specific
type of join, inner or outer. The MicroStrategy SQL Engine applies the
designated join type to the data pulled from your data source's tables. The
join type places conditions on the data to be displayed in the report.

Inner and outer joins are discussed with examples below.

l Inner join: An inner join includes in the calculation only the data common
to all the tables from which data is being gathered in your data source.

l Outer join: An outer join includes in the calculation all of the data in all of
the tables from which data is being gathered in your data source.

Examples of inner and outer joins

Inner joins are generated by default for all metrics in a report. The resulting
report contains only those rows that have data returned for all the metrics.

For example, review the data in the following table. The Sales Information
and Budget Information columns show whether data exists in the data
source for that type of data in that region.

Region Sales Information? Budget Information?

North Yes No

South Yes Yes

East Yes Yes

West No Yes
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A report is created containing Sales and Budget metrics, and the Region
attribute. The default inner join is not changed, because you want to view
metric values that are common to both metrics and that are therefore not
empty for either metric. Since the North region does not have any budget
data, as shown in the table above, no data is displayed for the North region
on the report. Similarly, the table above shows that sales data has not been
tracked for the West, so all data for the West region is also omitted from the
report. The resulting report, with an inner join between metrics, displays
only those regions that have both sales and budget information, or data that
is common to all components of the join. The result looks like the following
report:

However, assume you need to change your analysis and you want to display
all of the data from the tables in your data source, whether or not data exists
for all the metrics at all levels in the report. (For a definition and examples of
levels, see How data is aggregated on a report: metric level, page 119.) You
apply an outer join to both metrics because you know there is some
incomplete or empty data for some regions in your data source. The outer
join results in the following report, in which the North and West regions
appear even though they have no data for one of the metrics.

Finally, you can specify different joins for each of the metrics on a report.
You want to see all sales data even if budget data has no values for some
regions in your data source, so you apply an outer join to the Sales metric
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and an inner join to the Budget metric. All regions (all report rows) with
information on sales are displayed. The following report is created:

West is not displayed because it does not contain sales information. It is
irrelevant whether data exists for the Budget metric or not.

When to use an inner or outer metric join

Inner joins

An inner join is generally more commonly used for metric data than outer
joins. (The exception is with rank metrics; see Outer joins below for details.)
Inner joins are effective in many situations, including the following:

l Inner joins provide effective results when you know the metrics on your
report are closely related to each other, such as the Revenue metric and
the Profit metric.

l Inner joins are most effective if your data source contains relatively
complete metric data, without empty values.

l Inner joins require less processing time than outer joins, so they are useful
to lessen the processing load on your MicroStrategy Intelligence Server
machine.

Outer joins

Outer joins are effective if your data source contains empty values for some
metric data in some tables. Outer joins are also necessary for metrics that
show rank. Outer joins allow you to see all data that is available for a metric.
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For example, your revenue data may be completely up to date, but several
profit values have not been reported and entered in the data source for
certain days during the past week. When the Revenue and Profit metrics are
both included on the same report, you can apply an outer join to the
Revenue metric so that you can see all values for Revenue for each day of
the past week, even if the Profit value for a given day is currently empty.

When a metric calculates rank, it is important to use an outer join on the
rank metric. If the default inner join is used on a rank metric, some of the
ranks (and therefore, the ranked attribute elements) may not appear on the
report because an inner join does not include elements with null values in
the result set. But an element with a null value may have a rank. With an
outer join, all rows are displayed on the report even if there is no result
displayed for some of the elements for some of the metrics on the report.
The goal for a rank metric is to display all rankings, so all elements must
appear whether they have values or not.

Viewing and changing metric join types

The image below shows the metric join type setting in the Report Data
Options dialog box.
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To view and change metric join types

1 In Developer, open a grid report.

2 From the Data menu, select Report Data Options. Under the
Calculations category, select Metric Join Type. The Metric Join Type
subcategory lists all metrics on the report, along with each metric's join
type, as shown in the image above.

If you have a long list of metrics, you can sort them by metric name or by
join type, by clicking the Metric or Join Type column headers.

3 You can change a metric's join type by clicking the join type (Inner or
Outer) for the metric you want to change.

4 From the drop-down list that appears, select a different join type. Inner
and outer joins are described fully above. You can select the following:
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• Default: This option sets the metric to use the join type set for that
individual metric when that metric was created with the Metric Editor.
If no join type was determined this way for the metric, this option sets
the metric to use the join type set at the project level.

• Inner: This option displays only the data common to all data source
tables from which data is being gathered for this metric.

• Outer: This option displays all of the data from all data source tables
from which data is being gathered for this metric.

5 Click OK.

Evaluation order of calculations
Evaluation order is the order in which objects are calculated by
MicroStrategy's Analytical Engine. Changing the order in which data is
calculated can change report results. You change the evaluation order of a
report's data calculation by changing the order in which compound smart
metrics, consolidations, derived metrics, derived elements, report limits, and
subtotals on the report are calculated.

The default order of calculation is as follows:

1. Compound smart metrics (which are compound metrics with smart
totals enabled)

2. Consolidations, which are evaluated by their relative position on the
report template:

l Rows, from left to right

l Columns, from top to bottom

3. Report limits

4. Subtotals

Compound metrics that are not the direct aggregations of other metrics can
be used in the evaluation order by setting the Allow Smart Metrics option of
the Metric Editor to Yes.
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Page-by and sorting are determined last, to arrange the positions of the
calculation results. Their evaluation order cannot be changed.

Many reports contain objects that require complex considerations to
determine an effective evaluation order. For a more detailed discussion of
evaluation order and how to change it, including examples, see the
Designing Reports chapter of the Advanced Reporting Help.

Subtotals
Subtotals are totals of selected groups of your metric data, totaled at a level
you select. (For a definition and examples of levels of aggregation, see How
data is aggregated on a report: metric level, page 119.) A subtotal lets you
see the totals for subgroups of your report data.

A metric's designer must enable grand totals and/or subtotals for a metric. If
grand totals and/or subtotals have been enabled, an analyst can choose to
either display or hide them for that metric on a given report. Analysts can
also change the function used with a subtotal. The subtotal functions
available include sum, count, minimum, maximum, average, and median, as
well as others.

Analysts also have the ability to change the level at which a subtotal is
calculated. For background information on levels, see How data is
aggregated on a report: metric level, page 119 in Chapter 4, Answering
Questions about Data.

Report designers can also construct custom subtotals in MicroStrategy
Developer that, for example, allow you to apply subtotals to selected metrics
only. Custom subtotal functionality is explained in detail in the Advanced
Reporting Help.

Displaying subtotals

You can choose to display a subtotal across levels on a report, display grand
totals, or display all subtotals.
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You can select the value that is displayed in place of a null value in a
subtotal. For steps, see Formatting null values and blank cells, page 31.

To display subtotals in Developer

This procedure assumes that the person who created the metric has enabled
grand totals or subtotals for the metric.

1. Open a grid report.

2. From the Data menu, select Subtotals.

3. Select the type of subtotal function you want to use on the report.

4. Click Advanced.

5. In the Applied levels section, specify the level on the report at which to
calculate the selected subtotal.

For a definition of a level and examples, see How data is aggregated
on a report: metric level, page 119 in Chapter 4, Answering Questions
about Data.

The levels you can select from are:

l By position: Apply the subtotal to particular parts of the report: rows,
columns, and/or page-by fields. Each of these is considered an axis
of the grid report. Then select one of the following:

l Grand Total: Apply only the subtotal across the whole axis.

l All Subtotals: Apply the subtotal across all levels on the axis.

l None: Apply the subtotal to no level of the axis.

l Across level: Apply the subtotal to all attributes and hierarchies
available on the report. When you select this, attributes and
hierarchies are listed for you to choose from. Select those you want
to subtotal.

l Group by: Apply the subtotal by the selected attribute across all
other attributes on the report, regardless of position. This works best
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i f the report has been sorted based on the attribute you want to group
the subtotal by. When you select this, click Add to add new group-by
levels. The Grand Total check box adds a subtotal grouped by
nothing, which means the grand total is calculated based on all
attributes on the report.

6. Click OK.

To display subtotals in MicroStrategy Web

This procedure assumes that the person who created the metric has enabled
grand totals or subtotals for the metric.

1. Open a grid report.

2. From the Data menu, select Edit Totals.

3. From the Definitions tab, select the type of subtotal function you want
to use on the report.

4. Click OK.

For information on using subtotals in custom groups, see the Custom Groups
and Consolidations chapter in the Advanced Reporting Help.
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ANSWERING QUESTIONS
ABOUT DATA
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Filters are an integral part of almost every report. Filters screen the data
that the report brings back from your data source. To successfully interpret
the data displayed in a report, it is important to understand what data was
specifically included in that report, as well as what data was excluded. This
chapter shows you how to view a report fi lter's definition, and provides
examples for simple and more complex filters. See Filtering data, page 110.

Dril l ing is one of the most powerful data analysis functionalities in any
reporting environment. Dril l ing lets you explore data beyond the data
immediately visible on a report. You can dril l through a report to analyze
data that is closely related to the original report data, or you can expose an
entirely different object on a report to see what the data looks like within a
different context. See Drill ing into related data, page 120.

Dril l ing successfully on data in a report requires that you understand how
business attributes in a reporting project can relate to each other within
higher-level business concepts called hierarchies. Hierarchies and dril l ing
are covered in this chapter. See Understanding hierarchies, page 115.

Filtering data

A report fi lter sifts the data in your data source to bring back the information
that answers exactly what you require. The following image shows a report
that has not had a filter added to it. (This is the Yearly Revenue Growth by
Customer Region report, located in the sample Tutorial project.) You can
see that the filter is empty by looking at the information in the Report details
pane above the report, as shown in the image below:y
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(To display report details for any report, click the Report Details icon .)

Now a filter is applied to the report, for the Eastern regions of the United
States (Northeast, Mid-Atlantic, and Southeast). The following image shows
the Yearly Revenue Growth by Customer Region report "fi ltered on" specific
regions. You can see the filter's definition in the Report details pane above
the report. The filter definition is {Customer Region} = Northeast,

Mid-Atlantic, Southeast.

A more complex filter is used in the next report. The report shows revenue
and revenue forecasts. The filter selects only that data related to a
company's electronics products, only for the company's northeastern and
Mid-Atlantic US stores, and only for the current year. The filter's definition
is:

[Category = Electronics] And [Quarter = 2006 Q1,2006 Q2,2006 Q3

or 2006 Q4] And [Region = Northeast or Mid-Atlantic]

The report and its filter are shown in the image below.
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Filters are usually created and added to reports by a report designer. For
any report, you can easily see not only whether a report has a filter applied
to it, but also what that fi lter's definition is. You can view this information in
the Report Details pane, as shown in the images above. This information
helps you understand exactly what data in your data source was included in
the report's results, as well as what was excluded. For steps to view a filter's
definition in a report, see Viewing a filter's definition, page 113.

OLAP Services view filters and regular filters
MicroStrategy OLAP Services lets MicroStrategy Developer, Web, and
Office users slice and dice data in reports without having to re-execute SQL
against the data source. Different from a report fi lter that restricts how much
data is retrieved from the data source, a view filter dynamically limits the
data being displayed on a report without re-executing the report against the
warehouse.

The advantage of using both standard report fi lters and view filters on a
report is that the report can use the standard report fi lter to bring back more
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data than can usefully be displayed at any one time. The analyst can then
use a view filter to change the data displayed, as long as it falls within the
data already retrieved from the database. The analyst generates a view
report, which is the result of a view filter. A view filter does not trigger re-
execution against the data source. This capability translates into improved
response time and decreased database load.

For details on MicroStrategy OLAP Services, see OLAP Services, page 16.

Viewing a filter's definition
Use the appropriate procedure below to view a report's fi ltering information
in MicroStrategy Web.

To specify the information that you want displayed in Report Details, see
Customizing the Report Details pane, page 113.

To see a report 's filter ing information in MicroStrategy Web

1. Open a report.

2. From the Tools menu, select Report Details. The Report Details pane
appears, showing a Report Description and the details of any filter that
is included on the report.

Customizing the Report Details pane
MicroStrategy Developer users can determine what information appears in
the Report Details pane for all reports viewed on their machines. You can
configure the following report details:

l Filter details, which display the report fi lter and report limit by default,
although other types of filters can be displayed

l Report limit details, which display the report limit

l Prompt details, which display the prompt information for all prompts in the
report
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l Report details, which display the report description, prompt details, fi lter
details, and template details.

l Template details, which display the complete template details, including
attribute and metric details

You can configure different options for different types of report details. For
example, you can select whether to include view filter information or the
attribute name in the filter details. For report details, you can choose
whether to include information on prompts or filters. For complete
descriptions of all the report detail options, see the MicroStrategy Developer
Help (formerly the MicroStrategy Desktop Help) or the Advanced Reporting
Help.

The following image displays the report description, report fi lter, and report
limits information in the Report Details pane in a report:

You can configure the report details for a specific report, with the Report
Details Formatting option in the Report Editor, or for the entire project, with
the Project Configuration Editor. Settings configured at the report level
override settings configured at the project level. For steps to set the report
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details formatting options, see the Developer Help or the Advanced
Reporting Help.

The Report Details preferences specified in the Developer Preferences
dialog box override the report details properties that control whether the
following information is displayed:

l Report description

l Prompt details

l Filter details

l Definition of shortcut fi lters

l View filter details

l Metric details

You can change this behavior by disabling Developer Preferences for report
details, as described in the following procedure. For steps to customize
report details using Developer Preferences, see the Developer Help or the
Advanced Reporting Help.

To disable Developer Preferences for report details

1. In Developer, from the Tools menu, select Preferences.

2. Expand the Reports category, and then select Report Details.

3. To use the report details properties instead of the Developer
Preferences, clear the Apply these Developer preferences to the
Report Details check box.

4. Click OK.

Understanding hierarchies

Most data calculation in a business reporting environment is based on the
concept of levels. Hierarchies are an important part of understanding levels
in MicroStrategy. To understand a hierarchy, you must first know what a
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business attribute (generally called an attribute) is. This section defines an
attribute, describes a hierarchy, and then explains the concept of levels.

Business attributes
An attribute is a business concept, such as Store, Employee, Geographical
Region, or Year. These concepts help you understand the business data
(usually numbers) stored in your data source. While knowing your
company's total sales is useful, knowing where and when the sales took
place provides the kind of analytical depth you require on a regular basis.
Attributes provide the answers to the questions "where" and "when".

Attributes appear on reports as row headings or column headings, to tell you
what the data in that row or column is for.

Behind the scenes, attributes are MicroStrategy objects associated with one
or more columns in a lookup table within your data source. In a reporting
environment, attributes provide a context for calculating data and filtering
data. Attributes help you make sense of the business facts stored in the data
source.

For example, you have a report with the Month, Year, and Region attributes
on it, as well as a Revenue metric based on the Revenue fact. When
executed, the report displays your company's revenue by region, and for a
given month and year. It might tell you that the northeast region brought in a
mill ion dollars in revenue in the first three months of last year. Because of
the attributes on the report (Region, Month, and Year), a substantial amount
of information is available, such as which regions produced the least
revenue and which years saw the highest growth in revenue. If you remove
the attributes from the report, you can only see how much revenue the entire
company grew in total, over all t ime.

The attributes your organization's project designer creates are based on
whatever business concepts are important to your organization. By
converting each of these important business concepts into an individual
object that can be placed on a report, concepts like Day, Month, Quarter,
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and Year, or Region, City, and Customer, can appear on a report that
displays data within the context of those attributes.

Hierarchies
A hierarchy is made up of a group of related business attributes that are
conceptually related to each other. (For a description and examples of
attributes, see Business attributes, page 116.)

For example, an organization's data source tables may be updated daily with
sales data, and they may store inventory information that is updated
monthly. The data source may also store specific financial data in its tables
on a quarterly or annual basis. All of this data is stored based on the
concepts of day, month, quarter, and year. Therefore, when a MicroStrategy
project is created based on the data in this data source, attributes will l ikely
be created to represent Day, Month, Quarter, and Year so that daily sales
data can be reported, monthly inventory can be reported, and reports of
financial data can display quarterly or annual details and summaries for
corporate presentations.

If your data source contains data on daily sales figures, can you see weekly,
monthly, or annual sales figures? Yes, you can if you dril l to that data, which
works because of hierarchies.

The attributes Day, Month, Quarter, and Year all share one thing in common:
they are all concepts that describe the larger idea of time. Because they are
all part of the same higher-level concept, these attributes are combined into
a group called a hierarchy; in this case, the attributes Day, Month, Quarter,
and Year are combined into the Time hierarchy. Within a hierarchy,
attributes are arranged in a specific way that is based on their relationship to
each other. The Year attribute is the highest-level attribute in the Time
hierarchy because it encompasses all the other concepts of time (Day,
Month, and Quarter). The lowest-level attribute, or least-inclusive attribute,
in this hierarchy is Day. This Time hierarchy is shown below:
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The example above shows a hierarchy of all the attributes that relate to the
business concept of Time. (These attributes and this hierarchy are part of
the sample Tutorial project.)

This hierarchical grouping of related business attributes is useful for
analyzing data in a reporting project. For example, the sales data is stored
in the data source on a daily basis. But what if you want to see a report
showing monthly sales data? Because Day and Month are part of the same
hierarchy, you can simply dril l from the daily sales data displayed on the
report, up to monthly sales data. The new report you dril l to (which contains
monthly sales data) is recalculated automatically based on the dril l ing path
you select. "Dril l ing up" reflects the direction you are dril l ing into the data in
relation to where the attribute exists within the hierarchy: you dril l from Day
(shown on the report) up the Time hierarchy to Month (which appears on the
new, dril led-to report).

In another example, imagine that your company is an Internet-based retailer
and has its call centers all over the U.S., and therefore stores its employee
data in your data source within the concept of geographical locations within
the U.S. The related business attributes within this idea of geographical
location become part of the Geography hierarchy. An example using sample
data from the Tutorial project is shown below:
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In the Geography hierarchy above, Country is the highest-level attribute and
Employee is the lowest-level attribute.

Employee might just as likely be the highest-level attribute in a hierarchy
called Employee Resources, which includes related lower level attributes
like Profile (Age Range, Gender, Nationality, Ethnicity, Education and
Degree Type, Marital Status), Hire Date, Leave Date, Date of Birth, Title,
Address, Department, Division, Location, Salary Range Level, and so on.
Which attributes are grouped into what hierarchies is decided by your
organization's system architect or project designer when a MicroStrategy
project is first created. If you are interested in complete details, see the
Project Design Help .

How data is aggregated on a report: metric level
When more than one attribute is on a report, as is generally the case, a
metric is calculated by default at the lowest level that is on the report. As
described in Hierarchies, page 117, the lowest level is usually the attribute
that reflects the least-inclusive business concept, such as Day (in a Time
hierarchy) or Employee (in a Geography hierarchy).
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For example, imagine a report that shows your company's revenue listed by
month and year. The report therefore contains the metric Revenue, and the
attributes Year and Month. Is the Revenue metric going to be summed up
and displayed by year? Or is it going to be summed up and displayed by
month? Since a metric is calculated by default at the level of the lowest
attribute that is on the report, in this example the metric results are
calculated to reflect monthly sales data, since Month is a less-inclusive, or
lower-level, concept than Year.

Be aware that the person who created the metrics on your report can change
this default level of calculation. If you have questions about what level your
metric data is being calculated for, contact your organization's
MicroStrategy report designer or metric designer.

Drilling into related data

Drill ing allows you to view report data at levels other than that originally
displayed in the report. (To understand levels, read Understanding
hierarchies, page 115.) It allows you to retrieve more information after a
report has been executed. You can investigate the data in your report
quickly and easily with the help of dril l ing. Dril l ing automatically executes
another report based on the original report to get more detailed or
supplemental information.

To understand what you are doing when you are dril l ing up, down, or
across, you should understand the concept of hierarchies. See
Understanding hierarchies, page 115 for an introduction to this concept.

For example, you look at the revenue, cost, and profit data for all your
stores, at the regional level. The sample report is shown below.
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You decide that you want to look at this information at the Call Center level.
Right-click the Region column header, and choose Drill to Call Center. A
new report is automatically created, the metrics are recalculated to reflect
the new attribute that you are dril l ing to, and the report displays the revenue,
cost, and profit data for your stores by call center. The new report is shown
below:

Even though a report generated as a result of dril l ing is related to the
original report, they are two entirely different reports. The two reports can be
saved or changed independently of each other. For steps, see Tracking your
dril l path and naming the dril led-to report, page 122.

You can dril l on attribute elements, consolidations, custom groups, and
metrics, both on the report and in the page-by field. Consolidations and
custom groups are described in detail in the Advanced Reporting Help, but
dril l ing on them is included in the following procedures.
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Methods for drilling on a report
Depending on the dril l ing method that you choose, you can dril l on the entire
report or only a part of the report. Some drill ing methods provide more
dril l ing options than others. All these methods use the default settings
defined by the report designer. For descriptions of the settings that you can
change to control the dril l ing behavior, including steps, see Controlling
dril l ing behavior to affect report results, page 123.

Dril l ing is often performed on the attribute elements in a report. Elements of
an attribute are the values of an attribute. For example, 2011 and 2012 are
elements of the Year attribute, while New York and London are elements of
the City attribute.

Tracking your drill path and naming the drilled-to report
When you dril l from a report, the name of the resulting, dril led-to report
automatically becomes the original report's name plus the name of the
object that you dril led to.

For example, in the Inventory and Unit Sales report in the Tutorial project,
you can dril l from the Item attribute up to the Category attribute. The
resulting, dril led-to report's name is "Inventory and Unit Sales -> Category".
You then dril l from this resulting report by dril l ing down from Category to
Subcategory. The dril led-to report's name is "Inventory and Unit Sales ->
Category -> Subcategory". If you then dril l across from Subcategory to
Region, the resulting report's name is "Inventory and Unit Sales -> Category
-> Subcategory -> Region".

You can use this report name to track your dril l ing path, which is especially
useful if you continue to dril l from each resulting, dril led-to report.

If you dril l repeatedly along a single path, at some point the report's name
can become too long or cumbersome to be useful. Consider saving a specific
dril led-to report with a new name that is useful for you. Then, when you
continue dril l ing from that report, your dril l path as reflected by each
resulting report's name is shorter and more useful again.
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Controlling drilling behavior to affect report results

You can set various options that determine how drill ing works on a given
report. These allow you to control how other users dril l on the report when
they execute it, or to preserve your own most useful dril l ing paths and
dril l ing behavior for later reuse on a given report. For background
information on dril l ing and dril l ing paths, see Hierarchies, page 117.

Most dril l ing options involve attributes on reports. An attribute is a
MicroStrategy object that represents business data in your data source,
such as Customer, Product, or Store. For background information on
attributes, see Business attributes, page 116.

You can control how drill ing behaves on a report with the options described
in this section.

You can change these options for an entire report, as described in the
procedures in the following sections. You can also change many of these
options for a specific dril l action, while you are dril l ing in Developer. A Web
administrator can also customize dril l settings under the Drill Mode page of
Project Defaults.

Customizing drilling behavior
To find the best ways to customize dril l ing for your way of working or to suit
your reporting goals, see the following table for suggestions.

What do you want to do? Solutions

Reduce the width of reports,
especially when dril l ing.

Do not allow the attribute that you are dril l ing on to appear
in the dril led-to report. To customize this behavior, see
Keeping or removing the dril led-from attribute in the new
report, page 127.

Keep track of the dril l path so
that you can remember what

• The report name automatically adjusts each time that
you dril l, by adding the dril led-to object's name to the
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What do you want to do? Solutions

reports you dril led from for
each new, dril led-to report.

end of the report's name. For ideas on managing the
report's name as it grows, see Tracking your dril l path
and naming the dril led-to report, page 122.

• Make sure each attribute that you dril l on appears in the
resulting, dril led-to report, so the object that you dril led
on always appears in the subsequent report. To
customize this behavior, see Keeping or removing the
dril led-from attribute in the new report, page 127.

Restrict other users of a
report from being able to dril l
wherever the report allows.

Restrict dril l ing paths to dril l ing down only. To do this, see
Enabling dril l ing down or dril l ing anywhere, page 125.

Have the dril led-to report
show only data related to the
currently visible page-by
object on the dril led-from
report.

Use the procedure described in Drill ing on a report grouped
by page-by fields, page 132.

Have page-by fields on the
dril led-to report show exactly
the same information that
they displayed on the dril led-
from report.

Use the procedure described in Drill ing on a report grouped
by page-by fields, page 132.

Have the dril led-to report
display subtotals, if the
dril led-from report also
contained them.

Use the procedure described in Drill ing on a report with
subtotals calculated across levels, page 150.

Enable dril l ing in all
directions.

Use the procedure described in Enabling dril l ing down or
dril l ing anywhere, page 125.

Restrict dril l ing to lower-level
attributes within a given
hierarchy.

Use the procedure described in Enabling dril l ing down or
dril l ing anywhere, page 125.
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Enabling drilling down or drilling anywhere
For a given report, you can enable dril l ing in all directions or restrict dril l ing
to lower-level attributes in a given hierarchy.

l Drill anywhere: When this option is selected in the procedure below,
users can view data associated with the object they dril l from, no matter
which direction in the attribute's hierarchy they dril l. For example:

l A user can dril l down from an attribute to the child attribute data, for
example, dril l ing from Year data down to Month data.

l A user can dril l up from an attribute to the attribute's parent attribute
data, for example, dril l ing from Item data up to Category data.

l A user can dril l across to other, related attributes, for example, dril l ing
from Region data across to Category data.

l Drill down only: When this option is selected in the procedure below,
users can only view data associated with objects lower in the hierarchy
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than the attribute on which they are dril l ing. For example:

l Drill ing down from the Month attribute or one of its elements, users can
only dril l to Day.

l Drill ing down from the Category attribute or one of its elements, users
can only dril l to Subcategory and Item.

For background information on dril l ing and how to dril l on a report, see
Hierarchies, page 117.

To enable drilling in Developer

1. Open a grid report.

2. From the Data menu, select Report Data Options.

3. Expand General in the list of categories, then select Drilling.

4. If it is not already selected, select the Enable Report Drilling check
box.

5. Select one of the following options:

l Drill anywhere: Users can view data associated with the object they
dril l from, no matter which direction in the attribute's hierarchy they
dril l: up, down, or across. Examples are provided above.

l Drill down only: Users can only view data associated with objects
lower in the hierarchy than the attribute on which they are dril l ing.
Examples are provided above.

6. Click OK.
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To enable drilling in MicroStrategy Web

1. Open a grid report.

2. From the Tools menu, select Report Options.

3. On the General tab, select one of the following options:

l Drill anywhere: Users can view data associated with the object they
dril l from, no matter which direction in the attribute's hierarchy they
dril l: up, down, or across. Examples are provided above.

l Drill down only: Users can only view data associated with objects
lower in the hierarchy than the attribute on which they are dril l ing.
Examples are provided above.

4. Click OK.

Keeping or removing the drilled-from attribute in the new
report
When you dril l on a report, you can have the dril led-from attribute and its
related data displayed in the resulting report, or you can choose to not
display the dril led-from attribute on the resulting report. The following
examples show the results of both of these options.

For example, a report contains Country, Region, and the Revenue metric, as
shown below:
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You drill down from Region to Call Center. To do this, you right-click on
Region, select Drill, select Down, and select Call Center. If you specify
that the dril led-from attribute (called the parent attribute) is kept on the
dril led-to report, Region (the dril led-from attribute) appears on the dril led-to
report along with Call Center (the dril led-to attribute), as shown below:

If you specify that the dril led-from attribute is not kept, when you dril l down
from Region to Call Center, Call Center replaces Region on the dril led-to
report as shown below:
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Keeping the dril led-from attribute can be helpful to trace your dril l ing path.
However, resulting reports can become very wide if you have many
attributes and metrics. Not keeping the dril led-from attribute can help reduce
the width of dril led-to reports.

The default behavior is to keep the dril led-from attribute on the dril led-to
report. Be aware that the report's designer may have changed the default.

You can change this option for an entire report using MicroStrategy
Developer, as described in the procedure below. In MicroStrategy Web or
Developer, you can specify whether to keep or remove the dril led-from
attribute while you are dril l ing, for that specific dril l action. For steps, see
Methods for dril l ing on a report, page 122.

To keep or remove the drilled-from attr ibute when drilling

1. Open a grid report in Developer.

2. From the Data menu, select Report Data Options.

3. Expand General in the list of categories, then select Drilling.
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4. Select one of the following options from the Keep Parent While
Drilling drop-down list:

l To ensure the dril led-from attribute appears on the dril led-to report,
select Yes.

l To ensure the dril led-from attribute does not appear on the dril led-to
report, select No.

5. Click OK.

Drilling on a report with threshold formatting
Thresholds are conditional formatting that appears on report data when
certain, specified conditions are met. For example, if certain cells of data
appear bolded or have a red background on a report, that is data that has
met a specified threshold and so is formatted differently to highlight it. For
background information on thresholds, see Formatting conditional values on
a grid: Thresholds, page 26.

You can have thresholds on the dril led-from report be displayed
automatically on any dril led-to report. For example, a report containing the
Region attribute and the Revenue metric has a threshold that highlights
revenue greater than $2 million. The revenue amount is bolded when the
threshold is met, as shown in the image below:

When you dril l from Region to Call Center, the revenue amounts are
recalculated for the Call Centers. For the dril led-to report, you can
determine whether revenue over $2 million should stil l appear bolded.
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If you choose to keep thresholds while dril l ing, and you dril l down from
Region to Call Center, Revenue amounts over $2 mill ion are bolded on the
dril led-to report, as shown below:

If you choose to remove thresholds while dril l ing, and you dril l down from
Region to Call Center, no data is bolded, as shown below:
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When deciding whether to enable this option, be aware that, when a report is
dril led on, thresholds can become meaningless. For example, if you dril l up
on an attribute, all the data in the new report could potentially meet the
threshold condition. Using the example above where revenue over $2 million
is bolded, if you dril l up from Region to Country, the entire report is likely to
consist of revenue over $2 million. The thresholds then only clutter the
report and do not provide any meaningful information.

The default behavior retains the threshold on the dril led-to report. Be aware
that the report's designer may have changed the default behavior.

You can change this option for an entire report using MicroStrategy
Developer, as described in the procedure below. In Developer, you can
specify whether to keep or remove thresholds while you are dril l ing, for that
specific dril l action. For steps, see Methods for dril l ing on a report, page
122.

To keep or remove thresholds when drilling

1. Open a grid report in Developer.

2. From the Data menu, select Report Data Options.

3. Expand General in the list of categories, then select Drilling.

4. Select one of the following options from the Keep thresholds while
drilling drop-down list:

l To ensure that thresholds appear on the dril led-to report, select Yes.

l To ensure that thresholds do not appear on the dril led-to report,
select No.

5. Click OK.

Drilling on a report grouped by page-by fields
Page-by is a method of grouping large amounts of report data so you only
see a separate subset, or page, of data on the report at one time. For
example, in a report that shows sales numbers for every country in which
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your organization does business, if you only want to see one country's data
per page of the report, you put the Country attribute in the page-by pane.
For a full description of page-by and examples, see Grouping data by page,
page 84.

Determining the effect of the page-by field on the resulting report

You can determine how the page-by field on a dril led-from report affects the
dril led-to report. Specifically, if a report you want to dril l on contains a page-
by field (that displays an attribute or a metric, for example) at the top of the
report, you can choose whether to have the object that is currently visible in
the page-by field be part of the filter for the dril led-to report.

For example, you have a report that shows sales data for individual
countries, one country at a time. It has the Country attribute in the page-by
pane above the report. If the currently visible page-by field says Country:
USA, and you dril l down on the report, which one of the following results do
you want to see:

l Data for all countries continues to be displayed on the dril led-to report,
one country at a time.

l Only data related to the USA is displayed, and no other countries can be
selected in the page-by field.

The options described in the following sections let you determine how you
want dril l ing to perform when you dril l on a report that has one or more page-
by fields:

l Drill ing to a report that is unaffected by page-by fields, page 134

l Drill ing to a report with page-by fields restricted to visible pages on the
original report, page 137

l Drill ing to a report with one page-by field restricted and other page-by
fields unaffected, page 141

l Drill ing on a report with page-by fields in the same hierarchy, page 143
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If your report has two or more page-by fields that have objects in the same
hierarchy, page-by behavior changes slightly when dril l ing. Be sure you
review Drill ing on a report with page-by fields in the same hierarchy, page
143 for details.

For steps to set these options, see Customizing dril l ing behavior for a report
with page-by fields, page 146.

Personalizing the drilling locat ion to affect page-by results

You can determine what part of a report will perform specific dril l ing
behaviors. This personalization lets you locate certain dril l ing behavior
within specific areas of a report to suit your dril l ing habits. When you dril l
from the page-by field itself, by default the currently visible page-by field
becomes part of the dril led-to report's fi lter. Conversely, when you dril l from
the body of a report, by default the dril led-to report is identical to the original
report (except for the appearance of the object you dril led on, of course).

Drill ing to a report that is unaffected by page-by fields

When you dril l on a report, you can have the page-by fields of the original
report appear in exactly the same state in the dril led-to report, with all the
same paging choices available.

For example, a report contains the Region attribute and the Revenue metric,
with the Year attribute and the Subcategory attribute in the page-by fields
above the report grid. The currently selected year is 2005, shown by Year:
2005 in one page-by field. The currently selected subcategory is Art &
Architecture, shown by Subcategory: Art & Architecture in the other page-
by field. The report has no filter. The report is shown in the image below:
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Your goal is to have these same page-by fields, showing these same options
and with the same drop-down list of selections, in the dril led-to report.

Drilling from the grid

When you dril l on the report's grid, from the Region attribute down to the
Call Center attribute, the resulting dril led-to report appears as shown below:

Note the results in the dril led-to report:
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l The new report's fi lter is empty, as it was in the dril led-from report.

l The page-by fields stil l contain the Year attribute and the Subcategory
attribute, as they did in the dril led-from report. The drop-down lists of the
page-by fields contain all years and all subcategories, as they did in the
original report, which means you can view revenue data for other years
and subcategories in the dril led-to report.

l Call Center replaces Region in the grid of the new report because Call
Center was the object you dril led down to.

You must clear the Any page-by field and Any other part of the report
check boxes to achieve this dril l ing behavior. To do this, see To customize
dril l ing on a report that has page-by fields, page 149.

Drilling from the page-by pane

When you dril l on one of the report's page-by fields, for example from
Subcategory down to Item, the resulting dril led-to report appears as shown
below:

Note the results in the dril led-to report:

l The new report's fi lter remains empty.

l The Year page-by field stil l contains the Year attribute, and the
Subcategory page-by field became the Item page-by field because that is

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 137

the object you dril led down to. The drop-down lists of the page-by fields
contain all years and all items within all subcategories, which means you
can view revenue data for other years and items within other
subcategories in the dril led-to report.

In summary, based on setting certain dril l ing options, no page-by fields from
the original report have been added to the filter of the resulting report, and
therefore all years and all subcategories are included in the data of the
dril led-to report.

You must clear the Any page-by field and Any other part of the report
options to achieve this dril l ing behavior. To do this, see To customize dril l ing
on a report that has page-by fields, page 149.

Drill ing to a report with page-by fields restricted to visible pages
on the original report

You can include all currently visible page-by fields as part of the new,
dril led-to report's fi lter when you dril l from the original report. As a result,
the dril led-to report contains data specific to the page-by fields currently
visible on the dril led-from report. Additionally, the page-by fields change to
display the objects on the level to which you dril led.

To illustrate this using the same example as above, a report contains the
Region attribute and the Revenue metric, with the Year attribute and the
Subcategory attribute in the page-by fields above the report grid. The
currently selected year is 2005, shown by Year: 2005 in one page-by field.
The currently selected subcategory is Art & Architecture, shown by
Subcategory: Art & Architecture in the other page-by field. The report has
no filter. The report is shown in the image below:
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Drilling from the grid

When you dril l on the report's grid, from the Region attribute down to Call
Center, the resulting dril led-to report appears as shown below:

Note the results in the dril led-to report:

l The new report's fi lter contains the objects that were in the page-by fields
of the original report, namely Year = 2005 and Subcategory = Art &
Architecture.
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l The Year page-by field stil l contains the Year attribute, and the
Subcategory page-by field stil l contains the Subcategory attribute.
However, the drop-down list of the Year page-by field contains only the
year that was visible on the original report when you dril led, in this case
2005. The drop-down list of the Subcategory page-by field contains only
the subcategory that was visible on the original report, in this case Art &
Architecture. This means you only view revenue data for that year and that
subcategory in the dril led-to report.

l Call Center replaces Region in the grid of the new report because Call
Center was the object you dril led down to.

You must select the Any Page-by field check box, the Apply to all page-by
fields option, and the Any other part of the report check box to achieve
this dril l ing behavior. To do this, see To customize dril l ing on a report that
has page-by fields, page 149.

Drilling from the page-by pane

When you dril l on a page-by field at the top of the report, for example from
Subcategory down to Item, in the resulting, dril led-to report, 2005 and Art &
Architecture have been added to the new report's fi lter so that all of the
revenue data on the resulting report is 2005-specific and lists revenue only
for art and architecture books.

The dril led-to report is shown below:
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Note the results in the dril led-to report:

l The filter on the dril led-to report contains 2005 and Art & Architecture.
This means the data for this dril led-to report was filtered so that only
revenue for art and architecture books in 2005 is returned.

l Item replaced Subcategory in the page-by field because you dril led down
from Subcategory to Item. In the new page-by field, 100 Places to Go
While Stil l Young at Heart appears because that book happens to be the
first book among all the art and architecture books that are stored in the
data source. This page-by field functions like all page-by fields, in that
only revenue for this book is included on the page currently displayed in
the new report.

In summary, based on setting specific dril l ing options, all page-by fields
from the original report have been added to the filter of the resulting report,
and therefore only those subcategories and years included in that fi lter are
included in the data of the dril led-to report.

You must select the Any Page-by field check box, the Apply to all page-by
fields option, and the Any other part of the report check box to achieve
this dril l ing behavior. To do this, see To customize dril l ing on a report that
has page-by fields, page 149.
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Drill ing to a report with one page-by field restricted and other
page-by fields unaffected

When you dril l from the original report, you can include only the page-by
field on which you dril l, as part of the dril led-to report's fi lter. Any other
page-by fields remain as they were on the dril led-from report. As a result,
the dril led-to report contains data specific to the dril led-on page-by field
visible on the dril led-from report. All other page-by fields stay the same as
they were on the original report.

To illustrate this using the same example as above, a report contains the
Region attribute and the Revenue metric, with the Year attribute and the
Subcategory attribute in the page-by fields above the report grid. The
currently selected year is 2005, shown by Year: 2005 in one page-by field.
The currently selected subcategory is Art & Architecture, shown by
Subcategory: Art & Architecture in the other page-by field. The report has
no filter. The report is shown in the image below:

Drilling from the page-by pane

When you dril l on a page-by field, for example from Subcategory down to
Item, the new, dril led-to report is shown below:
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Note the results in the dril led-to report:

l The dril led-to report has a filter, for Art & Architecture. The filter contains
the page-by field that was dril led on and contains the object that was
visible on the page-by field in the original report.

l Item replaces Subcategory in the page-by field, because that is the object
you dril led down to.

l The drop-down list of the Year page-by field contains all years, but the
drop-down list of the Item page-by field contains only art and architecture
books, since that is the only subcategory in the filter. Only revenue for the
items in that subcategory is displayed on the report.

You must select the Any Page-by field check box and the Apply to current
page-by field option to achieve this dril l ing behavior. To do this, see To
customize dril l ing on a report that has page-by fields, page 149.

Drilling from the grid

The dril l ing behavior described above can only be achieved when you dril l
from the page-by pane of a report. If you set up a report's dril l ing behavior
this way, you can choose from one of two options for how drill ing from the
report's grid should behave:
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l All the page-by fields are restricted to page-by objects that were visible on
the original report. To achieve this dril l ing behavior, you must select the
Any Page-by field check box, the Apply to current page-by field option,
and the Any other part of the report check box.

l All page-by fields are unaffected by the dril l ing action and appear as they
did on the original report. To achieve this dril l ing behavior, you must
select the Any Pageby field check box and the Apply to current page-by
field option.

To set these options, see To customize dril l ing on a report that has page-by
fields, page 149.

Drill ing on a report with page-by fields in the same hierarchy

This section assumes you understand what a hierarchy is and how attributes
are related within a hierarchy. For background information on hierarchies
and attributes, see Understanding hierarchies, page 115.

If you dril l on a report that has two or more page-by fields that contain
attributes within the same hierarchy, when you dril l on one of those
attributes, the dril l ing behavior described in the sections above is slightly
different.

Specifically, if two or more attributes in the page-by fields are in the same
hierarchy, and you dril l on one of them, all related page-by fields are
restricted to the object that was visible on the original report when you
dril led.

For example, you have a report with one page-by field showing the Year
attribute, one page-by field showing the Category attribute, and one page-by
field showing the Subcategory attribute. This report is shown in the image
below:
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The Category and Subcategory attributes are both within the project's
Product hierarchy, as shown on the left side of the image below. The Year
attribute is in a separate hierarchy.

You leave all dril l ing behavior options in the Report Data Options dialog box
set to default, as shown in the image below:

These settings normally provide the following results:
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l A filter is added to new report; the filter contains only the page-by object
that was dril led on.

l The dril led-on page-by field is restricted to the page-by object visible on
original report.

l All other page-by fields remain as they were on the original report.

However, when page-by fields contain related attributes, the behavior in the
third bullet above is slightly different.

To see the resulting report, you dril l from the Subcategory page-by field
down to Item. The resulting report is shown in the image below, with the
Category page-by field expanded:

When dril l ing from any page-by field using the default behavior settings,
normally only that dril led-on page-by field is changed so that it shows only
the object that was visible in the original report. Other page-by fields are not
affected by the dril l ing action and remain as they appeared on the original
report.

As expected, based on your behavior settings the Subcategory page-by field
was placed in the resulting report's fi lter. And as expected, the Year page-by
field remains as it was on the original report, with all years available to be
selected from the Year page-by.
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However, because Category and Subcategory are in the same hierarchy, in
the resulting report the Category page-by field only displays choices related
to the subcategory that was currently visible in the original report (rather
than showing all items from all subcategories as was displayed in the
Category page-by field in the original report). This behavior occurs because
the higher-level attribute Category must logically reflect the elements
displayed in the lower-level attribute Item that you dril led down to. The Art &
Architecture subcategory is placed in the resulting report's fi lter, and thus
limits the Category page-by field to displaying only Books.

Because these attributes are connected by their relationship within the same
hierarchy, they affect each other when you dril l on one of them. This causes
dril l ing behavior to perform slightly differently than the default behavior
described throughout this section of the manual. In summary, in a report that
has page-by fields containing attributes in the same hierarchy, when you
dril l on a page-by field containing one of those attributes, all other page-by
fields with attributes in the same hierarchy are restricted to the hierarchy
level of the page-by field you dril l on.

Customizing dril l ing behavior for a report with page-by fields

The procedure below describes the options to set dril l ing behavior for a
report that has one or more page-by fields. For complete details and
examples for each of these options, see the sections above. You can also
refer to the table below for a quick reference to choose the right options to
achieve the dril l ing behavior you prefer on a given report.

The following table summarizes the options described in detail in this
section of the manual:
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Option(s) Selected
Drill Location In
Original Report

Appearance Of Resulting Report

Drill from a page-by
field

• Filter is added to new report; fi lter
contains only the page-by object
that was dril led on.

• Dril led-on page-by field is
restricted to the page-by object
visible on original report.

• Other page-by fields remain as
they were on the original report.

Dril l from the report
grid

• Filter is empty.

• All page-by fields remain as they
were on the original report.

Dril l from a page-by
field

• Filter is added to new report; fi lter
contains all page-by objects that
were visible on original report.

• All page-by fields are restricted to
the page-by objects visible on
original report.

Dril l from the report
grid

• Filter is empty.

• All page-by fields remain as they
were on the original report.

Dril l from a page-by
field

• Filter is added to new report; fi lter
contains only the page-by object
that was dril led on.

• Dril led-on page-by field is
restricted to the page-by object
visible on original report.

• Other page-by fields remain as
they were on the original report.

Dril l from the report • Filter is added to new report; fi lter
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Option(s) Selected
Drill Location In
Original Report

Appearance Of Resulting Report

grid

contains all page-by objects that
were visible on original report.

• All page-by fields are restricted to
the page-by objects visible on
original report.

Dril l from a page-by
field

• Filter is added to new report; fi lter
contains all page-by objects that
were visible on original report.

• All page-by fields are restricted to
the page-by objects visible on
original report.

Dril l from the report
grid

• Filter is added to new report; fi lter
contains all page-by objects that
were visible on original report.

• All page-by fields are restricted to
the page-by objects visible on
original report.

Dril l from a page-by
field

• Filter is empty.

• All page-by fields remain as they
were on the original report.

Dril l from the report
grid

• Filter is added to new report; fi lter
contains all page-by objects that
were visible on original report.

• All page-by fields are restricted to
the page-by objects visible on
original report.

Dril l from a page-by
field

• Filter is empty.

• All page-by fields remain as they
were on the original report.
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Option(s) Selected
Drill Location In
Original Report

Appearance Of Resulting Report

Drill from the report
grid

• Filter is empty.

• All page-by fields remain as they
were on the original report.

You can change this option for an entire report using MicroStrategy
Developer, as described in the procedure below. In Developer, you can
specify the page-by options while you are dril l ing, for that specific dril l
action. For steps, see Methods for dril l ing on a report, page 122.

To customize drilling on a report that has page-by fields

1. Open a grid report.

2. From the Data menu, select Report Data Options.

3. Expand General, then select Drilling.

4. You can set the following dril l ing options, which determine how the
page-by on the dril led-from report affects the dril led-to report, as
described in the examples above:

l Any page-by field: The page-by object is added to the filter of the
dril led-to report when you dril l from a page-by field. If this is selected,
choose one of the following:

l Apply to current page-by field: Only the page-by object that is
currently visible is added to the filter of the dril led-to report.

l Apply to all page-by fields: All page-by objects are added to the
filter of the dril led-to report.

l Any other part of the report: The page-by object is added to the
filter of the dril led-to report when you dril l from anywhere on the
report's grid. You choose to locate the page-by dril l ing feature in the
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body of the report, where most users dril l from the data.

5. Click OK.

Drilling on a report with subtotals calculated across levels
A report can be designed to calculate subtotals across selected attribute
levels, also referred to as across-level subtotals. The subtotal is applied to
particular levels—rows, columns, or pages. Across-level subtotals can be
thought of as "group by attributes to the left of the selected attribute". (For a
detailed description of across-level subtotals, see the Reports chapter of the
Advanced Reporting Help.)

If a report is subtotaled across levels, you can determine whether the
subtotals on the dril led-from report are displayed on the dril led-to report.
Across-level subtotals are hidden only when all of the following is true:

l Inherit across-level subtotal from parent is set to No.

l Keep parent while drilling is set to No.

l You drill from the object that is the level of the subtotal.

The following example demonstrates how the results of the report change
when the above conditions are applied.

A report contains the Region, Category, and Revenue metrics. Subtotals are
calculated across all elements of the attribute Category. The attribute to the
left of Category is Region, so the subtotals are grouped and calculated for
each region, as shown in the portion of the report displayed below.
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By default, subtotals are inherited from the parent. Dril l from Category to
Subcategory. In the resulting report, Region, Category, and Subcategory are
displayed. Since the subtotals are inherited, subtotals are applied across
the levels of both Category and Subcategory. Subtotals are therefore
calculated for Category and Region, the attributes to the left of Category and
Subcategory. A portion of that dril led-to report is shown below.

Return to the original, dril led-from report. Specify that subtotals are not
inherited from the parent. Dril l from Category to Subcategory again. As with
the previous dril led-to report, Region, Category, and Subcategory are
displayed. Subcategory does not inherit its parent's subtotal (its parent
being Category). Subtotals are stil l applied at the level of Category, so
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subtotals are calculated for Region, the attribute to the left of Category. A
portion of that report is displayed below.

By default, the parent attribute is kept on the dril led-to report, so Category is
displayed in these examples. Return to the original, dril led-from report.
Specify that the parent is not kept when the report is dril led on. Dril l from
Category to Subcategory. The resulting report displays Region and
Subcategory, with no subtotals. Because Category is no longer on the
report, the across-level subtotals are no longer valid. A portion of the
resulting report is displayed below.
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For information about and examples of the Keep parent while drilling
option, see Keeping or removing the dril led-from attribute in the new report,
page 127.

Return to the original, dril led-from report. Specify that subtotals are
inherited from the parent. Dril l from Category to Subcategory. The resulting
report displays Region and Subcategory, as with the previous report, but
subtotals are calculated for Region. Subtotals are inherited from the parent,
so the across-level subtotals are transferred to the Subcategory. Since
Region is to the left of Subcategory, the report is subtotaled at that level. A
portion of that report is displayed below.
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Return to the original, dril led-from report. Dril l from Region to Call Center
this time, so that you are not dril l ing on the attribute that the across-level
subtotals are defined for. The resulting report displays Call Center and
Category. Subtotals are calculated for Call Center, because Call Center is
now the attribute to the left of Category. A portion of the resulting report is
shown below.
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You can change this option for an entire report using MicroStrategy
Developer, as described in the procedure below. In Developer, you can
specify whether to show or hide subtotals while you are dril l ing, for that
specific dril l action. For steps, see Methods for dril l ing on a report, page
122.

To show or hide subtotals when drilling from a report with across-

level subtotals

This procedure assumes that the report already contains across-level
subtotals. For steps, see the MicroStrategy Developer Help (formerly the
MicroStrategy Desktop Help).

1. Open a grid report.

2. From the Data menu, select Report Data Options.

3. Expand General, then select Drilling.

4. Specify whether or not the subtotals are displayed in the dril led-to
report:

l To display subtotals in the dril led-to report, set Inherit across-level
subtotal from parent to Yes.

l To hide subtotals in the dril led-to report, set Inherit across-level
subtotal from parent to No.

l Subtotals are stil l displayed unless Keep parent while drilling is set
to No and you dril l from the object that is the level of the subtotal.

l To use the value set in the dril l path, set Inherit across-level
subtotal from parent to Default. For information about creating dril l
paths, see the Advanced Reporting Help.

5. Click OK
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ANSWERING PROM PTS
AND REFRESHING DATA
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Your analysis of data can only be as accurate as the results displayed in a
report. In many instances, you will want to have the most recent information
from your data source displayed on your reports. In this case, if you execute
a report multiple times, you probably want to be sure the query is submitted
through your data source each time so you know you are seeing results
based on the latest data available.

At other times, you simply need to see the same report you looked at before
— you do not care whether the data is up-to-the-minute. In this case,
MicroStrategy provides caching so you can retrieve report results as quickly
as possible without submitting the request through your data source again.

This section discusses report caches, as well as various methods of
refreshing a report's data.

Refreshing a report

As an analyst, you may find yourself regularly executing certain reports that
have provided useful information to you in the past. When you re-execute a
report, how do you know that the data that is returned reflects the most
recent data available in your data source? To answer this question, you
must consider a few factors:

l The frequency with which your data source is updated.

l Whether the report you are running is being executed through the data
source again, or whether it is pulling its data from a stored cache that was
created in MicroStrategy when the report was run the first time.

Your data source may be updated on a daily basis or only biweekly. It is a
good idea to familiarize yourself with the frequency and the days or times
when your data source receives updates. This information helps you
determine when it is most desirable to re-execute your most commonly run
reports, if it is important for you to see report results that reflect the latest
data.
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To take advantage of recently updated data in your data storage, you must
refresh the data displayed on the report. To effectively refresh data on a
report, you should take a moment to understand your data sources.

Understanding your data sources
With MicroStrategy, you can report on and analyze your organization's data
with the goal of answering your business questions. MicroStrategy makes
sense of the large amounts of data stored in your data source and returns
report results which reflect that data. A data source can be a data
warehouse, a simple text fi le, a Microsoft Excel fi le, or an external data
source such as SAP-BW, Microsoft Analysis Services, or Hyperion Essbase.

No matter which type of data source your organization uses, data sources
are commonly separated into specific business divisions. For example, you
might have a data source that only holds information related to your supply
chain data, storing all data related to monitoring the efficiency of your
business workflow. Your organization might also have a separate data
source to store all human resources data such as employee headcount,
employee turnover, and so on.

It is important to know which data source(s) you are regularly accessing
when you execute reports. By knowing which data sources are providing you
with your report data, you can learn how frequently they are updated with
new data. This information in turn can help you decide how often you need to
re-execute certain reports, making sure that the report query is submitted
through your data source rather than through a stored report cache in
MicroStrategy.

Refreshing the data displayed on a report
There are several ways that data shown on a report can be refreshed so that
the report reflects the latest values in the data source.

l Prompted report: A report analyst can automatically refresh the data on a
prompted report by answering the prompts differently than they have been
answered during any previous execution of the report. Answering
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prompted reports is discussed in this chapter, in Answering report
prompts, page 163.

l Report cache: A cache is the stored results of a report query that has
already been executed. When the report is executed again, the system can
quickly access the cache to display report data, rather than putting a load
on the system to re-run the request to the data source. Caches are
discussed in more detail below, including information on how to determine
whether a report's results came from a cache or not. The following
methods can be implemented to ensure refreshed data is accessible when
a report is re-executed:

l Delete a report's cache: A system administrator can delete a report's
cache to ensure the data on that report is refreshed the next time it is
executed. If the stored cache is deleted, the system is forced to submit
the request through the data source again, thus gathering the most
recent data.

l Disable caching for a report: A system administrator can disable caching
for a specific report, so that a cache of results is never created in the
system when that report is executed. In this way, every time the report is
re-executed, the query goes through your data source and thus returns
the most recent data.

Report caches
A report cache is a special data store within MicroStrategy software that
holds information that was recently requested from the data source to be
displayed on a report. A cache is created when a report is executed for the
first time and the request is submitted to the database to gather the latest
data. The report's results are then cached, or stored, in MicroStrategy.

Generally, frequently requested reports are cached because future requests
for the same reports return data faster if the report has been cached. The
execution time is quicker because cached reports do not need to run against
the data source. In a cache, results from your data source are stored and
can be used by new job requests that require the same data.
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Caching is a useful strategy your administrator can use to reduce demands
on your database and improve the speed of MicroStrategy's reporting
performance. However, cached data is not always the most up-to-date,
because it has not been run through your data source since the cache was
created.

You can get new data for a report that has been cached, by deleting the
report's cache before you execute the report. (There are other ways to
refresh data on a report, which are discussed in this chapter.) Deleting the
report's cache forces the report to be executed through your data source
again, thus returning the most recent data from your data source. You must
have administrative privileges to delete a report cache.

You can see whether the results on a report have come from a MicroStrategy
cache in two ways:

l Look at the Report Details for the report. To do this, open a report and,
from the View menu, select Report Details. An example image of the
Report Details pane and its related report is shown below:
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In the Report Details pane above, the last line shows whether the
cache was used to populate the report with data. For this report, the
answer is Cache Used: No.

l Look at a report in SQL view. To do this, from the View menu select SQL
View. As shown in the image below, for this report the 5th line says Cache
Used: Yes.
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Cached data and OLAP Services

MicroStrategy OLAP Services lets MicroStrategy Developer, Web, and
Office users make use of features that slice and dice data in reports to
create new reports, without re-executing SQL against the data source.
These reports are called view reports. This improves performance by
resulting in quicker data display within a report as users analyze and
manipulate the data. OLAP Services view reports are populated from the
original report's cache rather than being run against the data source.

The Report Objects pane is an OLAP Services feature that lets users create
mini-reports based on an original report, by dragging objects on and off the
report. When report objects are dragged to or from the Report Objects pane,
the report results are recalculated based on the cached data rather than
being submitted through the data source again.

To determine whether you have OLAP Services, and for details on other
OLAP Services features, see OLAP Services, page 16.
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Answering report prompts

Any report can contain prompts. A prompt is a question presented to the
user who runs the report. Depending on the answers the user provides, the
report brings back and displays different data from the data source.

Answering a prompted report differently each time it is executed is one way
to ensure that a report is executed against your data source and displays the
most recent data. This is because different prompt answers usually require
different data than what is stored in the report's cache.

There are several types of prompts. The following image shows one example
of a prompt that appears when a prompted report is executed. You choose
one or more answers from the center pane, in this case months of a given
year for which you want to see data. You move your selection(s) to the right,
then you finish running the report to see your chosen data displayed.
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Saving and re-using prompt answers: Personal
answers

When you are answering prompts in a report, you can save a prompt answer
independently of the report. Once saved, a prompt answer is called a
personal answer. The personal answer can be used when you re-execute the
report, and also for any other report that uses the same prompt.

The steps below assume that you have already selected a prompt answer,
but have not yet clicked Finish or Run Report.

To save a personal answer

Use this procedure to save the prompt answer as a personal answer.

1. Determine whether the prompt lets you save prompt answers as
personal answers. You can tell whether a prompt will let you save a
personal answer if the Remember this answer check box (for a single
personal answer) or the Save this answer check box (for multiple
personal answers) is displayed.

2. If the Remember this answer check box is displayed, only one prompt
answer (which can contain multiple items or qualifications) can be
saved.

To save the personal answer, select the Remember this answer check
box. The items that you selected are saved as the personal answer for
this prompt. They are displayed, to be used again if you choose, when
you re-execute this report and also for any other report that uses this
prompt.

3. If the Save this answer check box is displayed, you can save and
name multiple personal answers.
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a. To save the personal answer, select the Save this answer check
box.

b. Type a name in the Name f ield. Create a descriptive name that will
remind you of the details when you see it at a later date.

c. You can set this personal answer as the default, so that it displays
when you are presented with this prompt again, either on this
report or another.

You do not have to save the report to save a personal answer; the
personal answer is saved automatically when one of the check boxes
above is selected.

Saving reports with prompts

When you save a prompted report after having executed it, you are
presented with special save options that give you several ways to save your
prompted report.

You can save your answers with the report. When you run the report in the
future, you are not prompted again. (This is called saving the prompted
report as static.) The prompt answers that you selected when you ran the
report are saved to the report definition, and that definition is used every
time the report is run in the future.

You can also save the report so that it prompts you or other users again,
when the report is re-executed. You continue to be prompted every time you
run the report in the future. (This is called saving the prompted report as
prompted.) If you want, you can also have your current prompt answers
become the new default prompt answers when the report is run again. This
can speed up report execution, because you can save your own preferred
answers as the defaults, and then each time you re-run the report, when you
are prompted you can simply click Finish to accept all the default answers.
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To save a prompted report in Developer

1. Open a prompted report.

2. Answer the prompts and execute the report. For steps to answer a
prompt, see Answering report prompts, page 163.

3. Click Save.

4. Select whether you want to save the report as static or prompted:

l Static: The report is saved with the currently displayed report and
filter information. When you execute the report in the future, you are
not prompted again.

l Prompted: The report is saved with active prompts. The next time
that you run the report, the report prompts you for answers again.

5. If you select prompted, you can choose whether or not to use the
current prompt answers as the default prompt answers when you run
the report again, as described below:

l To save the current prompt answers as the default prompt answers,
select the Set the current prompt answers to be the default
prompt answers check box. When you run the report again, you will
be prompted, and you can choose to use the default answers or
change them.

l To use the default prompt answers defined in the prompt, clear the
Set the current prompt answers to be the default prompt
answers check box. When you run the report again, you will be
prompted, and you can choose to use the displayed default answers
or change them. If default prompt answers have not been defined in
the prompt, no default answers are displayed.

6. If you select the Remember options next time check box, your
selections above (in this Save Options dialog box) become the default
method for saving all prompted reports when you save prompted
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reports in the future.

7. Click OK.

To save a prompted report in MicroStrategy Web

1. Open a prompted report.

2. Answer the prompts and execute the report.

3. Click Save.

4. You can choose to save the report as a prompted or a static report:

l To save it as a prompted report, select the Keep report prompted
check box. The report is saved with active prompts. When you
execute the report in the future, you are prompted for answers again.

l To save it as a static report, clear the Keep report prompted check
box. The report is saved with the currently displayed report and filter
information. When you execute the report in the future, you are not
prompted again.

5. If you save it as a prompted report, you can choose whether or not to
use the current prompt answers as the default prompt answers when
you run the report again, as described below:

l To save the current prompt answers as the default prompt answers,
click Advanced Options. Select the Set the current prompt
answers to be the default prompt answers check box. When you
run the report again, the prompt answers that you selected are
displayed as the default prompt answers. You can choose to use the
default answers or change them.

l To use the default prompt answers defined in the prompt, click
Advanced Options. Clear the Set the current prompt answers to
be the default prompt answers check box. The prompt answers that
you selected are not saved with the report. When you run the report
again, the default prompt answers defined in the prompt are
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displayed. You can choose to use the default answers or change
them. If default prompt answers have not been defined in the prompt,
no default answers are displayed.

6. Click OK.
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BUILDING A QUICK
QUERY FOR ANALYSIS
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This chapter shows analysts and report designers how to create a simple
business report. Before you create a report, you must have a business query
in mind for that report to answer. You must also have access to various
report objects that have already been created, so you can place them on the
report and provide that report with the information it needs to gather the
right data from your data source. You can use report objects that have
already been created by your company's project designers and report
designers.

Prerequisites

Make sure you review the following prerequisites before you create a report
in MicroStrategy. They can save you time and make your report results more
effective, thus making data analysis much easier.

l Define your business query: Before you can determine what objects to
place on a new report, you need to know what data you want to see
displayed on a report. MicroStrategy reports answer business questions
that can be answered with the help of the data stored in your data source.
To define your business question, make sure you consider the following
questions:

l What is the main topic area the report needs to address? In other words,
at a general level, what do you need to know?

l What level of detail do you need? For example, do you want complete
details, or do you only want to see a few key measurements of particular
data? Key measurements can be useful for a business meeting or high-
level presentation.

l Look for existing reports: Before you create a report or document, search
through MicroStrategy to see whether a similar report already exists that
can serve the same purpose as the report you intend to create. This can
not only save you time, it can help you avoid unnecessary duplication in
your MicroStrategy project.
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l Look for appropriate report objects: Do objects already exist in the project
which match what you want to see on a report? If not, a report designer
can create them.

l The objects which you will use to create a report must already be created
in a MicroStrategy project. Report objects are generally created by the
project's designer when the project is first created, and by report
designers.

l Understand how your MicroStrategy project reflects your data source:
Since you use objects to create reports, it can be useful for you to
understand how the project's objects reflect the actual data in your
organization's data source. In this way, you can choose objects to use on
reports with full knowledge of the data source tables that data is coming
from when the report is executed.

It is not necessary to have in-depth knowledge of your MicroStrategy
project's design if you are creating quick reports for analysis, but if you
desire more details on project design and data modeling, see the Project
Design Help.

Creating a report by combining a template and a
filter: Report Wizard

A report is a combination of a template and a filter:

l A report template is the structure that underlies any report. It specifies the
set of information that the report should retrieve from your data source,
and the way that you want the data to be displayed. For example, a report
template can contain the Region and Call Center attributes, and the
Revenue and Profit metrics. The Revenue metric is formatted to display as
currency, with no decimal. The attributes display in the rows and the
metrics in the columns.

l A filter screens data in your data source to determine whether the data
should be included in or excluded from the calculations of the report
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results. For example, you might filter the Year attribute so that data is only
returned for the current year, or for the first three months of last year.

The Report Wizard allows you to quickly and easily create a report by
selecting an existing template and filter.

To build a report using the Report Wizard

This procedure assumes that a project designer has created a project in
MicroStrategy that reflects your organization's stored data, and the project
contains templates and filters.

To start the Report Wizard

1. In MicroStrategy Web, log in to a project. To log in to a specific project,
see Starting MicroStrategy, page 2.

2. Click the MicroStrategy icon and select New Report.

3. Click Report Wizard.

To select the template

A report template is the structure that underlies any report, containing what
is to be displayed on the report and the way to display it.

In the list of available templates on the left, navigate to and select the
template to use. Click the right arrow to move the selected template to the
list of selected templates on the right.

You can search for a template, by typing the word to search for in the
Search for f ield and clicking the Search icon.

To select the filter

A filter specifies the conditions that the data must meet to be included in the
report results.
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In the list of available filters on the left, navigate to and select the filter to
use. Click the right arrow to move the selected filter to the list of selected
filter on the right.

You can search for a filter, by typing the word to search for in the Search
for f ield and clicking the Search icon.

To finish your new report

1. In the Report Message Name f ield, type a name for the new report.

2. Depending on your user privileges, do one of the following:

l Analysts: If you have Web Analyst privileges, you can run the report or
save it.

l To run the report, click Run Report. If the filter contains a prompt, the
prompt is displayed for you to answer. (For steps to answer a prompt,
see Answering report prompts, page 163.) Your report is executed
against your data source and your results are displayed.

l Click Save. If the filter contains a prompt, the prompt is displayed for
you to answer. (For steps to answer a prompt, see Answering report
prompts, page 163.)

l Report Designers: If you have Web Professional privileges (or higher), you
can edit the report or save it.

l To edit the report, click Edit in Design Mode. The report opens in
Design Mode within the Report Editor, where you can continue to build
the report with additional objects and user functionalities. For
information on using the Report Editor, adding or creating additional
objects, and adding user functionalities, see Chapter 7, Building Query
Objects and Queries, for Designers.

l Click Save.
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Quick report creation: Building a new report

This chapter provides steps to create a new report using the MicroStrategy
Report Builder tool. The Report Builder is meant for users who are already
familiar with MicroStrategy objects that are used to create a report, and who
need to create a report quickly. However, the Report Builder tool limits you
to only adding certain objects to the report while you are using the tool.
Once you finish creating a report in Report Builder, you can continue to
modify the report in the Report Editor and add additional objects.

If you have Web Professional privileges, before you create a report, you can
create links, or shortcuts, to objects that you will want to use regularly. You
can place the shortcuts in a location within the project that is conveniently
accessible to you. For steps to create shortcuts to objects, see Quick object
access: Creating shortcuts to objects, page 194.

Creating a report for analysis
This section describes how to create a report using the quick report creation
tool called Report Builder. MicroStrategy's Report Builder steps you easily
through the process of quick report creation, and lets you access a wide
variety of report objects in your project to define your report.

Report Builder asks for four specific pieces of information from you:

l The attributes to include on the report

l The metrics to include on the report

l Information to create a filter for one or more attributes; the filter is optional

l Information to create a filter for one or more metrics; the filter is optional

Each of these pieces of information is described more fully, with examples,
in the procedure below.
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Creating a quick report using Report Builder

To create a report that accurately answers a specific business query, be
sure you have access to objects that have already been created, as
described above in Prerequisites.

To build a quick report using Report Builder

This procedure assumes that a project designer has created a project in
MicroStrategy that reflects your organization's stored data, and the project
contains attributes and metrics.

To st ar t Repor t Bu i lder

1. In MicroStrategy Web, log in to the project that contains the objects you
want to use to create a report. To log in to a specific project, see
Starting MicroStrategy, page 2.

2. Click the MicroStrategy icon and select New Report.

3. Click Report Builder.

The Report Builder steps on the left pane allow you to easily navigate
between different sections of the Report Builder.

To include at t r ibu t es on t he r epor t

Attributes are the business concepts reflected in your stored business
data in your data source. Attributes provide a context in which to report
and analyze business data. While knowing your company's total sales is
useful, knowing where and when the sales took place is more helpful.

For example, you have a report containing the Month, Year, and Region
attributes, as well as a Revenue metric. When executed, the report
displays your company's revenue for each region, during each month and
year for which data is available. Because of the attributes on the report, a
substantial amount of information is available, including which regions
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produced the least revenue and which years saw the highest growth in
revenue.

1. Under Choose the attributes of the report, in the Search for f ield,
type the name of the attribute. Alternatively, from the Available pane,
browse to the attribute that you want to include on your report.

2. Select one or more attributes and click the Add arrow to move them to
the Selected pane.

l You must select at least one attribute.

l Generally, one to three attributes are sufficient to add to a report,
depending on the business query you are trying to answer with the report.

l If you add more than one attribute to the report, make sure you select
attributes that make sense when placed together on a report.

When you are finished adding attributes, add the metrics for your report
under Choose the metrics of the report.

To include m et r ics on t he r epor t

Metrics are MicroStrategy objects that represent business measures.
Metrics are the calculations performed on data stored in your database,
the results of which are displayed on a report. Metrics are similar to
formulas in spreadsheet software.

Questions such as "What were the sales for the eastern region during the
fourth quarter?" or "Are inventory levels being consistently replenished at
the beginning of each week?" can easily be answered by metrics. A
metric is made up of facts stored in your data source and the
mathematical operations to be performed on those facts, so that
meaningful business analysis can be performed on the results.

1. Under Choose the metrics of the report, in the Search for f ield, type
the name of the metric. Alternatively, from the Available pane, browse
to the metrics you want to include on your report.
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2. Select one or more metrics and click the Add arrow to move them to the
Selected pane.

Generally, one or two metrics is sufficient to add to the report, depending on
the business query you are trying to answer with the report.

When you are finished adding metrics, you can add filtering conditions to
your attributes under Qualify on any attribute.

To include an at t r ibu t e f i l t er on t he r epor t

A filter screens data in your data source to determine whether the data
should be included in or excluded from the calculations of the report
results. For example, you might filter the Year attribute so that data is
only returned for the current year, or for the first three months of last
year.

An attribute filter restricts data specifically for the attributes on, or
related to, your report. You only need to include an attribute filter if it
makes sense with your business query.

If you do not want to include an attribute filter, proceed to the next subtask
in this procedure, To include a metric filter on the report, page 179.
However, most reports use a filter to limit the quantity of data returned from
the data source, and to help focus the report on a specific business
question.

1. Under Qualify on any attribute, navigate through the hierarchies
displayed in the Available pane. Alternatively, type the name of the
hierarchy in the Search for f ield.

Hierarchies group all the attributes in your project into logical subsets.
For example, the Day, Week, Month, and Year attributes might all be
grouped into a Time hierarchy.
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2. Double-click the hierarchy that holds the attribute you want to filter data
for. The attributes within that hierarchy are displayed in the Available
pane.

3. Select the attribute you want to use a filter on, and then click the Add
arrow to move it to the Selected pane.

It is generally simplest to select an attribute that is part of your report,
unless you need an attribute filter that relies on a different attribute.

4. For each attribute moved to the Selected pane, select one of the
following options, depending on how you want to filter the attribute
data:

l Return results that only show data related to specific elements of the
attribute. For example, the attribute Customer might have the
elements John Smith, Jane Doe, William Hill, and so on. You can
filter data to display a list of only those customers (those elements)
that you specify.

l To create this kind of filter, from the filter's expression, first choose
Select and then choose the In List operator. Click Empty to display
the attribute's elements. Then, select the elements on the left and
click the arrow to move them to the right. Click OK.

l Return results that show all the attribute's data EXCEPT for the
specific elements you define. Using the example in the bullet above,
you might specify certain customers whose data you do not want to
see.

l To create this kind of filter, from the filter's expression, first choose
Select and then choose the Not In List operator. Click Empty to
display the attribute's elements. Then, select the elements on the left
and click the arrow to move them to the right. Click OK.

When you are finished defining your attribute filter, you can add filtering
conditions for your metrics in the report under Qualify on any metric.
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To include a m et r ic f i l t er on t he r epor t

A metric filter screens data based on a metric's value or rank. For example,
you might create a filter that displays sales data for only those products with
an inventory count below a specified number.

You only need to include a metric filter if it makes sense with your business
query.

If you do not want to include a metric filter, proceed to the next subtask in
this procedure, To finish your report, page 180.

1. Under Qualify on any metric, in the Available pane, select the metric
on which you want to use a filter. Alternatively, type the name of the
metric in the Search for f ield.

2. Click the Add arrow to move the metric to the Selected pane.

It is generally simplest to select a metric that is part of your report,
unless you need a metric filter that relies on a different metric.

3. For each metric moved to the Selected pane, select one of the following
options, depending on how you want to filter the metric data:

l Return results that show all data greater than a specific amount.

l To create this kind of filter, from the filter's expression, select the
Greater than operator. Click Value and in the Enter Value f ield,
enter the number that all calculated values should be greater than.

l Return results that show data that is outside a particular range of
values.

l To create this kind of filter, from the filter's expression, select the Not
Between operator. Click the first Value and in the Enter Value f ield,
enter the number that marks the lower end of the range. Click the
second Value and in the Enter Value f ield, enter the number that
marks the higher end of the range.
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l Click the Operator drop-down list to see the many other common
operators you can define your filter with. Experiment with other
options to create the exact filter you want. For guidance:

l Metric qualifications are discussed in detail in Filtering data based
on attribute relationships or metrics: Set qualifications, page 253.

To f in ish you r r epor t

1. Review your selections for the report and make changes, if required.

2. Type a name for the report in the Report Message Name f ield.

3. Prior to saving the report, you can choose to view the report results and
verify your report selections.

l Web Analyst: If you have Web Analyst privileges, click Run Report.
Your report is executed against your data source and your results are
displayed.

l Web Professional: If you have Web Professional privileges (or
higher), click Edit in Design Mode. The report opens in Design Mode
in the Report Editor, where you can continue to build the report with
additional objects and user functionalities.

l To execute the report without making any further changes, from the
toolbar select Run Report.

l For information on using the Report Editor, adding or creating
additional objects, and adding user functionalities, see
MicroStrategy Web Report Editor interface, page 437.

4. Click Save.
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BUILDING QUERY
OBJECTS AND QUERIES,
FOR DESIGNERS
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This chapter introduces the basics of designing and creating business
reports. Before you create a report, you must have a business query in mind
for that report to answer. You must also have access to various report
objects that have already been created, so you can place them on the report
and provide that report with its definition. If you have the appropriate
privileges, you can create report objects yourself, or you can use report
objects that have been created by other report designers.

This chapter also shows you how to add user-friendly additions to a report,
such as a dril l ing map or other capabilit ies.

Most of the tasks in this chapter are performed in MicroStrategy Web. Some
are performed in MicroStrategy Developer, and are clearly labeled.

This chapter assumes you are familiar with all the other chapters in this
guide. The other chapters contain introductory information on the user
experience with basic functionality in the MicroStrategy environment.

Before you begin

Before you begin building query objects and queries, you should review
these items:

l Report designer role

l Developing a business query and report design: Best practices

Report designer role
This chapter primarily discusses software functionality that is only available
to users who have privileges equivalent to Developer or Web Professional
roles in MicroStrategy (or a broader set of privileges, such as those provided
to the Administrator role). If you are not sure which privileges are assigned
to your user name in the MicroStrategy environment, contact your system
administrator.

Report designers design a reporting context or environment in which report
analysts can successfully analyze business data. This environment allows
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report analysts to work within defined limits, ensuring that business data can
be easily and quickly analyzed, as well as making sure that only reasonable
queries are submitted to the database. Reasonable means that irrelevant
data sets cannot be created, nor can huge amounts of data be retrieved from
your data source, which can hamper system performance.

These roles allow a defined group of report designers to be trained on more
advanced report functionality, while report analysts can manipulate reports
without needing to understand the details of creating reports. Report
analysts are not required to have a thorough understanding of the project.
These users can analyze data, generate new reports from existing reports
through dril l ing, and create quick and easy reports using Report Builder,
which can all be performed in a controlled, user-friendly environment.

For example, a report designer might design a report for the sales
department that displays data on the organization's annual regional
revenue, including product brands. The report designer places the attributes
Customer Region, Category, and Brand on the report, and the metrics Profit,
Revenue, and Revenue Rank by Region. (To view this actual report, see the
Brand Performance by Region report in the MicroStrategy Tutorial project.)
A report analyst can then execute this report and dril l to see details about
revenue and profits for only the states in the Northeast region. Another
report analyst can execute the same report, dril l on a different object on the
report, such as the brand Son, and view revenue and profits for a single item
in the product line that concerns him.

There are numerous ways to design reports, each one giving users a slightly
different data analysis experience. For example, you can design reports that
prompt users for an answer about the type of data they want to view, before
the report is run. Each user then sees report results specific to how he
answered the prompts. A prompted report might allow users to select from
certain attribute elements to create their own personalized version of the
report. (Elements of an attribute are the values of an attribute. For example,
2011 and 2012 are elements of the Year attribute, while New York and
London are elements of the City attribute.)
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A report designer can also add to a report a selection of extra functionality
for users. For example, dril l maps define specific paths for users to navigate
through the data. Dril l ing is a report manipulation method through which the
user requests additional information that is directly related to the information
available in the current report. After running a report, you can allow users to
dril l to various levels on the report. For example, with a dril l map in the
Brand Performance by Region report discussed above, a report analyst
might dril l from the regional level down to the State level, then down to the
City level, then dril l further down to view data for individual customers. Each
dril l ing displays a new report.

Each of these report design methods is described in this chapter:

l For information on creating prompts and adding them to a report, see
Asking for user input: Prompts, page 280.

l For information on dril l ing, see Drill ing into related data, page 120 in
Chapter 3, Analyzing Data.

l For information on dril l maps, see Enabling dril l ing and customizing dril l
maps, page 393.

l For information on creating metrics, see Calculating data on a report:
Metrics, page 197.

l For information on creating a report, see Creating a grid report, page 345.

Developing a business query and report design: Best practices
Before you create a report, you need to gather information from your user
community, your project designer, your database administrator, and your
MicroStrategy software. Some best practices are described here.

Gather information about your user audience

Ask yourself who the audience is for the report you plan to create. Questions
you should have answers to include:
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l What is the main topic area the report needs to address? In other words, at
a general level, what do users need to know?

l What level of detail do users need? For example, sometimes executive
level users only want to see a few key metrics of certain data. Other
analysts may need to see very detailed financial numbers or inventory
counts.

l What types of reports do users expect?

l Higher level executives sometimes have expectations on how data is
displayed in a report, so it can be helpful to ask what types of reports
they are used to receiving, and whether it is important to try to adhere to
that data display style.

l For all user communities, determine whether they are will ing to learn a
new report format or whether it will be easier for them to receive reports
in a style they have become used to. For example, some users adopt
MicroStrategy so they can read spreadsheets of data more easily. A
standard MicroStrategy grid report can be a good style to start with when
introducing spreadsheet users to MicroStrategy reports.

l Who makes up your universe of users?

l If your universe of users is extremely diverse, consider making reports
as flexible as possible for each user who executes them, by adding
prompts to the report. A prompt asks users questions about the results
they want to see on a report, and then submits the appropriate report
query to the data source. For details on prompts, see Asking for user
input: Prompts, page 280.

l Your universe of users may include different security requirements. For
example, you may need a single report for a group of users, but that
group includes both external and internal users, and you want to restrict
some data from external view. You must confirm that appropriate
security is in place for a report's underlying objects, and that security
filters are in place to control row-level access to data. Object-level
security is performed using ACLs, or access control lists.
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Security filters and ACLs are generally implemented by your system
administrator, but one or both may be under the control of your project
designer. See the System Administration Help for details on security
filters, ACLs, and other security features.

Gather information about your data source

If you need an introduction to or refresher on data sources, review
Understanding your data sources, page 158.

Make sure the data your organization stores can support the information
your users want to analyze in a reporting environment. Questions you should
ask include:

l Does your organization gather the data that users want to see reports on?

l Is your data organized in such a way that it can be used? Is the data
reliable, and is it clean? One way to check on the reliability of your data is
to create some simple grid reports designed to validate whether your data
reflects your understanding of reality.

For example, if you have a good sense of how many customers own two or
three of your organization's products, create a report that shows basic data
on the count of customers who purchased those specific products over the
past few years. If the numbers you see in the report do not come close to
what you expected to see, it is worthwhile to spend some time with your
database administrator to address the reliability of the data stored in your
data source.

Gather information about your MicroStrategy project

Many of the objects within a project are generally created by the project's
designer when the project is first created. Since you use these objects to
design reports, it can be useful to understand your project's design, and
specifically how the project's objects reflect the actual data in your
organization's data source. In this way, you can choose objects to use on
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reports with full knowledge of the data source tables that data is coming
from when the report is executed.

For details on general project design and data modeling, see the Project
Design Help.

Questions you should ask about your project include:

• Do objects exist in the MicroStrategy metadata which match what users
want to see on reports? If not, you or another report designer can create
them.

l MicroStrategy provides flexibil ity in combining information from your data
source into specific objects which reflect the concepts that make sense to
your users. Consolidations and custom groups are just two examples of
ways you can present data to your users in a way that does not directly
reflect your data source's storage structure. For an introduction to
consolidations and custom groups, see Adding consolidations and custom
groups , page 396.

l What VLDB (Very Large Database) properties have been set? These
settings affect how the SQL is written when a report sends a SQL query to
your data source. VLDB properties are usually determined by an
administrator, but some may also be defined by a project's designer. All
VLDB properties are described in detail in the System Administration Help.

l What project configuration settings have been set that will affect reports or
documents? Ask your project designer about any configuration settings
made for the project as a whole, because most reports and report objects
revert to the project's settings when no object-specific or report-specific
settings override them.

Locate or create time-savers

Consider the following approaches to report creation:

l Before you create a report, search through MicroStrategy to see whether a
similar report already exists that can serve the same purpose as the report
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you intend to create. This can save you time and help you avoid
unnecessary duplication in your MicroStrategy metadata.

l Before you create the finished report, use Microsoft Excel, Paint,
PowerPoint, or another tool to create a mock-up of the report you intend to
design. Send the mock-up to your user community to gather their feedback
on its usefulness. This can save you valuable time creating a complex,
finished report that may have to be redone.

l If you format the orientation of text in cells (for example, its vertical or
horizontal alignment within a cell), you can use an autostyle to apply that
same orientation to all reports you design. To do this, create an autostyle
with the desired vertical and horizontal alignment (see Preset formatting:
Autostyles, page 68). While creating the autostyle, from the Format menu
select Row or Column, select Values, and choose your text alignment on
the Alignment tab. Then right-click the project, select My Preferences,
select the Grid tab, and select General. From the Default style drop-
down list, select your new autostyle to be applied to all reports you create.

Quick report creation: Building a new report

If you are already familiar with MicroStrategy objects that are used to create
a report, and you need to create a report quickly, MicroStrategy's Report
Builder steps you through the process of quick report creation.

Quick reports can be useful to test out a basic report design concept for a
more complex report, as described in Locate or create time-savers, page
187. Before you spend time creating, formatting, and fine-tuning a complex
report, you can create a basic report quickly and ask users to provide
feedback on its general usefulness in answering their business queries.
Once you feel confident that your basic report design includes the
appropriate objects, you can move on to create any additional objects
necessary and to create the more complex, final report.

While Report Builder itself provides limited access to certain objects and
functionality during report creation, when you are finished with Report
Builder, it opens your new report in Design Mode if you have design
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privileges. In Design Mode you can add, edit, or remove objects freely, and
you can provide additional functionality for users who will later execute the
report to perform data analysis.

To create a report quickly using Report Builder, see Creating a report for
analysis, page 174.

To create objects, see Creating and saving objects, page 193. To create a
report from scratch, see Creating a grid report, page 345.

MicroStrategy objects

All reports have specific business objects placed on them. Those objects
determine what data is gathered from your data source, how that data is
calculated, and how the results are displayed when each report is run.
Therefore, to create a report, you must first determine whether the objects
you want to place on it already exist. If they do not, you must learn how to
create the objects you want.

Objects used on reports include such things as:

l Attributes: An attribute is a business concept, such as Product,
Employee, Month, and so on. Attributes provide a context for metrics
(described below). Attributes based on the data in your data source should
have already been created by your company's project designer. An
attribute on a report serves as a label for a group of metrics. To use
attributes on a report, see Providing business context to a report:
Attributes, page 195.

l Metrics: A metric is a business measure or key performance indicator,
such as Revenue, Profit, Employee Headcount, or Probability of Purchase.
From a practical perspective, metrics are the calculations performed on
data stored in your database, the results of which are displayed on a
report. A metric on a report shows a list of values used for analytical
calculations. To create metrics and use them on reports, see Calculating
data on a report: Metrics, page 197.
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l Filters: A filter sifts the data in your data source to bring back the
information that answers exactly what you require. To create filters and
use them on reports, see Filtering data on a report: Filters, page 232.

l Prompts: A prompt is a question the system presents to a user during
report execution. How the user answers the question determines what data
is displayed on the report. To create prompts and use them on reports, see
Asking for user input: Prompts, page 280.

The objects you can create in MicroStrategy fall into one of three groups:
schema objects, application objects, and reports and documents.

l Schema objects: Schema objects are generally created by a project
designer and include such things as facts, attributes, hierarchies, and
transformations. Schema objects are building block objects; they are used
to create application objects. For information on how to create these types
of objects, see the Project Design Help.

l Application objects: These objects are used to create reports.
Application objects are generally created by a report designer and are
built from schema objects. This chapter describes how to create these
types of objects. Samples of each type of application object are located in
the Public Objects folder in the Tutorial project.

l Report and document objects: Reports (and documents, if you own
MicroStrategy Report Services) are built from application objects. Reports
and documents are the objects that display the results calculated from
your data for analysis purposes. Reports and documents are generally
created by a report designer. This chapter describes how to create these
types of objects.

The objects in each group, and their related icons, are shown in the
following diagram. Take a moment to familiarize yourself with the icons for
application objects and reports, so you can quickly identify objects you want
to use in the MicroStrategy interface:
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Application objects must be created and saved within a project before they
can be used on reports.

MicroStrategy projects
Conceptually, a project in MicroStrategy is the environment in which all
related reporting is done.

The image below shows the default projects that appear if all default
installation options were accepted during MicroStrategy installation. The
projects in the image below include MicroStrategy Tutorial and My First
Project, as well as other sample projects.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 192

A typical project contains reports, fi lters to qualify the report data, metrics
that calculate the data, attributes that provide context for the metric data,
and mathematical functions. Projects generally also contain other schema
objects and application objects. This chapter introduces you to basic
attributes, metrics, fi lters, and prompts. For detailed information on and
examples of other report objects, see the Advanced Reporting Help. For
interface-specific information on report objects, click Help.

The image below shows some dashboards in the MicroStrategy Tutorial
project, within the Bill ing Managers folder on the left. Objects within a
selected folder on the left (in this case, the folder called Bill ing Managers)
appear on the right side of the screen.

Basic Repor t ing Guide

https://www2.microstrategy.com/producthelp/2021/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm


Copyright © 2022 All Rights Reserved 193

Generally, a report designer places various MicroStrategy objects such as
filters, metrics, and attributes on reports, thus creating reports for business
users to run and analyze.

If you do not have a working project yet, you can use the Tutorial project
with most of the procedures in this chapter to learn how to create the various
report objects in MicroStrategy. For information about what the Tutorial
project is and how to access it, see About sample data and the
MicroStrategy Tutorial project, page 4.

Creating and saving objects
Before you create a report to display your business data, you must have
objects to place on the report. These objects define what business data will
be displayed in any report on which the objects are placed.

In MicroStrategy, you use editors to create and save the report-related
objects you intend to use on reports. Steps to create several types of objects
are in this chapter.
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When a saved object is placed on a report, the definition you gave to that
object becomes part of the report's definition, and in turn affects the SQL
that is sent to your data source when the report is run. The SQL determines
the appropriate data to be gathered, calculated, and displayed on this
report. In this way, the objects you create and place on a report determine
the results a user sees when he runs the completed report.

Quick object creation
The quickest way to create an object is to create a shortcut object, which is
simply a shortcut to an existing object. Because a new shortcut object must
be based on an existing object, other objects must already exist in your
project. If your project does not yet contain objects, see the following
sections of this chapter to create the objects you need to place on reports.

Shortcut objects are stand-alone objects in MicroStrategy that represent
links to other objects, such as reports, fi lters, metrics, and so on. Shortcut
objects make navigating among objects easy and quick, because you can
locate specific report objects in the most useful folders within a project.
Creating shortcuts to objects in different locations facilitates access to these
objects without having to duplicate them.

Shortcuts also make project maintenance easier by eliminating the need to
maintain numerous duplicate copies of objects. Using shortcuts, when you
want to change any properties of an object, you only have to modify the
original object and these changes are reflected in all shortcuts linked to this
object. You can also edit the original object by right-clicking one of its
shortcuts and selecting Edit. The original object is displayed in the editor.

For steps to create shortcuts to existing objects, see Quick object access:
Creating shortcuts to objects, page 194.

Quick object access: Creating shortcuts to objects
The quickest way to access an existing object to place on a report is to
create a shortcut to the object, called a shortcut object. A shortcut object is
simply a link, or shortcut, to an existing object in a MicroStrategy project.
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You can place a shortcut object in a location that is most convenient for you.
By creating shortcut objects for the objects you commonly use in a project,
you can make the report creation process quicker and easier.

For example, you use the Units Sold metric frequently when you create new
reports. You want to create a shortcut to the Units Sold metric, which resides
in the project's Metrics folder, and you want the shortcut to be saved in the
My Objects folder. Locate the Units Sold metric by expanding the Metrics
folder, then expanding the Sales Metrics folder. Right-click the Units Sold
metric and choose Create Shortcut. In the Browse to Folder dialog box that
opens, navigate to the My Objects folder and click OK. The Units Sold
shortcut object is created in the My Objects folder.

Prerequisites

l DHTML must be enabled. For steps, click Help in MicroStrategy Web.

l Because a new shortcut object must be based on an existing object, other
objects must already exist in your project. If your project does not yet
contain objects, your report designer or object designer can create the
objects you need to place on reports.

To create a shortcut object from the original object

1. In MicroStrategy Web, right-click the object for which you want to
create a shortcut and select Create Shortcut.

2. Navigate to the folder in which to create the new shortcut and click OK.

3. By default, the name of the shortcut is the same as the name of the
object. To rename the shortcut, right-click the object and select
Rename. Type a new name for the object and click the Apply icon .

Providing business context to a report: Attributes

Attributes are the business concepts reflected in your stored business data
in your data source. Attributes provide a context in which to report on and
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analyze business facts or calculations. While knowing your company's total
sales is useful, knowing where and when the sales took place provides the
kind of analytical depth users require on a daily basis.

For example, you have a report containing the Month, Year, and Region
attributes, as well as a Revenue metric. When executed, the report displays
your company's revenue for each region, during each month and year for
which data is available. Because of the attributes on the report, a substantial
amount of information is available, including which regions produced the
least revenue and which years saw the highest growth in revenue. If you
remove the attributes from the report, you can only find out how much
revenue the company made in total. An attribute on a report serves as a
label for a group of metrics.

As you can see from the examples above, when you place attributes on a
report, you should choose attributes that make sense together when they
are on the same report.

Attributes are created by the project designer when an organization's project
is first created. If you do not already have a company project running, you
can use the sample Tutorial project that comes with MicroStrategy. For
details on accessing the Tutorial project, see About sample data and the
MicroStrategy Tutorial project, page 4.

The elements of a business attribute are the unique values for that attribute.
For example, 2006 and 2007 are elements of the Year attribute, while New
York and London are elements of the City attribute. On a report, attributes
are chosen to build the report, but once the report is executed, the
attribute's elements are displayed in the rows or columns.

To see sample attr ibutes in the Tutorial project

1. Open the MicroStrategy Tutorial project and log in to MicroStrategy
Web.
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2. On the left, click Create and select New Report. Then select Blank
Report.

3. On the left, click Attributes and explore the various attributes within
each folder.

For details on creating attributes, see your MicroStrategy project designer or
the Project Design Help.

Calculating data on a report: Metrics

Metrics are MicroStrategy objects that represent business measures and key
performance indicators. From a practical perspective, metrics are the
calculations performed on data stored in your database, the results of which
are displayed on a report. Metrics are similar to formulas in spreadsheet
software.

It is not an overstatement to say that the focus of almost any report is its
metrics. Most of the decisions you make about the other objects to include
on a report depend on the metrics you use on the report. Questions such as
"What were the sales for the eastern region during the fourth quarter?" or
"Are inventory counts being consistently replenished at the beginning of
each week?" can easily be answered by metrics.

Specifically, metrics define the analytical calculations to be performed
against data that is stored in the data source. A metric is made up of data
source facts and the mathematical operations to be performed on those
facts, so that meaningful business analysis can be performed on the results.
A metric on a report shows a list of values used for analytical calculations.

Metric creation is usually the responsibility of advanced analysts.

Metrics terminology
The following terms are used throughout this guide and the MicroStrategy
Web Help and the Advanced Reporting Help to describe aspects of metrics.
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It is useful to understand their relationship to each other if you want to
develop a logical approach to creating metrics.

Metric formula: A metric's formula is made up of a mathematical function
and the business facts stored in your data source. A metric's formula can
also consist of other metrics.

Metric expression: A metric's expression is made up of all the metric
components displayed when a metric is opened in the Function Editor:
formula (described above), level, condition (if any), and transformation (if
any).

Metric definition: A metric's definition includes the metric's expression,
plus any software settings applied to the metric.

Viewing and working with metrics: The Function Editor
You use the Function Editor mode of the Metric Editor to create and save
most metrics, and to edit most existing metrics. The Function Editor is
shown in the image below:
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To access the Function Editor

1. In MicroStrategy Web, on the left, click Create, then select New Metric.
The Metric Editor opens in Function Editor mode.

2. Select the function to use to calculate data in the metric. You can
narrow the list of functions displayed in the pane by doing one of the
following:

l To search for the function by name, type the function's name in the search
field.

l Choose a function category from the drop-down list, such as Math
Functions or Financial Functions. The pane is updated to include only the
functions that belong to the selected category.

When you select a function, a description of the function is displayed at
the bottom of the dialog box. Click Details to view more information
about the function, such as syntax and examples.

To open an exist ing metr ic in the Function Editor

Click any metric within the MicroStrategy software to open that metric and
view the metric's definition.

Most metrics open in Function Editor mode in the Metric Editor. Compound
metrics and custom metrics open in Formula Editor mode in the Metric
Editor. For details on compound and custom metrics in the Formula Editor,
click the MicroStrategy Web Help.

All of the terms in the definitions above are described in the following pages.

Providing business context: Calculating metric levels
A metric's formula must be calculated within the context of a business
concept. For example, a report with the metric called Revenue on it could
show a list of company revenue — but in what context? Revenue generated
by a particular salesperson, or by your company's top five best-selling
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products? Revenue earned last year, or lost due to lost sales leads last
quarter? Revenue data alone is meaningless without at least one business
attribute to provide context to the metric data. If you add the attribute Year,
revenue for the current year makes sense.

A metric, therefore, must be calculated in relation to some attribute if the
metric is to have meaning on the report. Therefore, every metric definition
must include a reference to the attribute that you want to provide context to
the metric's calculation of data.

For an introduction to attributes, see Providing business context to a report:
Attributes, page 195.

Level of calculation for a metric

As noted above, a metric must be calculated within the context of a business
attribute - but which attribute? Most reports contain more than one attribute.
For example, on a report containing the Revenue metric and the attributes
Month and Year, is revenue calculated and displayed by month? Or is it
calculated and displayed by year?

Another way to ask this question is, at what level is the Revenue metric
calculated? Is it calculated at the higher-level Year attribute or the lower-
level Month attribute? To understand an attribute's level, picture a hierarchy
of related business attributes. An example is shown below:
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The example above shows a hierarchy of all the attributes that relate to the
business concept of Time. (These attributes and this Time hierarchy are part
of the sample Tutorial project.) The attribute Year is higher than Quarter,
Month, or Day, because it appears above those other attributes. The highest
level attribute is usually the attribute that reflects the most-inclusive
business concept. In this hierarchy, Day is the lowest-level attribute and
reflects the least-inclusive business concept.

In another example, suppose that your company is an Internet-based retailer
and has its call centers all over the U.S. Your company therefore stores its
employee data in your data source within the concept of geographical
regions within the U.S. The related business attributes within this idea of
geographical region become part of the Geography hierarchy. An example
using sample data from the Tutorial project is shown below:

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 202

In the Geography hierarchy above, Country is the highest-level attribute and
Employee is the lowest-level attribute.

A metric's level (sometimes called dimensionality) determines the level at
which the metric is calculated. Therefore, every metric must have a level as
part of its definition. By default, a metric is calculated at the report level,
which means it is calculated at the level of the attribute on the report in
which the metric is placed.

When more than one attribute is on a report, as is generally the case, a
metric is calculated by default at the level of the lowest-level attribute that is
on the report. The lowest level is usually the attribute that reflects the least-
inclusive business concept. For example, a report shows your company's
revenue listed by month and year. The report therefore contains the
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Revenue metric and the attributes Year and Month. Is the Revenue metric
going to be summed up and displayed by year? Or is it going to be summed
up and displayed by month? The metric results by default are calculated to
reflect monthly sales data, since Month is a less-inclusive, or lower-level,
concept than Year.

Determining calculation level

In MicroStrategy, the level at which a metric is calculated is displayed in
both the Function Editor and the Formula Editor.

In the Function Editor, the level appears in the Level area, as shown below,
where it is listed as Report Level:

In the Formula Editor, the level appears within curly braces, as shown
below.

l {~} denotes the default metric level. If the default level is changed, the
name of the attribute that represents the new level appears between the
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curly braces.

l {~+} denotes that the metric is calculated at the level of the lowest
attribute on the report, which is the default calculation level for a metric.

Following are examples of metric formulas with the level displayed at the
end of the formula:

Sum(Revenue - Cost){~+}

Sum(Abs (Revenue - Cost)){~+}

The level at which a metric is calculated can be changed. In a report that
shows Revenue, Year, and Month, which means the metric on the report
measures revenue by year and month, you might change the Revenue
metric's level from the default of Month (which is the level of the lowest
attribute on the report,) and redefine the level as Year. The metric then
calculates at the Year level, and the report results display yearly sales data.
This metric appears in the Formula Editor as:

Revenue {Year}
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For examples of more complex metrics with various levels, see the
Advanced Metrics chapter of the Advanced Reporting Help.

Metrics that do not use a level

Certain types of metrics can only have a level applied to their constituent
parts, not to the metric as a whole. These restricted metrics are called
compound metrics. See Metrics made up of metrics: Compound metrics,
page 214 for a description and examples of these types of metrics.

Components of a metric
The pieces, or components, of a metric include such things as the metric's
mathematical formula, the business context in which to calculate the
formula, and so on. When you define the components that make up a metric
and then adjust any specific settings for the metric, you create a definition
for that metric.

A metric definition contains some components that are required, and some
components that are optional. The components you decide to include in the
metric's definition are based on the calculations you want to be performed
on the data in your data source, and thus the results to be displayed when
that metric is placed on a report and the report is executed.

Required metric components

All metrics require the following components as part of the metric's
definition:

l Mathematical formula, which includes a mathematical function

l Business level at which to calculate the formula

Both required metric components are described below.
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M at hem at ical f o r m u la

A metric definition must contain a formula, which determines the data to be
used from your data source and the calculations to be performed on that
data. An example of the formula of a metric is

Sum(Cost)

where Cost is a fact stored in the data source. (Facts are one type of
business data, typically numeric, stored in a data source.) The metric
formula above calculates the sum of all costs recorded in the data source, to
determine a measure of a company's expenditures.

A metric formula can be made up of facts in the data source (as in the
example above), business attributes in the data source, or other metrics that
have already been created. The following examples of metrics show these
different formula options:

l Metric made up of facts: (Sum(Profit) + Sum(Cost))

This metric's formula adds all profits recorded in the data source, adds all
costs recorded in the data source, and then adds the cost total to the profit
total.

l Metric made up of attributes: Count(Employee)

This metric's formula counts the total number of company employees
recorded in the data source. (An attribute is a business concept that is
reflected in your stored business data, such as Year or Customer or
Product. Attributes provide a context in which to evaluate metric data.)

l Metric made up of other metrics: [This month's profit] - [Last

month's profit] / [Last month's profit]

This metric's formula subtracts last month's profit (a metric) from this
month's profit (another metric), then divides the result by last month's
profit to determine the percent difference in profit from last month. Existing
metrics can be part of a newly created metric's formula, and thus they
become part of the new metric's definition.
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A metric that contains other metrics is called a compound metric.
Compound metrics are discussed in Metrics made up of metrics:
Compound metrics, page 214.

If you are familiar with SQL syntax, a metric's formula is included in the
SELECT clause of a SQL statement.

A metric formula that is shared among many metrics is called a base
formula; for details, see Required metric components, page 205.

Funct ion

Most metrics must also have a mathematical function as part of the metric
formula. The function is part of the formula.

In the examples above, the functions are Sum and Count. If a formula did not
have a function, a metric formula might consist solely of the Cost fact or the
Profit fact, and the data results of such a formula would simply be the
extensive list of all the costs or profits ever recorded in the tables in your
data source.

The default function for every formula made up of facts is Sum. The default
function for every formula made up of attributes is Count.

Once your formula is in the Function Editor, you can change the function, of
course. MicroStrategy provides over a hundred functions that can be a part
of all calculations, whether simple or complex. For a description and
examples of every function available, see the Functions Reference . You can
also create your own functions. See the Advanced Reporting Help for
information on creating your own functions.

Optional metric components

Optional components that can be added to a metric include:

l Arithmetic operators, page 208

l Filtering metric data: Conditionality, page 208
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l Time-series analysis: Transformation, page 211

l Base formulas, page 213

Arithmetic operators

A metric's formula can also contain one or more arithmetic operators. You
can add an arithmetic operator to a metric's definition in the Formula Editor
(to access the Formula Editor, from the Function Editor click the Switch to
Formula Editor l ink). Place the cursor in the appropriate location in the
metric's formula and type the operator, such as + or -. When you are finished
changing the formula, click Validate to validate your formula.

Filter ing metr ic data: Condit ionality

When you filter data in your data source, you screen a broad set of data and
extract the specific information you want to see. For example, you have a
report that displays monthly operations data, such as operating income,
payroll, overtime, and so on. This report provides a good overall view of your
monthly numbers. You decide you want to see the same metric calculations
on the same data, but you want to restrict payroll numbers to contractors'
payroll only, and only for your subsidiaries in the northwest region. You can
create a filter consisting of Employee=Contractor and Region=Northwest.
You then apply this filter to the report, and your results appear and are
calculated for only the data that your filter specifies.

A filter is a condition placed on data from your data source. A filter placed on
a report as a whole screens overall report data. You can also apply a filter
directly to an individual metric on a report. A filter applied this way screens
only the data related to that individual metric. The filter becomes part of that
metric's definition.

In this context, the filter is called a condition and the metric to which the
filter is applied is called a conditional metric. A condition is not required in a
metric's definition; this is an optional metric component. Applying
conditionality to a metric forces the calculation of a metric to be qualified by
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the metric's filter irrespective of what is specified in the report fi lter, if one
exists.

For example, you want to create a report with multiple metrics: Cost, Profit,
and Sales. You want to apply a time filter, January 2007, so that users only
see data for January, 2007 when the report is executed. To achieve this, you
create a report fi lter for January 2007 and place it on the report. However,
for one metric, Sales, you want to show all the values for the entire year
2007. You want this one metric to ignore the filter on the report. By creating
a condition for the Year=2007 and adding it to the Sales metric's definition,
when the report is run the Sales metric ignores the report fi lter (January
2007) and uses its own condition (2007) to calculate and display the sales
for the entire year 2007.

To apply conditionality to a metric, you define a filter (a condition) as part of
the metric's definition so that only data that meets the filter conditions is
included in that metric's calculation.

To determine whether a metr ic has a condit ion applied to it

1. Click the metric you want to see the definition for. The metric opens in
the Function Editor.

2. The metric's condition is shown in the Condition area:

l In the example below, there is no filter displayed in the Condition area, so
this metric has no condition applied to it.
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l In the example below, the Condition area shows the Web Sales filter, so
this metric has a filtering condition as part of its definition. The condition
filters data by looking at only those sales that occurred on the web.

While you can only use one filter on a metric, that single filter can contain
multiple filtering criteria.

For details on filters generally and on creating various types of conditions
for filters, see Filtering data on a report: Filters, page 232.

For information to create and use a conditional metric, as well as additional
examples on conditionality, information on conditional metrics with multiple
conditions and levels, and details on how conditional metrics interact with
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report fi lters, see the Advanced Metrics chapter of the Advanced Reporting
Help.

M et r ics t hat do not accept a condit ion

Certain types of metrics can only have a condition applied to their
constituent parts, not to the metric as a whole. These restricted metrics are
called compound metrics. See Metrics made up of metrics: Compound
metrics, page 214 for a description and examples of these types of metrics.

Tim e-ser ies analysis: Tr ansfo r m at ion

A transformation applies offset values, such as "four months ago," to a
metric on a report. A transformation is not required in a metric's definition;
this is an optional metric component.

Transformations are generally added to metrics that are designed to do
time-series analysis, for example, to compare values at different times, such
as this year versus last year, or month-to-date. Transformations are useful
for discovering and analyzing time-based trends in your data.

Transformations are created as a separate object and then added to a
metric. Transformations are schema objects, so you must have the
appropriate privileges to create or modify them.

When a transformation is created and applied to a metric, you have created
a transformation metric. A transformation metric is a metric that assumes the
properties of the transformation applied to it. For example, you create a
metric to calculate revenue. If you add a transformation named Month to
Date to that metric, the new metric (a transformation metric) calculates
month to date revenue, or the sum of revenue this month, up to today's date.
The following image shows the resulting report from this example:
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Any transformation can be included as part of the definition of a metric, and
multiple transformations can be applied to the same metric.

To determine whether a metr ic has a transformation applied to it

1. Click the metric whose definition you want to see.

2. If the metric has a transformation, it is shown in the Transformation
area of the Function Editor, as shown in the images below:

l In the example below, there is no transformation displayed in the
Transformation area, so this metric has no transformation applied to it.

l In the example below, the transformation transforms Month to Last Month
and Day to Last Month's Day, so this metric has a transformation as part of
its definition.
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For details to use a transformation with a metric, and for more information on
metrics that use transformations, refer to the Advanced Metrics chapter of
the Advanced Reporting Help. For information on creating transformations,
see the Project Design Help.

Metrics that do not accept a transformation

Certain types of metrics can only have a transformation applied to their
constituent parts, not to the metric as a whole. These restricted metrics are
called compound metrics. See Metrics made up of metrics: Compound
metrics, page 214 for a description and examples of these types of metrics.

Base fo r m u las

A base formula is a standard metric formula that is saved and then used in
multiple metrics. A base formula is typically a common expression used in a
large number of metrics.

A base formula saves time. As you create metrics, you do not have to type
the common formula repeatedly but can instead re-use the formula by
adding the base formula to each new metric.

A base formula used in a metric is linked to that metric as a shortcut. This
means that when you update the base formula, it is automatically updated in
all metrics in which it is used. Base formulas only contain calculation
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information; they do not include level information or conditionality, and you
cannot use them to perform transformations or calculate subtotals.

For steps to create a base formula, add a base formula to a metric, or
remove the base formula from a metric, see the MicroStrategy Developer
help (formerly the MicroStrategy Desktop help).

To see the full expression for a metric that contains a base formula, in
Developer, open the metric in the Metric Editor, and then, in the Metric
metricname is defined as area, select Formula.

Metrics made up of metrics: Compound metrics
Certain types of metrics can only have a level, condition, or transformation
applied to their constituent parts, not to the metric as a whole. These metrics
are called compound metrics. If a metric contains any of the following
elements, it is a compound metric and can only have levels, conditions, and
transformations applied to its individual parts:

l A metric is a compound metric if it uses a non-group function, which
includes OLAP functions and scalar functions. (For details on the all
functions available in MicroStrategy, see the Functions Reference.)

l A metric is a compound metric if it consists of two or more existing metrics
joined by an arithmetic operator (+, -, *, and /).

Each of these compound metric types is described with examples below.

One advantage of compound metrics compared to simple metrics is that
compound metrics can use smart totals. Smart totals define the evaluation
order for the final calculation. For more information on smart totals, see
Totals and subtotals, page 221.

Compound metric with an arithmetic operator

The following example shows a compound metric that uses an arithmetic
operator to create a metric formula out of existing metrics:

Sum(Cost) + Sum(Profit)

Basic Repor t ing Guide

https://www2.microstrategy.com/producthelp/2021/FunctionsRef/index.htm


Copyright © 2022 All Rights Reserved 215

where Cost and Profit are metrics. The addition operator (+) between the
two metrics makes this a compound metric.

The same metric is shown in the Formula Editor within the Metric Editor in
the image below. It is a compound metric because it contains an arithmetic
operator (+) that creates a formula out of two existing metrics, Cost and
Profit. The level of the metric is indicated between curly braces ({ }) in the
metric definition. {~+} denotes that the metric is calculated at the level of the
lowest attribute on the report, which is the default calculation level for a
metric. Each constituent metric has its own level, and you can change the
default level for the individual metrics. No level exists for the entire
compound metric as a whole.

Levels, conditions, and transformations cannot be set on a compound
metric, although they can be applied separately on the constituent metrics
that make up the compound metric. For more information on compound
metrics and examples of compound metrics used in reports, refer to the
Advanced Metrics chapter of the Advanced Reporting Help.

Compound metric with a non-group function

The following example shows a compound metric that uses a non-group
function:

RunningAvg(Cost)
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where Cost is a metric. The Cost metric is part of the definition of the
RunningAvg(Cost) compound metric. The compound metric's formula
contains a non-group function, Running Average.

The same metric is shown in the Function Editor within the Metric Editor in
the image below. It is a compound metric because it contains a non-group
function, Running Average. Because it uses a non-group function, the
Function Editor displays the value list and parameters for the function,
rather than level, condition, and transformation options. The Cost metric is
the input value of the function.

If you switch to the Formula Editor, you do not see the syntax for the level,
as you did in the previous example (see Compound metric with an arithmetic
operator, page 214). You do not use a level, condition, or transformation
with a compound metric. You can apply a level, condition, or transformation
to the Cost metric that is used in this compound metric, by editing the Cost
metric.
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Creating a metric
You create a metric using the Metric Editor. You can also use the Metric
Editor to modify an existing metric. For an image of the Metric Editor, see
Viewing and working with metrics: The Function Editor, page 198.

When you create a metric, you define its formula, enable a total or subtotal if
you want, and determine a function for dynamic aggregation. The following
steps walk you through this process in the Metric Editor.

After you create a metric, you can then include it on a report. When placed
on a report, the metric becomes part of the report's definition and
determines the data displayed each time the report is executed. For steps to
add a metric to a report, see Reports: Adding metrics to a report, page 355.

To create a metr ic

1. From the MicroStrategy home page, click New Metric . If you are on

a folder page, click Create on the icon bar on the left, then select New
Metric.

2. Select the function to use to calculate data in the metric. You can
narrow the list of functions displayed in the pane by doing one of the
following:

l To search for the function by name, type the function's name in the search
field.

l Choose a function category from the drop-down list, such as Math
Functions or Financial Functions. The pane is updated to include only the
functions that belong to the selected category.

When you select a function, the function is added to the metric and a
description of the function is displayed at the bottom of the dialog box.
Click Details to view more information about the function, such as syntax
and examples.
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To def ine t he m et r ic's f o r m u la

Different options are available depending on the type of function selected
above:

l If you selected a grouping function, such as Sum, Average, First, or
Maximum, you define the metric's expression, as well as optional
components such as level, condition, and transformation. Do one of the
following:

l To specify the expression by typing the name of an object, type the
name of the object in the Function f ield. As you type, matching objects
are displayed in a drop-down list. You can type multiple objects, such as
Revenue-Profit.

l To specify the expression by choosing an object, click the Browse icon
. The Select... dialog box opens. Navigate to and select an object, or

search for the object.

l Depending on the function that you selected, you may be able to define
parameters for the function. Click the Function Parameters icon .

l If you selected a non-grouping function, such as data mining, date, OLAP,
and ranking functions, you are presented with options to define the input
values (called arguments) for the function, as well as any parameters you
can use to determine the behavior of the function. For guidance on
arguments and parameters for the selected function, click Details at the
bottom of the dialog box. Perform the following steps:

a. Depending on the function that you selected, you may need to
determine arguments. For each argument listed, type a value or click
the Browse icon to find the metric, fact, prompt, or other

compatible object to use as input values of the function.

An argument is the input value of a function. For example, you can
select the Profit fact as the argument of the Average function, to
calculate the average profit.
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b. Depending on the function that you selected, you may need to define
parameters. For each parameter listed, type a value or select the
parameter value from the drop-down list.

Parameters determine the behavior of the function. For example, the
NTile function requires two parameters, Ascending and Tiles.
Ascending controls whether the NTiles are ordered in ascending or
descending order, while Tiles determines the number of splits.

To select sub t o t al f unct ions

You can determine which aggregation functions can be used to calculate
subtotals for a metric. When the metric is added to a report and the report is
run, users can display subtotals for the metric by selecting from the
functions that you have made available. See Totals and subtotals, page 221
for details on subtotals.

1. Click the Options icon .

2. In the list of categories on the left, click Subtotals.

3. Select the default function to use to calculate report subtotals from the
Function for default subtotal drop-down list.

4. You can select additional functions that will be available to calculate
subtotals for the metric. To do this, click the expand icon next to

Select the subtotals you want available for this metric. Select the
subtotal types to be available to the user when the report is run, and
clear any subtotal types that you do not want to be available.

To select a dynam ic aggr egat ion funct ion for OLAP Ser vices

Dynamic aggregation allows you to change the level of report aggregation as
users move objects off the report grid and into the Report Objects pane, and
vice versa. You can define the dynamic aggregation function.
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For an overview of OLAP services, see OLAP Services, page 16. For details
to set up and use dynamic aggregation, see the Reports chapter of the
Advanced Reporting Help.

1. In the list of categories on the left, click General.

2. Select the function to be used for the report aggregation from the
Dynamic Aggregation function drop-down list.

3. Click OK.

4. Click Save.

The metric you created can now be added to a report. For steps, see
Reports: Adding metrics to a report, page 355.

A metric definition can also include a level, condition, and transformation.
To apply a level, condition, or transformation to your metric, see the
sections listed below:

l Components of a metric, page 205

l Components of a metric, page 205

l Components of a metric, page 205

Joins for rank metrics

If you create a rank metric, which is a metric that ranks attribute elements by
numbering them, for example, 1 through 10, you must set the metric's join
type to outer. If the default inner join is used on a rank metric, some of the
ranks (and therefore, the ranked attribute elements) may not appear on the
report because an inner join does not include elements with null values in
the result set. But an element with a null value may have a rank. With an
outer join, all rows are displayed on the report even if there is no result
displayed for some of the elements for some of the metrics on the report. For
steps to set a metric's join type, see Determining how metric data is
combined: Metric join types, page 98 in Chapter 3, Analyzing Data.
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Totals and subtotals
You can enable subtotals and grand totals for a metric, so that analysts can
display them on a report at run time. You must decide what function will be
used to calculate a subtotal or grand total for a given metric. You can enable
several different subtotals from which analysts can choose, depending on
their analysis needs.

To see an example of a report with subtotals and a grand total, in the
Tutorial project open the Subtotals report, which is displayed below. The
example below shows subtotals for each region, an additional subtotal for
each quarter (encompassing all regions), and a grand total at the bottom of
the report.

Grand totals (usually called totals) and subtotals allow users to control how
metrics are further calculated at different levels (such as by quarter, by year,
by region, and so on), and they can be applied dynamically by the analyst to
any report on which a metric is used that has the totals or subtotals enabled.
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When you enable a total or subtotal for a metric, you select a function by
which the metric should be aggregated to display the total or subtotal. You
can use one of many standard functions such as total, count, minimum,
maximum, standard deviation, and others.

You can also create your own functions to be used with subtotal
calculations. For details on creating your own function, see the Advanced
Reporting Help.

For more advanced information on subtotals, see the Advanced Reporting
Help.

Applying a grand total or subtotals to a metric

The following steps show you how to enable a grand total or subtotals for a
metric. When the metric is added to a report and the report is run, users can
display subtotals for the metric by selecting from the functions that you have
made available. Steps are also provided below to remove totals and
subtotals so that they cannot be displayed on a report.

To enable totals or subtotals for a metr ic

1. In MicroStrategy Web, click the metric for which you want to enable a
grand total or subtotals. The Metric Editor opens in either Function
Editor mode or Formula Editor mode, depending on the type of metric
you chose to edit.

2. Click the Options icon .

3. In the list of categories on the left, click Subtotals.

4. Select the default function to use to calculate report subtotals from the
Function for default subtotal drop-down list.

5. You can select additional functions that will be available to calculate
subtotals for the metric. To do this, click the expand icon next to

Select the subtotals you want available for this metric. Select the
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subtotal types to be available to the user when the report is run, and
clear any subtotal types that you do not want to be available.

6. Click OK.

7. Click Save.

To remove a grand total or subtotals from a metric

You may want to remove, or disable, a grand total or subtotals for a
particular metric. For example, if the metric counts inventory numbers,
subtotals may be irrelevant and should therefore not be displayed on a
report.

1. In MicroStrategy Web, click the metric for which you want to enable a
grand total or subtotals. The Metric Editor opens in either Function
Editor mode or Formula Editor mode, depending on the type of metric
that you chose to edit.

2. Click the Options icon .

3. In the list of categories on the left, click Subtotals.

4. To prevent a grand total from appearing when the metric is used on a
report, from the Function for default subtotal drop-down list, select
None.

5. To prevent any subtotals from appearing when the metric is used on a
report, click the expand icon next to Select the subtotals you want
available for this metric. Clear all subtotal types.

6. Click OK.

7. Click Save.

When this metric is used on a report in the future, the removed totals or
subtotals cannot be displayed as part of the report.
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Smart totals

Smart totals are also referred to as smart metrics. Smart totals are used on
compound metrics.

Smart totals allow you to change the default evaluation order of a compound
metric. For details on what a compound metric is, see Metrics made up of
metrics: Compound metrics, page 214. Smart totals calculate subtotals on
individual elements of the compound metric. For example, a smart metric
uses the formula Sum (Metric1) / Sum (Metric2) rather than Sum
(Metric1/Metric2).

The smart metric property is available for compound metrics and for some
simple metrics which combine two or more calculation formulas with
arithmetic operators. To enable or disable smart metrics, use the Allow
Smart Metric check box on the Advanced Metric Options dialog box in the
Metric Editor.

For example, consider the following report.

Year Revenue Discount Ratio of Discount to Revenue

2005 $200 $50 25%

2006 $100 $50 50%

If you choose to display the grand total for the report without using smart
totals for the Ratio of Discount to Revenue metric, you get the following
results.

Year Revenue Discount Ratio of Discount to Revenue

2005 200 50 25%

2006 100 50 50%

Total 300 100 75%
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However, the Total value in the last column is incorrect; it is displaying a
sum of the percentages of the Ratio of Discount to Revenue metric. To
calculate a meaningful total value for this metric, enable smart totals by
editing them in the Metric Editor and selecting the Allow Smart Metric option.
When you select the Allow Smart Metric check box, you get the following
correct results.

Year Total Sales Discount Sales Ratio of Discount Sales to Total Sales

2005 200 50 25%

2006 100 50 50%

Total 300 100 33.33%

A more complex business example for smart totals is provided in the
Advanced Metrics chapter of the Advanced Reporting Help.

To enable or disable smart totals for a metr ic

1. In MicroStrategy Web, click the metric for which you want to enable or
disable smart totals. The Metric Editor opens in either Function Editor
mode or Formula Editor mode, depending on the type of metric that you
chose to edit.

2. Click the Options icon .

3. From the left, click General.

4. Do one of the following:

l To enable smart metrics, select Allow smart metric.

l To disable smart metrics, clear Allow smart metric.

5. Click OK.

6. Click Save.
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Formatting a metric
Metrics can be formatted independently of the report(s) on which they
appear. When you format a metric, you can format the metric's column or
row header, and you can also format the data that will appear for that metric.

You can apply special formatting to numeric values that appear when a
metric is calculated, such as currency, percentages, and date format style.
You can apply special font styles and sizes, and you can determine cell
background colors or patterns. This formatting can help analysts more easily
identify specific data. For example, you might have all sales data appear in a
blue font, while profit data appears in a bold green font.

Metric formatting can be performed using either of the following interfaces:

l Metric Editor: Use this method to format one metric at a time. Formatting
changes made using this method affect the metric no matter which report
the metric is included on. For details on accessing the Metric Editor, see
Viewing and working with metrics: The Function Editor, page 198.

l Find and Replace feature: Use this method to format a number of metrics
at one time with the same format.

For information about using the Find and Replace feature to format metrics,
see the Advanced Reporting Help. For specific steps to use the feature, as
well as information on each option in the software, open the Find and
Replace feature from Developer's Tools menu, and then click Help.

For information to format metric data on a report so that the formatting
applies to that report only, see Formatting for easier data analysis, page
379.

Formatting a metric's header and values

You can format a metric's display of numeric values, font styles and sizes,
cell display colors, and so on. You can select different formatting options for
metric column headers (the title of the metric) and metric values (the
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numbers calculated by the metric and displayed in the report). This
formatting, called metric-level formatting, is used to display the metric when
the metric is placed on a report. You can override metric-level formatting in
a specific report by defining formatting options on the report (except for
graph colors, as described below). For more information on metric
formatting at the report level, including how the different levels work
together, see the Advanced Reporting Help.

You can format the:

l Number display: Determine how numeric data is displayed. For example,
you can format numbers to appear as dollars and cents, as percentages,
or even as scientific notation. You can also determine whether the values
appear with or without decimal places.

Number formatting is only relevant for metric values. If a number appears in
your report results that does not reflect a metric calculation, such as a list of
product identification numbers, you cannot format the data.

l Alignment: Control vertical and horizontal alignment of data within a cell,
and select whether or not to wrap text. For example, you can right justify
and pad the data.

l Font: Select the font name, script, size, and color of the data; whether the
font is bold, underlined, or italicized; and whether to strikeout the text.

l Borders: Select the style and color of the border line. You can select
which borders (top, bottom, left, and right) are displayed, or hide all the
borders.

l Background: Apply a background color, including a gradient.

l Graph: Apply a background color for a metric when it is displayed as a
series in a graph report. (Available for metric headers.)

By default, the graph color that you define for a metric overrides any default
color schemes for the graph report, although you can disable this metric
formatting. For more detailed steps, see Defining a graph color for metrics,
page 60.
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To format metr ic values or headers

1. In MicroStrategy Web, click the metric you want to format. The Metric
Editor opens in either Function Editor mode or Formula Editor mode,
depending on the type of metric that you chose to edit.

2. Click the Format icon .

3. Select the area of the metric to format by selecting one of the following
from the drop-down list at the top left:

l To format the metric column headers (the titles), select Metric
Headers.

l To format the metric values (the numbers calculated by the metric),
select Metric Values.

4. From the left, select the type of formatting to define for the metric:

l Number

l Alignment

l Font

l Borders

l Background

l Graph (available only for metric headers)

Select the appropriate options to define the formatting for the metric.

5. Repeat the appropriate steps above to add additional formatting as
desired.

6. Click OK.

7. Click Save.
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Customizing a metric number format

You can create a custom format syntax for metric values to be displayed on
the report. Following are some examples of common customized formatting
you can apply to a metric:

l Cut off decimal numbers automatically after a certain number of digits, or
truncate the leading zero in a decimal so that 0.2 becomes .2.

l Align decimals down a column, rather than left-aligning or right-aligning.

l Include strings that always appear with the calculated value, such as "this
month", "sales=", or "Customer no.".

l Provide a specialized date or time format, such as Feb 3, 06 or 01h 32m.

To create a custom metric format

1. In MicroStrategy Web, click the metric you want to format. The Metric
Editor opens in either Function Editor mode or Formula Editor mode,
depending on the type of metric that you chose to edit.

2. Click the Format icon .

3. Select the area of the metric to format by selecting one of the following
from the drop-down list at the top left:

l To format the metric column headers (the titles), select Metric
Headers.

l To format the metric values (the numbers calculated by the metric),
select Metric Values.

4. From the list of categories on the left, select Number.

5. Select Custom.

6. Enter your custom format syntax in the Custom f ield. See the Advanced
Reporting Help for a table of formatting symbols you can use and
examples you can replicate.

7. Click OK.

8. Click Save.
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Asking for user input into a metric's definition
You can allow the user who executes the report that contains the metric, to
decide for himself certain aspects of the metric's formula. This lets each
individual user define the report results he sees. To do this, you include a
prompt in the metric's definition. You can make use of prompts in any metric
where you want to let each user impact the formula of the metric, by having
the user enter a specific number that makes sense for that user.

For example, if you create a tax metric that calculates tax numbers on sales,
you can let each user who executes the report enter the sales tax for his own
state. Thus, the report's results will reflect the information each user wants
to see.

To add a prompt to your metric's definition, use the following high-level
steps:

1. Decide what prompt type you need for your metric. Prompt types that
you can use in a metric definition are listed in the table in Reports:
Adding prompts to a report, metric, or fi lter, page 362.

2. Follow the steps in this chapter to create that prompt; for the
appropriate procedure, see Creating a prompt, page 291.

3. Then follow the steps in this chapter to add the prompt to your metric's
definition; see Reports: Adding prompts to a report, metric, or fi lter,
page 362.

Editing a metric
You can open an existing metric in the Metric Editor. The metric is ready to
be edited.

1. In MicroStrategy Web, click the metric you want to format. The Metric
Editor opens in either Function Editor mode or Formula Editor mode,
depending on the type of metric that you chose to edit.

2. Use the information above for various metric components and types of
metrics to edit your metric according to your needs, as follows:
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l To change the formula or the function in the formula, see Components of a
metric, page 205 or Creating a metric, page 217.

l To change or add an arithmetic operator, see Components of a metric,
page 205.

l To change or add totals or subtotals, see Totals and subtotals, page 221.

l To edit the appearance of a metric or its values, see Formatting a metric,
page 226.

l To create a custom number format, see Formatting a metric, page 226.

Additional metric functionality
In the Advanced Reporting Help, you build on your knowledge of metrics that
you have learned in this guide. You learn about creating various types of
advanced metrics such as level metrics, non-aggregatable metrics, and
transformation metrics. You can find information on the following advanced
metrics topics in the Advanced Reporting Help:

l Compound metrics: Learn details about compound metrics, how they
work with smart subtotals, and additional information and examples.

l Level metrics: Learn about targets, grouping, fi ltering, and how to use
level metrics with filters, along with additional information and examples.

l Conditional metrics: Learn about conditional metrics with multiple
conditions and with metric levels, how they work with report fi lters, and
additional information and examples.

l User-defined subtotals: Learn about these custom subtotals by following
the detailed examples.

l Metric-specific VLDB properties: Learn how to use certain VLDB (Very
Large Database) properties in MicroStrategy to customize the SQL queries
to your database.

l Metric column aliases: Learn about the information you can change for a
metric, such as the column name as it appears in the SQL for a report,
data type, and byte length.
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l Metric functions: Learn how to use various functions that are particularly
useful or commonly used in metrics.

l Custom plug-in functions: Learn how to use custom functions to make a
metric relevant to your business environment.

l Metric creation using Command Manager: Learn how to automate the
metric creation process.

Filtering data on a report: Filters

A report fi lter is the part of a MicroStrategy report that screens data in your
data source to determine whether the data should be included in or excluded
from the calculations of the report results. A brief introduction to filters is
provided for report analysts in Chapter 4, Answering Questions about Data,
in the section Filtering data, page 110. Review this information if you are
new to creating report fi lters. It describes how to view a filter's definition for
a given report. This can be a useful way to create an effective filter, because
you can copy parts of an existing filter's definition when creating a new filter.
You can even use an existing filter within a newly created filter.

If you are familiar with SQL syntax, a filter is equivalent to the WHERE
clause in a SQL statement.

Filters are helpful in clarifying large quantities of data and only displaying
subsets of that data, so reports show users what they really need to see. For
example, you want to determine the number of injuries to your delivery
personnel in 2005 that may have been due to bad winter weather in the
northeastern U.S. You also want to know the time of day when most injuries
occurred. You place the Delivery Location and Delivery Time attributes on
your report. You also place the Number of Reported Injuries metric on the
report. But you only want the report to display injuries in your northeast
region during the winter of 2005. Without a filter, you would have to sift
through a lot of report data on your own. By creating a filter that includes
Northeast Region, January 2005, and February 2005, and using that filter on
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the report, the data displayed when the report is executed is limited to that
geographical region and season.

In another example, consider the following diagram, which shows a table of
data filtered by three different fi lters.

Each filter returns a different result set. Filters ensure that the report results
contain only the data that answers the specific business query the report
was designed to answer. It is important to design the correct fi lter to retrieve
the desired data.

Filters are most commonly used on reports, to filter all the data the report
would otherwise retrieve from the data source and display to users.
However, fi lters can also be used with a specific object on a report, such as
on a metric. A filter placed on a metric only filters data related to that metric.
When used on a metric, a filter essentially "goes with" the metric so that
whatever report the metric is placed on, the filter is always part of that
metric. (This type of metric is called a conditional metric. For details on
conditional metrics, see the Advanced Reporting Help.)

Filters are an important part of almost all reports. Understanding how to
create a filter is an important skill in making the best use of the data in your
data source. This section describes the different types of filters available in
MicroStrategy and shows you how to create a simple filter of each type.
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Basic knowledge of formal logic is useful in understanding report fi lters and
their concepts, but it is not a prerequisite to learn how to create filters.

Many of the reports and filters used as examples in this section already
exist in the MicroStrategy Tutorial project. You can follow the steps
presented in this chapter to create filters, or you can view the saved
samples in the Tutorial project. For information on the Tutorial project and
how to access it, see About sample data and the MicroStrategy Tutorial
project, page 4.

A note on terms: filter, qualification, condition
A filter is composed of one or more qualifications. Qualifications define the
conditions that the data must meet to be included in a report, for example,
"Region = Northeast" or "Revenue > $1 million". If a filter contains more than
one qualification, the qualifications are joined by an arithmetic operator such
as AND or NOT. For details on using operators to join filter qualifications,
see Joining filter qualifications with operators, page 268.

Creating or editing filters: The Filter Editor
You can create and save a filter using the Filter Editor. You can also use the
Filter Editor to modify an existing filter. The Filter Editor is accessible from
MicroStrategy Web.

To access the Filter Editor

In MicroStrategy Web, on the Home page, click New Filter. The New Filter
page opens as shown below:
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To create a filter, see Types of filters, page 235 to determine which kind of
filter you need. Then follow the related procedure for the filter type you
choose to create.

To edit a filter, click on the filter in MicroStrategy Web. The filter opens
within the Filter Editor. For details on each filter type, see the appropriate
section below.

After you create a filter, you can then include it in a report, a metric, or some
other report object. When placed on a report, a filter becomes part of the
report's definition and affects the data displayed each time the report is
executed. For steps to include a filter on a report, see Reports: Adding a
filter to a report, page 357.

Types of filters
Select a filter type from this list, and then specify the information that is
required for the type of filter you are creating.

Filter types include the following:
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Filter Type Filter Name What Data It Is Designed To Filter

Attribute qualifications

These types of qualifications restrict
data related to attributes on the
report.

Attribute form
qualification

Create a filter
based on
attribute forms.

For details, see
click here.

Filters data related to a
business attribute's form(s),
such as ID or description.

• For example, the attribute
Customer has the forms ID,
First Name, Last Name,
Address, and Birth Date. An
attribute form qualification
might filter on the form Last
Name, the operator Begins
With, and the letter H. The
results show a list of
customers whose last names
start with the letter H.

Attribute element
list qualification

Create a filter
based on
attribute
elements.

For details, see
click here.

Filters data related to a
business attribute's elements,
such as New York, Washington,
and San Francisco, which are
elements of the attribute City.

• For example, the attribute
Customer has the elements
John Smith, Jane Doe,
William Hill, and so on. An
attribute element list
qualification can filter data to
display only those customers
specified in the qualification
by selecting the In List option
or all the customers
excluding those specified in
the qualification by selecting
the Not In List option.

Set qualifications
Metric set
qualification

Filters data related to a set of
attributes that are determined
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Filter Type Filter Name What Data It Is Designed To Filter

These types of qualifications restrict
data based on the value, rank, or
percentage of a metric, or based on
the relationships between the
attributes on the report.

Create a filter
based on metric
value or rank.

For details, see
click here.

based on the metrics
associated with those
attributes.

• For example, a metric set
qualification might filter data
to display sales data for only
those products with an
inventory count below a
specified number.

Relationship set
qualification

Create a filter
based on
relationships
between
attributes.

For details, see
click here.

Filters data based on a specific
relationship between two
attributes.

• For example, a relationship
set qualification might filter
data to display those stores
selling Nike shoes in the
Washington, DC area.

Shortcut qualifications

These types of qualifications restrict
data related to existing report
results or an existing filter.

Shortcut-to-a-
report
qualification

Create a filter
based on the
results of an
existing report.

For details, see
click here.

Uses the result set of an
existing report as is, or with
additional conditions, as a filter
in a different report.

• For example, you might use
a shortcut-to-a-report
qualification by taking the
result set of one report
showing all customers in the
Southwest region, placing
that result set as a filter into
a new report, adding a new
filter qualification for active
customers in the current
year, and displaying all
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Filter Type Filter Name What Data It Is Designed To Filter

currently active customers in
the Southwest region.

Shortcut-to-a-filter
qualification

Create a filter
based on an
existing filter.

For details, see
click here.

Uses an existing filter as is, or
with additional conditions, in a
report.

• For example, you might use
a shortcut-to-a-filter
qualification by taking an
existing filter for Region =
Northeast and Year = 2006,
placing it in a report, and
adding a new filter
qualification for Month of
Year = December.

You can also create advanced qualifications such as attribute-to-attribute
qualifications and prompted filters. For more information on all types of
advanced filters, refer to the Advanced Filters chapter of the Advanced
Reporting Help.

Stand-alone filter vs. fi lter as part of report

This chapter primarily describes how to create stand-alone filters. A stand-
alone filter is a filter created as an independent MicroStrategy object. The
stand-alone filter can then be used on many different reports, as well as on
metrics and other objects. However, in MicroStrategy, fi lters can also be
created as part of a given report, at the same time the report itself is being
created. These kinds of filters are generically called report fi lters. Report
fi lters are saved with the report's definition. Therefore, a report fi lter cannot
be used on any other report.

However, a report fi lter can use any of the qualification types described in
this chapter. Both stand-alone filters and report fi lters accomplish the same
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results: the filter's qualifications determine the data to use when calculating
the data displayed in a report.

For an example of a report fi lter and steps to create one during the report
creation process, see the procedure in Creating a report for analysis, page
174.

Filtering data based on business attributes: Attribute
qualifications
When you want to restrict report data to a certain subset of information, and
your restriction conditions are defined by an attribute's forms or elements,
you use an attribute qualification. Attribute qualifications come in two types:
attribute element list qualifications and attribute form qualifications.

Attribute element list qualification

The elements of a business attribute are the unique values for that attribute.
For example, 2006 and 2007 are elements of the Year attribute, while New
York and London are elements of the City attribute. On a report, attributes
are chosen to build the report, but once the report is executed, the
attribute's elements are displayed in the rows or columns.

The filter type called an attribute element list qualification qualifies (or
filters) report data based on a list of attribute elements belonging to an
attribute. For example, the attribute Customer has elements which are
individual customer names. For a report containing the attributes Region,
Customer, and Income Range, you can use an attribute element list
qualification on the attribute Customer to obtain income data for only those
customers you specify in your filter's list.

At t r ibu t e elem en t l ist qual i f icat ion exam p le

You want to create a report that includes the revenue, cost, and profit by
month for all employees last year. However, certain months are not
representative of the normal business cycle, so they should be excluded
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from the report calculations. To do that, you create an attribute element
qualification that excludes the months April, May, and December, which are
elements of the Month attribute.

The steps to create this attribute element list qualification are in the
procedure below. The example after the procedure shows how a report is
affected when this filter is applied.

Cr eat ing a f i l t er based on at t r ibu t e elem en t s

This procedure creates an attribute element list qualification based on the
example described above. It uses the sample MicroStrategy Tutorial project.

To filter data based on business attr ibute elements

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the attribute that has the elements
by which you want to filter a report's data. Alternatively, type the name
of the attribute in the Find f ield.

3. Right-click the attribute and select Add to Filter. You can also drag
and drop the attribute to the right pane. For the Tutorial example
described above, browse to the Attributes folder and select the Month
of Year attribute.

The right pane displays fields similar to the image below:
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4. To create the list of elements that the filter will use to filter data,
perform the following steps:

a. Click Select.

b. From the In List drop-down list, select one of the following:

l To define what attribute elements the filter should include data
for, select In List.

l To define what attribute elements the filter should exclude data
for, select Not In List.

For this Tutorial example, select Not In List.

c. The Available area on the left displays the elements that belong to
the attribute you chose for this filter. Select an element and then
click the right arrow to move the element to the Selected area.
Press CTRL to select multiple elements. If the Available list
contains a large number of elements, use the Search for f ield to
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locate the elements you want to select.

For this Tutorial example, select April, May, and December.

5. Click the Apply.

6. Click Save As. For this Tutorial example, name the filter Month and
save it in the My Objects folder.

7. Click OK.

If you have multiple qualifications, be aware that it is possible to
unintentionally change the evaluation order of a filter's qualifications simply
by adding a new qualification and not looking at where the new qualification
is added in the list of qualifications. For information on changing the
evaluation order of qualifications, see Editing a filter, page 278.

The filter you created can now be added to a report. For steps, see Reports:
Adding a filter to a report, page 357.

If you followed the Tutorial example in the procedure above, you created the
Month filter which excludes the months April, May, and December. Now see
what happens to report data when the filter is used on a report. Open the
Basic Report from the Tutorial project, located in Shared Reports\

MicroStrategy Platform Capabilities\

Advanced Reporting Guide. The Basic Report, part of which is shown
below, displays employee revenue, cost, and profit for all months of the
year:
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In the Basic Report, Leanne Sawyer's contribution to revenue is $2,411,912.
Next, add your Month filter. To do this, from the Home menu click the
Design icon. From the left pane, navigate to where you saved your Month
filter, and drag the filter into the report's fi lter pane. When you re-execute
the report, it looks like the following image:
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(To see the filtered report shown above, open the report named Filter -
Month Report Filter from the Tutorial project, located in Shared

Reports\MicroStrategy Platform Capabilities\Advanced

Reporting Guide.) In this filtered report, the metrics have different values
than in the unfiltered Basic Report. Sawyer's contribution to revenue is now
$1,813,538. In the unfiltered Basic Report, the data was retrieved from the
data warehouse for all months of the year. In the filtered report, the data for
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the months April, May, and December is not retrieved from the data
warehouse, so the metrics cannot include this data in their calculations. As
this filtered report shows, your top revenue-producing employees can be
very different if you exclude the months April, May, and December.

Attribute form qualification

Attribute forms are additional descriptive information about a business
attribute. Most attributes only have the forms ID and Description. But an
attribute can have many other forms. For example, the attribute Customer
has the forms First Name, Last Name, Address, Email Address, and so on. A
form is a descriptive category for any data your organization saves about
any of its attributes.

Attribute form qualifications allow you to filter report data based on an
attribute form. For example, to return data for only those customers whose
last names start with the letter H, you can create an attribute form
qualification defined with the form Last Name, the operator Begins With, and
the letter H as the value.

At t r ibu t e fo r m qual i f icat ion exam p le

A report includes the revenue, cost, and profit for all employees. You want to
view the data of only those employees whose last name begins with the
letter B. To do this, create a filter that qualifies on the Last Name form of the
attribute Employee. The steps to create this attribute form qualification are
listed below. The example after the procedure shows what happens to report
data when the filter is used on a report.

Cr eat ing a f i l t er based on business at t r ibu t e fo r m s

This procedure creates an attribute form qualification based on the example
described above. It uses the sample MicroStrategy Tutorial project.
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To filter data based on business attr ibute forms

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the attribute whose form you want to
filter a report's data by. Alternatively, type the name of the attribute in
the Find f ield.

3. Right-click the attribute and select Add to Filter. You can also drag
and drop the attribute to the right pane.

The right pane displays fields similar to the image below:

For this Tutorial example, choose Employee.

4. To create the list of forms that the filter will use to filter data, perform
the following steps:

a. Select Qualify.

b. From the first drop-down menu, select the form you want to filter
data based on.

For this Tutorial example, click Last Name.

c. From the next drop-down menu, select the operator that describes
how you want to filter the data.

For this Tutorial example, click Begins With.

d. In the last field, type the value to use to qualify on the attribute
form. This is the value that will be compared against the data in
your data source.
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Depending on the operator you have selected, you may need to
enter multiple values. For example, the operator Between requires
two values.

For a date attribute form, you can compare the form to a dynamic
date, which is a fixed offset of the current date, such as one month
ago. For more information on dynamic dates, see the Advanced
Reporting Help.

For this Tutorial example, type B.

5. Click Apply .

6. Click Save As.

7. For this Tutorial example, name the filter Employee Last Name = B
and save it in the My Objects folder.

8. Click OK.

If you have multiple qualifications, be aware that it is possible to
unintentionally change the evaluation order of a filter's qualifications simply
by adding a new qualification and not looking at where the new qualification
is added in the list of qualifications. For information on changing the
evaluation order of qualifications, see Editing a filter, page 278.

The filter you created can now be added to a report. For steps, see Reports:
Adding a filter to a report, page 357.

If you followed the Tutorial example in the procedure above, you created the
Employee Last Name = B filter which excludes all employees except those
whose last name begins with the letter B. Now see what happens to report
data when the filter is used on a report. Open the Basic Report from the
Tutorial project, located in Shared Reports\MicroStrategy Platform

Capabilities\Advanced Reporting Guide. The Basic Report, shown
in the image below, displays data for all employees:
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Next, add your Employee Last Name = B filter. To do this, from the Home
menu click the Design icon. From the left pane, navigate to where you saved
your Employee Last Name = B filter, and drag the filter into the report's fi lter
pane. When you re-execute the report, it looks like the following image:
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The report displays the revenue of only those employees whose last names
begin with the letter B.

Filtering data based on dates

This filter is an attribute form qualification that enables you to filter data
based on an attribute with a date data type. For example, you can create a
date qualification on the Day attribute to return data for only those days
between January 1, 2011, and February 6, 2011.

Use the following procedure to create a date qualification filter. The example
after the procedure shows what happens to report data when the filter is
used on a report.

Cr eat ing a f i l t er based on dat es

This procedure creates a date qualification based on the example described
above. It uses the sample MicroStrategy Tutorial project.

To qualify on a date

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the attribute with the date data type
on which you want to qualify. Alternatively, type the name of the
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attribute in the Find f ield.

3. Right-click the attribute and select Add to Filter. You can also drag
and drop the attribute to the right pane.

For this Tutorial example, select the Day attribute.

The right pane displays fields similar to the image below:

4. Select Qualify.

5. From the first drop-down menu, select the form you want to filter data
based on.

For this Tutorial example, click the ID attribute form.

6. From the next drop-down menu, select the operator that describes how
you want to filter data.

7. For this Tutorial example, select Between.

8. In the last field, type the value(s) or click the calendar to select a date
to use to qualify on the attribute form. This is the value that will be
compared against the data in your data source.

If you are using a date range in your filter, click the calendar again to
select the second date. For example, if you want to filter data so the
report shows results between January 1, 2011 and February 6, 2011,
click the calendar and select January 1, 2011, then click the calendar
again and select February 6, 2011.

You can compare the form to a dynamic date, which is a fixed offset of
the current date, such as one month ago. For more information on
dynamic dates, see the Advanced Reporting Help.
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For this Tutorial example, use the drop-down list to select the date
range January 1, 2011 to February 6, 2011.

9. Click the Apply icon to create your filtering condition.

10. Click Save As.

11. For this Tutorial example, name the filter Date Filter and save it in the
My Objects Folder.

12. Click OK.

If you have multiple qualifications, be aware that it is possible to
unintentionally change the evaluation order of a filter's qualifications simply
by adding a new qualification and not looking at where the new qualification
is added in the list of qualifications. For information on changing the
evaluation order of qualifications, see Editing a filter, page 278.

The filter you created can now be added to reports. For steps, see Reports:
Adding a filter to a report, page 357.

If you followed the Tutorial example in the procedure above, you created the
Date Filter which excludes all data except the data gathered between
January 1, 2011 and February 6, 2011. Now see what happens to report data
when the filter is used on a report. Open the Basic Report from the Tutorial
project, located in Shared Reports\MicroStrategy Platform

Capabilities\Advanced Reporting Guide. The Basic Report, shown
in the image below, displays all employee revenue:
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Notice the revenue amount of Leanne Sawyer. Next, add your Date Filter. To
do this, from the Home menu click the Design icon. From the left pane,
navigate to where you saved your Date Filter, and drag the filter into the
report's fi lter pane. When you re-execute the report, it looks like the
following image:
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The report displays the revenues of employees for only the specified date
range. Notice the new revenue amount for Leanne Sawyer.

Filtering data based on attribute relationships or metrics: Set
qualifications
This type of filter allows you to generate data in a report based on a set of
attributes. The set of attributes is generated dynamically based on either the
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metrics associated with those attributes or the relationships between the
attributes.

For example, a metric set qualification might limit the data displayed on a
report to sales numbers for only those products whose current inventory
count falls below a certain number. The system must first generate the set of
products with the specified inventory count; then it can generate the sales
numbers for that set of products.

A relationship set qualification might limit the data displayed on a report to
those bank customers who have checking accounts but not savings
accounts. In this example, the system must first generate the set of
customers with checking accounts; then it can generate the subset of those
customers without savings accounts.

For details and steps, see:

Metric set qualification

A metric set qualification lets you define the attributes to be used in a filter
by restricting the attributes in the set based on the value, rank, or rank
percentage of a metric associated with the attributes. For example, a store
manager wants to see sales numbers for products whose current inventory
count falls below a certain level. A metric set qualification lets the manager
restrict data based on a set of attributes, in this case certain products,
based on a metric value, rank, or rank percentage, in this case, inventory
count below a certain level.

The resulting report displays the sales data for only those products with
inventory counts below the threshold value. This report does not necessarily
display the inventory figures for those products.

Fi l t er s and m et r ic calcu lat ions: Ou t pu t , Br eak By, and r ank

A metric set qualification is additionally defined by an output level and a
break by setting. The output level specifies the level at which the metric is
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calculated, and the break by setting allows you to choose the level at which
to restart counting rank or percent values for a metric. For more information
and examples on output level and break by, see the Advanced Reporting
Help. For an explanation of levels, see Components of a metric, page 205.

You can also designate a level at which to stop counting rank or percent
values for a metric and then restart the count. See the Advanced Reporting
Help for details and an example to use the BreakBy property in a metric set
qualification.

Cr eat ing a f i l t er based on m et r ic value or r ank

Use the following steps to create a simple metric set qualification. For more
details on any of the options, click Help.

To filter data based on a metric value, rank, or rank percentage

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the metric on which you want to filter
data. Alternatively, type the name of the metric in the Find f ield.

3. Right-click the metric and select Add to Filter. You can also drag and
drop the metric to the right pane.

The right pane displays fields similar to the image below:

4. From the first drop-down menu, select an operator that describes how
you want to filter data, such as Equal To or Less Than.

5. In the field on the right, type a metric value to use for the metric
qualification. This is the value against which the metric calculation will
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be compared.

6. Depending on the operator you selected from the previous drop-down
menu, you may need to type multiple values. For example, the operator
Between requires two values.

7. Click the Apply icon to create your filtering condition.

8. Click Save.

If you have multiple qualifications, be aware that it is possible to
unintentionally change the evaluation order of a filter's qualifications simply
by adding a new qualification and not looking at where the new qualification
is added in the list of qualifications. For information on changing the
evaluation order of qualifications, see Editing a filter, page 278.

The filter you created can now be added to a report. For steps, see Reports:
Adding a filter to a report, page 357.

Relationship set qualification

A report must list customers from the same region as a specific customer,
Hugh Abarca. You need to use the relationship between customer and
customer region to filter the report. A relationship set qualification lets you
restrict data based on the relationship between two attributes, in this case
Customer and Customer Region.

The image below shows a section of the report without the relationship set
qualification added. Notice that all customers are listed regardless of
customer region.
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In a relationship qualification, you create a relationship between two
attributes and then place a filter on that relationship. In this case, a
relationship between customer Hugh Abarca and Customer Region is
created and the report is fi ltered to show only customers in the same region
as Hugh Abarca.

Relationship filters are considered set qualifications because they create a
subset of attributes from the whole. They are created using either the Set
qualification or Advanced qualification option in the Filter Editor. The Set
qualification option provides an interface to guide you through the process,
whereas the Advanced qualification option allows you more control by letting
you use commands. For more information on the Advanced qualification
option, see the Advanced Reporting Help.

Fi l t er s and at t r ibu t es: Ou t pu t level

A relationship set qualification lets you determine the output level, which is
the level at which the set should be calculated. Using the example above, to
create a report that shows customers in the same region as Hugh Abarca,
you need to set the output level to Customer Region and the filter
qualification to Hugh Abarca.

For details on levels, see How data is aggregated on a report: metric level,
page 119. For more information on the output level, see the Advanced
Reporting Help
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Cr eat ing a f i l t er based on r elat ionsh ips bet ween at t r ibu t es

Use the following steps to create a simple relationship set qualification. For
more details on any of the options, click Help or see the Advanced Reporting
Help.

A filter based on relationships between attributes is created from
MicroStrategy Developer.

To create a filter based on relat ionships between attr ibutes

1. Log in to a project in Developer. On the File menu, point to New, and
choose Filter.

If the New Filter dialog box is displayed, click the Empty Filter icon. If
you do not want this dialog box to be shown in the future, select Don't
show this dialog in the future. Click OK. For more information about
Object templates, see the Designing Reports chapter of the Advanced
Reporting Help.

If you are using the MicroStrategy Tutorial to create the example
mentioned above, log in to the MicroStrategy Tutorial project. Create a
new report containing the Customer Region and Customer attributes,
and the Revenue metric. To create a new report in Developer, see the
MicroStrategy Developer Help.

2. Double-click the Filter definition pane at the top right.

3. Click the Add a Set qualification option, and click OK.

4. Select Relationship from the Type drop-down list. The Set
Qualification pane expands, similar to the image below:
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5. Set the output level, which is the level at which the set is calculated. To
do this, browse by clicking ... (the browse button) next to the Output
Level to locate the level at which you want the set calculated. Select
the attribute, and click OK. (For an explanation of levels, see How data
is aggregated on a report: metric level, page 119.)

If you are using the Tutorial, set the output level to Customer Region.

6. In the Filter Qualification area, choose a filter in one of the following
ways:

To use an existing filter, click Browse. In the Open dialog box, navigate
to the folder that contains the filter, select the filter, and click OK.

To build a new filter, click Create. The Qualification Editor opens. (You
may notice that this editor is similar to the Filter Editor.) When you are
finished, click Save and Close.

If you are using the Tutorial, create a filter with an attribute
qualification for Customer = Hugh Abarca.

7. By default, the Filter Qualification chosen applies to the whole report
and not just the relationship filter. You can change this option by
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clicking Advanced and clearing the Also apply this qualification
independently of the relationship filter box. For more information on
this option, see the Advanced Reporting Help

If you are using the MicroStrategy Tutorial, clear the default so the
Hugh Abarca filter is applied only to the relationship. Otherwise, when
the report is executed, the only row in the report will be Hugh Abarca,
with no other customers from his region included.

8. Click OK.

9. Click Save and Close.

If you have multiple qualifications, be aware that it is possible to
unintentionally change the evaluation order of a filter's qualifications simply
by adding a new qualification and not looking at where the new qualification
is added in the list of qualifications. For information on changing the
evaluation order of qualifications, see Editing a filter, page 278.

The filter you created can now be added to a report. If you are using the
MicroStrategy Tutorial, apply the filter to the report you created above. For
steps, see Reports: Adding a filter to a report, page 357.

Filtering data based on existing filters or report results:
Shortcut qualifications
You can use existing report results or existing filters as the basis of a new
filter. These types of filters are called shortcut qualifications, because you
are creating a shortcut to an existing report or to an existing filter. Details
and steps to create each type are below:

Shortcut-to-a-report qualification

The results of an existing report can be used as a filter for another report.
You can use the first report itself as a filter inside a new report. This type of
filter is called a shortcut-to-a-report qualification.
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To be used as a shortcut-to-a-report qualification, a report cannot contain
any of the following objects or be of any of the following report types:

l Consolidations

l Custom groups

l Freeform SQL reports: Reports created using MicroStrategy's Freeform
SQL functionality

l MDX cube reports: Reports that draw their data from an MDX cube source
such as SAP Business Intelligence Warehouse (SAP BW), Microsoft
Analysis Services (Analysis Services), or Hyperion Essbase (Essbase)

For example, consider the Basic Report shown below, which has no filter.
Notice that Leanne Sawyer has earned $2,411,912 in revenue.
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Create a new filter. Drag and drop the Revenue By Brand report into the
right pane of the new filter, and save. Open the Basic Report and drag and
drop your newly-created filter to the Report Filter pane, to use the Revenue
By Brand report as a filter in the Basic Report. Finally, re-execute the Basic
Report.
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With its new filter, the Basic Report displays the revenue generated by each
employee only for those brands specified in the results of the Revenue by
Brand report. The filtered Basic Report is shown below. Notice that Leanne
Sawyer has now earned only $1,655,540 in revenue.

You can perform the example above on your own. The Basic Report and the
Revenue By Brand report are located in Shared
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Reports\MicroStrategy Platform Capabilities\Advanced

Reporting Guide.

You can also use a report as a filter and then add additional qualifications to
expand the overall fi lter definition. For example, you can take the result set
of one report showing all customers in the Southwest region, place that
result set as a filter into a new report, and add a new filter qualification for
active customers in the current year. The new report displays all currently
active customers in the Southwest region.

This approach shows you the value of creating some basic, relatively simple
reports in your project, such as a report for customers in a specific region.
Then you can make use of these basic reports within shortcut-to-a-report
fi lters to make the filter creation process quicker.

Shor t cu t -t o -a-r epor t qual i f icat ion and OLAP Ser vices

If you have MicroStrategy OLAP Services, be aware that a report's view
definition does not affect how the report is used in a shortcut-to-a-report
qualification. A report's data definition is the query that is sent to the
database to retrieve information for the report, whereas the report's view
definition determines how much of the retrieved information is displayed in
the report. When you use a report as a filter, the report's entire data
definition is considered; any view definitions do not influence the filter
conditions.

For an introduction to MicroStrategy OLAP Services, see Determining
whether you have OLAP Services.

Cr eat ing a f i l t er based on t he r esu l t s o f a r epor t : Shor t cu t -t o -a-r epor t
qual i f icat ions

Use the following steps to create a simple shortcut-to-a-report qualification.
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To use a report as a filter in a shortcut-to-a-report qualificat ion

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the report that you want to use as a
filter. Alternatively, type the name of the report in the Find f ield.

3. Right-click the report and select Add to Filter. Alternatively, drag and
drop the report to the right pane.

You cannot use a report containing a consolidation or custom group, a
Freeform SQL report, or an MDX cube report as a shortcut to a report.

The report is added to the right pane as shown in the image below:

4. Click Save As, navigate to the folder where you want to save the filter,
type a Name and Description for the filter, and click OK.

The shortcut-to-a-report fi lter you created can now be added to a report. For
steps, see Reports: Adding a filter to a report, page 357.
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Shortcut-to-a-filter qualifications

A shortcut-to-a-filter qualification allows you to move an existing filter into a
new filter, and apply the new filter to a report. You can also add additional
conditions to the new filter and then apply the new filter to the report. For
example, Filter 1 contains two conditions, A and B. You can use Filter 1 as
the basis of a new filter, and then add another condition C to the new filter.
The data that is filtered for must then satisfy all three conditions A, B, and C
to be included in any report which uses the new filter. Note that Filter 1
remains unchanged throughout this process.

For example, you are a manager in New England, responsible for stores in
Boston, Providence, and Greenwich. Your project contains a filter called
Stores In My Region, which is defined as the Boston, Providence, and
Greenwich stores. A second filter, called the Women's Clothing f i lter,
includes the categories Blouses and Dresses. A third filter, All Days in
December 06, is a date range that includes all the days in the month of
December, 2006. To study December sales in your stores for women's
clothing, you create a new filter. The new filter includes a shortcut to each of
the three filters. Use this new filter in your report. The original three filters
are unchanged, which is useful for other reports that use one or more of
those filters.

You can also use an existing filter as a base for a new filter and then add
additional qualifications to expand the overall fi lter definition. For example,
you can take a filter that screens data for all customers in the Southwest
region, place that filter into a new filter, and add a new filter qualification for
active customers in the current year. The new filter screens data for all
currently active customers in the Southwest region.

This approach shows you the value of creating some basic, relatively simple
filters in your project, such as a filter for customers in a specific region.
Then you can make use of these basic filters within shortcut-to-a-filter fi lters
to make the filter creation process quicker.
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Cr eat ing a f i l t er based on anot her f i l t er

Use the following steps to create a simple shortcut-to-a-filter qualification.
For more details on any of the options, click Help.

To create a filter based on another filter

1. In MicroStrategy Web, on the Home page, click New Filter.

2. In the pane on the left, navigate to the filter that you want to use in the
new filter. Alternatively, type the name of the filter in the Find f ield.

3. Right-click the report and select Add to Filter. You can also drag and
drop the filter to the right pane.

The filter is added to the right pane as shown in the image below:

4. Add desired conditions to the filter. Navigate to the appropriate report
object in the pane on the left. Right-click and select Add to Filter.
Define the conditions in the right pane.
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5. Click Save As, navigate to the folder where you want to save the filter,
type a Name and Description for the filter, and click OK.

The filter you created can now be added to a report. For steps, see Reports:
Adding a filter to a report, page 357.

Joining filter qualifications with operators
When a filter has multiple qualifications, they are always joined by
operators. When qualifications are joined, operators govern the interaction
between different fi ltering conditions and thus affect the evaluation order of
qualifications in a filter.

Whenever you have more than one qualification in a report fi lter, you can
define the operator as any of the following:

l AND

l OR

l OR NOT

l AND NOT

The AND operator is the operator assigned by default when more than one
qualification is added to a filter. You can change the default AND operator
by simply clicking or right-clicking on the word AND, and selecting a
different operator.

For more information on advanced operators to apply to a report limit, see
Appendix B: Logical and Mathematical Operators for Filtering inthe
Advanced Reporting Help.

For more information on changing evaluation order among qualifications in a
filter, see Editing a filter, page 278.

The AND operator

By default, the operator AND is inserted between filter qualifications.
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The following images show the initial report with no filter, and the resulting
report after two filter qualifications are applied and joined with AND. The
initial report with no filter appears as follows:

After the filter (Year = 2010) And (Region = Northeast) is applied to the
initial report, the report appears as follows:

The following diagram shows the impact of the AND operator on a result set:
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The shaded area represents the report's result set, which contains only
revenue generated in the Northeast in 2010.

The OR operator

For those familiar with logic terminology, the OR operator acts as an
inclusive OR, not an exclusive OR.

The following images show the initial report with no filter, and the resulting
report after two filter qualifications are applied and joined with OR. The
initial report with no filter appears as follows:
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After the filter (Year = 2010) Or (Region = Northeast) is applied, the report
appears as follows:
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The following diagram shows the impact of the OR operator on a result set:

As represented by the shaded areas, revenue generated in either 2010, or
the Northeast, or in both 2010 and the Northeast, is returned in the result
set.

The OR NOT operator

The following images show the initial report with no filter, and the resulting
report after two filter qualifications are applied and joined with OR NOT. The
initial report with no filter appears as follows:
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After the filter (Year = 2010) Or Not (Region = Northeast) is applied, the
report appears as follows:
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The following diagram shows the impact of the OR NOT operator on a result
set.
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In this case, revenue generated in 2010 in any region (including the
Northeast), or revenue generated in all other years in any region except for
the Northeast, is returned in the result set.

The AND NOT operator

The following images show the initial report with no filter, and the resulting
report after two filter qualifications are applied and joined with AND NOT.
The initial report with no filter appears as follows:

After the filter (Year = 2010) And Not(Region = Northeast) is applied, the
report appears as follows:
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The following diagram shows the impact of the AND NOT operator on a
result set.

As shown by the shaded area, revenue generated in 2010 in any region
except the Northeast is returned in the result set.

Changing the operator which joins filter qualifications

The following steps show how to change the operator that joins filter
qualifications.

Changing the operator can affect the evaluation order among qualifications
in a filter. For more information on changing evaluation order among
qualifications in a filter, see Editing a filter, page 278.
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To change the operator between filter qualificat ions

1. In MicroStrategy Web, on the Home page, click New Filter.

2. From the pane on the left, add more than one qualification to the pane
on the right. For steps to create filter qualifications, see Creating or
editing filters: The Filter Editor, page 234.

3. In the right pane, right-click the operator and then choose the required
operator, as shown in the image below:

Asking for user input into a filter's definition
You can allow the user who executes the report that contains the filter, to
decide for himself certain aspects of the filter's definition. This lets each
individual user define the report results he sees. To do this, you include a
prompt in the filter's definition. You can make use of prompts in any filter
where you want to let each user impact the results of the filter, by having the
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user enter a specific number, date, or text that makes sense for that user.
For examples of prompts, see Asking for user input: Prompts, page 280.

To add a prompt to your filter's definition, use the following high-level steps:

1. Decide what prompt type you need for your filter. Prompt types that you
can use in a filter's definition are listed in the table in Reports: Adding
prompts to a report, metric, or fi lter, page 362.

2. Follow the steps in this chapter to create that prompt; for the
appropriate procedure, see Creating a prompt, page 291.

3. Then follow the steps in this chapter to add the prompt to your filter's
definition; see Reports: Adding prompts to a report, metric, or fi lter,
page 362.

Editing a filter
You can make changes to an existing filter using the Filter Editor. For an
image of the Filter Editor and more information on working with filters, see
Creating or editing filters: The Filter Editor, page 234.

When you edit a filter, you can add a new qualification, change the operator
in a qualification, or remove a qualification that is part of the filter's
definition. You can also change the evaluation order of qualifications.

l To add qualifications, see Types of filters, page 235 to determine the type
of qualification you want to add, then use the appropriate section for the
type of filter you choose.

l To change operators between qualifications, see Joining filter
qualifications with operators, page 268.

l To remove a qualification from a filter, open the filter, click the Remove
condition icon to the left of the qualification you want to delete.

l To change the evaluation order of qualifications in a filter, see the options
below.
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Changing the evaluation order of qualifications in a filter

Qualifications at the top of a filter are evaluated first. To change the
evaluation order, you can perform a number of steps depending on the final
evaluation order that you want to achieve:

l You can move qualifications up and down in the order so that they are
evaluated before or after other qualifications. Qualifications must be
indented at the same level to be able to move them above or below one
another. To do this, in MicroStrategy Web click Shift Up or Shift Down
next to the qualification. The qualification is moved up or down
accordingly.

l You can group qualifications so that they are evaluated together. The filter
must contain at least 3 qualifications to be able to group qualifications. To
do this, in MicroStrategy Web click Shift Left or Shift Right between 2
qualifications that you want to group together. The qualifications are
grouped together and moved together either to the right (indented) or to
the left.

l When you add or remove a qualification, you are changing the evaluation
order. To add qualifications, see Types of filters, page 235 to determine
the type of qualification you want to add, then use the appropriate section
for the type of filter you choose. To remove a qualification from a filter,
open the filter, and click the Remove condition icon to the left of the
qualification you want to delete.

l When you change an operator between qualifications, you may be
changing the evaluation order of qualifications. For steps to change
operators between qualifications, see Joining filter qualifications with
operators, page 268.

Additional filtering functionality
The Advanced Reporting Help provides detailed information about the
following advanced features:
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l Attribute-to-attribute qualifications: Learn about creating reports that
compare two attributes, using their respective attribute forms.

l Dynamic dates: Learn how to filter on fixed offsets of the current date.

l Break by property for set qualification filters: Learn about the level at
which to restart counting rank or percent values for a metric.

l Metric-to-metric comparisons: Learn how to create a filter that dynamically
compares the values of two metrics.

l Output levels for set qualification filters: Learn how to specify the level at
which the metric is calculated for a set qualification.

l Custom expressions: Learn about creating custom metric expressions to
fit particular needs.

l Joint element lists: Learn about using attribute elements from different
attributes to filter the report result set.

l Imported filter elements: Learn how lists of data from existing files can be
imported into the filter definition.

l Report object prompts: Learn how to have the results of one report be
included in a prompt, and how to specify a search object or specify a
predefined list of objects to choose from during report execution.

Asking for user input: Prompts

A prompt is a question the system presents to a user during report
execution. How the user answers the question determines what data is
displayed on the report when it is returned from your data source.

For example, an analyst in an accounting company needs a report designed
to show actual revenue and forecasted revenue for his company's clients.
However, the analyst does not want to see data for every corporation his
company does business with; he is only interested in seeing revenue and
forecasts for certain corporations and only for the current year.

The report designer can create one prompt that asks users to select which
corporations they want to see data for, and another prompt that asks users
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what year they want to see data for. The report designer places the prompts
on a report. When the analyst executes the report, he is prompted to answer
these questions before the report's SQL query is sent to the data source,
and as a result the report displays revenue and forecast numbers for only
those corporations and the year that this analyst is interested in seeing.

A report designer can include one or more prompts in any report. Prompts
are an effective tool for the report designer, because:

l Prompts allow each user who executes the report to request individualized
sets of data from your data source when he answers the prompts and runs
the report. Effectively, each user creates his own filter for the report.

l Prompts can allow the report designer to create a smaller number of
reports overall, using more inclusive objects, rather than having to create
numerous, more specific reports that are individualized to each analyst.

l Prompts allow the report designer to ensure that the objects on a report
are the latest available objects in the project. This is possible using a
search object in a prompt. When a user launches a prompt by running a
report, the search object goes through the project and retrieves the latest
objects that fit the search criteria the report designer defined. Thus, no
matter when the prompt was created, each time a user executes the
report, the user chooses prompt answers from a list of the most up-to-date
objects available in the project, including objects that may not have
existed when the prompt was created.

l Prompts allow users to keep the objects on their saved reports up-to-date,
because users can save a prompted report so that the objects within the
prompt remain connected to the original objects within the project that
they were originally based on when the prompt was created. If objects are
modified or deleted in the project, the report can reflect those changes the
next time the prompted report is run.

With prompts, you can let the user decide how to restrict the data to be
returned from the data source.
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For information on using prompts in a report to be displayed on an Apple®
iPhone® or iPad®, or an Android device, see the MicroStrategy Mobile
Administration Help.

A prompt is similar to a filter (see Filtering data on a report: Filters, page
232) because a prompt determines the specific data to be displayed on a
report. The difference, from a report designer's perspective, is that you
create a filter for a report to provide a single, specific definition for the
report. A filtered report then displays the same set of data to every user who
executes that report. In contrast, a prompt dynamically modifies the contents
of a report. With prompts, users can determine the objects (attributes,
attribute elements, metrics, and so on) they want to be part of, or excluded
from, the report query that is sent to the data source. Therefore, a prompt
can be seen as a way for users to create their own filter for a given report.
For example:

l Users can choose from among several existing filters to determine exactly
what filter will screen the data on the report they are about to execute. To
achieve this, create an Object prompt that contains existing filters and
place that Object prompt on a report. Then the user can choose which filter
to apply to the report.

l Prompts allow a report to have a dynamic report definition, which users
can change each time they submit the query by choosing different answers
when prompted. If you create an Attribute prompt containing the Year
attribute, users are prompted to select the year for which they want the
report results. The report can be run the first time by selecting 2005 and
then a second time by selecting 2006.

Prompts and security filters
Security filters in MicroStrategy restrict a user's ability to access or view
certain objects within a given MicroStrategy project. As a result, a security
filter can limit the data a user sees on a report, even if the report is designed
to display a broader set of data. For example, a report shows revenue data
for all geographical regions of the U.S., but a set of users may have a
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security filter assigned to their MicroStrategy user accounts that limits the
display of data to only the Northeast region.

For prompts, this means that users who have a security filter assigned to
them may only see certain prompt answers to choose from when they
execute a prompted report, even when the prompt creator has explicitly
defined a broader set of prompt answers to be available to users of that
report.

When describing what prompt answers will be available to users, this manual
assumes that no security filter restricts an individual user's access to certain
objects or object elements. However, most environments use security filters,
so it is important to be aware of the potential impact of a security filter on a
user's experience when answering a prompt. Consider this possibility when
designing a specific prompt for your users' reporting needs.

For details on security filters, see the System Administration Help.

Components of a prompt
The pieces that make up a prompt control how a prompt appears and how it
functions. These components include the following:

l Answer requirement: This component lets you determine whether users
will be required to answer the prompt or an answer will be optional. If an
answer is required, a report with this prompt cannot be executed until an
answer is provided.

Keep in mind that, because a report with a required prompt cannot be
executed until an answer is provided, a report with this type of prompt is not
a good choice to be subscribed to. This is because the subscription will be
unable to answer the required prompt and thus unable to execute the report.
The subscription is then automatically invalidated and deleted. To avoid this
scenario, always add a default prompt answer when you make an answer
required.
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l Default prompt answers: This component lets you include a pre-selected
answer for the prompt, which the user can then accept, replace with a
different answer, or accept and add more answers.

l Personal answers: This component lets a user save prompt answers for a
specific prompt, and then reuse the answers on any report that uses the
prompt. Personal answers are saved for each prompt and each user, but
they can be used on different reports. Allowing users to save personal
answers can help reduce the storage space taken up by saved static
reports.

l Title and instructions: This component lets you provide a useful name for
the prompt, which can significantly impact how straightforward or complex
a user finds prompts to be. You can also include instructions on how to
use the prompt.

Consider your users' needs as well as the purpose of the report and the
objects on it when you decide on these options.

These prompt components are defined from the Create Prompt page. See
Creating a prompt, page 291 for steps to access the Create Prompt page.
Each prompt component is described below.

If you plan to apply a schedule to a prompted report, the decisions you make
about answer requirements and default answers will affect how the report is
fi ltered when it is automatically executed on schedule. For a table showing
how various combinations of these options affect how a scheduled report is
fi ltered when executed, see the Advanced Prompts chapter in the Advanced
Reporting Help.

Answer requirements

You can either require users to answer a prompt when they execute a report,
or you can make an answer optional.

l Required: A required prompt means at least one prompt answer must be
selected from the available choices, or the report cannot be executed.
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l Optional: An optional prompt does not require a prompt answer to be
selected. The report can be executed without any input from the user.

If you determine that a prompt must be answered, consider also providing a
default answer. Default answers allow users to execute prompted reports
quickly because they can simply accept the defaults. Default answers are
especially useful if you have a large number of users of a given report who
will l ikely choose the same answer for the prompt. See Answer
requirements, page 284.

To specify whether an answer is required or optional, select the Prompt
answer is required check box on the New Prompt page. See the
appropriate procedure below for the type of prompt you want to create, for
steps to select this setting when creating a prompt.

Default prompt answers

You can specify default answers for prompts. Users can then do one of the
following:

l Execute the report using the default answer(s)

l Select a different answer

l Keep the default answer and add additional answers

Providing default answers allows users to execute prompted reports more
quickly, because they can simply accept the defaults with a single click and
run the report. Default answers are particularly useful if a large percentage
of your users will answer the prompt the same way. A common example is a
prompt on the Year attribute, from which users can choose the attribute
element (for example, 1998, 2005, or 2006) they want to see data for. If
many users will choose the current year every time they run the report, then
providing the current year as the default answer can save users time.
Additional scenarios where default prompt answers can be useful:

l If a user subscribes to a report. This is common for mobile users. When
the subscription is delivered to a user's mobile device, the prompts are
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answered automatically using the default answers defined by the designer.
So, the mobile user can simply open his device and view the executed
report.

l If a report is being used as the destination of a link in a widget, document,
or report (the source of the link). When the user clicks the link to a report
from the source, the default answer defined by the designer allows the link
to directly open the destination report without requiring the user to answer
prompts before they can see the report.

If default answers are not provided for prompts, users must take the time to
answer each prompt question individually, unless answers are not required.
The default prompt answer is always displayed when a value prompt is used,
even if the default prompt answer was cleared and then the report is
reprompted.

You can determine whether to have prompts in a report automatically
answered when the report is run, using default prompt answers.

To specify a default prompt answer

1. In MicroStrategy Web, create a prompted report. For steps to include a
prompt on a report, see Reports: Adding prompts to a report, metric, or
fi lter, page 362.

2. From the toolbar, select Run Report.

3. Select the answer that you want to save as the default prompt answer
and click Run Report to execute the report.

4. Click Save.

This sets the prompt answers that you selected while answering the
prompted report, as the default prompt answers to be used the next time the
report is run.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 287

Personal answers

You can allow personal answers, so that a user can save prompt answers for
a specific prompt, and then reuse the answers on any report that the prompt
is used on.

Personal answers can save time, for example, when a prompt answer
involves complicated metric qualifications. Allowing users to save personal
answers can help reduce the storage space taken up by saved static reports.
Personal answers also provide consistency, to ensure that the same prompt
answers are used across a number of reports.

Personal answers are saved for each prompt and each user, but they can be
used on different reports. Users can save prompt answers without having to
save the report itself.

When you create a prompt, you can allow no, one, or multiple personal
answers:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l One: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

In MicroStrategy Web, while creating a prompt, you can allow personal
answers for the prompt, if the administrator has enabled personal answers
in the default settings for prompts. An administrator can change this default
setting for prompts from the Preferences Menu.
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Examples of each option follow. While they are simple examples, they
illustrate how the different types of personal answers work.

Exam p le: No per sonal answer s

Create an attribute element list prompt (see Filtering data on an attribute,
attribute form, attribute element, or metric: Qualification Prompts, page 298
for steps) on Region, and do not allow personal answers (select None for
the Personal answers allowed option). Name the prompt No personal
answers.

Create a report with Region, the Revenue metric, and the No personal
answers prompt. Execute the report, and select Northeast, Mid-Atlantic, and
Southeast at the prompt. Save the report as a prompted report rather than a
static one (select the Keep report prompted check box in the Save As
dialog box; for more information see Saving reports with prompts, page
165).

Re-execute the report. You are not able to select a saved personal answer
from your previous report execution, but instead you must enter your prompt
answers again.

Exam p le: Single per sonal answer

Create an attribute element list prompt on Region, and allow a single
personal answer. Name the prompt Single personal answer.

Create a report with Region, the Revenue metric, and the Single personal
answer prompt. Execute the report and select Northeast, Mid-Atlantic, and
Southeast at the prompt. Select the Remember this answer check box,
which saves your selections as a personal answer. Save the report as a
prompted report.

It is not required to save a report in order to save the personal answer.
However, save the report for this example.
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Re-execute the report. Northeast, Mid-Atlantic, and Southeast are displayed
automatically as the default answer. You can continue executing the report
or change the prompt selections by adding or deleting regions. Delete all the
regions from the prompt answers, and replace them with Southeast,
Southwest, and South. Do not clear the Remember this answer check box.
These regions are now saved as the personal answer.

Re-execute the report. Southeast, Southwest, and South are displayed
automatically as the default answer. Delete all the regions from the prompt
answers, and replace them with just Central. Clear the Remember this
answer check box. The personal answer is now cleared.

Re-execute the report. Since no personal answer exists, no prompt answers
are displayed. You must enter your prompt answers manually.

Exam p le: M u l t ip le per sonal answer s

Create an attribute qualification prompt on Region, and allow multiple
personal answers.

Create a report with Region, the Revenue metric, and the prompt that you
created above. Execute the report, and select Northeast, Mid-Atlantic, and
Southeast at the prompt. Save the prompt answer (select the Save this
answer when report is run check box), naming it Eastern Regions. Save
the report as a prompted report.

It is not required to save a report in order to save the personal answer.
However, save the report for this example.

Re-execute the report. No default prompt answers are displayed, but you
can select Eastern Regions, the personal answer that you created
previously, by clicking the Load Answers icon. Instead, select Southeast,
Southwest, and South for prompt answers. Save them as a personal answer,
naming it Southern Regions. Set this personal answer as the default (select
the Set as default check box).
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Re-execute the report. Southeast, Southwest, and South are displayed as
the default prompt answers, since they were defined as the default above.
Clear the prompt answers, and replace them with Central. Do not save it as
a personal answer.

Re-execute the report. Southeast, Southwest, and South are displayed as
the prompt answers, since they are stil l the default. You can select Eastern
Regions or Southern Regions (the current selection) as personal answers.

When you click Load Answers, you can view the personal answers created
previously. You can delete and rename these personal prompt answers by
clicking the More Options l ink. You cannot edit the contents of personal
answers.

Title and instructions

You can customize a prompt's tit le and instructions, which are displayed to
users when they are answering the prompt.

Think about a name and instructions carefully, with your users in mind. The
title and instructions you provide for a prompt can make the difference
between users finding prompted report execution confusing and users
completing rapid report execution and displaying exactly the data they want
to see.

Exam p le o f an inef f ect ive p r om pt t i t le and inst r uct ions

You create an Attribute Element prompt. You select the Year attribute, from
which the user will be asked to select one or more attribute elements (years)
to see data displayed for. You name this prompt "Attribute element prompt"
and you provide the following instructions: "Choose an attribute element."

This tit le and instructions are not useful to the majority of users, who likely
do not know what an attribute element is. A better choice is described below.
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Exam p le o f a usefu l p r om pt t i t le and inst r uct ions

You create an Attribute Element prompt. You select the Year attribute, from
which the user will be asked to select one or more attribute elements (years)
to see data displayed for. You name this prompt "Year(s)" and you provide
the following instructions: "Select one or more years for which you want to
see data."

This tit le makes sense to all users and defines the prompt generally enough
so it can be easily used by report designers on other reports. The
instructions are useful not only because it uses language that users will
understand, but also because it is more than just a repeat of the title. It
provides basic information to the user who may never have used a prompt
before, and it emphasizes that more than one year can be chosen, in case a
user missed that information at the top of the prompt screen.

You can determine the title and instructions for a prompt on the New Prompt
page. See the appropriate procedure below for the type of prompt you want
to create, for steps to enter a title and instructions when creating a prompt.

Creating a prompt
You create a prompt for a report when you want to let the user decide what
restrictions the data must meet to be displayed on the report.

Prompts can be placed on a report, and they then become part of the report
definition. They can also be used in a filter, metric, or custom group.

This chapter covers prompts placed on reports, fi lters, and metrics. Prompts
used on custom groups are covered in the Advanced Prompts chapter of the
Advanced Reporting Help.

The image below shows the Create Prompt page, where you select the type
of prompt you want to create. See Types of prompts, page 292 for details on
each prompt type.
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To access the Create Prompt page

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. To create a new prompt, click on the type of prompt that you want to
create.

After you create a prompt, you then place the prompt on any report so it
becomes part of the report's definition and any user who executes that
report must interact with the prompt. For steps to include a prompt on a
report, see Adding a prompt to a report.

Types of prompts
The correct prompt type to create depends on what report objects you want
users to be able to base a filter on to filter data.
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Prompt Type Prompt Name What Data it Allows Users to Define

Object prompts

This type of prompt
allows users to select
objects to include in a
report, such as
attributes, metrics, or
filters.

Object prompt

Users can use this prompt to add more data to a
report. Users select objects (such as attributes
or metrics) they want to add to the report. Users
can also choose from among a selection of
filters, to apply a filter that is most useful for their
analysis purposes.

For steps, see Filtering data based on metrics,
attributes, or other objects: Object prompts, page
329.

Hierarchy Qualification
Prompts

This type of prompt
allows users to
determine how the
report's data is
filtered based on
attributes in a
hierarchy.

Hierarchy
Qualification
Prompt

Users can select prompt answers from one or
more attribute elements from one or more
attributes. The attribute elements they select are
used to filter data displayed on the report. This
prompt lets you give users the largest number of
attribute elements to choose from when they
answer the prompt to define their fi ltering criteria.

For example, on a report displaying profit
forecasts, if the prompt lets users select from the
Product hierarchy, one user might choose to see
forecasts for certain electronic products, while
another user might select different electronics
products, or all media products.

For steps, see Filtering data on an attribute,
attribute form, attribute element, or
metric: Qualification Prompts, page 298.

Attribute Qualification
Prompts

This type of prompt
allows users to
determine how the
report's data is
filtered based on
attribute form.

Attribute
Qualification
Prompt

Users can select prompt answers from a list of
attribute elements from a single attribute. This
prompt is more restrictive than the Hierarchy
prompt, because the user has fewer attribute
elements to select answers from.

For steps, see Filtering data on an attribute,
attribute form, attribute element, or
metric: Qualification Prompts, page 298.
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Prompt Type Prompt Name What Data it Allows Users to Define

Attribute Element List
Prompts

This type of prompt
allows users to
determine how the
report's data is
filtered based on
attribute element.

Attribute
Element List
Prompt

Users can select prompt answers from a limited
list of specific attribute elements. This prompt is
the most restrictive of the Hierarchy
Qualification, Attribute Qualification, and
Attribute Element List prompts, because the user
has the fewest number of attribute elements to
select answers from.

For steps, see Filtering data on an attribute,
attribute form, attribute element, or
metric: Qualification Prompts, page 298.

Metric Qualification
Prompts

This type of prompt
allows users to
determine how the
report's data is
filtered based on
metrics.

Metric
Qualification
Prompt

Users can define a metric qualification, which
determines what data should be displayed for
one or more specific metrics on the report.

For steps, see Filtering data on an attribute,
attribute form, attribute element, or
metric: Qualification Prompts, page 298.

Value prompts

This prompt type lets
users select a single
value, such as a date
or a specific text
string, and filter
report data based on
their selection.

For steps, see
Filtering data based
on a single value or
string: Value prompts,
page 335.

Date prompt
Users enter a specific date for which to see data.
This prompt is used in a filter.

Numeric
prompt

Users enter a specific number, up to 15 digits,
which is then used as part of a filter, or within a
metric, to look for specific numeric data.

If a user enters more than 15 digits for a numeric
prompt, the data is converted to scientific
notation. If precision is needed beyond 15 digits,
you should use a Big Decimal value prompt
instead.

Text prompt
Users enter a word or phrase, which is then used
as part of a filter to look for specific data with that
text.
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Prompt Type Prompt Name What Data it Allows Users to Define

Big Decimal
prompt

Users can enter up to 38 digits, to search for
numeric data with the Big Decimal data type
assigned to it.

Long prompt
Users enter up to 10 digits, to search for numeric
data.

Level prompts

This prompt type
allows users to
specify the level of
calculation for a
metric.

Level prompt

Levels are explained in Components of a metric,
page 205.

Level prompts are covered in the Advanced
Prompts chapter of the Advanced Reporting
Help.

Most of the prompt types in the table above are explained in detail in the
sections that follow. Level prompts are covered in the Advanced Prompts
chapter of the Advanced Reporting Help.

Choosing the right prompt type

Use the table below as a reference when choosing which prompt to create,
to help you provide the reporting results that your users need.

User Needs Solutions

Restrict the
amount of
data
displayed on
a report

Prompts used on filters in a report are more restrictive than other prompts
in terms of the number of attribute elements from which a user can select
prompt answers. For details on prompts used on a filter, see Filtering data
on an attribute, attribute form, attribute element, or metric: Qualification
Prompts, page 298.

Increase the
amount of
data

• Object prompts are more inclusive in terms of the data that is displayed
on the resulting report, because the user can select additional objects to
include on the report. To create an Object prompt, see Filtering data
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User Needs Solutions

displayed on
a report

based on metrics, attributes, or other objects: Object prompts, page
329.

• In general, the more answers an analyst is allowed to select for a
prompt, the more information is displayed on the report. The maximum
number of answers a user can provide is determined by one component
of all prompts, called an answer requirement. You can allow users to
select more answers for a prompt by setting or changing the maximum
number of answers. For details, see Components of a prompt, page 283.

Answer
prompts that
are easier to
use

• The Attribute Element List prompt and the Object prompt are generally
the simplest prompts for a user to answer. Users simply click one or
more objects they want to see data for and execute the report. The user
does not have to create a filtering definition as with other prompts.

• Any prompt increases the complexity for a user when running a report.
This can be alleviated by providing good descriptions for the prompts so
that users are clear about the questions they are answering. For an
example of an effective prompt description, see Components of a
prompt, page 283.

Choose a
report fi lter
from among a
selection of
filters

Users can choose from among several existing filters to determine exactly
what filter will screen the data on the report they are about to execute. To
do this, create the filters you want users to be able to choose from, then
create an Object prompt made up of existing filters, and then place that
Object prompt on a report. To create an Object prompt, see Filtering data
based on metrics, attributes, or other objects: Object prompts, page 329.

Select a
prompt
answer from
the most up-
to-date
objects in the
project

You can use a search object in most prompts. A search object will search
for and display specific objects at the moment the user accesses the report
and the prompt appears. This lets users select their answers from the most
up-to-date hierarchies, attributes, metrics, or other objects in the project.
To do this, create a search object, then during prompt creation choose the
search object rather than choosing specific attributes or other objects to
prompt the user with. For steps to create a search object, see the prompt
creation procedure below for the prompt you want to create. Steps to
create a search object are within the prompt creation steps.
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User Needs Solutions

Restrict the
number of
attribute
elements
users can
choose from
when
answering a
prompt

The three Hierarchy and Attribute prompts are designed to be increasingly
restrictive in the number of objects they allow users to select answers
from. These three prompts are listed below, in increasing order of
restrictiveness:

• Hierarchy Qualification Prompt: Allows users the widest number of
objects to choose answers from.

• Attribute Qualification Prompt: More restrictive than the Hierarchy
prompt. Allows fewer objects for users to choose answers from.

• Attribute Element List Prompt: The most restrictive of the three prompts.
Allows the fewest objects for users to choose answers from.

Select from a
reasonable
subset of a
long list of
attribute
elements, for
example, a
list of
customer
names

The Attribute Element List prompt provides a filter option. You can use this
option to create a filter that will display to users a specific list of attribute
elements, based on the condition defined in the filter. For example, you
create a filter to display the top 20 customers in terms of revenue or the
top 10 employees in terms of sales. Place this filter in the Attribute
Element prompt, and place the prompt on a report. To create an Attribute
Element prompt, see Filtering data on an attribute, attribute form, attribute
element, or metric: Qualification Prompts, page 298.

Stand-alone prompt vs. prompt as part of report or fi lter

This chapter primarily describes how to create stand-alone prompts. A
stand-alone prompt is a prompt that is created as an independent
MicroStrategy object. A stand-alone prompt can then be used on many
different reports, as well as on filters, metrics, and other objects, and can be
used by other report designers. A stand-alone prompt gives report designers
flexibil ity.

However, in MicroStrategy, prompts can also be created as an intrinsic part
of a given report, at the same time the report itself is being created. Prompts
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created as part of a report are saved with the report's definition. Therefore,
a prompt created as part of a report cannot be used on any other report.

Prompts can also be created as an intrinsic part of a filter, at the same time
the filter itself is being created. Prompts created as part of a filter are saved
with the filter's definition. Therefore, a prompt created as part of a filter
cannot be used on any other filter.

No matter how a prompt is created, whether stand-alone or as part of
another object, each approach allows you to create most prompt types
described in this chapter. Both stand-alone prompts and prompts created as
part of another object accomplish the same results: the user is presented
with one or more questions to answer, and the answers determine the data
used when calculating the results displayed on a report.

Filtering data on an attribute, attribute form, attribute element,
or metric: Qualification Prompts
These types of prompts let users define the filtering criteria for a report.
While answering the prompt, the user actually goes through the process of
creating a filter for the report. You create the prompt to define constraints
for which objects can be used to create the filter. Filtering criteria might
include certain attributes in a hierarchy, specific attribute forms or attribute
elements, or certain metrics.

For example, if you create a Hierarchy Qualification prompt, you can specify
a hierarchy from which users can select attributes or attribute elements to
create a filter with. (The option to create this prompt in the Create Prompt
page is called "Hierarchy Qualification Prompt".) Users are presented with a
prompt similar to the following image when they execute the report:
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When creating the prompt shown above, the report designer chose the Time
hierarchy, so users could choose any attribute within that hierarchy for
which to see data. The prompt shown above is asking the user to select from
the attributes listed, or the user can also browse to a specific attribute's
elements and select one or more of those elements. Then the user drags a
desired attribute or element into the filter's Definition pane on the right-hand
side. (Alternatively, the user can use the Attribute Qualification pane to
select an attribute for the filter.) By being able to interact with this prompt,
each user can create his own filter with which to screen the data that
appears on the resulting report.

You can add these types of prompts to a stand-alone filter, so that the
prompt is presented to any users who run a report on which that filter is
placed. Alternatively, you can place these types of prompts directly on a
report. Either way, these types of prompts allow users to specify conditions
that data must meet to be included in report results.
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For a table of where to use all prompts, see Reports: Adding prompts to a
report, metric, or fi lter, page 362.

You can create the following types of prompts:

l Hierarchy Qualification Prompt: This prompt lets the user create a filter
by selecting from any attribute or attribute element that is part of one or
more hierarchies you specify. The attribute elements the user selects then
become the filter for the report when it is sent to your data source. To
create a Hierarchy Qualification prompt, see Filtering data on an attribute,
attribute form, attribute element, or metric: Qualification Prompts, page
298.

l Attribute Qualification prompt: This prompt enables the user to filter (or
qualify) the report based on the attribute forms or the attribute elements of
the specified attribute. To create an Attribute Qualification prompt, see
Filtering data on an attribute, attribute form, attribute element, or
metric: Qualification Prompts, page 298.

l Attribute Element List prompt: This prompt enables the user to filter the
report based on a specified set of attribute elements from a given
attribute. To create an Attribute Element List prompt, see Filtering data on
an attribute, attribute form, attribute element, or metric: Qualification
Prompts, page 298.

l Metric Qualification prompt: This type of prompt enables the user to
filter (or qualify) the report based on a specific metric. To create a Metric
Qualification prompt, see Filtering data on an attribute, attribute form,
attribute element, or metric: Qualification Prompts, page 298.

After you have created a prompt, you can incorporate it into a report as
described in Reports: Adding prompts to a report, metric, or fi lter, page 362.

Hierarchy Qualification prompts

The Hierarchy Qualification prompt allows users to create their own report
fi lter using attributes and attribute elements from:
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l A specific hierarchy

l Specific hierarchies returned by a search object

l All hierarchies in the project

For an explanation of what a hierarchy is, see Hierarchies, page 117.

For example, analysts want to be able to monitor the aging of various
accounts receivable transactions by customer. You create a report with the
Customer attribute and various Accounts Receivable-related metrics on it.
(The report and its metrics are shown below.) You want users to be able to
select any corporations or parent corporations to view past-due amounts for,
when they execute the report.

You create a Hierarchy Qualification prompt which asks the user to choose
an attribute or attribute elements from the Organization hierarchy. Then you
add the Hierarchy Qualification prompt to the report.

When you execute the report and respond to the prompt by choosing the
Global Enterprises HQ corporation, the report appears as shown in the
following image. (This image shows only part of the resulting report.)

The Hierarchy Qualification prompt allows users to select from the widest
number of attribute elements when they are choosing prompt answers to
define their fi ltering criteria. The Attribute Qualification prompt is more
restrictive, and the Attribute Element List prompt is the most restrictive,
allowing users to choose from the fewest number of attribute elements to
define their fi lter criteria.
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To create a Hierarchy Qualificat ion prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Hierarchy Qualification Prompt.

To select the hierarchy

Select the hierarchy which contains the attributes the user will be prompted
to choose from as he creates the filter for the report.

On the Definition tab, choose one of the following options and, as
necessary, specify the required information for your chosen option:

l All hierarchies: Select this option to let the user choose attributes from
all the hierarchies in the project.

l Choose a hierarchy: Select this option to present the user with a specific
hierarchy from which to choose attributes and elements.

l Click Select Hierarchy, select the hierarchy or specify the name of the
hierarchy, and then click OK.

l Use a predefined list of hierarchies: Select this option to allow the user
to choose attributes from a list of hierarchies that you select.

l To add hierarchies, click Add, select the hierarchy or specify the name of
the hierarchy, and then click OK.

l To delete a hierarchy from the list, highlight it and click Remove.

l To remove all the hierarchies from the list, click Clear.

l Use the result of a search object: Select this option to browse to and
select a previously created search object or specify the name of the
search object. A search object will search for and display specific project
objects when the user executes the report. This lets you prompt the user
with the most up-to-date objects in the project.
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l Click Select Search, select the search object or specify the name of the
object, and then click OK.

To determine the attribute forms which are displayed to the user

Once users select a hierarchy, the prompt displays the related attributes
and attribute elements for users to select their fi lter criteria from. The
attribute forms can also be displayed.

An attribute form is a descriptive aspect of an attribute. Most attributes
have at least two forms, ID and description (Desc). For example, the
Product attribute has an attribute form called ID, which is made up of ID
numbers that represent each attribute element (each product). The
attribute form Last Name contains the last names for each attribute
element, such as each customer in the Customer attribute, or each
employee in the Employee attribute. Your project designer determines
which attribute forms users see directly in a report's results (the report
display forms), and which attribute forms users can see displayed in the
Object Browser, for browsing purposes (the browse forms). You can
select which of these display types users can select from when they
answer the prompt.

From the Displayed forms drop-down list, select one of the following
options:

l All attribute forms: This option allows users to see and select from
attribute elements within all attribute forms. It is the default choice.

l Browse forms: This option allows users to see and select from only the
attribute forms defined as browse forms. All attribute forms defined as
browse forms are displayed in the Data Explorer when the user browses
the related attribute.

l Report display forms: This option lets users see only the attribute forms
defined as report display forms. All attribute forms defined as report
display forms are included in report results for a report that uses the
related attribute.
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l Custom display forms: This option allows you to specify a customized
set of attribute forms to display to users by selecting each attribute form
from a list. In the list of attribute forms in the bottom left, select the
attribute forms that you want to display, then click the Add icon to add the
attribute forms to the list on the right. You can select more than one
attribute form at the same time by pressing CTRL and clicking additional
attribute forms. This option is available if the Choose an attribute option
above is selected

To specify a title and instructions

For considerations when determining a title and description, see
Components of a prompt, page 283.

l On the General tab, type a Title, which is used as the default object name
when you save the prompt, although you can change it.

l Type text in the Instructions f ield, which is displayed when the prompt is
run during report execution.

To restrict the number of prompt answers.

1. To require users to answer the prompt before running the report,
specify whether the prompt requires an answer. Select the Prompt
answer is required check box. If you require an answer, it is a good
idea to also provide a default answer, otherwise a subscription to this
report will fail.

2. Set the maximum and/or minimum number of prompt answers allowed,
if desired. Select the Minimum number of qualifications and/or the
Maximum number of qualifications check boxes, and type the
numbers in the fields.

To allow personal answers

Personal answers allow a user to save prompt answers for this prompt,
and then reuse the answers on any report that this prompt is used on. For
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more information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt, select
one of the following options from the Personal answers allowed drop-down
list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l One: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To specify the layout and display style of the prompt

1. On the Style tab, from the Display style drop-down list, specify a
presentation style such as Tree or Shopping Cart for the prompt.
Depending upon the option you select, the prompt is displayed to the
user when the report is executed.

The following image shows the Tree display style:
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The following image shows the Shopping Cart display style:
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2. To ensure that the prompt's text fields and options are a fixed size,
select the Fixed textbox width and/or the Fixed textbox height check
boxes, and specify the size of the prompt's text fields and options in the
fields.

Specifying the size of the textbox can be beneficial when users answer
prompts on a smaller screen of a mobile device.

1. To determine how prompt options are arranged, from the Orientation
drop-down list, select Vertical or Horizontal.

2. To determine the number of prompt answers displayed in a row or
column (depending on alignment), select the Items per column/row
check box and enter the number in the field.

3. You can determine whether to allow users to use a search box to locate
prompt answers. Searching for objects allows analysts to quickly locate
specific objects to use to answer the prompt. From the Show search
box drop-down list, select one of the following options:

l To display the search box, select True.

l To not display a search box, select False.

4. If the search box is enabled, you can ensure that users use the search
box to locate answers, by selecting the Make search required check
box.

If you are using the Shopping Cart display style, you can select the Use
folder structure check box to display the prompt choices in a folder
structure. This option, available for search objects only, is useful when the
same object with the same name is saved in multiple folders.

l Select the Do not show empty folders check box if you do not want the
search result to display empty folders.

l To allow users to navigate above the root folder when searching, select
the Allow navigation above search root check box.
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To specify how qualifications are displayed in the prompt

1. On the Qualification tab, determine the types of qualification
expressions allowed in the prompt by selecting an option from the
Expression type allowed drop-down list.

2. Determine the default condition (for example, Select or Qualify) that is
displayed in the prompt by selecting an option from the Default
expression type drop-down list.

3. Determine the default qualification operator (for example, Greater than
or Less than) that is displayed in the prompt by selecting an option from
the Default condition operator drop-down list.

4. Determine how many elements are listed in each prompt answer list by
selecting the Maximum number of elements per list check box and
entering the number in the field.

5. To allow users to import a list of attribute elements from which they can
choose, select the Allow element import check box.

6. Determine the default logical operator that is used between conditions
by selecting an option from the Default operator between conditions
drop-down list.

7. To allow users to modify expressions, select the Allow modification of
the logical operator check box.

To ensure that users can only use a single condition operator
(AND/OR) between all of the conditions in an expression, select the
Use a single logical operator between all conditions option.

To ensure that users can choose a default operator to use between each
condition, select the Allow the user to set independent logical operators
between conditions option.

To save your prompt

Click Save As, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK. Your new
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prompt is saved.

You can now add your new prompt to a report or fi lter. For a table showing
how to add each prompt type to a report, metric, or fi lter, see Reports:
Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.

Attribute Qualification prompts

The Attribute Qualification prompt can be used to create a more focused
prompt than the Hierarchy Qualification prompt. You determine a single
attribute from which each user who executes the report can select elements
to define his report fi lter. You can also let users select an attribute from a
set of attributes, and then select elements from their chosen attribute.

For example, your report contains the attribute Region and the metric
Revenue. You want users to be able to select specific geographical regions
of the country for which to see revenue data, from among all regions.

You create an Attribute Qualification prompt, which prompts the user to
choose attribute elements from the Region attribute. Using the
MicroStrategy Tutorial project data, you might choose the following default
answers for the prompt:

l Northeast

l Northwest

l Southeast

l Southwest

When you apply this prompt to the report and execute the report using the
default answers, the report appears as shown in the following image.
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The Attribute Qualification prompt is more restrictive than a Hierarchy
Qualification prompt but less restrictive than an Attribute Element List
prompt. The Hierarchy Qualification prompt allows users to select from the
widest number of attribute elements when they are choosing prompt answers
to define their fi ltering criteria. The Attribute Element List prompt is the most
restrictive, allowing users to choose from the fewest number of attribute
elements to define their fi lter criteria.

To create an Attr ibute Qualificat ion prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Attribute Qualification Prompt.

To select the attribute from which the user can create the filter

You must determine which attribute will be displayed to the user when the
user is prompted. (Alternatively, you can present the users with a list of
attributes from which the user selects one attribute.) The user then selects
elements from that attribute to be part of the filter he creates to filter data for
the report.

On the Definition tab, choose one of the following options:

l Choose an attribute: You can present the user with a specific attribute to
select elements from.

l Click Select Attribute, select the attribute or specify the name of the
attribute, then click OK.

l Use a predefined list of attributes: Select this option to allow the user to
choose attributes from a list of attributes that you select.
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l Click Add, select the attributes, then click OK.

l To delete an attribute from the list, select the attribute, then click
Remove.

l To remove all the attributes from the list, click Clear.

l Use the results of a search object: A search object will search for and
display specific project objects when the user executes the report. This
lets you prompt the user with the most up-to-date objects in the project.
Use this option to present the user with a list of attributes, from which he
can choose one.

Click Select Search, select the object or specify the name of the
object, then click OK.

To determine which attribute forms to display to the user

The prompt displays the related attribute elements for users to select their
fi lter criteria from. The attribute's forms can also be displayed.

An attribute form is a descriptive aspect of an attribute. Most attributes have
at least two forms, ID and description (Desc). For example, the Product
attribute has an attribute form called ID, which is made up of ID numbers
that represent each attribute element (each product). The attribute form Last
Name contains the last names for each attribute element, such as each
customer in the Customer attribute, or each employee in the Employee
attribute. Your project designer determines which attribute forms users see
directly in a report's results (the report display forms), and which attribute
forms users can see displayed in the Object Browser, for browsing purposes
(the browse forms). You can select which of these display types users can
select from when they answer the prompt.

From the Displayed forms drop-down list, select one of the following
options:

l All attribute forms: This option allows users to see and select from
attribute elements within all attribute forms. It is the default choice.
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l Browse forms: This option allows users to see and select from only the
attribute forms defined as browse forms. All attribute forms defined as
browse forms are displayed in the Data Explorer when the user browses
the related attribute.

l Report display forms: This option lets users see only the attribute forms
defined as report display forms. All attribute forms defined as report
display forms are included in report results for a report that uses the
related attribute.

l Custom display forms: This option allows you to specify a customized
set of attribute forms to display to users by selecting each attribute form
from a list. In the list of attribute forms in the bottom left, select the
attribute forms that you want to display, then click the Add icon to add the
attribute forms to the list on the right. You can select more than one
attribute form at the same time by pressing CTRL and clicking additional
attribute forms. This option is available if the Choose an attribute option
above is selected.

To specify a title and instructions

For considerations when determining a title and description, see
Components of a prompt, page 283.

1. On the General tab, type a Title, which is used as the default object
name when you save the prompt, although you can change it.

2. Type text in the Instructions f ield, which is displayed when the prompt
is run during report execution.

To restrict the number of prompt answers.

1. You can specify whether the user is required to answer the prompt
before running the report. To require users to answer the prompt, select
the Prompt Answer is Required check box.

2. Set the maximum and/or minimum number of prompt answers allowed,
if desired. Select the Minimum number of qualifications and/or the
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Maximum number of qualifications check boxes, and enter the
numbers in the fields.

To allow personal answers

Personal answers allow a user to save prompt answers for this prompt, and
then reuse the answers on any report that this prompt is used on. For more
information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt, select
one of the following options from the Personal answers allowed drop-down
list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l Single: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To specify the layout and display style of the prompt

1 On the Style tab, from the Display style drop-down list, specify a
presentation style, such as Textbox, for the prompt. Depending upon the
option you select, the prompt is displayed to the user when the report is
executed.

The following image shows the Textbox display style:
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The following image shows the Radio Button display style:

The following image shows the Pull Down display style:

The following image shows the List display style:

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 315

2 To ensure that the prompt's text fields and options are a fixed size, select
the Fixed textbox width and/or the Fixed textbox height check boxes,
and specify the size of the prompt's text fields and options in the fields.

• Specifying the size of the textbox can be beneficial when users
answer prompts on a smaller screen of a mobile device.

3 To determine how prompt options are arranged, from the Orientation
drop-down list, select Vertical or Horizontal.

• To determine the number of prompt answers displayed in a row or
column (depending on alignment), select the Items per column/row
check box and enter the number in the field.

4 You can determine whether to allow users to use a search box to locate
prompt answers. Searching for objects allows analysts to quickly locate
specific objects to use to answer the prompt. From the Show search box
drop-down list, select one of the following options:

• To display the search box, select True.

• To not display a search box, select False.

The Show search box option is not available if you are using the Textbox
display style.
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5 If you are using the Shopping Cart display style, you can select the Use
folder structure check box to display the prompt choices in a folder
structure. This option, available for search objects only, is useful when
the same object with the same name is saved in multiple folders.

• Select the Do not show empty folders check box if you do not want
the search result to display empty folders.

• To allow users to navigate above the root folder when searching,
select the Allow navigation above search root check box.

For an Attribute Qualification prompt that uses a search object and the Tree
display style, the Use folder structure check box is selected and cannot be
changed.

To specify how qualifications are displayed in the prompt

6 On the Qualification tab, determine the types of qualification
expressions allowed in the prompt by selecting an option from the
Expression type allowed drop-down list.

7 Determine the default condition (for example, Select or Qualify) that is
displayed in the prompt by selecting an option from the Default
expression type drop-down list.

8 Determine the default condition operator (for example, Greater than or
Less than) that is displayed in the prompt by selecting an option from the
Default condition operator drop-down list.

9 Determine how many elements are listed in each prompt answer list by
selecting the Maximum number of elements per list check box and
entering the number in the field.

10 To allow users to import a list of attribute elements from which they can
choose, select the Allow element import check box.

11 To allow users to browse the elements in attribute qualification, select
the Allow element browsing in attribute qualification check box.
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12 Determine the default logical operator that is used between conditions by
selecting an option from the Default operator between conditions
drop-down list.

13 To allow users to modify expressions, select the Allow modification of
the logical operator check box.

• To ensure that users can only use a single condition operator
(AND/OR) between all of the conditions in an expression, select the
Use a single logical operator between all conditions option.

• To ensure that users can choose a default operator to use between
each condition, select the Allow the user to set independent
logical operators between conditions option.

To save your prompt

14 Click Save As, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK. Your new
prompt is saved.

You can now add your new prompt to a report, metric, or fi lter. For a table
showing how to add each prompt type to a report, metric, or fi lter, see
Reports: Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.

Attribute Element List prompts

The Attribute Element List prompt allows a user to choose from a list of
attribute elements to be included in a filter or custom group. This is
generally the simplest prompt for users to answer, because it offers the
fewest number of answers to choose from and does not require the user to
create a filtering "statement".
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You define the specific attribute elements to be displayed in the prompt, by
using one of the following methods:

l Selecting all elements associated with an attribute

l Creating a filter that returns a limited list of elements from one attribute

l Selecting specific attribute elements one by one

For example, your report contains the attribute Region and the metric
Revenue. You want users to be able to select specific geographical regions
of the country for which to see revenue data, from among only eastern U.S.
regions.

You create an attribute element list prompt, which prompts the user to
choose from three attribute elements in the Region attribute. Using the
MicroStrategy Tutorial project data, you might use all three regions as
default answers for the prompt:

l Northeast

l Mid-Atlantic

l Southeast

When you apply this prompt to the report and execute the report using the
default answers, the report appears as shown in the following image.

The Attribute Element List prompt is the most restrictive, allowing users to
choose from the fewest number of attribute elements to define their fi lter
criteria. The Hierarchy Qualification prompt allows users to select from the
widest number of attribute elements when they are choosing prompt answers
to define their fi ltering criteria. The Attribute Qualification prompt is more
restrictive than the Hierarchy Qualification prompt, but less restrictive than
the Attribute Element List prompt.
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To create an Attr ibute Element List prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Attribute Element List.

To determine the attribute whose elements the user will be able to choose
from

The prompt will display the related attribute elements for users to select
their fi lter criteria from.

On the Definition tab, click Select Attribute. Select the attribute whose
elements are displayed in the prompt and click OK.

To define the specific elements the user will be able to choose from

Choose one of the following options:

l List all elements (no restriction): This option displays all of the
attribute's elements to the user when he is answering the prompt.

l Use a pre-defined list of elements: This option lets you select specific
attribute elements to display to the user.

l Click Add, select the elements, then click OK.

l To delete an element from the list, select the element, then click
Remove.

l To remove all the elements from the list, click Clear.

l Use a filter to reduce the number of elements: This option is useful for
attributes with a large number of elements, such as Customer or
Employee. You can create a filter that returns a specific set of customers,
for example, the top 100 customers this month.

Click Select Filter, select the filter or specify the name of the filter,
then click OK.
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To specify a title and instructions

For considerations when determining a title and description, see
Components of a prompt, page 283.

1. On the General tab, type a Title, which is used as the default object
name when you save the prompt, although you can change it.

2. Type text in the Instructions f ield, which is displayed when the prompt
is run during report execution.

To restrict the number of prompt answers

1. You can specify whether the user is required to answer the prompt
before running the report. To require users to answer the prompt, select
the Prompt Answer is Required check box.

2. Set the maximum and/or minimum number of prompt answers allowed,
if desired. Select the Minimum number of answers and/or the
Maximum number of answers check boxes, and enter the numbers in
the fields.

To allow personal answers

Personal answers allow a user to save prompt answers for this prompt,
and then reuse the answers on any report that this prompt is used on. For
more information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt,
select one of the following options from the Personal answers allowed
drop-down list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l Single: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
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delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To specify the layout and display style of the prompt

1. On the Style tab, you can determine the presentation style used to
display the prompt to the user. The default is Shopping Cart. From the
Display style drop-down list, select one of the following:

l Radio Button: This prompt lets users select an attribute element
option by selecting a radio button.

l Check Box: This prompt lets users specify attribute elements by
selecting check boxes.

l Pull Down: This prompt lets users select an answer from a drop-
down list.

l List: This prompt lets users select prompt answers from a list.

l Shopping Cart: This prompt lets users add attribute elements to a
list of selected attribute elements.

l Calendar: This prompt lets users answer the prompt by selecting a
date on a calendar. This option is available if a date/time attribute
such as Month of Year is selected.

l Barcode Reader: This prompt lets users answer the prompt by
scanning or typing a bar code.

l Geo Location: This prompt lets users filter the attribute element list
based on their current geographical location.

Styles for prompts for mobile devices, including the Calendar,
Barcode Reader, and Geo Location display styles, display when the
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prompt is viewed on a mobile device with MicroStrategy Mobile.
Certain styles are available for specific types of Attribute Element
List prompts. For more information on displaying prompts for mobile
devices, see the Allowing users to filter data: prompts section of the
MicroStrategy Mobile Administration Help.

2. To ensure that the prompt's text fields and options are a fixed size,
select the Fixed textbox width and/or Fixed textbox height check
boxes, and specify the size of the prompt's text fields and options in the
fields.

Specifying the size of the textbox can be beneficial when users answer
prompts on a smaller screen of a mobile device.

3. To determine how prompt options are arranged, from the Orientation
drop-down list, select Vertical or Horizontal.

To determine the number of prompt answers displayed in a row or
column (depending on alignment), select the Items per column/row
check box and type a number in the field.

4. You can determine whether to allow users to use a search box to locate
prompt answers. Searching for objects allows analysts to quickly locate
specific objects to use to answer the prompt. From the Show search
box drop-down list, select one of the following options:

To display the search box, select True.

To not display a search box, select False.

5. To require using the search box to locate prompt answers, select the
Make search required check box.

6. If you are using the Shopping Cart display style, you can select the Use
folder structure check box to display the prompt choices in a folder
structure. This option, available for search objects, is useful when the
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same object with the same name is saved in multiple folders.

Select the Do not show empty folders check box if you do not want
the search result to display empty folders.

To allow users to navigate above the root folder when searching, select
the Allow navigation above search root check box.

7. For the Barcode Reader prompt style, to specify the attribute form used
to look up item barcodes, select an attribute form from the Barcode
mapping attribute form drop-down list.

8. For the Geo Location prompt style, from the Select location mapping
level drop-down list, select the level at which you wish to filter
elements in the attribute. For example, select City to filter the attribute
elements by the current city in which the mobile device is located.

9. To select the attribute whose elements you want to filter, click Select
Attribute, browse to and select the attribute, and then click OK.

To save your prompt

Click Save As, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK. Your new
prompt is saved.

You can now add your new prompt to a report, metric, or fi lter. For a table
showing how to add each prompt type to a report, metric, or fi lter, see
Reports: Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.
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Metric Qualification prompts

The Metric Qualification prompt allows users to create their own instant fi lter
for data returned for one of the metrics on the report. You create a Metric
Qualification prompt by selecting one or more metrics. Users will be able to
define their fi lters based on these metrics.

For example, your report contains the attribute Region and the metric
Revenue. You want users to be able to define the amount of revenue they
want to see data for, showing any geographical region which satisfies the
user's selected metric condition.

You create a Metric Qualification prompt, which prompts the user to enter a
value for which all revenue data will be displayed that is greater than the
value entered by the user. Using the MicroStrategy Tutorial project data, you
might define the default answer for the prompt to be Revenue > $1,000,000.

When you apply this prompt to the report and execute the report using the
default answer, the report appears as shown in the following image.

The metric(s) you choose for the prompt do not have to appear on the report
itself. For example, a store manager needs a report to show sales data for
products whose current inventory falls below a certain count. However, the
report does not necessarily need to display inventory counts for those
products.

When answering the prompt, users can define their fi lters based on the
value, rank, or percentage of the metric.
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To create a Metr ic Qualificat ion prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Metric Qualification Prompt.

To select the metric(s) for which users can define their fi lters

The prompt will display the metric(s) on which users define their fi lter
criteria.

On the Definition tab, choose one of the following options:

l Choose a metric: Users will be able to filter their report data based on the
metric you select.

Click Select Metric and select a specific metric or specify the name of the
metric to use in the prompt.

l Use a predefined list of metrics: Select this option to allow the user to
choose metrics from a list that you select.

l Click Add, select the metrics, then click OK.

l To delete a metric from the list, select the metric, then click Remove.

l To remove all the metrics from the list, click Clear.

l Use the results of a search object: A search object will search for and
display specific project objects when the user executes the report. This
lets you prompt the user with the most up-to-date objects in the project.
For example, you can let the user select a metric from a search for all
metrics with "Revenue" in the name.

Click Select Search, select the object or specify the name of the object,
then click OK.
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To specify a title and instructions

For considerations when determining a title and description, see
Components of a prompt, page 283.

1. On the General tab, type a Title, which is used as the default object
name when you save the prompt, although you can change it.

2. Type text in the Instructions f ield, which is displayed when the prompt
is run during report execution.

To restrict the number of prompt answers.

1. You can specify whether the user is required to answer the prompt
before running the report. To require users to answer the prompt, select
the Prompt Answer is Required check box.

2. Set the maximum and/or minimum number of prompt answers allowed,
if desired. Select the Minimum number of qualifications and/or the
Maximum number of qualifications check boxes, and enter the
numbers in the fields.

To allow personal answers

Personal answers allow a user to save prompt answers for this prompt,
and then reuse the answers on any report that this prompt is used on. For
more information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt,
select one of the following options from the Personal answers allowed
drop-down list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l Single: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
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delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To specify the layout and display style of the prompt

1. On the Style tab, from the Display style drop-down list, specify a
presentation style, such as Textbox, for the prompt. Depending upon
the option you select, the prompt is displayed to the user when the
report is executed.

2. To ensure that the prompt's text fields and options are a fixed size,
select the Fixed textbox width and/or the Fixed textbox height check
boxes, and specify the size of the prompt's text fields and options in the
fields.

Specifying the size of the textbox can be beneficial when users answer
prompts on a smaller screen of a mobile device.

3. To determine how prompt options are arranged, from the Orientation
drop-down list, select Vertical or Horizontal.

To determine the number of prompt answers displayed in a row or
column (depending on alignment), select the Items per column/row
check box and enter the number in the field.

4. You can determine whether to allow users to use a search box to locate
prompt answers. Searching for objects allows analysts to quickly locate
specific objects to use to answer the prompt. From the Show search
box drop-down list, select one of the following options:

l To display the search box, select True.

l To not display a search box, select False.
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The Show search box option is not available if you are using the
Textbox display style.

5. To show the object path (folder hierarchy), select the Use folder
structure check box. This option, available for search objects, is useful
when the same object with the same name is saved in multiple folders.
If you are using the Shopping Cart display style, you can select the
check box to display the prompt choices in a folder structure.

l Select the Do not show empty folders check box if you do not want
the search result to display empty folders.

l To allow users to navigate above the root folder when searching,
select the Allow navigation above search root check box.

For a Metric Qualification prompt that uses a search object and the
Tree display style, the Use folder structure check box is selected and
cannot be changed.

To specify how qualifications are displayed in the prompt

1. On the Qualification tab, determine the default condition operator (for
example, Greater than or Less than) that is displayed in the prompt by
selecting an option from the Default conditionoperator drop-down list.

2. Determine the default logical operator that is used between conditions
by selecting an option from the Default operator between conditions
drop-down list.

3. To allow users to modify expressions, select the Allow modification of
the logical operator check box.

l To ensure that users can only use a single condition operator
(AND/OR) between all of the conditions in an expression, select the
Use a single logical operator between all conditions option.
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l To ensure that users can choose a default operator to use between
each condition, select the Allow the user to set independent
logical operators between conditions option.

4. To allow users to specify the output level of metrics, select the Display
output level selector check box.

To save your prompt

Click SaveAs, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK. Your new
prompt is saved.

You can now add your new prompt to a report, metric, or fi lter. For a table
showing how to add each prompt type to a report, metric, or fi lter, see
Reports: Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.

Filtering data based on metrics, attributes, or other objects:
Object prompts
Object prompts provide users the ability to add additional objects to a report.
You can let users select from almost any object available in MicroStrategy.
The objects the user selects in the prompt are placed on the report. This
essentially allows users to create their own reports, although you use the
Object prompt to control what objects they can choose to include on their
reports.

For example, you can create a prompt that allows users to choose from a list
of existing stand-alone filters to apply to the report. Or, you can create a
prompt that displays the Day, Month, Quarter, and Year attributes to users,
so the user can specify the granularity of the report. Object prompts enable
you to provide versatile reports to users.
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The Customer Distribution Trend report contains two Object prompts. The
report's display is shown below:

The first prompt, called Demographics List, contains a set of attributes that
users select one or more answers from. Answer choices include the
attributes Customer Income Range, Customer Age Range, and Customer
Gender. The second prompt, called Psychographic List, contains another set
of attributes users can choose from. Its answer choices include the
attributes Customer Education, Customer Household Count, Customer
Housing Type, Customer Marital Status, and so on.

By separating the user's choices into two Object prompts, the designer is
able to group the attributes according to user analysis needs. In this case, a
user can focus on customer demographics and customer psychographics
separately when the user is considering what data to see in the resulting
report. Additionally, data for various combinations of demographics and
psychographics can be compared by running the report again and answering
the prompts differently.

Object prompts can be used in many places, including the following:
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l Object prompt containing attributes: Any place that can accept a list of
attributes.

l Object prompt containing metrics: Embedded in a Set qualification filter,
as well as any place that accepts metrics.

One prompt can contain different types of objects, such as both metrics and
attributes, or attributes and custom groups. However, if the prompt mixes
metrics with another type of object, either the metrics or the other objects
are removed when the prompt is executed in a report. For a more detailed
explanation, see the Advanced Prompts chapter in the Advanced Reporting
Help.

For a table of where to use all prompts, see Reports: Adding prompts to a
report, metric, or fi lter, page 362.

Creating Object prompts

When you create an Object prompt, you can decide whether users can select
from a specified list of MicroStrategy objects, or you can define a specific
search that presents an up-to-date set of objects for users to select from.
Including a search object in the Object prompt, rather than specifying the
exact object names, allows users to select from new objects that might not
have been part of the project when you first created the prompt.

To create an Object prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Object Prompt.

To cr eat e t he l ist o f ob ject s f r om wh ich t he user can select

You can only use objects of one type in an Object prompt. For example,
you can include metrics or attributes in a single Object prompt, but not
both. To prompt for multiple object types in the same report, you must
create an Object prompt for each object type.
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On the Definition tab, choose one of the following options:

l Use a pre-defined list of objects: This option lets you define a specified
list of objects.

l Click Add, select the objects, then click OK.

l To delete an object from the list, select the object and click Remove.

l To remove all the items from the list, click Clear.

l To change the order in which the objects are displayed in the prompt,
select an object and click the Up and Down arrows to move the selected
object.

l Use the results of a search object: A search object will search for and
display specific project objects when the user executes the report. This
lets you prompt the user with the most up-to-date objects in the project.

Click Select Search, select the object, then click OK.

To speci f y a t i t le and inst r uct ions

For considerations when determining a title and description, see
Components of a prompt, page 283.

1. On the General tab, type a Title, which is used as the default object
name when you save the prompt, although you can change it.

2. Type text in the Instructions f ield, which is displayed when the prompt
is run during report execution.

To r est r ict t he num ber o f p r om pt answer s

1. You can specify whether the user is required to answer the prompt
before running the report. To require users to answer the prompt, select
the Prompt Answer is Required check box.

2. Set the maximum and/or minimum number of prompt answers allowed,
if desired. Select the Minimum number of answers and/or the
Maximum number of answers check boxes, and enter the numbers in
the fields.
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To al low per sonal answer s

Personal answers allow a user to save prompt answers for this prompt,
and then reuse the answers on any report that this prompt is used on. For
more information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt,
select one of the following options from the Personal answers allowed
drop-down list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required) or ignore it.

l Single: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
answer is displayed. A user can keep the personal answer, or add or
delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To speci f y t he layou t and d isp lay st yle o f t he p r om pt

1. On the Style tab, from the Display style drop-down list, specify a
presentation style, such as Check box, for the prompt. This is how the
prompt is displayed to the user.

2. To ensure that the prompt's text fields and options are a fixed size,
select the Fixed textbox width and/or the Fixed textbox height check
boxes, and specify the size of the prompt's text fields and options in the
fields.

Specifying the size of the textbox can be beneficial when users answer
prompts on a smaller screen of a mobile device.
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3. To determine how prompt options are arranged, from the Orientation
drop-down list, select Vertical or Horizontal.

To determine the number of prompt answers displayed in a row or
column (depending on alignment), select the Items per column/row
check box and enter the number in the field.

1. You can determine whether to allow users to use a search box to locate
prompt answers. Searching for objects allows analysts to quickly locate
specific objects to use to answer the prompt. From the Show search
box drop-down list, select one of the following options:

l To display the search box, select True.

l To not display a search box, select False.

1. If you are using the Shopping Cart display style, you can select the Use
folder structure check box to display the prompt choices in a folder
structure. This option, available for search objects, is useful when the
same object with the same name is saved in multiple folders. Use the
up and down ordering arrows to reorder prompt objects.

To allow users to navigate above the root folder when searching, select
the Allow navigation above search root check box.

2. For an object prompt that uses a search object and the Tree display
style, the Use folder structure check box is selected and cannot be
changed. You can select whether or not empty folders are shown in the
tree when the prompt is executed. Select or clear the Do not show
empty folders check box. Note that selecting it can impact
performance.

The search object must search within subfolders. For background
information on search objects and steps to create them, see the
MicroStrategy Developer Help (formerly the MicroStrategy Desktop Help).
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To save you r p r om pt

Click Save As, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK. Your new
prompt is saved.

You can now add your new prompt to a report, metric, or fi lter. For a table
showing how to add each prompt type to a report, metric, or fi lter, see
Reports: Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.

Filtering data based on a single value or string: Value prompts
Value prompts are useful when the result desired on the report is a single
value, such as a specific date, a number, or a specific word or phrase. The
Value prompt is designed to return report results based on the data type
assigned to the data in your data source.

For example, you want a report that lists all employees whose age is less
than 40 years. You create a report with the Employee attribute and the
Employee Age attribute. You create a Numeric Value prompt while you are
creating the report. The Numeric Value prompt contains the Employee Age
attribute, the operator Less than, and a Maximum Value set at 50.

Using the MicroStrategy Tutorial sample data, if you execute the report and
answer the prompt by specifying 40 as the Employee Age, the final report
looks like the following:
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Value prompts are typically used on a filter, where they become part of the
filter's definition, but they can also be used on a metric as part of the
metric's formula. The filter or metric is then placed on a report.

Because they are often used in filters, Value prompts can be created directly
in the Filter Editor at the same time you create the filter in which you want to
place the Value prompt. When created this way, a Value prompt is part of the
filter's definition and is not a stand-alone prompt, so it cannot be added to
another filter. To create a stand-alone Value prompt, create it in the New
Prompt page. This gives you and other designers the flexibil ity to create a
Value prompt once and add it to various filters.

For a table of where to use all prompts, see Reports: Adding prompts to a
report, metric, or fi lter, page 362.

The different types of Value prompts are:

l Date prompt: This Value prompt type asks users to type or select a date,
and returns data that has the date data type assigned to it and that
matches the user's entered date. For example, the Date prompt can be
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useful when added to a filter that screens data based on Year=2006. The
prompt lets users select a specific date within the year of the filter's
condition. Date prompts are used in filters which qualify on a date.

l Numeric prompt: This Value prompt type asks users to type a numeric
value. Numeric Value prompts accept integers or decimals up to 15 digits
of precision. Numeric prompts can be used in any filter that needs a
number input from the user, such as a metric qualification. For information
on metric qualification filters, see Filtering data based on attribute
relationships or metrics: Set qualifications, page 253.

If a user enters more than 15 digits for a numeric prompt, the data is
converted to scientific notation. If precision is needed beyond 15 digits, you
should use a Big Decimal value prompt instead.

l Text prompt: This Value prompt type asks users to type a string of text.
Text prompts are commonly used in attribute form qualification filters. For
information on attribute form qualification filters, see Filtering data based
on business attributes: Attribute qualifications, page 239.

l Big Decimal prompt: This Value prompt type asks users for a "big
decimal" value. Big Decimal Value prompts accept integers and decimals
up to 38 digits of precision.

Big Decimal prompts should be used in expressions that require high
precision, such as qualifying on a Big Decimal attribute ID.

l Long prompt: This Value prompt type asks users for a long integer value.
Long prompts accept integer numbers up to 10 digits.

Long prompts can be created in MicroStrategy Developer. The ability to
create a Long Value prompt is not enabled in the Prompt Generation
Wizard by default. To enable Long Value prompts:

a. Double-click your project to open it.

b. From the Tools menu in Developer, select My Preferences.

c. Expand the General category on the left, and select Prompts.
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d. Select Add long prompts to the list of available value prompts.

e. Click OK.

Creating Value prompts

To create a Value prompt

1. In MicroStrategy Web, on the Home page, click New Prompt.

2. Click Value Prompt.

To def ine t he p r om pt t ype t o be pr esen t ed t o t he user

Specify the type of Value prompt:

l Date and Time prompt: This prompt lets users filter for data related to
either a specific date or a range of dates.

l Numeric prompt: This prompt lets users filter numeric data, usually based
on a metric.

l Text prompt: This prompt lets users filter text data, usually based on
attribute forms.

l Big Decimal prompt: This prompt lets users filter data based on a big
decimal value for a metric.

To speci f y a t i t le and inst r uct ions

For considerations when determining a title and description, see
Components of a prompt, page 283.

1. On the General tab, type a Title, which is used as the default object
name when you save the prompt, although you can change it.

2. Type text in the Instructions f ield, which is displayed when the prompt
is run during report execution.
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To def ine a r ange w it h in wh ich t he user 's answer m ust f al l

1. You can specify whether the user is required to answer the prompt
before running the report. To require users to answer the prompt, select
the Prompt Answer is Required check box. For considerations about
required and optional prompt answers, see Components of a prompt,
page 283.

2. To restrict the user to entering values within certain ranges:

l Select the Minimum value check box and enter the lowest value allowed
for the prompt answer.

l For a Date prompt, this is the earliest date.

l For a Text prompt, this is the fewest number of characters allowed in the
text string.

l Select the Maximum value check box and enter the highest value allowed
for the prompt answer.

l For a Date prompt, this is the latest date.

l For a Text prompt, this is the maximum number of characters allowed in
the text string.

To al low per sonal answer s

Personal answers allow a user to save prompt answers for this prompt,
and then reuse the answers on any report that this prompt is used on. For
more information on personal answers, and how they can be used, see
Components of a prompt, page 283.

To determine whether personal answers can be saved for this prompt, select
one of the following options from the Personal answers allowed drop-down
list:

l None: No personal answers can be saved. Every time a user sees the
prompt, he must answer it manually (if it is required).

l Single: Only one personal answer can be saved for this prompt. When the
prompt is used again (on this report or a different one), the personal
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answer is displayed. A user can keep the personal answer, or add or
delete selections. He can save his changes as a new personal answer, but
only one personal answer can be saved for the prompt.

l Multiple: Multiple personal answers can be named and saved, allowing
different answers for the same prompt. When the prompt is used again (on
this report or a different one), the personal answers are available. The
user can select one of them, or answer the prompt manually.

To speci f y t he layou t and d isp lay st yle o f t he p r om pt

1. On the Style tab, from the Display style drop-down list, specify a
presentation style, such as Textbox, for the prompt. This is how the
prompt is displayed to the user.

Styles for prompts displayed for mobile devices, such as Slider,
Stepper, and Switch, display when the prompt is viewed on a mobile
device with MicroStrategy Mobile. Certain styles are available for
specific types of Value prompts. For a general overview of displaying
prompts on mobile devices, see the Allowing users to filter data:
prompts section of theMicroStrategy Mobile Administration Help.

The options are:

l Textbox: This prompt lets users type a value directly into a field.

l Slider: This prompt lets users specify a numeric value on a horizontal
slider.

l Stepper: This prompt displays a numeric value. Users can use the
increment and decrement buttons to increase or decrease the value
displayed.

l Switch: This prompt lets users choose between two choices, On and
Off.

l Wheel: This prompt displays a wheel or row of wheels the user can
move up or down to specify a value.
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l Geo Location: This prompt lets users filter results based on their
current geographical location.

l Barcode Reader: This prompt lets users answer the prompt by
scanning or typing an item's bar code.

2. Depending on the prompt's type and display style, you can specify
other available formatting options:

l To ensure that the prompt's text fields and options are of a fixed size,
select the Fixed textbox width check box and type a value in the field.

l For the Date and Time prompt, to allow users to select time before
running a report, select the Allow user to select time check box.

On mobile devices, the Date and Time prompts are displayed as a
calendar by default. If the Allow user to select time check box is selected,
the Date and Time prompts are displayed as wheels on an iPhone or iPad,
and as a date/time stepper on an Android device.

l For the Numeric prompt, to specify a value for the prompt when it is set to
the on position, type a value in the On value f ield. To specify a value for
the prompt when it is set to the off position, type a value in the Off value
f ield.

l To specify the interval between numeric values that are displayed in the
prompt, type a value in the Interval f ield. For example, in a Numeric
prompt with the display style set to Slider, a minimum value of 1 and a
maximum value of 50, and an interval of 5, users can select values such as
5, 10, 15, and so on.

l For prompts with the display style set to Geo Location, to specify whether
the prompt is set using latitude or longitude, select Latitude or Longitude
from the Location coordinate drop-down list.

l To format how numeric values are displayed in the prompt, click Number
Format,select a number formatting style and click OK.
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To save you r p r om pt

Click Save As, navigate to the folder where you want to save the prompt,
type a Name and Description for the prompt, and click OK.

All Value prompts must be added to either a metric or a filter (depending on
the type of Value prompt and what you want it to do), and then the metric or
filter is added to a report.

For a table showing how to add each prompt type to a report, see Reports:
Adding prompts to a report, metric, or fi lter, page 362.

You can also set a default prompt answer, which allows the user to complete
report execution quickly, as they do not need to answer the prompt but can
simply run the report using the default answer. For steps to specify a default
prompt answer, see Components of a prompt, page 283.

Editing a prompt
You can edit any prompt by clicking it in MicroStrategy Web. The prompt
opens in Edit mode. For steps to edit a prompt, see Types of prompts, page
292 to determine the type of prompt you are editing, and then use the
appropriate section to make changes to any aspect of the prompt.

Additional prompt functionality
The Advanced Reporting Helpprovides detailed information about the
following advanced features:

l Prompts in scheduled reports: Learn about how prompted reports work
when they are on a set schedule to be executed, and what the special
requirements are for scheduled reports with prompts.

l Level prompts: Learn about creating a Level prompt that lets users
determine what level a metric is aggregated at, as well as any target or
grouping associated with the metric's level.

l Dynamic dates: Learn about defining a date that is a fixed offset of the
current date.
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l System prompts: These are special built-in prompts, such as the User
Login system prompt. Additional information and examples can be found in
the System Administration Help.

Designing a report's structure: Templates

A template is the structure that underlies any report. A template specifies
the set of information that the report should retrieve from your data source,
and it also determines the structure in which the information is displayed in
the report's results. A template's structure is the location of objects on the
template, such as showing that metrics have been placed in the report's
columns, and attributes have been placed in the rows; the Revenue metric
has been placed to the left of the Revenue Forecast metric so that a user
reading left to right can see current revenue before seeing forecasted
revenue; and so on.

When you are creating a report, you place various MicroStrategy objects on
the report's template. Objects can include attributes, metrics, fi lters, and
prompts, as well as other objects such as custom groups and consolidations
which are introduced in the Advanced Reporting Help. Filters and prompts
further restrict and refine the data displayed on the executed report. When a
report is executed, the data related to all the objects on the template that
have satisfied the filtering conditions of the report fi lter are displayed on the
report using the format specified by the template.

MicroStrategy comes with a set of pre-created report templates which you
can use to build your own reports. These templates let you create a new
report quickly because the template already contains common objects and
basic filters. When you create any new report, you can start with an existing
template, which will shorten the time it takes to produce the finished report.
The Create Report page opens whenever you create a new report in
MicroStrategy Web, and this is where you can select an existing template on
which to base the new report. The templates on the Create Report page are
shown in the image below:
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The diagram below shows the template and filter for a report, as well as the
executed report that results from what is defined on the template.
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Whenever you initiate the creation of a new report, the system automatically
creates a template and a basic, empty report fi lter. Although you may not
specifically define and use a separate template or report fi lter object, a
template and empty filter are a logical part of every report's definition.

Creating a grid report

A report is a MicroStrategy object that represents a request for a specific set
of formatted data from your data source. In its most basic form it consists of
two parts:

l A report template (usually simply called a template), which is the
underlying structure of the report.

l The report-related objects placed on the template, such as attributes,
metrics, fi lters, and prompts.

To create a report that accurately answers a specific business query, be
sure you understand the fundamental MicroStrategy objects that make up a
report, as described in MicroStrategy objects, page 189. This section
assumes you have a basic understanding of each object presented in this
chapter. For information on the specific objects that make up a report, refer
to the following:

l Attributes: See Providing business context to a report: Attributes, page
195.

l Metrics: See Calculating data on a report: Metrics, page 197.
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l Filters: See Filtering data on a report: Filters, page 232.

l Prompts: See Asking for user input: Prompts, page 280.

l Templates: See Designing a report's structure: Templates, page 343.

l Consolidations and custom groups: See the Consolidations and Custom
Groups chapter in the Advanced Reporting Help.

A simple report generally has at least one attribute, one metric, and one
filter. It is not necessary to have all these objects in the report, but the data
returned is more meaningful if all these objects are present in the report.

For example, if you create a report with just one attribute, such as Customer,
and run the report, it returns a list of all the attribute elements for that
attribute. In this case, you see a list of names for every customer who has
done business with your company and is in your database. Likewise, if you
add just one metric to an otherwise blank report, you see all revenue data
for all t ime, for all regions.

If you add a metric and an attribute to the same report, such as the
Customer attribute and the Revenue metric, the report data begins to
become useful because you can view what revenue each customer brought
to your stores. However, for most organizations, this is stil l a prohibitively
large report.

If you add a report fi lter to the report, you can limit the data to a specific
area of interest. For example, you can define a specific geographic region
and a time period by adding a few additional attributes to the report, such as
Region and Year. Then you can add a filter to see only your most profitable
Northeast region customers for the past year. The resulting report can
display those customers in your Northeast region who brought in the most
revenue last year.

It is not required that the objects in a filter are also part of the report itself.
In this example, adding the Region and Year attributes to the report lets the
report's users see the context of the report's results.
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This section describes how to design a report with basic reporting
components, such as attributes, metrics, and filters, in MicroStrategy Web
using the Report Editor. It provides procedures to create a new report and
add attributes, metrics, fi lters, and prompts to the report. It also provides a
procedure to modify an existing report.

If you use the MicroStrategy Tutorial project to perform the examples in the
procedures that follow, you can become familiar with the Report Editor
environment and the features it offers. The Tutorial project offers an
opportunity to use MicroStrategy even if your organization does not yet have
its own data available in a MicroStrategy project.

Prerequisites
To create a report that displays your organization's data, you must have a
MicroStrategy project already created, and you must have the appropriate
MicroStrategy privileges to perform the necessary tasks. If you plan to use
the MicroStrategy Tutorial project and its sample data with the following
procedures, you only need the privileges necessary to perform the
procedures; it is not necessary to have your own project set up in
MicroStrategy.

Each of these requirements is discussed below.

A working project with data objects

Before you create your own reports, you must have a working MicroStrategy
project containing objects that reflect your business data. (If you do not yet
have your own working project, you can use the Tutorial project to practice
procedures in this book. The Tutorial project is discussed below.) A project
must contain objects that reflect your business data, so that those objects
can be placed on a report and, when the report is executed, the appropriate
business data can be retrieved from your data source.

Business objects that must already be created within a project include the
following:
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l Facts, for example Revenue or Units Sold, are business measurements,
which take the form of data stored in your data source, or variables. Facts
are typically numeric and suitable for aggregation. They are used to create
metrics as well as other objects in MicroStrategy.

l Attributes are business concepts that answer questions about facts, such
as when, where, and so on. Attributes provide a context for reporting those
facts.

Your project may already contain other objects in addition to attributes and
facts, such as metrics, fi lters, and prompts. Facts and attributes are the
minimum objects that must already be created. They are usually created by
your project designer when the project itself is created.

For example, on a report that contains the Year attribute and a Units Sold
metric (based on a Units Sold fact), you can view how many units were sold
during a given year. Without any attribute on this report, the report can
provide information only about how many units were sold overall; it cannot
answer questions about who purchased the units, when, where, and so on.

Detailed information about creating projects, as well as about facts,
attributes, and how to create these objects can be found in the Project
Design Help.

If you do not have a working project yet, you can use the Tutorial project
with the procedures in this chapter to learn how to create the various report
objects in MicroStrategy. For information on the Tutorial project and how to
access it, see About sample data and the MicroStrategy Tutorial project,
page 4.

Report design and creation privileges

As a MicroStrategy user, you must have the appropriate privileges assigned
to you, to be able to create reports and report objects, as follows:
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l For MicroStrategy Web, the group of privileges assigned to most report
designers is called Web Professional.

l For MicroStrategy Developer, the group of privileges assigned to most
report designers is called Developer.

See your administrator for any questions about privileges assigned in
MicroStrategy.

Creating a report with the Report Editor
You can use the Report Editor available in MicroStrategy Web to create a
new report or modify an existing report. The Report Editor displays the
report as it will be seen by the user and includes toolbars, menus, and
panels that allow you to change how the report is displayed.

To modify a report's template, fi lter, or any other aspect of the report's
definition, you can use Design Mode within the Report Editor. A new report
automatically opens in Design Mode. It is also accessible within an existing
report through the Home menu of the Report Editor interface.

Design Mode allows you to create or edit the report's template and
definition. A report's definition is the definitions of all the objects that are
included on the report when the report is designed, as well as any formatting
applied to the report.

Creating a quick report

If you are already familiar with MicroStrategy objects that are used to create
a report, and you need to create a report quickly, you can use
MicroStrategy's Report Builder to create a report. However, the Report
Builder tool limits you to only adding certain objects to the report while you
are using the tool. Once you finish creating a report in Report Builder, you
can continue to modify the report in the Report Editor and add additional
objects.

To use Report Builder to create a quick report, see Creating a report for
analysis, page 174.
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Opening the Report Editor with a blank report template

Templates are introduced in Designing a report's structure: Templates, page
343.

Once objects are added to it, a template specifies the set of information that
the report should retrieve from your data source, and it also determines the
structure in which the information is displayed in the report's results.

This section contains steps to open Design Mode in MicroStrategy Web with
a blank report template, so you can create a new report.

To access a blank report

1. In MicroStrategy Web, log in to the project in which you want to create a
report.

If you are using the MicroStrategy Tutorial project and its sample data,
log in to the Tutorial project.

2. Click the MicroStrategy icon and select Create Report.

3. Click Blank Report.

The following image shows Design Mode displaying a blank report
template in MicroStrategy Web.
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For a description of each area or pane of the MicroStrategy Web Report
Editor and Design Mode, see MicroStrategy Web Report Editor
interface, page 437.

4. Use the following sections to add attributes, metrics, fi lters, and
prompts to your new report. Almost all reports have one or more
attributes, one or more metrics, and one filter.

l Attributes: See Reports: Adding attributes to a report, page 352.

l Metrics: See Reports: Adding metrics to a report, page 355.

l Filters: See Reports: Adding a filter to a report, page 357.

l Prompts: See Reports: Adding prompts to a report, metric, or fi lter, page
362.
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Reports: Adding attributes to a report
Attributes are MicroStrategy objects that represent the business concepts
reflected in your stored business data in your data source. Attributes provide
a context in which to report on and analyze business facts or calculations.
While knowing your company's total sales is useful, knowing where and
when the sales took place is much more helpful for analysts. For details on
attributes, see Providing business context to a report: Attributes, page 195.

Selecting the right attributes

When you choose attributes to place on a report, select attributes that make
sense together. For example, Product Supplier and Customer Income
Bracket do not make much sense when their related data is displayed side-
by-side on a report. It is difficult to imagine a metric that can be included on
a report with these attributes, which would calculate useful report results
which would be meaningful for both these attributes.

However, the Customer Income Bracket attribute makes sense when it is
combined with the Product attribute on a report, where they might allow an
analyst to consider a list of products preferred by higher and lower income
bracket customers. The Product Supplier attribute makes more sense when
combined with any or all of the attributes Ship Date, Rush Orders, Weeks to
Ship, or some other attribute related to the supply chain.

To add an attr ibute to a report

If you are using one of your organization's projects, this procedure assumes
attributes have been created. Attributes are usually created by your
project's designer. If attributes need to be created, see the Project Design
Help.

1. In MicroStrategy Web, create a new report in Design Mode. See
Creating a report with the Report Editor, page 349.
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2. In the All Objects pane on the left, navigate to your project's attributes
folder and open it.

l If you are using the Tutorial project, open the Schema Objects
folder, then open the Attributes folder. Select any attribute to use for
the next step. In this procedure, Category attribute from the Products
folder is used.

l To search for an attribute in your project, type the name of the
attribute in the Find text field and press Enter or click the Find icon.

3. To add an attribute to the report, do one of the following:

l Drag and drop the attribute to the desired location on the report's grid.

l Double-click the attribute to add it to the report.

l Right-click the attribute and select Add to Grid as shown in the image
below, then move it to the desired location on the report's grid.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 354

Attributes are commonly displayed in a report's rows, although you can
add attributes to a report's column, if you want. To add an attribute to a
column, do one of the following:

• Drag and drop the attribute to the Drop objects here to add
columns area of the grid.

• Right-click the attribute name, select Move and select To Columns.

4. The attribute appears in the row or the column section of your report's
template depending upon where it is added, as shown in the image
below:

5. Repeat the steps above to add additional attributes to your report, if
you wish.

6. Almost all reports have one or more attributes, one or more metrics,
and one filter. If you need to, use the following sections of this manual
to add additional objects to your new report:

l Metrics: See Reports: Adding metrics to a report, page 355.

l Filters: See Reports: Adding a filter to a report, page 357.
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l Prompts: See Reports: Adding prompts to a report, metric, or fi lter, page
362.

7. Save the report.

Reports: Adding metrics to a report
Metrics are MicroStrategy objects that represent business measures and key
performance indicators. From a practical perspective, metrics are the
calculations performed on data stored in your database, the results of which
are displayed on a report. For details on metrics, see Calculating data on a
report: Metrics, page 197.

To add a metric to a report

If you are using one of your organization's projects, this procedure assumes
at least one metric has been created. If you need to create metrics, see
Calculating data on a report: Metrics, page 197.

1. In MicroStrategy Web, create a new report in Design Mode. See
Creating a report with the Report Editor, page 349.

2. In the All Objects pane on the left, navigate to your project's metric
folder and open it.

l If you are using the Tutorial project, open the Public Objects folder,
then open the Metrics folder. Select any metric to use in the next
step. In this procedure, the Average Revenue metric from the Sales
Metrics folder is used.

l To search for a metric in your project, type the name of the metric in
the Find text field and press Enter or click the Find icon.

3. To add a metric to the report, do one of the following:

l Drag and drop the metric to the desired location on the report's grid.

l Double-click the metric to add it to the report.
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l Right-click the metric and select Add to Grid as shown in the image
below, then move it to the desired location on the report's grid.

Metrics are commonly displayed in a report's columns, although you
can add metrics to a report's row, if you want. To add a metric to a row,
do one of the following:

l Drag and drop the metric on the row in the report grid.

l Right-click the Metrics header, select Move and select To Rows.

4. The metric appears in the row or the column section of your report's
template depending upon where it is added, as shown in the image
below:
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5. Repeat the steps above to add additional metrics to your report, as
needed.

6. Almost all reports have one or more attributes, one or more metrics,
and one filter. If you need to, use the following sections of this manual
to add additional objects to your new report:

l Attributes: Reports: Adding attributes to a report, page 352.

l Filters: Reports: Adding a filter to a report, page 357.

l Prompts: Reports: Adding prompts to a report, metric, or fi lter, page
362.

7. If you want to see what your report looks like when executed against
the data source, once your report has one or more attributes and
metrics in it, from the toolbar select Run Report.

8. Save the report.

Reports: Adding a filter to a report
A filter screens data in your data source to determine whether the data
should be included in or excluded from the calculations of the report results.
A filter is not required in a report, although reports without filters are more
likely to return too much data to be displayed effectively. If a filter is added,
it should make sense with the objects already on the report.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 358

For details on filters in general and the various types of filters, see Filtering
data on a report: Filters, page 232. You need to know what type of filter you
want to have when you add it to a report.

Filters can be added to a report in two ways:

l If a filter object has already been created in your project (this is a stand-
alone filter), use the To add a stand-alone filter to a report, page 358
procedure below.

l If a separate filter has not already been created, you can create a filter
directly in the report. However, be aware that the filter cannot be used as
an independent object on other reports. To create a filter within the report,
use the To create a filter directly within a report: Embedded filters, page
360 procedure below.

To add a stand-alone filter to a report

If you are using one of your organization's projects, this procedure assumes
at least one filter has been created. If you need to create filters, see
Filtering data on a report: Filters, page 232.

1. In MicroStrategy Web, create a new report in Design Mode. See
Creating a report with the Report Editor, page 349.

2. If the Report Filter pane is not displayed above the report, display it by
clicking the Filter icon on the toolbar.

3. In the All Objects pane on the left, navigate to the folder where your
filter is located and open it.

l If you are using the Tutorial project, open the Public Objects folder,
then open the Shared Filters folder. Select any filter to use in the
next step. In this procedure, the Top 5 Customers By Revenue filter
from the Customer Analysis Filters folder is used.

l To search for a filter in your project, type the name of the filter in the
Find text field and press Enter or click the Find icon.
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4. To add a filter to the report's Filter pane, do one of the following:

l Drag and drop the filter on the Report Filter pane.

l Double-click the filter to add it to the Report Filter pane.

l Right-click the filter and select Add to Filter as shown in the image
below.

5. Repeat the steps above to add additional fi lters to your report, as
needed.

6. Almost all reports have one or more attributes, one or more metrics,
and one filter. If you need to, use the following sections of this manual
to add additional objects to your new report:

l Attributes: Reports: Adding attributes to a report, page 352.

l Metrics: Reports: Adding metrics to a report, page 355.
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l Prompts: Reports: Adding prompts to a report, metric, or fi lter, page
362.

7. If you want to see what your report looks like when executed against
the data source, once your report has one or more attributes and
metrics in it, from the toolbar select Run Report.

8. Save the report.

To create a filter direct ly within a report: Embedded filters

1. In MicroStrategy Web, create a new report in Design Mode. See
Creating a report with the Report Editor, page 349.

2. If the Report Filter pane is not displayed above the report, display it by
clicking the Filter icon on the toolbar.

3. Select the object you want to base your filter on:

l To base your filter on an object that is part of the report's definition,
select Report Objects from the bottom left to open the Report
Objects pane if it is not already open. Select the object you want to
base your filter on. The object can be an attribute or a metric.

l To base your filter on the results of another report, select All Objects
from the bottom left to open the All Objects pane if it is not already
open. Navigate to and select the report you want to base your filter
on.

4. To add the selected object to the report's Filter pane, do one of the
following:

l Drag and drop the object on the Report Filter pane.

l Right-click the object and select Add to Filter as shown in the image
below.
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5. Depending on the type of object you added to the filter, a new set of
choices may appear. The links below provide steps to filter data based
on the object you chose:

l If you are filtering based on an attribute, see one of the following:

l Filtering data based on business attributes: Attribute qualifications,
page 239.

l Filtering data based on business attributes: Attribute qualifications,
page 239.

l Filtering data based on business attributes: Attribute qualifications,
page 239.

l If you are filtering based on a metric, see Filtering data based on
attribute relationships or metrics: Set qualifications, page 253.
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l If you are filtering based on the results of another report, see Filtering
data based on existing filters or report results: Shortcut
qualifications, page 260.

l If you are filtering based on a filter, see Filtering data based on
existing filters or report results: Shortcut qualifications, page 260.

l If you are creating an advanced filter, see the Advanced Reporting
Help.

6. Click Apply.

7. You can add additional conditions to the report's fi lter by repeating the
steps above to add another object to the filter and define the condition.

8. Almost all reports have one or more attributes, one or more metrics,
and one filter. If you need to, use the following sections of this manual
to add additional objects to your new report:

l Attributes: See Reports: Adding attributes to a report, page 352.

l Metrics: See Reports: Adding metrics to a report, page 355.

l Prompts: See Reports: Adding prompts to a report, metric, or fi lter,
page 362.

9. If you want to see what your report looks like when executed against
the data source, once your report has one or more attributes and
metrics in it, from the toolbar select Run Report.

10. Save the report.

Reports: Adding prompts to a report, metric, or filter
You need to know what type of prompt you will be using when deciding
where and how to add it to a report, a metric, or a filter. For example, Object
prompts are most commonly placed directly on a report, but can also be
placed in the condition part of a metric's definition in the Metric Editor,
depending on the type of object in the Object prompt.

Use the following table when considering how and where to add a prompt to
a report, metric, or fi lter:
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Filter Name

Add To
Report
Editor:
Template
Definition
Pane

Add To
Report
Editor:
Report
Filter
Pane

Add To
Report
Editor:
Page-by
Pane

Add To
Metric
Editor:
Definition
Pane

Add To Filter Editor:
Filter Definition Pane

Hierarchy
Qualification
prompt

No Yes No No Yes

Attribute
Qualification
prompt

No Yes No No Yes

Attribute
Element List
prompt

No Yes No No Yes

Metric
Qualification
prompt

No Yes No No Yes

Object Prompts

Object prompt
of attributes

Yes No Yes Yes
Added as part of an
advanced qualification

Object prompt
of metrics

Yes No Yes Yes No

Object prompt
of fi lters

No Yes No Yes Yes

Object prompt
of reports

No Yes No No Yes

Value Prompts

Date prompt No No No No

Added as part of an
attribute form
qualification, on an
attribute form of Date
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Filter Name

Add To
Report
Editor:
Template
Definition
Pane

Add To
Report
Editor:
Report
Filter
Pane

Add To
Report
Editor:
Page-by
Pane

Add To
Metric
Editor:
Definition
Pane

Add To Filter Editor:
Filter Definition Pane

data type

Numeric
prompt, Long
prompt, or Big
Decimal
prompt

No No No Yes

Added as part of a
metric set
qualification, as a
metric value
comparison

Text prompt No No No No

Added as part of an
attribute form
qualification, on an
attribute form of a text
data type

Add To
Report Editor:
Template
Definition
Pane

Add To
Report Editor:
Report Filter
Pane

Add To
Report Editor:
Page-by Pane

Add To Metric
Editor:
Definition
Pane

Add to Filter
Editor: Filter
Definition
Pane

Procedure

Reports:
Adding
prompts to a
report,
metric, or
fi lter, page
362

Reports:
Adding
prompts to a
report,
metric, or
fi lter, page
362

Reports:
Adding
prompts to a
report,
metric, or
fi lter, page
362

Reports:
Adding
prompts to a
report,
metric, or
fi lter, page
362

Reports:
Adding
prompts to a
report,
metric, or
fi lter, page
362
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Adding prompts in the Report Editor

Adding a prompt to the Template definit ion pane in the Report Editor

You can add Object prompts to the Template definition pane of the Report
Editor.

This procedure assumes you have already created and saved a prompt. For
steps to create an Object prompt, see Filtering data based on metrics,
attributes, or other objects: Object prompts, page 329.

To add a prompt to the Template definit ion pane in the Report Editor

1. In MicroStrategy Web, if you are creating a new report, open Design
Mode. For steps to do this, see Creating a report with the Report Editor,
page 349. If you are adding the prompt to an existing report, from the
Home menu in the Report Editor, select Design.

2. In the All Objects pane on the left, navigate to the folder where the
prompt you want to add to the report is located and open it.

To search for the prompt, type the name of the prompt in the Find text
field and press Enter or click the Find icon.

3. Drag and drop the prompt to the desired location on the report's grid.
Alternatively, right-click the prompt and select Add to Grid as shown in
the image below, then move it to the desired location on the report's
grid.
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4. Add more prompts or other objects to the report if desired.

5. If you want to see what your report looks like when executed against
the data source, and if you want to see how a prompt works for a user,
once your report has one or more attributes and metrics in it and you
have added a prompt, from the toolbar select Run Report.

6. Save the report.

Adding a prompt to the Report Filter pane in the Report Editor

You can add Filter Definition prompts to the Report Filter pane of the Report
Editor. You can also add an Object prompt that is made up of filters or
reports.

This procedure assumes you have already created and saved a prompt. For
steps to create a filter definition prompt, see Filtering data on an attribute,
attribute form, attribute element, or metric: Qualification Prompts, page 298.
To create an Object prompt, see Filtering data based on metrics, attributes,
or other objects: Object prompts, page 329.
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To add a prompt to the Report Filter pane in the Report Editor

1. In MicroStrategy Web, if you are creating a new report, open Design
Mode. For steps to do this, see Creating a report with the Report Editor,
page 349. If you are adding the prompt to an existing report, from the
Home menu in the Report Editor, select Design.

2. In the All Objects pane on the left, navigate to the folder where the
prompt you want to add to the report is located and open it.

To search for the prompt, type the name of the prompt in the Find text
field and press Enter or click the Find icon.

3. Drag and drop the prompt onto the Report Filter pane. Alternatively,
right-click the prompt and select Add to Filter as shown in the image
below:

4. Add more prompts or other objects to the report if desired.

Basic Repor t ing Guide



Copyright © 2022 All Rights Reserved 368

5. If you want to see what your report looks like when executed against
the data source, and if you want to see how a prompt works for a user,
once your report has one or more attributes and metrics in it and you
have added a prompt, from the toolbar select Run Report.

6. Save the report.

Adding a prompt to the page-by pane in the Report Editor

Page-by lets you turn a long report into a set of individual pages. The pages
are created based on the objects on the report, allowing users to see
manageable subsets of otherwise large quantities of data. For background
information on page-by fields, see Grouping data by page, page 84.

You can add Object prompts to the page-by pane of the Report Editor.

This procedure assumes you have already created and saved a prompt. For
steps to create an Object prompt, see Filtering data based on metrics,
attributes, or other objects: Object prompts, page 329.

To add a prompt to the page-by pane in the Report Editor

1. In MicroStrategy Web, if you are creating a new report, open Design
Mode. For steps to do this, see Creating a report with the Report Editor,
page 349. If you are adding the prompt to an existing report, from the
Home menu in the Report Editor, select Design.

2. In the All Objects pane on the left, navigate to the folder where the
prompt you want to add to the report is located and open it.

To search for the prompt, type the name of the prompt in the Find text
field and press Enter or click the Find icon.

3. Drag and drop the prompt onto the page-by pane.

The image below shows an Object prompt called Object Prompt on
Metric in the page-by pane:
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4. Add more prompts or other objects to the report if desired.

5. If you want to see what your report looks like when executed against
the data source, and if you want to see how a prompt works for a user,
once your report has one or more attributes and metrics in it and you
have added a prompt, from the toolbar select Run Report.

6. Save the report.

Adding prompts in the Metric Editor

Adding a prompt to a metr ic's definit ion in the Metr ic Editor

You can add the following prompt types to a metric's definition in the Metric
Editor:

l An Object prompt of attributes, to allow the user to select the attribute at
which to calculated the metric. For steps to create a level metric, see the
Advanced Reporting Help.
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l A Numeric prompt, Big Decimal prompt, or Long prompt, which are all
types of a Value prompt.

l You can use a Value prompt in the formula of a metric. For example, a
user can enter the tax rate to be multiplied by the Revenue fact. For
steps, see To add a prompt to a metric's definition in the Metric Editor,
page 370 below.

l For a non-group function, you can use a Value prompt as the input
values of the function. For more information about non-group functions,
see Metrics made up of metrics: Compound metrics, page 214.

You can create a conditional metric, which filters data for that metric. As
part of the filter on the metric, you can use a prompt. For steps to create a
conditional metric, see the Advanced Reporting Help.

To add a prompt to a metr ic's definit ion in the Metr ic Editor

This procedure assumes you have already created and saved a prompt. For
steps to create a Value prompt, see Filtering data based on a single value
or string: Value prompts, page 335.

1. In MicroStrategy Developer, go to File > New > Metric.

2. Create your metric's formula. Use the Object Browser on the left to
locate the prompt to add to the metric's definition.

If the Object Browser is not displayed, from the View menu select
Object Browser.

3. Drag the prompt onto the Definition pane at the bottom right, as shown
in the image below:
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4. Save the metric, and add it to a report. For steps to do this, see
Reports: Adding metrics to a report, page 355.

If you want to see what your report looks like when executed against the
data source, and if you want to see how a prompt works for a user, once your
report has one or more attributes and metrics in it, from the View menu
select Grid View.

Saving a report
After you create or modify a report, you must save the report so that you and
others can execute it in the future. When you save a report, its name and its
definition such as the template, report fi ltering criteria, and report formatting
information are stored in the MicroStrategy metadata repository.

You can select options for prompted reports, such as whether to keep the
report prompted. You can also save reports as filters or templates, as
follows:

l Saving a report as a filter allows you to use the saved report to filter a
different report. For example, if you have a report that returns basic data
such as revenue for the year 2008, you can save the report as a filter and
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then use the new filter on other reports; in this example, the filter would
restrict data on other reports to revenue in the year 2008.

l Saving the report as a template allows you to use the saved report as a
base on which to build other reports. For example, if you have a report that
returns basic data such as countries and revenue, you can save the report
as a template on which you build several other reports, all of which contain
country and revenue data but also contain additional data as appropriate
for each report.

Saving a new report creates a predefined report. Other users can then
execute that report to analyze the data it shows, and they can limit or
reformat the data results according to their own analysis needs. To execute
the report, double-click the report to retrieve and display the most recent
data from your data source.

To save a report

This procedure assumes you have either finished creating a new report or
modifying an existing report, and you have the report open in the Report
Editor. For steps to create a report, see Creating a grid report, page 345.

1. From the Home menu, select one of the following:

l To save a report, select Save.

If the report has already been saved and contains prompts, the
report is automatically saved as a prompted report with the Filter and
Template set as prompted, and the Set the current answers to be the
default prompt answers check box selected. To select different
prompt options, select Save As from the Home menu instead of
Save, as described in the option below.

l To save a copy of an existing report using a different name or to
specify prompt options for an existing report, select Save As.
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2. Browse to the folder in which you want to save the report. You can
create a new folder in which to save the report. To do so, click the
Create New Folder icon. The Create Folder dialog box is displayed. To
create a new folder:

a. In the Folder f ield, enter a name for the folder. You cannot create
a folder with the same name as an existing folder.

b. In the Description f ield, enter a description for your folder.

c. Click Create Folder.

3. If you are saving a prompted report, you can choose whether or not to
keep the report prompted when the report is executed again. Select the
Keep report prompted check box. Expand the Advanced Options,
then select one of the following:

l To save the prompt answers you specified and automatically skip the
prompt selection page when running the report, select the Save report as
static option. The next time the report is run, the saved answers will
automatically be used to answer the prompts and run the report. The
prompt selection page will not be displayed to users.

l To display the prompt selection page each time the report is run, select
the Save report as prompted option, then perform the following steps:

a You can determine which prompts will be presented to users
when the report is run. You can choose to display prompts that
are part of the report's fi lter, prompts that have been placed on
the report's template, or both. Select one of the following:

— To present users only with prompts that have been added to
the report's fi lter, select the Only filter will be prompted
option. The next time the report is run, users will only be
prompted to provide answers for filter definition prompts.
Answers for prompts that have been placed on the report's
template, such as objects that users have selected in an
object prompt or levels selected in a level prompt, are saved
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with the report definition and do not need to be provided by
the user.

— To present users only with prompts that have been added to
the report's fi lter, select the Only filter will be prompted
option. The next time the report is run, users will only be
prompted to provide answers for filter definition prompts.
Answers for prompts that have been placed on the report's
template, such as objects that users have selected in an
object prompt or levels selected in a level prompt, are saved
with the report definition and do not need to be provided by
the user.

— To present users only with prompts that are part of the
report's template, select the Only template will be
prompted option. The next time the report is run, users are
only prompted to select objects for prompts that have been
placed on the report's template. Answers for prompts that
have been added to the report's fi lter are saved with the
report definition and do not need to be provided by the user.

— To present users with all prompts, regardless of whether they
have been added to the report's fi lter or the report's template,
select the Filter and template will be prompted option. The
report is saved so that object prompts, level prompts, and
filter definition prompts all remain active.

b You can choose to use the prompt answers you specified as
default prompt answers to be used the next time the report is
run. Do one of the following:

— To use the prompt answers as default prompt answers, select
the Set the current prompt answers to be the default
prompt answers check box.
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— To save the report without default answers, clear the Set the
current prompt answers to be the default prompt
answers check box.

3. To save the report as a filter, perform the following steps:

a Click the Filter tab.

b Select the Keep filter prompted check box. Expand the
Advanced Options and choose one of the following:

▫ To save the prompt answers that have been selected for the
report and automatically use them as answers each time the
user runs a report to which the report-as-filter has been
added, select the Save filter as static option. The report-as-
filter is not prompted when a report it has been added to is
run.

▫ To present the prompt selection page to the user each time
the user runs a report to which the report-as-filter has been
added, select the Save filter as prompted option. The
report-as-filter is prompted when the report it is added to is
run.

4. To save the report as a template, perform the following steps:

a Click the Template tab.

b Select the Keep template prompted check box. Expand the
Advanced Options and choose one of the following:

▫ To save the prompt answers that have been selected for the
report and automatically use them as answers each time the
user runs a report that is based on the report-as-template,
select the Save template as static option. The report-as-
template is not prompted when a report that is based on it is
run.
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▫ To present the prompt selection page to the user each time
the user runs a report that is based on the report-as-template,
select the Save template as prompted option. The report-
as-template is prompted when a report that is based on it is
run.

5. In the Name and Description f ields, type a name and description for
the report.

6. Click OK to save the report. If a report with the same name already
exists in the folder, the Confirm Overwrite dialog box appears. Click
Yes i f you want to replace the existing report.

After you create and save a report, you can include additional functionality
on the report for users, so they can explore report data more effectively and
see related data. For details on additional options you can add to a report,
see Adding features for users, page 378.

Example for creating a new report
This section provides tutorials for designing a basic grid report in
MicroStrategy Web.

Using the procedure below, you design the report called My Revenue by
Region using the Region attribute and the Revenue metric. The report on
which it is based can be found in the MicroStrategy Tutorial project in the
following location: Shared Reports\Subject Areas\Sales and

Profitability Analysis. The report is shown in the image below:
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Designing a report

The following procedure assumes you are using report objects from the
MicroStrategy Tutorial project and are making use of the sample Tutorial
data. For details on the Tutorial project, see About sample data and the
MicroStrategy Tutorial project, page 4.

This procedure also assumes you are familiar with the Report Editor in
MicroStrategy Web; see MicroStrategy Web Report Editor interface, page
437 in Appendix A, Reporting Interfaces in MicroStrategy for an introduction
to the Report Editor functionality.

To design the Revenue by Region report

1. In MicroStrategy Web, log in to the MicroStrategy Tutorial project, click
the MicroStrategy icon and select New Report.

2. Select Blank Report.
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3. In the Object Browser on the left, click Schema Objects to open the
Schema Objects folder. Open the Attributes folder and then the
Geography folder.

4. Double-click the Region attribute to add it to the Template pane.

5. In the Object Browser, browse to the Public Objects folder. (To do this,
navigate back to MicroStrategy Tutorial, then select Public Objects.)
In the Public Objects folder, select Metrics.

6. In the Metrics folder, open the Sales Metrics folder. Double-click the
Revenue metric to add it to the Template pane.

7. Click Save.

8. Click Run newly saved report to execute the report and display the
results, showing sample data from the sample data warehouse. When a
report like this is built using your organization's objects, this view
provides actual revenue numbers an analyst can use for detailed
reporting purposes.

9. From the Home menu, select Graph. This lets analysts compare data
on a higher level to see how various regions are doing in terms of
revenue.

Adding features for users

You can provide several report manipulation capabilit ies for report analysts,
by either enabling them or creating and adding them to an existing report.
These options provide an interactive reporting experience to your users. You
can also format the "No Data Returned" message that appears in a report or
document when no data is returned. For steps, see the Document Creation
Help.

User features you should consider adding include:
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Formatting for easier data analysis
If you created a report in MicroStrategy Developer, be sure to execute and
look at your new report in MicroStrategy Web as well. Make sure the report
is visually pleasing, and if necessary apply an autostyle to ensure the report
is easy to read. A report designer can create new autostyles in Developer
and make them available in MicroStrategy Web.

Additional formatting ideas can be found in the Reports chapter of the
Advanced Reporting Help.

Formatting row and column headers and cells

Analysts can apply a number of formatting characteristics to a report they
have executed. However, the report's designer can apply a broader range of
formatting options to a report, so that users can more effectively understand
the data displayed on the report, or to simply achieve a pleasing and easy-
to-read look. Formatting options available to analysts are described in
Chapter 2, Formatting a Report.

To format row and column headers and cells

1. In MicroStrategy Web, run the report that you want to format.

2. From the Format menu, select Advanced Grid Formatting.

If DHTML is disabled, click Go.

3. From the first drop-down list at the top of the dialog box, select the area
of the grid to change.

4. From the second drop-down list at the top of the dialog box, select
whether to format the All, Header, Values, Subtotal Names, or
Subtotal Values of that area of the grid.
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5. Select one of the following tabs to access formatting options for your
report.

l Font: Change the font and color of letters and numbers in the report,
and change the background by applying gradients and other effects.

To change cell background (fil l) color:

l If DHTML is enabled, use the Fill Color option on the Color and
Lines tab.

l If DHTML is disabled, use the Fill Color drop-down list on the Font
tab.

l Number: Specify a number format for values. For example, you can
ensure that certain metric values are displayed as percentages.

l Alignment: Specify how values and text are aligned within cells on
the grid report.

l Color and Lines: Change the formatting of lines in your grid report,
such as cell borders.

To format cell borders:

l If DHTML is enabled, use the Borders options on the Color and
Lines tab.

l If DHTML is disabled, use the Borders tab in the Format panel.

6. Click Apply.

Formatting empty cells and null values

Some cells within the tables in your data source may be empty because the
data was not available. This, along with other reasons, can cause cells in
some reports to be empty. You can determine how these empty or null
values are handled for display within a report. Determining a specific format
for null values can be helpful for analysts who might otherwise be confused
on seeing one or more blank cells in a report.
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In Freeform SQL reports, null values can occur when the report references
unavailable objects. For example, you map the attribute description and ID
forms of the Region attribute, but you only include the ID in the SELECT
clause. When the report is executed, the description cannot be displayed
because it has not been retrieved from the data source.

For steps to format empty cells or null values, see Formatting null values
and blank cells, page 31 in Chapter 2, Formatting a Report.

Analysts can apply formatting for null values to a given report, if they want
to.

Merge, Lock, and Rename column and row headers

Merging column and row headers

You can merge row headers or column headers in the following ways:

l Merge any row headers that are repeated. All headers displaying the same
value are automatically merged into one header. For example, a report
displays sales by merchandise type, payment method, and total amount
sold. If there is a row for each merchandise type for each method of
payment, all headers corresponding to a merchandise type can be merged
into one.

l Merge any column headers that are repeated. For example, if three
metrics on the report are related to Sales, do you want all three columns to
have Sales in the header, or do you want to merge these column headers
into a single header? If merged, Sales appears only once for the three
related columns.

To merge the column or row headers of a report

1. In MicroStrategy Web, run the report that you want to format.

2. From the Tools menu, select Report Options.
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3. Select the Merge check box in either or both the Rows and Columns
areas. Click OK.

If DHTML is disabled, select Merge Row Headersor Merge Column
Headers, then click Go.

4. Click OK.

Locking column and row headers

You can lock column and row headers at the top and side of a grid report, so
that when a user scrolls through a large report, the row and column headers
remain visible. Row and column headers can be locked independently of
each other.

Prerequisite

DHTML must be enabled. For steps, click Help in MicroStrategy Web.

To lock the column or row headers of a report

1. In MicroStrategy Web, run a report.

2. From the Tools menu, select Report Options.

3. Select the Lock check boxes in either or both the Rows and Columns
areas, depending on whether you want to lock rows, columns, or both.

4. Click OK.

Renaming row and column headers: Aliasing

Creating different aliases for different reports enables you to create flexible
reports for many different users. Different departments of the same company
may have different names for the same business measurement. For
example, you create a metric named Sales. The Sales department commonly
refers to this metric as Revenue, while Marketing calls it Sales. Use an alias
to display the Sales metric as Revenue for Sales department reports. Metric
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aliases help provide greater flexibil ity for naming conventions in situations
such as this one.

Aliases also allow you to initially name metrics descriptively, including the
level and condition in the name, which can be helpful while you are
designing reports. However, that name is often too long and technical to be
displayed for analysts on a report. The end users may not need or want to
know what the level is; they simply want to know what the metric represents
on their specific report. Aliases provide a second opportunity to name the
metric for those users, without changing the original name of the metric or
its name on other reports.

For more details on aliasing and steps to create an alias on a report, see
Renaming row and column headers, page 33 in Chapter 2, Formatting a
Report.

Formatting metrics on a specific report

You can format the data related to individual metrics on a report. Certain
formatting choices can help analysts more quickly identify important values
or perform data comparisons.

For example, an analyst can instantly understand what a particular metric's
values mean when they are preceded by a currency sign. Financial numbers
are generally easier to work with when a decimal is in place. Consider the
type of data that is returned on the report you are formatting, and apply
formatting choices that enhance understanding of that data.

The procedure below formats a metric only within the context of the report
that is open when the formatting is applied to the metric. If the metric is also
used on another report, the formatting applied with this procedure does not
appear on that other report. To format a metric so that the formatting
appears on every report in which the metric is used, see Formatting a
metric, page 226.
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To format a metr ic on a specific report

1. In MicroStrategy Web, run the report containing the metric to be
formatted.

2. From the Format menu, select Advanced Grid Formatting.

3. From the first drop-down list at the top of the dialog box, select the
metric to be formatted.

4. You can format the metric's column or row header, and you can format
the metrics' values that appear when the report is executed against
your data source.

l To format the metric's column or row header, from the second drop-
down list at the top of the dialog box, select Header.

l To format the metric's values, from the second drop-down list at the
top of the dialog box, select Values.

5. Format any or all of the following aspects of the metric. The following
steps describe the most commonly used options.

l To format numbers: Select the Number tab. Choose a Category,
then choose how to format numbers for this metric.

l For example, if you select Date as your category, the Type l ist lets
you choose which date format to use, such as 4/12/06, April 12, 2006,
12/4/2006, and so on. If you select Fixed as your category, you can
determine the number of decimal places to be displayed, whether you
want numbers to be separated every three decimal places, and
whether negative numbers are allowed to be displayed.

l To format the alignment: Select the Alignment tab. Select an
alignment option. Text alignment determines how the content of each
cell is aligned, for example, centering the text. You can also select
Horizontal and Vertical alignment, and whether to wrap the text.
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l To format the font: Select the Font tab. Select the Font that you
want values to appear in. You can also select a Size, a Style (Bold,
Italic, and so on), and a Color in which text should be displayed.

l To format the background and borders: Select the Color and
Lines tab. You can select a color to fil l the cell background and the
type of border to display around the selected cells. You can also
customize the border by selecting the type of line and color used for
each of the left, right, top, and bottom borders.

6. Click OK.

Formatting conditional values on a grid: Thresholds

Data in a report can be set up to appear with special formatting if it satisfies
a particular condition. The condition that the data needs to satisfy and the
special formatting that it will appear with are pre-determined by the user. For
an introduction to thresholds, and for prerequisites to define conditions and
formatting, see Formatting conditional values on a grid: Thresholds, page
26.

MicroStrategy Web comes with several default thresholds:

l Quick thresholds: Quick thresholds allow end users to apply green, red, or
yellow colors or symbols to metric values on your report. The end users
can automatically format the thresholds, and add them to a report quickly.
See Formatting conditional values on a grid: Thresholds, page 26.

l Visual thresholds: Visual thresholds allow end users to use range
expressions (such as Greater Than, Less Than, or Top N%) to determine
whether a metric has met the condition. If a metric meets the condition, the
end users can apply special formatting to the values, or replace the values
with an image or a symbol. See Formatting conditional values on a grid:
Thresholds, page 26.

l Advanced thresholds: A Web Professional can use advanced thresholds to
apply formatting to a report or a grid in a document, based on multiple
metrics and more complex expressions than a visual threshold. This
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allows for very specific conditions to be defined. Advanced thresholds
allow Web Professionals to create conditions based on metrics or
attributes, and a single advanced threshold can be based on multiple
conditions.

Steps are below to create an advanced threshold.

To create an advanced threshold

1. In MicroStrategy Web, click the name of the report to run it.

2. From the Data menu, select Advanced Threshold Editor .

Specify the threshold's conditions

1. From the Filter On drop-down list, select the attribute or metric on
which to base the threshold.

2. If you are creating a condition based on a metric, do the following:

a. Select a comparison operator such as Greater Than or Less Than.

b. Enter a value in the field on the right or click Select Metric to
choose another metric to compare the original metric to.

c. Click Apply .

3. If you are creating a condition based on an attribute, do one of the
following:

To define your condition by typing specific attribute form values:

a. Select the Qualify option.

b. From the drop-down list on the left, select the attribute form on
which to base the condition. For example, you can qualify on the
attribute element's ID form, one of its description forms, or the
DATE i f the attribute is time-based.
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c. From the next drop-down list, select a comparison operator such
as Greater Than or Less Than. The operators available for a
selection depend on the attribute form you chose above.

d. Do one of the following:

l To compare the attribute form to a specified value, type the
value in the field.

l To compare the first attribute form to a second attribute form,
click Select Attribute, then select the second attribute form
from the drop-down list.

e. Click Apply .

To define your condition by selecting attribute elements from a list:

a. Choose the Select option.

b. From the drop-down list on the left, select In List or Not In List. If
you select Not in List, then the attribute elements in the Selected
list will not be included in the threshold condition.

c. Move attribute elements from the Available l ist to the Selected
l ist. Elements in the Selected list are included in the threshold
condition.

To search for a specific element, use the Search for f ield. Select
the Match case check box to return only items that match the
upper and lower cases you typed in the Search for field. For
examples of searches, click Help.

d. Click .Apply .

Specify the formatting for the threshold

1. To specify how data that meets the threshold is formatted, click the
threshold, then click the Cell Formatting icon on the toolbar.

2. Specify a name for the threshold in the Name f ield, if desired.
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3. To replace the threshold values with text, an image, or a quick symbol,
select the Replace Data check box and select one of the following from
the drop-down list.

l Replace Text: Replace data with any text you specify. For example, a
document shows the financial values of various sales opportunities.
For those sales opportunities that have been lost, you might display
the word LOST in red, rather than displaying the financial value. A
common use of this option is to display the word EMPTY when a data
value is null.

l If you select this option, type the text with which to replace the values
in the corresponding text field.

l Quick Symbol: Replace the normally displayed data with a common
symbol. For example, a document shows the financial contribution of
various sales groups to overall sales office activity. For the monthly
trend column you could show either a green plus + or a red minus –
symbol to represent positive or negative contribution trends.

l If you select this option, select the symbol with which to replace the
values from the corresponding drop-down menu.

l Image: Replace the normally displayed data with an image, such as
an arrow or green dot. You can specify the path to the image by
typing the address using one of the following:

l Absolute path: The default, for example, c:/images/img.jpg

l Relative to HTML Document directory: A relative path from the
document directory where the image is stored, for example,
images/img.jpg

l On the network: A path on the local area network, which is in a UNC
(Universal Naming Convention) format, for example, //machine_
name/shared_folder/img.jpg

l On the web: A URL to an image file, for example:
http://www.microstrategy.com/images/img.jpg
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4. To format the threshold values by adjusting the font, color, alignment,
and other options, make the appropriate selections within the Font,
Number, Alignment, and Color and Lines tabs. Click Help for more
information on the options available.

5. You can create, edit, and delete thresholds:

l It is often convenient to make a copy of a threshold if you plan to
create similar thresholds in the report. To copy a threshold, select the
threshold in the Advanced Threshold Editor and click Copy, then
paste the copied threshold by selecting the threshold and clicking
Paste.

l To delete a threshold, select the threshold and click Delete
Threshold .

l To move a threshold above or below other thresholds, select the
threshold and click Move up or Move down.

l To add an additional condition to a threshold, select the threshold
and click Add Condition .

l To clear the conditions from a threshold, select the threshold and
click Clear Conditions .

l To determine whether to apply the specified background color to
graph reports in which thresholds are met, select the Enable
Thresholds on Graph icon .

l To have an email automatically delivered to you or other users when
the threshold is met, click Create Email Alert or Create Mobile

Alert . For details on using the Alerts Editor, click Help.

6. Selectors provide dashboards with interactivity, allowing each user to
change how he sees the data. A selector can change panels, the focus
of a Grid/Graph, or dynamic text fields (a text field that is a reference to
an object on a report) in a panel stack. Selectors that contain attribute,
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custom group, or consolidation elements as selector items can also
include an option to display totals. The total is calculated for all the
selector items. A user can choose whether to display specific elements,
all of the elements at the same time, or the totals.

If you are formatting a grid in a document that is also the target of a
selector, you can specify whether to apply conditional formatting to the
grid when metrics are selected in the selector, when totals are
selected, or for both metrics and totals. To determine what parts of the
report are formatted when a threshold is met, select one of the
following options on the toolbar:

l To apply conditional formatting only when metrics are selected in the
selector, click the Format metrics only icon.

l To apply conditional formatting only when totals are selected in the
selector, click the Format subtotals only icon.

l To apply conditional formatting for both metrics and the Total option,
click the Format metrics and subtotals icon.

7. To add another threshold condition, click Add a New Threshold ,

then repeat the appropriate steps above.

8. Click OK.

Removing the extra Metrics column from a report

You can determine whether the word "Metrics", which usually appears in the
column headers, is displayed on a report. If you remove this column from the
report, it is also removed if you export the report.

To remove the extra 'Metr ics' column from a report

1. In MicroStrategy Web, click the name of a report to run it.

2. From the Tools menu, select Report Options.

3. Select the Remove extra column check box.
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If DHTML is disabled, from the Format drop-down list, select Overlap Grid
Titles, and then click the Go icon.

4. Click OK.

Displaying or hiding attribute forms

An attribute is a business concept. An attribute form is descriptive
information about an attribute. For example, the attribute Customer can
have the forms First Name, Last Name, Address, Email Address, and so on.
A form is a descriptive category for any data your organization saves about
any of its attributes. Just as an attribute element is a distinct occurrence of
an attribute, a form defines the attribute.

In Design Mode in MicroStrategy Web, report designers can choose which
attribute forms are displayed on a report. From the Report Objects panel,
right-click any attribute form and select the attribute forms you want to
appear on the report.

You can choose to display or hide any attribute forms related to the
attributes on your report.

To display or hide attr ibute forms

1. In MicroStrategy Web, run the report that you want to format.

2. From the Data menu, select the Edit Attribute Forms icon. The

Attribute Forms dialog box is displayed. If DHTML is disabled, click Go.

3. From the Current Attribute drop-down list, select the attribute whose
forms you want to display.

4. Select the check boxes next to the attribute forms you want to display.
In the Selected Forms area, you can see what attribute forms are
currently available for the given attribute.

5. To specify a display order for the attribute forms, click the name of the
attribute form to highlight it. Then, click the up or down arrow on the
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right to reorder the selected form. If DHTML is disabled, click the option
in the Selected column for the attribute form to move.

6. Click Apply to display the selected attribute forms in the report.

Letting users choose their own report filter
You can let each user choose the report fi lter that suits his analysis needs.
You can also let users design their own filters, within the constraints that
you define. To provide this functionality to users, you add prompts to a
report.

An Object prompt that is made up of filters lets each analyst choose from
among your chosen set of fi lters, to apply the most useful fi lter for that
analyst's reporting needs. A filter definition prompt allows analysts to design
their own filters, within your chosen constraints, before the report is
executed against your data source.

This provides an opportunity for individual analysts to define the data that is
returned from your data source. For details on Object prompts and filter
definition prompts, see Asking for user input: Prompts, page 280.

Adding usability to a Report Services document
Report Services documents are described in Report Services dashboards
and documents, page 14 in Chapter 1, Getting Started with MicroStrategy
Reporting. If you created a Report Services document, look carefully at your
final document before making it available to users, and consider the
following issues:

l Consider usability carefully. Be sure you have named the individual
datasets on the document with usable names. (A dataset is a set of data
that can be displayed on a document. A dataset can be a MicroStrategy
report, a MicroStrategy Intelligent Cube, or data imported directly from an
external data source.)

For example, a general tit le such as Customer Behavior which appears
above a list of products and percentages for each product, makes it
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difficult for a user to intuitively understand what to do with the numbers
displayed. Perhaps from the context of the overall document it seems clear
that the percentages represent purchasing behavior by customers for each
of the products listed, but it is better to make this explicit in the title of that
dataset.

l Spend a higher percentage of your design time making the information
understandable, rather than adding "bells and whistles". A clean,
minimalist document is always easier to derive useful information from
than a busy, cramped, and distracting document.

Confirming your choice of graph style
When you first decide on a graph style to use, you generally choose a style
that is compatible with the data you want to display. Most graph styles have
specific requirements for the type of data that must exist on the report for
the graph style to appear properly, as described in Choosing a graph style,
page 55 in Chapter 2, Formatting a Report.

After you have made this decision, consider your graph report from a
usability perspective. How easy is it for an analyst to get detailed data from
the graph report?

For example, a pie graph is useful in many circumstances, but it usually only
shows percentages, which can leave an analyst unclear about specific
numbers. A good alternative might be a bar graph, which usually lists actual
numbers for each attribute element.

For complete details on requirements and recommendations for each graph
style available in MicroStrategy, see the Graphing chapter in the Advanced
Reporting Help.

Enabling drilling and customizing drill maps
Analysts can dril l through a report by clicking on an object on the report, to
analyze data that is closely related to the original report data. They can use
dril l ing to expose an entirely different object on a report to see what the data
looks like within a different context. If you need an introduction to dril l ing or

Basic Repor t ing Guide

https://www2.microstrategy.com/producthelp/2021/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm
https://www2.microstrategy.com/producthelp/2021/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm


Copyright © 2022 All Rights Reserved 394

a better understanding of how users experience dril l ing, see Drill ing into
related data, page 120 in Chapter 4, Answering Questions about Data.

A dril l map is a set of restrictions you can define that shape the directions
that users can dril l (called a dril l path) on a report. If a report does not have
a dril l map specifically defined, the default paths available are based on the
system hierarchy of the project. Any customized dril l map you create can
override the default. You create a dril l map using the Drill Map Editor.

Analysts can perform several procedures to personalize their dril l ing
experience in a given report. For example, an analyst can determine
whether the dril led-from attribute automatically appears on the dril led-to
report. For more information on the personalizations related to dril l ing that
an analyst can define, see Controlling dril l ing behavior to affect report
results, page 123 in Chapter 4, Answering Questions about Data.

For more information on the default dril l map, and steps and examples for
creating a new drill map, see the Drill ing chapter of the Advanced Reporting
Help.

To enable or restr ict dr illing

1. In MicroStrategy Web, run the report that you want to enable dril l ing in.

2. From the Tools menu, select Report Options.

3. From the Drill options drop-down list, select one of the following
options to specify how users can dril l in the report:

l No drilling: Users cannot dril l up, down, or across to any objects.

l Drill down only: Users can only dril l down on objects on the report.
They cannot dril l up or across to other objects.

l Drill anywhere: Users can dril l up, down, and across to any objects
available in the drop-down list.

4. Click OK.
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Including totals and subtotals
If you enable grand totals and/or subtotals for a metric, an analyst can
choose to display or hide them on any report that contains the metric. You
can also create a selection of subtotals from which users can choose the
subtotal function that best suits their analysis purposes.

For information, examples, and steps to enable grand totals and subtotals
for a metric, see Totals and subtotals, page 221.

Including sorted data
Analysts can sort data in various ways on a report. But the report designer
can have report data appear automatically in a given sorted order, saving
analysts time and making some data trends clear immediately. You can sort
on any object placed on the report.

Information and an example for how to sort data in a column or row in either
ascending or descending order, called a Quick Sort, is in Sorting data, page
72 in Chapter 3, Analyzing Data. Quick sorting is limited to one row or
column of data.

For directions to create a more advanced sort for rows, columns, and pages,
for either a grid report or a graph report, see the Advanced Sorting section in
the Advanced Reporting Help. Advanced sorting lets you sort by multiple
rows and columns.

Hierarchical display of grouped attribute elements
For custom groups to display hierarchically, hierarchical display must be
enabled for the custom group and the item display of at least one custom
group element must be expanded.

For information about creating custom groups and setting hierarchical
display, see the Custom Groups and Consolidations chapter in the Advanced
Reporting Help.
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Grouping data by page: Adding objects to the page-by field in
a report
Page-by is the MicroStrategy functionality that lets you turn a long report
into a set of individual pages. The pages are created based on the objects
on the report, allowing users to see manageable subsets of otherwise large
quantities of data.

Users can place report objects in the page-by pane of a report, if they wish.
However, the report's designer can also place report objects into the page-
by pane of a report. When a user executes the report, the user is presented
with a subset of what would otherwise be a long list of data.

For images of the page-by feature, see Grouping data by page, page 84.

To add objects to the page-by field in a report

1. In MicroStrategy Web, open the report in Design Mode.

2. Select the object to include in the page-by pane from either the All
Objects pane on the left or from the report's template. Drag and drop
the object onto the page-by pane.

You can place more than one object in the page-by pane. If you decide to
place multiple related attributes in the page-by pane, be aware that order
matters. Whatever you page-by first (furthest to the left) affects the
elements displayed in the other page-by fields. Place multiple objects into
the page-by pane in logical order, from left to right.

For a list of objects that can be used as pages, see Grouping data by
page, page 84.

3. Save the report.

Adding consolidations and custom groups
A consolidation is a set of attribute elements grouped in a way that they
were not originally grouped within the project, so that you can use the
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consolidation (the newly consolidated elements) just like a regular attribute
on a report. For example, you might group the Month elements into
December, January, and February and call the consolidation Winter; then
you group March, April, and May into a consolidation called Spring; and so
on. These names appear on the resulting report.

When you create a consolidation, you do not change your organization's
data source definitions or the MicroStrategy metadata definitions.
Consolidations allow users to filter a report on a row-by-row basis.

A custom group is a group of filters that bring back from your data source a
specifically defined set of attribute elements to be displayed on the report.
Custom groups allow you to group and display attribute elements in a way
that is not defined in your data source. For example, you might create filters
to bring back data that is displayed as Top 5 Customers, Top 5 Employees
and Top 5 Items on the same report.

The table below compares consolidations and custom groups.

Consolidation Custom Group

Example
Grouping specific months into
seasons, and displaying the
seasons on a report.

Displaying Top 5 Customers, Top 5
Employees, and Top 5 Items on one
report.

Structure
Groups of attribute elements (such
as January, February, and so on).

Groups of filters (such as top 5 revenue-
producing customers, top 5 revenue-
producing employees, and so on).

How it
works

Creates a virtual attribute to allow
reporting on an attribute that does
not exist in the data model.

Applies different fi lters to different rows
of a report.

The following table outlines other differences between custom groups and
consolidations.
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Feature or Action Consolidation Custom Group

Arithmetic operations (row
level math)

Yes, this can be done. No, this cannot be done.

Site of final calculation
MicroStrategy
Analytical Engine.

Your data source.

SQL efficiency High.
Low. One pass for each custom
group element.

Recursive definition Yes. No.

Display mode
Fixed at element level
only.

Flexible and expandable.

Subtotals No. Yes.

For details on these differences, as well as business examples and steps to
create consolidations and custom groups, see the Consolidations and
Custom Groups chapter of the Advanced Reporting Help.

Specifying maximum and minimum values: Report limits
A report limit specifies a set of criteria used to restrict the data returned in a
result set after the report's metrics are calculated. Because it is based on
the report's final metric values, the report limit is applied after all the metrics
are calculated. A report limit can make a report more efficient to run,
because less information is returned from the data source.

For an introduction to report limits and steps to apply a simple report limit,
see Specifying maximum and minimum values: Report limits, page 93 in
Chapter 3, Analyzing Data.

For an explanation of the difference between a filter and a report limit, as
well as examples of each and how they affect a report, see the Filtering
chapter in the Advanced Reporting Help.
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Determining evaluation order of calculations
You can change the evaluation order of various objects on a report to affect
how data is calculated for a given report. You can change the evaluation
order of consolidations, compound smart metrics (which are compound
metrics with smart totals enabled), report limits, and subtotals.

The default evaluation order on a report is:

1. Compound smart metrics

2. Consolidations, which are evaluated by their relative position on the
report grid:

l First, rows from left to right

l Then, columns from top to bottom

3. Report limits

4. Subtotals

Notice that the metrics that are included in the evaluation order are
compound smart metrics. A metric must have smart totals enabled for the
evaluation order to affect it, otherwise the metric is always calculated first.
Only compound metrics can have smart totals enabled.

For steps to change the evaluation order of these objects on a report, see
Evaluation order of calculations, page 105 in Chapter 3, Analyzing Data.

For additional information on changing the evaluation order of objects on a
report, see the following chapters of the Advanced Reporting Help:

l For the evaluation order of multiple consolidations, see the Custom
Groups and Consolidations chapter.

l For the evaluation order of all other report objects, see the Reports
chapter.

For more information on compound metrics and smart totals, see Metrics
made up of metrics: Compound metrics, page 214 and Totals and subtotals,
page 221.
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Specifying the delivery options available to users subscribing
to a report
You can determine which delivery options are available to users subscribing
to a specific report. For example, you can specify which delivery schedules
can be used to subscribe to the report, or prevent users from subscribing to
the report altogether. Restricting the delivery schedules available when
subscribing to a report does not affect the delivery schedules available for
documents that use the report as a dataset.

If an existing report subscription uses a schedule or report that has been
made unavailable for subscriptions, the report will not be delivered.

For general information on subscribing to reports and documents, see the
MicroStrategy Web Help. For steps to specify delivery options for users
subscribing to a document, see the Formatting Documents chapter in the
Document Creation Guide.

You can create new schedules in Schedule Manager. For steps, see the
Scheduling Jobs and Administrative Tasks chapter in the System
Administration Guide.

To specify the delivery options available to users subscribing to a

report

1. In MicroStrategy Web, click the name of the report to run it.

2. From the Tools menu, select Report Options.

3. On the Advanced tab, select one of the following options under
Schedules for Subscriptions:

l To prevent users from subscribing to the report, select the Do not
allow this report to be scheduled option.

l To allow users to subscribe to the report using any schedule
associated with the MicroStrategy project in which the report is
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stored, select the Allow users to subscribe to all schedules
option.

l To specify the list of schedules users can select from when
subscribing to the report, select the Only allow users to subscribe
to schedules in the list below option. Schedules in the list on the
right are available to users. Select a schedule from the list on the left
and click the Add icon to move it to the list on the right.

Administrators can determine which schedules are included in the list on the
left. For more information, see the Web Administrator Help.

4. Click OK.

Modifying an existing report

This section shows you how to open an existing report in Design Mode. You
can access the Report Editor in MicroStrategy Web.

To modify an exist ing report

1. Open MicroStrategy Web and log in to the project that contains the
report you want to modify. For steps, see Starting MicroStrategy, page
2.

2. Locate and double-click the report you want to modify. The report
opens in the Report Editor interface.

3. From the Home menu, select Design. The report's template is
displayed within Design Mode.

The following image shows Design Mode in MicroStrategy Web
displaying the template for the sample report called Revenue
Forecast. On the right side of the image, you can see the report
objects on the template: the Subcategory attribute, the Quarter
attribute, and the Revenue Forecast metric:
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4. Modify the report in whatever way you wish, as follows:

l To add an object to the report, see the appropriate procedure in this
section, depending on what you want to add:

l Reports: Adding attributes to a report, page 352

l Reports: Adding metrics to a report, page 355

l Reports: Adding a filter to a report, page 357

l Reports: Adding prompts to a report, metric, or fi lter, page 362

l To modify an object on the report, see the appropriate procedure(s) in
this chapter, depending on what object you want to edit and the
changes you want to make to it:

To modify an attribute in a MicroStrategy Web report, open it in
MicroStrategy Developer to make your changes. The changes
appear when you save the attribute and the report in Developer and
then open the report in Web.

l To modify a metric, see Editing a metric, page 230.

l To modify a filter, see Editing a filter, page 278.
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l To modify a prompt, see Editing a prompt, page 342.

l To modify an attribute, see your project designer or the Project
Design Help.

l To remove an object from the grid report, right-click the object's
header and select Remove from Grid. The objects removed from
the grid are stil l available in the Report Objects, if you want to add
them back to the grid. To remove an object from the grid and the
Report Objects pane, right-click the object's header and select
Remove from Report.

l To add usability features to the report, see Adding features for
users, page 378

5. Save the report.

If you modify an object on a report and want to execute the report to see
how your changes appear, you must first save and close the report, then re-
open the report to see your changes.

Creating other types of reports

You can create other kinds of reports:

Creating a graph report
A graph report provides a different way to display report data than in the
standard grid format. Depending on the graph style you choose, viewing
report data in a graph can often highlight trends or allow comparisons that
are difficult when viewing data in a grid.

For details on designing a graph report, and for graph-related options and
other details, see the Graphing chapter in the Advanced Reporting Help.
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Creating a Report Services document
A MicroStrategy Report Services document contains datasets from one or
more reports. This data is positioned and formatted, resulting in a single
display of presentation quality. (A dataset is a set of data that can be
displayed on a document, Report Services dashboard, or Visual Insight
dashboard. A dataset can be a MicroStrategy report, a MicroStrategy
Intelligent Cube, or data imported directly from an external data source.)

When you create a document, you can specify the data that appears; control
the layout, formatting, grouping, and subtotaling of data; and specify the
position of page breaks. In addition, you can insert pictures and draw
borders in the document. All of these capabilit ies allow you to create reports
that are suitable for presentation to management and for printing boardroom
quality material.
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The image above shows a sample production and operational report
document. It l ists all sales opportunities in the pipeline, and it groups those
opportunities based on sales region, sales district, and sales representative.
This document also provides a snapshot of each opportunity's current status
and measures key metrics such as unweighted and weighted sales
forecasts.

Sales managers can use this document to see a general overview of the
sales pipeline and to identify key opportunities and opportunity statuses.
The data in this document can help you evaluate sales opportunities for
each sales representative and to prioritize those opportunities that have a
greater probability of being closed.

You must have MicroStrategy Report Services to be able to design and work
with Report Services documents. Detailed information to create and modify
Report Services documents can be found in the Document Creation Help.

The document types that can be created in MicroStrategy include the
following:

l Scorecards and dashboards: designed for visual impact, these documents
provide a distil led view of the business, organized in adaptive sections or
zones.

l Managed metrics reports: with a quantitative focus, these documents
present lists of metrics or process-driven tabular views of the business.

l Production and operational reports: designed for production operations
management, these documents present data in hierarchical categories or
bands and can span hundreds of printed pages.

l Invoices and statements: these documents use transaction and sub-
transaction level data necessary for bill ing, collection, and customer
service.

l Business reports: designed for financial and other statutory business
reporting, these documents present comprehensive data in print and
electronic forms.
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Creating an HTML document
HTML documents are a popular way to create dashboards and scorecards to
display a group of reports within the MicroStrategy platform. Dashboards
and scorecards display and distribute data from business intelligence
projects. Scorecards typically follow a specific methodology and are focused
on key metrics within a business area. Dashboards, on the other hand, tend
to provide key metrics along with summary information.

HTML documents in the MicroStrategy platform are HTML containers or
shells into which you can place MicroStrategy reports and other graphics,
and control the formatting and appearance with style sheets. You can modify
the appearance of an HTML document just like any other HTML page, to
include text, images, hyperlinks, tables, and one or more report objects.

For details on how to create HTML documents, see the HTML Documents
chapter in the Advanced Reporting Help.

Designing reports that use OLAP Services

OLAP Services lets MicroStrategy Developer, Web, and Office users make
use of features that slice and dice data in reports without re-executing SQL
against the data source. This improves performance by resulting in quicker
data display within a report as users analyze and manipulate the data.

If you own OLAP Services and analysts will be taking advantage of it, its
features can be useful for a report designer to understand. When you design
a report, you should take into account the fact that users can view subsets of
data easily with an OLAP Services "view report". This can allow you to
create larger and more inclusive reports, since analysts can later create
smaller reports, called view reports, made up of only that data they want to
see.

Specifically, OLAP Services surfaces in a grid report in two places:

Basic Repor t ing Guide

https://www2.microstrategy.com/producthelp/2021/AdvancedReportingGuide/WebHelp/Lang_1033/index.htm


Copyright © 2022 All Rights Reserved 407

l The Report Objects pane

l The View Filter pane

Each of these features is described below. To see descriptions and images
of these panes in the Report Editor, see MicroStrategy Developer Report
Editor interface, page 419.

View filters and view reports
Unlike a report fi lter that restricts how much data is retrieved from the data
source, a view filter dynamically limits the data being displayed on a report
without re-executing the report against the warehouse.

This feature allows analysts to create multiple reports out of a larger, parent
report, without stressing the system or your data source. It also allows
different users to access the same report cache but see different data
according to their needs.

The advantage of using both standard report fi lters and view filters on a
report is that the report can use the standard report fi lter to bring back more
data than can usefully be displayed at any one time. The analyst can then
use a view filter to change the data displayed, as long as it falls within the
data already retrieved from the database. The analyst generates a view
report, which is the result of a view filter. A view filter does not trigger re-
execution against the data source. This capability translates to improved
response time and decreased database load.

A report designer does not need to enable view filters for users to take
advantage of them. If you have OLAP Services, view filters can be used on
any report on which a user wants to use them.

For additional information on report caches and how they work with your
data source, see Report caches, page 159 in Chapter 5, Answering Prompts
and Refreshing Data. For steps to use a view filter, click Help.
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Derived metrics
Derived metrics are metrics that a report analyst can use to perform
calculations based on report results. A derived metric performs a calculation
on the fly with the data available in a report without re-executing the report
against the database. Derived metrics are created based on existing metrics
in the report. Since derived metrics are evaluated in memory, their
computation does not require any SQL execution in the database. They are
evaluated on the client for MicroStrategy Developer, or on Intelligence
Server for MicroStrategy Web.

A report designer does not need to enable derived metrics for users to take
advantage of them. If you have OLAP Services, derived metrics can be used
on any report on which a user wants to use them.

Dynamic aggregation
Dynamic aggregation allows a report analyst to change the level at which the
data on a report is aggregated. (For an introduction to levels, see
Components of a metric, page 205.) The analyst can make the change on
the fly, while reviewing the report data. Dynamic aggregation occurs when
report objects (such as an attribute or an attribute form) are moved from the
grid to the Report objects pane. As attributes are moved on and off the
report between the grid and the Report objects pane, metric values are
dynamically recalculated at the level of the objects remaining on the grid.

A report designer does not need to enable dynamic aggregation for users to
take advantage of it. If you have OLAP Services, dynamic aggregation can
be used on any report on which a user wants to use it.

To see an image of the Report objects pane, see MicroStrategy Developer
Report Editor interface, page 419.
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Building a query using alternative data access
methods

Freeform SQL and Query Builder are MicroStrategy tools that provide you
alternative methods to access your business data and create reports.

Freeform SQL
Freeform SQL is a MicroStrategy tool that allows you to write your own SQL
statements to run directly against a data warehouse or operational data
store, giving you full control over accessing your data.

Traditionally, you use the MicroStrategy Engine to generate SQL to run
against one specific relational database to return results for a desired
report. In addition to generating reports in the traditional way, you can also
use your own customized SQL statements to generate reports from
operational systems included in a MicroStrategy project. This capability can
save you time since you do not need to place the data into a data mart or
data warehouse first.

The Freeform SQL feature allows you to use your own SQL statements to
access data from various ODBC data sources, including relational
databases, Excel fi les, and flat fi les, as long as they are included in the
MicroStrategy environment. Since you create your own SQL statements to
create reports with Freeform SQL, a strong knowledge of how to create and
use SQL statements is essential.

For detailed information on how to create a Freeform SQL report, see the
Custom SQL Queries chapter in the Advanced Reporting Help.

Query Builder
Query Builder is a graphical user interface that helps guide you when
building SQL queries that can adapt to different data models. Query Builder
allows you to run queries against ODBC data sources that are not easily
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modeled to an attribute and fact schema. This includes databases that are a
collection of flat tables rather than being defined into fact and lookup tables.

Query Builder provides an easy way to quickly access your ODBC data
sources without having to write any SQL, which is required by the Freeform
SQL tool. You can create queries to be run against imported database
tables, which allows you to begin reporting and analysis with MicroStrategy
without performing the project creation step of modeling attribute and fact
schemas. (The modeling step is necessary for MicroStrategy's ROLAP
Engine to define attribute and fact schemas.) You can also import tables into
a project's Warehouse Catalog using the Query Builder feature.

Query Builder allows you more control over the SQL generated against your
database systems, without the need for extensive knowledge on how to
create SQL statements. A basic knowledge of how SQL statements use
tables, columns, and joins to build queries is essential.

For detailed information on how to create a Query Builder report, see the
Custom SQL Queries chapter in the Advanced Reporting Help.
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REPORTING INTERFACES
IN M ICROSTRATEGY
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If you are new to MicroStrategy, use this appendix to help you become
familiar with where things are in MicroStrategy Web and Developer.

If you are already familiar with MicroStrategy, use this appendix to identify
icons and other features you can take advantage of for quicker access to
your most commonly used functionality.

This appendix includes OLAP Services features as they appear in the
described interfaces. This information is useful if you own MicroStrategy
OLAP Services. For background information about OLAP Services, see
OLAP Services, page 16.

The Developer and Web interfaces for creating and editing reports and
documents can also be accessed from within MicroStrategy Office, if you
own it. For details on MicroStrategy Office, see the MicroStrategy for Office
Help.

MicroStrategy Developer interface

The MicroStrategy Developer interface has three panes:

l Folder List: Where all the project folders that hold your reports and
report-related objects are accessible. The Folder List displays all the
project sources, projects, application and schema object folders, and the
administrative functions for your business intelligence system. When all
panes are displayed, the Folder List is the center pane of the Developer
interface.

If the Folder List does not automatically appear when you log in to
MicroStrategy Developer, from the View menu select Folder List.

l Object Viewer: Where the contents of each folder, such as reports or
report objects, are displayed as you browse through folders in the Folder
List. The right pane of the MicroStrategy Developer interface is the Object
Viewer.
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l Shortcut Bar: This pane contains icons that allow you instant access to
your favorite or most frequently used folders. Simply click on a shortcut
icon to jump immediately to the folder to which it is linked. You can create
a shortcut to any folder that appears in your Folder List. You can add or
remove shortcuts at any time. For steps, see Adding and removing
shortcuts from the Shortcut Bar, page 413. When all panes are displayed,
the Shortcut Bar is the left pane of the Developer interface.

Adding and removing shortcuts from the Shortcut Bar
Shortcuts are icons on the left side of Developer that provide instant access
to commonly used folders. Shortcut icons are displayed within groups, called
shortcut groups. The image below shows the two default shortcut groups,
Tutorial Shortcuts and Other Shortcuts. The shortcut icons within the
Tutorial Shortcuts group are displayed:

Use the following procedures to create new shortcut groups, add shortcut
icons to groups, and rename or remove icons and groups.
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Creating a shortcut group

Shortcut icons are displayed within groups, called shortcut groups. By
default, the Shortcut Bar contains two shortcut groups, namely Tutorial
Shortcuts and Other Shortcuts. You can create additional groups of shortcut
icons, which can be useful for large MicroStrategy implementations.

You can view the shortcuts within each group by clicking the group name in
the Shortcut Bar. For example, when you click Tutorial Shortcuts in the
Shortcut Bar, the Tutorial Shortcuts group expands to display the shortcuts
to the Tutorial project login, the Tutorial project's My Reports folder, the
Tutorial project's Public Objects folder, and so on. The image above
displays the Tutorial Shortcuts group and its default shortcut icons.

To create a shortcut group

1. Right-click an empty area of the Shortcut Bar and select Add Group.

2. In the Create a new shortcut group dialog box, type a name for the new
group and click OK.

Adding a shortcut icon to a group

When you want to create a new shortcut to a commonly used folder or
project, you must create the shortcut icon within an existing shortcut group.

To add a shortcut icon to a group in the Shortcut Bar

1. On the Shortcut Bar, click the shortcut group to which you want to add
your new shortcut. Any shortcuts which are currently in the group
appear in the Shortcut Bar.

2. In the Folder List, right-click the project or folder for which you want to
create a shortcut, and select Add to Shortcut Bar.
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By default, the name of the shortcut icon is the same as the name of the
folder or project for which you created the shortcut. You can rename any
shortcut icon by right-clicking it and selecting Rename Shortcut.

Removing a shortcut icon from the Shortcut Bar

To remove a shortcut icon from the Shortcut Bar

1. Right-click the shortcut and select Remove from Shortcut Bar.

2. In the confirmation dialog box, click Yes.

Removing a shortcut group from the Shortcut Bar

If you remove a group that has existing shortcut icons within it, the shortcut
icons are deleted also.

To remove a shortcut group

1. Click the shortcut group you want to remove. The shortcut icons which
are currently in the group appear in the Shortcut Bar.

2. Right-click an empty area of the Shortcut Bar and select Remove
Group.

3. In the confirmation dialog box, click Yes to remove the shortcut group.

Renaming a shortcut icon or shortcut group

By default, the name of a shortcut icon is the same as the name of the folder
or project for which you created the shortcut. You can rename any shortcut
icon by right-clicking it and selecting Rename Shortcut.
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To rename a shortcut group

1. Click the shortcut group you want to rename.

2. Right-click an empty area of the Shortcut Bar and select Rename
Group.

3. In the Rename a shortcut group dialog box, type a name for the shortcut
group and click OK.

Navigating through Developer
Use the following menus and tools in MicroStrategy Developer to access the
different reporting features of MicroStrategy.

The menus, options, and icons available to you depend on your security
privileges. For example, if you do not have administrative privileges, you do
not see the Administration menu.

Developer menus

From the Developer menus, you can do the following.

Common Microsoft Windows-style menus and menu options are not included
here, such as the Edit menu, which contains Cut, Copy, Paste, and so forth.

Menu Description

File Create new objects and folders.

View
Change the appearance of the object icons in the Object Viewer
(Developer's right-hand pane). Show or hide the Status Bar, Shortcut
Bar, and Folder List.

Go
Move one level up in the Folder List or go directly to a project's home
page.

Tools Use general Developer tools, such as:
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Menu Description

• Search Editor

• Developer Preferences

• Change Password

Administration

Access administrative functions, such as:

• Project Configuration Editor

• Database Instance Wizard

• Report Scheduler

• User Manager Integrity Checker

• Event Viewer

Schema
Access project design tools such as the Project Creation Wizard and
the Attribute and Fact Creation Wizards.

Window Close all open editors with one click.

Help Access the online help system and useful MicroStrategy websites.

Developer interface icons

From the Developer toolbar, you can do the following:

Name Icon Description

Create a New
Object

Creates a new report or report-related object. The objects
you can create depend on your privileges and your
location in the Folder List.

Cut
Cuts the selected objects. Use this to move or remove
objects from the My Personal Objects folder (and the
folders within it).

Copy Copies the selected objects. Use this to duplicate objects.
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Name Icon Description

Paste
Pastes the objects you have cut or copied. Use this to
move or duplicate objects in the My Personal Objects
folder (and the folders within it).

Delete the
object
selected

Deletes the selected objects.

Rename the
object selected

Renames the selected object in the My Personal Objects
folder (and the folders within it).

View Object
Properties

Displays information about the selected object's general
properties such as type, location, description, creation
and modification dates, owner and user access.

Search
Opens the Search Editor. Use this to search for report-
related objects.

Edit the object
selected

Opens the appropriate editor for the selected object. Use
this to change the settings of an object's definition such
as formatting, sorting, defining totals or subtotals,
assigning thresholds, and so on.

Run
Executes the selected report. Use this to view your
business data in an existing report.

View
Lists options to change the display of the object icons in
Developer's right-hand pane.

Show or hide
the Folder List

Turns the Folder List display on or off. The Folder List
displays all the projects to which you have access, as well
as the folders containing objects within those projects.

Refresh object
with latest

Refreshes the current display.
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Name Icon Description

definition

Go to project Displays the home page of the current project.

Go one level
up

Moves one level up in the Folder List. Use this for quick
navigation among report-related objects and their folders.

MicroStrategy Developer Report Editor interface
If you have report designer privileges, you can use the Report Editor in
either MicroStrategy Developer or MicroStrategy Web to create new reports
in MicroStrategy. (You can of course also access these editors if you have
other sets of privileges, such as Administrator, and so on.) Use this section
to familiarize yourself with the Report Editor interface. The following image
shows the Report Editor in Developer, with the sample Revenue Forecast
report ready to be edited within it:
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For details on report designer privileges and the report designer role, see
Before you begin, page 182 in Chapter 7, Building Query Objects and
Queries, for Designers.

Finding your way around the Developer Report Editor

Refer to the image above as you read about the various areas or panes in
the Developer Report Editor. You can perform the following tasks within the
appropriate Report Editor pane:

l Report Objects pane: (top left) (This pane appears only if you have
MicroStrategy OLAP Services. See OLAP Services, page 16 for details.)
Where you can see a summary of all the objects you have included on your
report.

There may be more objects in this pane than are displayed on the
executed report, because OLAP Services lets analysts quickly remove or
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add objects from this pane directly to the report template. When the report
is executed, the MicroStrategy Engine generates SQL that includes all the
objects in this Report Objects pane, not just the objects that are displayed
in the report after it is executed. For details on using the Report Objects
pane, see Designing reports that use OLAP Services, page 406.

l Object Browser pane: (center left) Where you navigate through the
project to locate objects to include on the report. For details on report
objects, see MicroStrategy objects, page 189.

l My Shortcuts pane: (bottom left) Enables you to access any folder in the
Object Browser quickly. Creating shortcuts can save you time if you
repeatedly browse to the same folders. For details on creating shortcuts,
see Quick object access: Creating shortcuts to objects, page 194.

l View Filter pane: (top right) (This pane is only available if you have
MicroStrategy OLAP Services. See OLAP Services, page 16 for details.)
Where you apply a special kind of filter to any object that is in the Report
Objects pane. View filters do not modify the SQL for the report like normal
report fi lters do. Instead, view filters are applied to the overall result set
after the SQL is executed and results are returned from the data source.
This can help improve report execution performance. For details on using
view filters, see Designing reports that use OLAP Services, page 406.

l Report Filter pane: (center right) Where you add filtering conditions to a
report. Filtering conditions can be made up of attributes, metrics,
advanced filter qualifications, and shortcuts to an existing report fi lter. The
Report Filter pane allows you to create a filter without having to open a
separate object editor (the Filter Editor). Simple filters can be conveniently
created by dragging and dropping objects from the Object Browser into
this pane to create a filter. For details on creating filters, see Filtering data
on a report: Filters, page 232.

l Report View pane: (bottom right) Where you define your report layouts by
dragging and dropping objects from the Object Browser onto this report
view pane. You can create a report to serve as a template for other
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reports; for details on templates, see Designing a report's structure:
Templates, page 343.

l Page-by pane: (top of Report View pane) Where you place subsets of your
report results to be displayed as separate pages of the executed report.
For details on adding page-by functionality to a report, see Grouping data
by page, page 84.

MicroStrategy Web interface

The MicroStrategy Web interface is a set of web pages where you can
browse through folders containing reports and objects, preferences, and so
on for your projects. From the various pages in MicroStrategy Web, you can
perform a number of tasks with the reports, objects, and preferences
available on each page.

Navigating the report interface in MicroStrategy Web
When you execute and view a report in MicroStrategy Web, the interface
allows you to manipulate and explore the report data you are viewing.

The menus, options, and icons available to you depend on your security
privileges. For example, if you do not have administrative privileges, you do
not see the Administration menu.

Web menus

From the interface that is displayed when viewing an executed report in
MicroStrategy Web, you can perform the following.

Common Microsoft Windows-style menus and menu options are not included
here, such as the Edit menu, which contains Cut, Copy, Paste, and so forth.
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Menu Description

Home

Create, save, export, subscribe to, and view the details of reports, and send
reports to the History List.

Change the view of a report by choosing Design, Grid, Graph, or Grid and
Graph view.

Tools

Convert the report to a document.

Change the display using the following report options:

• Merge or lock column and row headers

• Show color banding on the report

• Enable outline mode

• Show thresholds

You can also show or hide the following:

• Report fi lter

• View filter

• Object Browser

• MicroStrategy Web toolbars

• Pivot and sort buttons

• Page-by axis

• A list of reports related to the current report

Data

Manipulate objects and data on the report.

For example, you can do the following:

• Swap the columns and rows

• Add objects to a report

• Edit view filter conditions

• Sort data

• Dril l on a report

• View only specific data on the report by filtering on selections
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Menu Description

• Reset, refresh, or re-prompt the report

• Insert a new metric

• Rename objects on the report

• Include attribute forms on the report

• Enable and customize totals

• Add and edit thresholds

Format

Format various aspects of a grid or graph report.

For example, you can do the following:

• Format the font, size, alignment, and colors of various objects on the grid or
graph report

• Resize the columns and rows

Web interface icons

From the MicroStrategy Web toolbars, you can perform the following:

Name Icon Description

Save Saves your document.

Undo
The last action you made in the document is undone. This option
is available in Design and Editable Modes.

Redo
The last action that was undone is redone. This option is
available in Design and Editable Modes.

Apply
Applies the undo/redo changes you have made to the document.
After clicking this icon, your changes cannot be undone or
redone.

Presentation
Mode

Displays the document in Presentation Mode, a high-level view
where you can view the document as a finalized
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Name Icon Description

product. Presentation Mode displays all document results.

Design

Displays the document in Design Mode, a high-level view where
you can insert and format controls in the document. Design Mode
does not display document results and so provides better
performance than Editable Mode.

Editable
Displays the document in Editable Mode, a detail-level view
where you can insert and format controls in the document.
Editable Mode displays all document results.

Grid View the report as a grid.

Graph View the report as a graph.

Grid and Graph View the report as a grid and the graph.

Home Toolbar

You can share and customize the presentation of your document with the
options listed in the Home toolbar. The Home toolbar is available in all
modes.

Name Icon Description

Grid View the report as a grid.

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

Add to
History List

Adds the document to your History List, which is a folder where you
can save report and document results. Document results in the
History List do not include the latest data unless you periodically
save the document to your History List or create a subscription.
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Name Icon Description

Create
Personal
View

Saves a custom view of the document, useful for giving users
personalized views of the same document. Personal views save all
actions made since opening the document, including sorting,
pivoting, and filtering.

Share
Shares your document in an email, as a link, or as an embeddable
HTML iFrame. You can also define which users or groups can see
and edit the document.

Print Exports the document to PDF for printing.

Send Now
Emails the document to stored email addresses. Email addresses
are stored in your project's preferences.

Schedule
Delivery to
History List

Creates a subscription for the document that sends document
results to the History List on a specific schedule.

Export
Exports your document to Excel, PDF, HTML, or Flash. Use the
drop-down list to select the appropriate export format.

PDF Exports the document to PDF.

Full Screen
Mode

Expands the layout area to fil l the entire screen. This option is
available in Express, Interactive, Editable, and Flash Modes.

Tools Toolbar

You can display or hide panels in the Document Editor with the options listed
in the Tools toolbar. This toolbar is available in Design, Interactive,
Editable, and Flash Modes.

Name Icon Description

Grid View the report as a grid.
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Name Icon Description

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

New Create a new report.

Create
Document

Create a new document.

Create
Dossier

Create a new dossier.

Report
Objects

Displays or hides the objects on your report.

All Objects
Displays or hides the All Objects panel. This option is available in
Design and Editable Modes.

Notes
Displays or hides the Notes panel. For information on using the
Notes panel, see Notes panel.

Related
Reports

Displays or hides the Related Reports panel. For information on
using the Related Report panel, see Related Reports panel.

Page-by-
Axis

Displays or hides the Page-By pane, which displays the attributes
the information is grouped by.

View Filter
Displays or hides the View Filter pane, which displays the filters on
your report.

Report
Details

Displays or hides the Report Details pane, which displays
information, such as filter and prompt details, about the report.

Show pivot
buttons

Displays or hides grid formatting capabilit ies. These buttons
appears on existing objects in your report and allow you to move an
object to a column/row, move the object left/right, add a page-by
filter, or remove the object from the grid.

Show sort Displays or hides the sort button, which sorts a column from A-Z or
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Name Icon Description

button Z-A.

Graph Zones Displays or hides the objects on the x and y axis of a graph.

Report
Options

Change general report options, such as dril l ing capabilit ies, report
formatting, and determining who can view your report.

Insert Toolbar

You can insert text fields, images, lines, panel stacks, and other controls in
a document with the options listed in the Insert toolbar. Select a control from
the Insert toolbar or menu, then click an area in the document to place the
control.

This toolbar is available in Design and Editable Modes.

Name Icon Description

Design

Displays the document in Design Mode, a high-level view where
you can insert and format controls in the document. Design Mode
does not display document results and so provides better
performance than Editable Mode.

Editable
Displays the document in Editable Mode, a detail-level view where
you can insert and format controls in the document. Editable Mode
displays all document results.

Select
Controls

Allows you to select controls instead of inserting them.

Lock Control
Allows you to insert a control that cannot be resized or moved.
Select this icon before placing the control you want to insert.

Text Inserts a rectangular field where you can type and format text.

Image Inserts an image into the document. The image must be stored in a
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Name Icon Description

location that is accessible by the Intelligence Server, the designers
of the document, and the document's end-users. For guidelines on
using accessible images, see Ensuring access to images.

Line Inserts a line into the document.

Rectangle
or Rounded
rectangle

Inserts a rectangle into the document. Use the drop-down list to
select the type of rectangle.

Report

Adds any report in your project as a Grid/Graph to the document. If
the report is not already a dataset for the document, the report is
added as a dataset as well.

A Grid/Graph acts as a standard MicroStrategy report and displays
data in Grid, Graph, or Grid and Graph view. To format and
manipulate the data in a Grid/Graph, see Displaying Reports in
Documents: Grid/Graphs.

Grid
Inserts a Grid placeholder that displays as a grid. A Grid
placeholder is an empty Grid, without a dataset to populate the Grid
with data. For more information, see Adding an empty Grid.

Graph

Inserts a graph as a placeholder. Use the drop-down list to select
the graph style. Whichever graph type you select appears without a
dataset to populate it with data. For more information, see Adding
an empty graph.

Panel Stack

Inserts a panel stack. A panel is an object in a dashboard used to
group related data. Panel stacks contain one or more panels, where
only one panel is displayed within the panel stack at a time. When
you add a panel stack to a document, one panel is automatically
added to the panel stack.

Filter Panel
Inserts a special panel stack, where all panels in the stack must
display selectors.

Table
Control

Inserts a form you can use to prompt users for information in a
document displayed on a mobile device. You can add multiple text
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Name Icon Description

(Mobile) fields for users to fil l out and group the text fields by category.

HTML
Container

Inserts an empty HTML container, which is used to display Flash
and AJAX content in the document. The content displays as though
it is in an HTML browser within the document. This allows a
document to display Flash information when the document itself is
not in Flash Mode. See Displaying real-time web and other HTML
content: HTML containers.

Selectors

Inserts a selector, which allows a user to flip through the panels in a
panel stack or display different attribute elements or metrics in a
Grid/Graph. Use the drop-down list to choose the type of selector.
Selectors are interactive in Editable and Presentation Modes.

Buttons

Inserts a button, which is a clickable field that redirects the user to
a report, document, or outside link. Use the drop-down list to select
the button type. For steps to link to a report, dashboard, or URL
from a button, see Linking from a button.

Widgets
Inserts a widget, which is a highly visual, Flash-based display of the
results of a dataset. Widgets are often interactive. Use the drop-
down list to choose the type of widget you want to use.

Layout
Inserts a layout, which is like adding a document within your
document. Layouts can have different primary datasets and
document settings.

Document
Inserts a previously-saved document as an additional layout to your
document.

Data Toolbar

You can conditionally format your data or control the display of values in a
Grid/Graph with the options listed in the Data toolbar. This toolbar is
available in Design, Interactive, Editable, and Flash Modes.
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Name Icon Description

Grid View the report as a grid.

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

Add View Filter
Conditions

Defines conditions for a view filter to exclude data from a grid or
graph. For background information on view filters and steps to
filter data, see Using view filters on Grid/Graphs.

Sort Defines sorting rules for the selected control.

Dril l Define dril l ing options.

Filter on
Selections

Filter on a specific section. Select a section of your report and
click the icon to filter the section.

Hide
Nulls/Zeros

Displays or hides null or zero values in a grid. For steps, see
Determining how null and zero metric values are displayed.

Refresh Refresh your report.

Swap Rows
and Columns

Switches the data displayed in the rows with the data in the
columns of a selected grid.

Insert New
Metric

Creates a new metric to add to a grid or dataset.

Rename/Edit
Objects

Renames or edits objects.

Edit Attribute
Forms

Define your attribute forms as either DESC, ID, or both.

Toggle
Attribute
Forms

Displays or hides all attribute forms for an attribute in a
Grid/Graph. Available if the attribute has multiple attribute forms
that can be displayed.
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Name Icon Description

Show Totals Displays subtotals and grand totals on a Grid/Graph.

Edit Totals
Opens the Totals Editor, where you can define the subtotals and
grand totals used on a Grid/Graph, such as Sum, Average, and
Count. You can define how and where subtotals are displayed.

Quick
Thresholds

Applies a predefined threshold to a metric in a grid. Use the
drop-down list to select the threshold type. For background
information on thresholds, including instructions and examples,
see Formatting conditional data in documents

Toggle
Thresholds

Displays or hides the thresholds in a grid. Available if a threshold
has been defined on the grid. For background information on
thresholds, see Formatting conditional data in documents.

Visual
Conditional
Formatting

Opens the Visual Conditional Formatting Editor, where you can
create a simple threshold based on a single metric. For steps to
create a simple threshold, see Creating a conditional format or
threshold based on a single metric.

Advanced
Conditional
Formatting

Opens the Advanced Conditional Formatting Editor, where you
can create thresholds which can be based on multiple metrics
and have more complex expressions than a simple threshold. For
steps to create an advanced threshold, see Creating a
conditional format or threshold based on multiple metrics or
attributes.

Grid Toolbar

You can format the display of a Grid/Graph in Grid view with features listed
in the Grid toolbar. The options available may vary depending on the display
mode used to view the document. This toolbar is available in Design and
Editable Modes.
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Name Icon Description

Grid View the report as a grid.

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

Autostyles

Applies a predefined autostyle to a selected grid. Use the drop-
down list to select the autostyle. For background information and
instructions on how to create and save an autostyle, see Formatting
using predefined formats (Autostyles).

Banding
Displays alternating rows of data in a Grid/Graph with alternating
background colors to make rows easier to read.

Outline Organizes the attributes in a Grid/Graph in a hierarchical display.

Merge
Column
Headers

Combines columns that are next to each other and have the same
header into a single column.

Merge Row
Headers

Combines rows that are next to each other and have the same
header into a single column.

Lock Row
Headers

Always displays row headers to the left of the selected grid when a
user scrolls horizontally in the grid.

Lock
Column
Headers

Always displays column headers at the top of the selected grid
when a user scrolls vertically in the grid.

Auto Fit to
Contents

Expands or shrinks the width of each column in a grid to fit the text
in the column.

Auto Fit to
Window

Expands the width of columns in a grid to fit the window. This option
does not reduce the size of columns if the window is not wide
enough to fit all text in them.
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Graph Toolbar

You can format the display of a Grid/Graph in graph view with the options
listed in the Graph toolbar. The options available may vary depending on the
display mode used to view the document. This toolbar is available in Design
and Editable Modes.

Name Icon Description

Grid View the report as a grid.

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

Graph Type

Defines the graph type of a Grid/Graph in Graph view, such as
Vertical Bar or Horizontal Bar. The graph type defines the shape
used to represent data values. Use the drop-down list to select the
graph type.

Graph
Subtype

Defines the graph subtype of a Grid/Graph in Graph view, such as
Clustered or Absolute. The graph subtype formats the axes and
display of categories and series. Use the drop-down list to select
the graph subtype.

Legend Displays or hides the legend for a Grid/Graph in Graph view.

Data Values
Displays or hides data values near data markers for a Grid/Graph
in Graph view.

Series by
Row

Displays objects on the Grid/Graph's rows as the series of the
graph.

Series by
Column

Displays objects on the Grid/Graph's columns as the series of the
graph.

Auto Arrange

Any formatting changes you have applied are undone and the
graph reverts to its default formatting.

This icon is available if the document was created based off of a
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Name Icon Description

graph report with the Manual Layout option enabled. The Manual
Layout option is located under Graph Preferences for a report in
MicroStrategy Developer.

Categories

Sets a maximum for the number of categories in a graph based on
the value typed into the Categories field. The limit must be applied
with the Apply icon before the graph is updated. The default value
is 6.

Series
Sets a maximum for the number of series in a graph based on the
value typed into the Series field. The limit must be applied with the
Apply icon before the graph is updated. The default value is 5.

Apply
Applies the limits defined in the Categories and Series fields to
the graph.

Format Toolbar

You can access common styling options from the Format toolbar. Many of
these features are not available outside of Editable Mode. This toolbar is
available in Design and Editable Modes.

Name Icon Description

Grid View the report as a grid.

Graph View the report as a graph.

Grid and
Graph

View the report as a grid and the graph.

The name of
the object
you want to
format

The object you want to format. Use the drop-down menu to select
the correct object. If additional drop-down lists appear, you may
select objects, shapes, and text within the initial object. You can
then select the appropriate options to format the object, as
described below.
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Name Icon Description

Font
Defines the font of the selected text. Use the drop-down menu to
change the font.

Font Size
Defines the font size of the selected text. Use the drop-down menu
to change the font size.

Bold Bolds the selected text.

Italic Italicizes the selected text.

Underline Underlines the selected text.

Left Left-aligns the selected text.

Center Center-aligns the selected text.

Right Right-aligns the selected text.

Justify
Justifies the selected text so that each line of text occupies the
same width.

Currency
Style

Displays the selected number with a US dollar sign in front and two
decimal places.

Percent Style
Displays the selected number as a percentage, with no decimal
places.

Comma Style
Displays the selected number with a comma every three digits and
no decimal places.

Increase
Decimal

Increases the number of digits that display after the decimal point.

Decrease
Decimal

Decreases the number of digits that display after the decimal
point.

Fill Color
Sets the background color of the control. Use the drop-down list to
select from a color palette, define a new color, or create a
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Name Icon Description

gradient.

Line Color
Sets the color of a line or border. Use the drop-down list to select
from a color palette or define a new color.

Text Color
Sets the color of text. Use the drop-down list to select from a color
palette or define a new color.

Borders
Defines the borders that display around a control. Use the drop-
down list to select the borders that display.

Border Style
Defines the line style of the selected border. Use the drop-down
list to select the line style.

Advanced
Grid
Formatting

Set advanced font, number, alignment, color, and line formatting
on a grid.

Advanced
Graph
Formatting

Set advanced font, number, alignment, color, and line formatting
on a graph.

MicroStrategy Web Report Editor interface
If you have Web Professional privileges, you can use the Report Editor in
MicroStrategy Web to create new reports. (You can of course also access
this editor if you have other sets of privileges, such as Administrator, and so
on.) Use this section to familiarize yourself with the Report Editor interface.
The following image shows the Report Editor in Web.
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For details on report designer privileges and the report designer role, see
Before you begin, page 182 in Chapter 7, Building Query Objects and
Queries, for Designers.

Finding your way around the MicroStrategy Web Report Editor

Refer to the image above as you read about the various areas or panes in
the Web Report Editor. You can perform the following tasks within the
appropriate Report Editor pane:

l Object Browser pane: (left-hand side) Where you navigate through the
project to locate objects to include in the report. In the Object Browser you
can navigate to All Objects in the project. If you have MicroStrategy
OLAP Services, you can also choose to navigate only through Report
Objects:

l All Objects pane: Where you see the list of all the objects available in
your project.

l Report Objects pane: (This pane appears only if you have
MicroStrategy OLAP Services. See OLAP Services, page 16 for details.)
Where you can see a summary of all the objects you have included on
your report.
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l There may be more objects in this pane than are displayed on the
executed report, because OLAP Services lets analysts quickly remove or
add objects from this pane directly to the report template. When the
report is executed, the MicroStrategy Engine generates SQL that
includes all the objects in this Report Objects pane, not just the objects
that are displayed in the report after it is executed. For details on using
the Report Objects pane, see Designing reports that use OLAP Services,
page 406.

l Notes pane: Where you can see the notes that include report details,
such as information on how the report was created, reasons to use it, or
queries about the data displayed.

l Related Reports pane: Where you can see a list of reports and
documents related to the objects in the current report.

l Report Filter pane: (top left) Click the Filter icon to display the Report

Filter and View Filter panes:

l Report Filter pane: Where you add filtering conditions to a report.
Filtering conditions can be made up of attributes, metrics, advanced
filter qualifications, and shortcuts to an existing report fi lter. The Report
Filter pane allows you to create a filter without having to open a
separate object editor (the Filter Editor). Simple filters can be
conveniently created by dragging and dropping objects from the Object
Browser into this pane to create a filter. For details on creating filters,
see Filtering data on a report: Filters, page 232.

l View Filter pane: (This pane is only available if you have MicroStrategy
OLAP Services. See OLAP Services, page 16 for details.) Where you
apply a special kind of filter to any object that is in the Report Objects
pane. View filters do not modify the SQL for the report like normal report
fi lters do. Instead, view filters are applied to the overall result set after
the SQL is executed and results are returned from the data source. This
can help improve report execution performance. For details on using
view filters, see Designing reports that use OLAP Services, page 406.
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l Page-by pane: (top left) Where you place subsets of your report results to
be displayed as separate pages of the executed report. For details on
adding page-by functionality to a report, see Grouping data by page, page
84.

l Template pane: (top left) Where you define your report layouts by
dragging and dropping objects from the Object Browser onto this report
template pane. For details on templates, see Designing a report's
structure: Templates, page 343.

Basic Repor t ing Guide


	Book Overview and Additional Resources
	1. Getting Started with MicroStrategy Reporting
	Starting MicroStrategy
	Opening a report
	Components of a report
	Report types
	Displaying multiple reports in a single presentation
	OLAP Services
	Printing a report
	Exporting data
	Emailing a report

	2. Formatting a Report
	Ideas for formatting
	Formatting a grid report
	Formatting a combined grid and graph report
	Formatting a graph report
	Formatting numeric data in a report
	Preset formatting: Autostyles

	3. Analyzing Data
	Sorting data
	Finding values
	Summary/detail of data
	Pivoting data
	Specifying maximum and minimum values: Report limits
	Calculating data

	4. Answering Questions about Data
	Filtering data
	Understanding hierarchies
	Drilling into related data
	Controlling drilling behavior to affect report results

	5. Answering Prompts and Refreshing Data
	Refreshing a report
	Answering report prompts
	Saving and re-using prompt answers: Personal answers
	Saving reports with prompts

	6. Building a Quick Query for Analysis
	Prerequisites
	Creating a report by combining a template and a filter: Report Wizard
	Quick report creation: Building a new report

	7. Building Query Objects and Queries, for Designers
	Before you begin
	MicroStrategy objects
	Providing business context to a report: Attributes
	Calculating data on a report: Metrics
	Filtering data on a report: Filters
	Asking for user input: Prompts
	Designing a report's structure: Templates
	Creating a grid report
	Adding features for users
	Modifying an existing report
	Creating other types of reports
	Designing reports that use OLAP Services
	Building a query using alternative data access methods

	A. Reporting Interfaces in MicroStrategy
	MicroStrategy Developer interface
	MicroStrategy Web interface


